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About this workbook
This workbook is intended to get you started learning and using ER Mapper 6
oil and gas exploration applications using interpreted seismic data. It provide
simple step-by-step lessons that give you hands-on practice using the basic 
features of the software, and using more advanced features as well. Please re
following important information before beginning.

• Chapter contents

• Setting up practice datasets

• Typographical conventions used in this document

This manual is not intended to cover all ER Mapper functionality in depth. Ple
refer to the ER Mapper User Guide and other manuals for more detailed 
information as needed.

Note: The hands-on exercises in this workbook require that the sample datasets an
algorithms supplied on the ER Mapper CD-ROM be installed and accessible.
Please refer to Appendix A “System setup” in this manual for more informatio

Chapter contents
The chapters in this manual give you extensive hands-on experience using th
ER Mapper software through a series of specially designed lessons.  Most le
have two basic sections: 

• an overview of key concepts

• a series of step-by-step hands-on exercises
ER Mapper Workbook -  Seismic Geophysics Applications 7
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It is recommended that you start at the beginning and proceed through the ch
in order because the later chapters build on concepts learned in earlier ones.
However, each chapter is independent of the others, so you can refer to a sp
chapter at any time for a quick procedural overview or refresher course. 

The emphasis of this manual is on learning and using the ER Mapper softwar
on teaching image processing, interpretation of seismic data, and other conc
For more detailed information on the concepts or specific applications, please
to the ER Mapper Applications Manual, any of the text books available, or journa
articles listed in Appendix B “References.” 

Setting up practice datasets
The exercises in this manual assume that ER Mapper is installed and license
that you will use the default ER Mapper ‘tutorial’ directory to save sample 
processing algorithms and other files during the lessons.  In addition, some 
chapters require that copies of the ER Mapper sample datasets be placed int
‘tutorial’ directory for use by individual students. For information on configurin
your system for these exercises, please refer to Appendix A “System setup” in
workbook.  

Typographical conventions 
The following typographical conventions are used throughout this document: 

• ER Mapper menus, button names and dialog box names are printed in boldfa
Helvetica type, for example: 

“Select Print  from the File  menu to open the Print  dialog box.”

• Where you are asked to click the mouse on an icon button in the user interface
the button and its formal name are indicated in the text. For example:

“Click the Print   button.”

• Text to be typed in a dialog box text field is shown in boldface Courier typeface
example: 

“Type seismic horizon in the text field.” 
8 ER Mapper Workbook -  Seismic Geophysics Applications
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Introduction to
ER Mapper

This chapter briefly describes the role ER Mapper plays as an important tool 
the enhancement, integration and analysis of interpreted 3-D seismic survey 
for the oil and gas exploration industry. It also contains a brief overview of gen
image processing concepts and terminology, and information about how ER 
Mapper works compared to traditional image processing software. 

Image processing of interpreted seismic
With the ever increasing number of 3-D seismic surveys being acquired, it is 
essential that interpretation of the data be both effective and efficient to ensur
maximum information is derived. Image processing, traditionally applied to 
datasets such as satellite images, has now become an important tool for explo
geophysicists to analyze interpreted seismic horizon datasets and their assoc
attributes. ER Mapper provides unique capabilities for enhancing and visualiz
surface interpretations, and integrating data from a variety of sources to crea
quality map products. ER Mapper can lower exploration costs by aiding detec
of subtle structural features and lineations not readily discernible by other me
This type of information can, for example, be used to improve the positioning
accuracy of target wells. 

ER Mapper provides many features to visualize and integrate interpreted seis
and attribute data, including abilities to: 
ER Mapper Workbook -  Seismic Geophysics Applications 11
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• import data in common geophysical formats, including SEG-Y, Landmark 
Graphics products, Schlumberger-GeoQuest products, and more;

• apply sophisticated illumination and shading effects to rapidly identify small sc
faulting, subtle stratigraphic features, and acquisition/processing artifacts; 

• combine structure and attribute images into a single display by showing data a
color and brightness (“colordraping”); 

• use math functions to generate dip, azimuth, isochron, and other derivative im
of complex time surfaces; 

• register satellite images to actual locations of seismic shots; 

• tie subsurface images to surface geology;

• combine different types of raster, vector, and tabular data into a single visualiza

• render top quality, cartographic maps to over 230 hardcopy devices and stan
graphics file formats. 

ER Mapper is also very easy to learn and use, so you can be performing use
work within hours rather than the days or weeks required for learning conventi
image processing software. 

Image processing concepts
The term digital image processing refers to the use of a computer to manipulate
image data stored in a digital format. The goal of image processing for earth 
science applications is to enhance geographic data to make it more meaning
the user, extract quantitative information, and solve problems.

A digital image is stored as a two-dimensional array (or grid) of small areas ca
pixels (picture elements), and each pixel corresponds spatially to an area on t
earth’s surface. This array or grid structure is also called a raster, so image data is 
often referred to as raster or gridded data. The raster data is arranged in hori
rows called lines, and vertical columns called samples. Each pixel in the image 
raster is represented by a digital number (or DN). 
12 ER Mapper Workbook -  Seismic Geophysics Applications
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For interpreted seismic data, the DNs represent two-way travel time, event 
amplitudes, or other seismic attributes. By applying mathematical transforma
to the digital numbers, ER Mapper can enhance image data to highlight and e
very subtle information that would be impossible using traditional manual 
interpretation techniques. This is why image processing has become such a 
powerful tool for all types of earth science applications. The exercises in this 
workbook provide many examples that illustrate how image processing is typic
used to enhance and visualize interpreted seismic datasets.

Image datasets can also have multiple bands (or layers) of data covering the same
geographic area, each containing a different type of information. For example
interpreted seismic dataset might have one band containing two-way time data
another band containing the corresponding event amplitudes.

Traditional image processing
Image processing was first developed on large mainframe computers in the 1
to process images from planetary satellites. To process an image, you specifi
name of the file to process, the type of operation you wanted to perform, then
waited for the system to process the data and write the results to a new imag
on disk (shown in the diagram below). You then used a separate display progr
view the output file and evaluate your results. 

columns
(samples)

rows
(lines)

individual cells or
pixels in raster grid

Input file
Single image

processing operation Output file
ER Mapper Workbook -  Seismic Geophysics Applications 13
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With traditional systems, the changes resulting from the image processing 
operation are saved in a separate output raster file. 

With the introduction of powerful workstations in the 1980’s, processing of lar
images could now be performed on the desktop. Surprisingly, nearly all imag
processing products on the market today are still designed around this 
“disk-to-disk” approach from the 1960’s. This means that to perform a proces
operation that requires several steps, you need to write an intermediate file to
for each step. Only when the final file is created can you view your desired res
This approach can consume tremendous amounts of time and disk space, an
result is not what you intended, you must often start all over again. 

ER Mapper image processing
Recognizing the restrictions inherent in traditional software and the capabilitie
new computers, the creators of ER Mapper developed an entirely new approa
Instead of writing a file to disk for each processing step, ER Mapper lets you 
combine many processing operations into a single step, and render the resul
directly to your screen display in near real-time. (In most cases, no processed
copies of your original data are written to disk unless you request to do so.) Th
of processing steps you apply to your data is called an “algorithm data view” 
ER Mapper because it lets you define a view into your data. 

With ER Mapper, you save only a description of the processing steps you wish to 
apply to the data (the algorithm), not separate processed copies of the original 
raster data file. By storing the algorithm data views separately from the actual 
image processing becomes much faster, easier to learn, and more interactive

In ER Mapper, algorithms can be used for simple viewing of data, or for very 
complex processing and modelling operations involving many images, 
transformations of the data, and overlays of other types of data. 

Image processing tasks
A flowchart of typical image processing tasks is summarized in the following 
diagram, from data import through processing to final output. You may or may
need to perform some of these tasks for your application, but it is helpful to ha
general idea of a typical procedure:

Processing algorithm:
   - formulas (ratios, PC, etc.)

Input file    - filters (sharpen, edges,)
   - contrast & brightness
   - sun illumination, etc...

Image
display
14 ER Mapper Workbook -  Seismic Geophysics Applications
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Data import
The first step in image processing is importing the data you want to use into 
ER Mapper. For exploration geophysics applications, raster datasets are usua
preprocessed and gridded using seismic interpretation software packages. T
resulting interpreted horizon datasets and attributes are then opened in ER M

Data

Image

Image

Image

Read external data from tape, CD-ROM, etc.

View image data on a CRT monitor to evaluate

Geometrically align images (register) or

Digitally process image data to aid visual

import

display

registration/
rectification

enhancement

Dynamic

Annotation

Data export

Links
layers

& map
composition

& hardcopy
printing

and convert for use and processing in ER Mapper.
(Raster image data or vector line data.)

quality or area coverage, or display statistical
information such as histograms or pixel values.

geometrically correct images to correspond
to geodetic coordinate systems (rectify).

interpretation or highlight specific information
(contrast enhancement, filtering, ratios, etc.).

Link directly to raster, vector, or tabular data

Setup a map page, and annotate images with

Export processed data to external file formats,

in external products or files and display the
data over raster images (without file translation).

text, lines, shaded polygons, legends, scale
bars, coordinate grids and other map objects.

and print images and maps on over 200 
hardcopy devices (printers, film, and more).
ER Mapper Workbook -  Seismic Geophysics Applications 15
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for further enhancement, analysis and map production. Typically the data mig
stored on magnetic tape, CD-ROM, or other media. There are two primary typ
data you may want to import into ER Mapper: raster and vector.

Note: ER Mapper can directly read image data in a number of formats without the n
to import it as an ER Mapper Raster Dataset.

Raster image data (such as an interpreted time grid) is the type used as input t
image processing operations. When you import a raster image file (using 
ER Mapper’s import utility programs), ER Mapper converts the data and crea
two files:

• a binary data file containing the raster data, in band interleaved by line (BIL) fo

• a corresponding ASCII header file with an “.ers” file extension

Vector data is stored as lines, points, and polygons. Many geographic informa
system (GIS) and mapping products use vector data structures because it is 
efficient for representing discrete spatial objects like faults (lines), wells (poin
or lease block boundaries (polygons). In an image processing product, it is of
helpful to overlay vector data on top of a raster image backdrop, for example 
overlay interpreted faults or lease boundaries on a seismic horizon. When yo
import a vector file (using ER Mapper’s import utility programs), ER Mapper 
converts the data and creates two files:

• an ASCII data file containing the vector data

• a corresponding ASCII header file with an “.erv” file extension

Image display
After importing the data, the next step is usually to display the image on your 
monitor to evaluate the data quality and geographic area of coverage. There 
several ways in which data can be viewed, including simple black and white o
pseudocolor displays, and red-green-blue (RGB) or hue-saturation-intensity (
color composite displays. The way in which you choose to display your raster
is called the “Color Mode” in ER Mapper. 

In addition to displaying the data, you may want to view statistical information
about it. Statistics are often good indicators of image quality and anomalies. Y
can calculate statistics for the dataset, such as the mean value in each band,
view them in a tabular format. Or you may want to view statistical information 
graphical format using tools like histograms, scattergrams, and traverse profi
16 ER Mapper Workbook -  Seismic Geophysics Applications
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Gridding
The ER Mapper Gridding Wizard can extract regularly gridded raster files from
combination of any or all of the following types of data.

• Random line data 
• Contour data, with faults, streamlines, ridgelines, and breaklines
• Random point data 
• Regular line data
• Regularly gridded raster file 

The output data is a raster (.ers) file with single or multiple bands containing 
regularly spaced grids.

This is useful where data is required to be in a regularly spaced grid, but is on
available as samples taken at irregularly spaced locations. 

Image rectification
Raster image data is sometimes supplied in a “raw” state, although this is usu
not the case with interpreted seismic datasets. Whenever accurate area, dire
and distance measurements are required, raw image data must usually be 
processed to remove geometric errors and/or rectify the image to a real world
coordinate system.

• Registration is the process of geometrically aligning two or more images to all
them to be superimposed or overlaid.

• Rectification is the process of geometrically correcting raster images so they 
correspond to real world map projections and coordinate systems (such as La
Longitude or Eastings/Northings).

If your application requires that your images be registered to one another or 
rectified to a map projection, you can use ER Mapper’s Geocoding Wizard 
utilities. You can also use the wizard to rotate a dataset, or to transform a dat
from one coordinate system to another (for example to match other data).

Image enhancement
Image enhancement refers to any one of many types of image processing 
operations used to digitally process image data to aid visual interpretation or 
extract quantitative information meaningful to the user. Image enhancement i
what many people commonly think of as “image processing.”

In ER Mapper, image enhancement operations are greatly simplified by the 
“algorithms” processing concept. Nearly all types of image enhancement 
operations can be applied and displayed in real time to provide truly interactiv
control without writing temporary files to disk. 

Typical image enhancement operations include:
ER Mapper Workbook -  Seismic Geophysics Applications 17
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• Colordraping–Drape one type of data over another to create a combined disp
allowing analysis of two or three variables. For example, drape seismic ampl
in color over a shaded two-way time image that highlights structural features.

• Contrast enhancements–Improve image presentation by maximizing the contras
between light and dark portions (or high and low data values) in an image. O
highlight a specific data range or spatial area in an image.

• Filtering–Enhance edges, smooth noise, or highlight or suppress specific line
spatial features in images. For example, apply a gradient directional filter to 
highlight structural features tending north-south in an image. ER Mapper also
includes Fourier transformations for processing in frequency domain space.

• Formula processing–Apply mathematical operations to combine multiple horizo
datasets or attributes to derive specific thematic information. In ER Mapper, 
formulas are used for thresholding, differencing, and for creating derivative im
such as dip, azimuth, isochrons and others.

• Real-time 3D visualization–View and manipulate time surfaces and attributes in 
perspective or 3D flythrough modes. ER Mapper lets you stack multiple surfa
such as time horizons with color attribute overlays, and manipulate the viewp
transparency, and other parameters of the surfaces in real-time.

Dynamic Link layers
Dynamic Links are a special ER Mapper feature that let you link to data in exte
products or file formats, and display the data on top of raster images without 
need for importing the files. Dynamic Links can link to raster, vector, or tabula
(point) datasets, so you can access and integrate all your geographic information. 
ER Mapper provides Dynamic Links to several popular products and file form
and the procedure is fully documented so you can also create your own links t
other product or format you desire. 

Types of Dynamic Links include: 

• Links to mapping and GIS products–Extract and display vector data from GIS 
products such as ARC/INFO, and mapping products such as Microstation. G
links are often used to overlay vector data such as geology or lease boundar

Tip: You can display, edit, and save ARC/INFO coverage files directly in ER Mapp
See the ER Mapper User Guide for details.

• Links to database products–Extract and display tabular (point location) data from
database products such Oracle. Tabular links are often used to overlay 
georeferenced point location symbols such as well locations.

• Links to external file formats–Display specialized annotation, vector data, or oth
data stored in PostScript, DXF, DGN, or other standard vector file formats.
18 ER Mapper Workbook -  Seismic Geophysics Applications
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Note: ER Mapper can also import vector data in Z-MAP Plus (.zgf), simple ASCII, a
other vector formats.

Map composition
You can use ER Mapper’s built-in annotation and map composition tools to cr
top quality image maps combining raster, vector, and tabular data. Annotation
you draw directly on-screen using text, line, polygon, and other annotation to
and specify fill color, shading, line styles, and group, resize and move objects
Vector annotation files can also be exported to external file formats for use in o
products (for example exporting faults interpreted in ER Mapper to other seis
processing products).

ER Mapper’s map composition tools let you create top quality image maps by
adding titles, coordinate grids, map collars, scale bars, legends, north arrows
many other map objects. You can layout and compose simple maps of any de
size or map scale, and more complex maps comprised of multiple images an
external data sources. All ER Mapper map objects are defined as full color 
PostScript, and you can easily add custom map objects such as company log
special north arrows.

Data export and hardcopy
Once you have completed processing your data, ER Mapper lets you translat
raster and vector data to external standard file formats or print to over 230 diffe
hardcopy devices. 

ER Mapper’s EVW compression allows you to save large images as small file
without any noticeable degradation in quality. This is particularly useful if you 
want to distribute the images over the Internet.

Data export is used to export the processed version of your raster images for 
another product that handles gridded raster data. Or, you may want export ve
annotation or vectorized thematic data to another product. 

Note: ER Mapper allows you to save your image data in a number of formats for us
external applications. 

Hardcopy printing is often the final goal of processing and annotating images
ER Mapper provides unsurpassed hardcopy support and output to standard 
graphics file formats. ER Mapper also includes a built-in PostScript-compatib
rendering engine, so you get PostScript-quality output (such as beautiful, sm
text) on any supported device, whether the device supports PostScript or not
ER Mapper Workbook -  Seismic Geophysics Applications 19
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You can also easily print at exact sizes and map scales, and automatically pr
images in strips for mosaicking large image displays. Supported hardcopy de
include film recorders, dye sublimation printers, electrostatic plotters, and ink
thermal and laser printers. Graphics file formats include PostScript, TIFF, CG
Targa, and CMYK and RGB color separations.
20 ER Mapper Workbook -  Seismic Geophysics Applications
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User interface
basics

This chapter introduces the basic use of the ER Mapper graphical user interfa
gives you practice using menus, toolbars, dialog boxes, and image windows,
loading and displaying datasets using sample algorithm data views.

Note: In order to complete the exercises in this manual, you will need to access the
sample datasets and algorithms supplied with ER Mapper. If needed, ask you
system manager for the location of the ER Mapper software directory at your

User interface components
This section provides a brief introduction to the main components of ER Mapp
graphical user interface (GUI). You can perform nearly all operations by point
and clicking with the mouse, and very little typing on the keyboard is required. 
GUI is part of ER Mapper’s original design, so it is well integrated and easy to
learn and use.
ER Mapper Workbook -  Seismic Geophysics Applications 21



Chapter 2 User interface basics z User interface components

ions 

n 
nual 

se 

 
se 

 

Using mouse buttons
When using ER Mapper, use the left button on your mouse to perform operat
like selecting items from menus, manipulating image windows, and drawing 
annotation. In this manual, all actions are performed with the left mouse butto
unless otherwise indicated. The following table explains terms used in this ma
to describe actions you perform with the mouse.

The symbol representing the mouse pointer on the screen changes shape 
depending on what you are pointing to and the task you are performing.

Term Meaning

Point Position the mouse pointer on an item.

Click Point to an item, then quickly push and release the left mou
button.

Right-click Point to an item, then quickly push and release the right 
mouse button.

Double-click Point to an item, then quickly click the left mouse button 
twice.

Drag Point to an item. Then press and hold down the left mouse
button as you move the pointer to a new location, then relea
the button.

Shift-click or
Ctrl-click

Hold down the Shift key or Ctrl key on your keyboard, then 
click.

Shift-drag or 
Ctrl-drag

Hold down the Shift key or Ctrl key on your keyboard, then 
drag the mouse.

Pointer Location on the screen Function

 Menu bars and buttons; or 
inside image window

Choose menu commands and click 
buttons; point to the image to see 
data values or coordinates.

 Text fields Type or select text, or reposition the
insertion point.

Inside the current image 
window

Zoom the image within the image 
window.

Inside the current image 
window

Drag a box over an area to fill image 
window.
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The ER Mapper main menu
When you start ER Mapper, the main menu appears. The main menu has two
primary components–the menu bar and rows of toolbar buttons.

Using ER Mapper toolbars
Toolbars give you quick access to many common functions, such as saving a
image processing algorithm or printing a hardcopy. ER Mapper also provides
optional toolbars for specific tasks and image processing applications. To hid
display various toolbars, use the Toolbar  menu. To get short help for any toolbar
function, point to the button and read the tool tips.

Inside the current image 
window

Pan the image within the image 
window.

 Inside inactive image 
windows

Select an inactive window to become
the current window.

 In image windows when 
annotation tools are selected

Draw annotation and map 
composition objects.

Menu bar Lets you select commands used to carry out actions in 
ER Mapper. To select a command from the menu bar, 
click on the name of the menu to open it, then click the 
desired command name.

Toolbar buttons Shows groups of buttons to let you carry out common 
tasks quickly. To choose a function from a toolbar, click
on the desired button. 

Tool tips Place the cursor on any toolbar button and within a 
couple of seconds the function of that toolbar button is 
displayed in a small text window just below the cursor

Title bar

Buttons

Toolbars

Menu bar
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ER Mapper provides toolbars for many common tasks, and also toolbars for 
building processing algorithms commonly used in remote sensing application
such as forestry, geophysics, and map generation. The functions of the Stand
and Common Functions toolbars are summarized below.

Using ER Mapper’s scripting language, you can also create your own custom
toolbars for specific tasks and functions. For more information on creating cus
toolbars, see the ER Mapper User Guide. 

Using dialog boxes
When you select menu commands or click toolbar buttons, dialog boxes often
appear for you to choose options to control your image processing tasks. Som
dialog boxes, such as the File Chooser, can disappear when you make your 
selection. Other dialogs can remain open for setting options for as long as yo
want to use them. 

To resize a dialog box, drag one of its corners or edges to the desired size. 
ER Mapper automatically resizes the dialog box intelligently, so that any cent
display areas are enlarged, and the layout of buttons remains the same. Afte
resizing, the dialog retains your new size for the current ER Mapper session. 

Standard Provides quick access to standard commands for 
opening and saving algorithms, printing, starting and 
stopping algorithm processing, and changing the mous
pointer. Most functions are also available from the 
menu bar.

Common Functions Provides quick access to commonly used functions, 
such as creating general types of algorithms, viewing 
and editing components of an algorithm.

text fields
(click to
place cursor)

drop-down
list (click to
open)

click to load
file

close dialog
without action

display setup
options

access on-line
help for this
function
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Using the File Chooser dialog boxes
When you choose to open or save a dataset, algorithm, or other file, ER Map
displays a File Chooser dialog box. The central window contains a list of 
directories, or files in the current directory.

To open a file or directory displayed in the scroll list window, either double-clic
on it, or click once to select it and click the OK or Apply  button to open it. 

Tip: You can see two levels of directories and/or files by widening the file chooser
dialog box (drag one of the sides).

current directory

scroll to view 
other items
in directory

click to view
comments

click to load and leave dialog open
click to load and
close dialog box

click to move up
and down one
directory level

menu bar to 
navigate and
mark directories

 

file types
ER Mapper Workbook -  Seismic Geophysics Applications 25



Chapter 2 User interface basics z User interface components

iews 
 

to an 
sor. 

k on 

. 

r 

 

 

The File Chooser menus at the top have the following functions:

Using the on-line help system
ER Mapper provides an extensive on-line help system with both simple overv
and detailed descriptions of all features and functions. There are two ways to
access help:

Typing text in text fields
To enter text for naming files or changing values in dialog boxes, ER Mapper 
provides text fields. When you point to a text field, the pointer shape changes 
I-beam. To enter text, click anywhere inside the text field to place the text cur

To select existing text, you can drag through the desired portion, or double-clic
a word or numeric value to select it. Text that is selected become reverse 
highlighted, and any subsequent typing replaces it. 

History menu Use to change the File Chooser’s current directory
The menu has two parts: the upper portion lists 
most recently visited directories, and the lower 
portion lists marked directories.

Special menu Use to change to your home directory, or to mark o
unmark a directory (any directory may be marked 
for fast access using the History menu).

View menu Use to sort the contents of the current directory by
name, date modified, or date created.

Volumes menu Use to access volumes or disk drives on your 
network.

Directories menu Use to change to any directory defined by your 
preferences settings.

ECW URL History List of the URLs of the most recently accessed 
image files from an Image Web Server. 

Help menu Lets you browse all the standard ER Mapper 
manuals on-line, and go between manuals and 
topics using hypertext links.

Help buttons The Help  button inside dialog boxes gives you 
context-sensitive help. If needed, you can navigate
to view more detailed information using the 
hypertext links.
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Hands-on exercises
The following hands-on exercises introduce you to the basic concepts of usin
menus and dialog boxes and managing image windows.

• Choose options from menus and toolbar buttons

• Access on-line help

• Display and hide toolbars

• Open an new image window

• Open an existing algorithm data view into a window

• Move and resize an image window

• Zoom and pan the image within the window

• Manipulate multiple image windows on the screen

• Close image windows

1: Using menus and toolbars

Move the ER Mapper main menu around the screen
1 Position the mouse pointer on the ER Mapper main menu title bar, then 

drag it to the lower-left part of the screen.

Pointing to the title bar and dragging is how you move dialog boxes and imag
windows around the screen.

2 Drag the main menu to the upper-right corner of the screen. 

This is the recommended position for the main menu for the exercises in this 
tutorial. 

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Objectives Learn to open and make selections from menus, use toolbars, and access on
help.
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Open a menu to display its commands, then close the menu
1 Click on the View  menu button; a list of commands under the menu 

displays. 

The small arrows next to Quick Zoom  and Statistics  indicate that they have 
additional commands under them.

2 Click on the Statistics  command to display its submenu.

3 Click anywhere outside the main menu to close the open menus without 
making a selection.

Note: In the rest of this manual, selecting commands from menus is indicated as fol
“From the Edit  menu, select Preferences... ” (which means click on Edit in the 
menu bar, then click on the Preferences command).

Select the Print command from the menu bar
1 From the File  menu, select Print .

The Print  dialog box appears with options for printing hardcopy.

2 Click the Cancel  button to close the dialog box.
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Select the Print command from the Standard toolbar

1 On the Standard toolbar, click the Print   button. 

The same Print  dialog box appears again. Using toolbar buttons is often a fas
way to access many commands in ER Mapper.

Tip: Many common commands on the menu bar, such as Print, are also available 
Standard toolbar. Use whichever is fastest or most comfortable.

Display context sensitive help for the Print function
1 On the Print  dialog box, click the Help  button.

The ER Mapper Help  dialog opens to show help for the current dialog box 
function (printing in this case). Accessing help from a dialog box takes you to
appropriate section in the ER Mapper User Guide manual. Hypertext links to other
on-line manuals appear as underlined text.

2 In the ER Mapper Help  dialog, click on the scroll buttons to move to the 
next page.

ER Mapper moves directly to the next on-line help page.

3 In the ER Mapper Help  dialog, click the Back  button at the top of the 
dialog.

You return to the previous help screen.

Note: The complete ER Mapper manual set is accessible from the on-line help syst
These are exactly the same as the printed manuals you receive when you pu
the software.

4 From the File  menu (on the ER Mapper Help  dialog), select Exit .

The on-line help system closes.

5 Click the Cancel  button on the Print  the dialog box to close it.

Click to open
Print  dialog
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Tip: You can also access the complete ER Mapper manual set using the Help  menu on 
the main menu.

Display and hide a toolbar
1 From the Toolbars  menu, select Oil and Gas .

A third row of toolbar buttons appears on the main menu below the Standard 
Common Functions toolbars. This toolbar has buttons for common image 
processing techniques used in oil and gas applications. 

2 Point to any button on the OIl and Gas toolbar.

A description of the button function displays directly below it (the tool tip). The 
first part of the tool tip indicates the toolbar name and the second part indicate
specific name and function of that button (for example, “Oil and Gas: Create 
Pseudocolor/TWT Algorithm”). 

3 From the Toolbars  menu, select Oil and Gas again.

The Oil and Gas toolbar buttons disappear from the main menu. Use the Toolbars  
menu to display or hide any toolbar. (It is recommended that you always disp
the Standard and Common Functions toolbars.)

2: Opening windows and algorithms
To display an image in ER Mapper, you first open an image window, then ope
algorithm file that processes and displays a specific dataset. You can have as
different image windows open on the screen as you need. (ER Mapper can a
create many type of algorithms for you automatically–you will learn about this
later.)

Objectives Learn to open image windows on your computer display, and open and run a
existing algorithm data view stored on disk.

Oil and Gas
toolbar
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Open a new empty image window
1 From the File  menu, select New.

An empty image window opens in the upper left corner of the screen. The win
title bar reads “Algorithm Not Yet Saved” because no processing algorithm is 
associated with this image window yet.

Open and display an image processing algorithm
1 From the File  menu, select Open... .

The Open  file chooser dialog box opens. 

2 From the Directories  menu (on the Open  dialog), select the path ending 
with the text \examples . (The portion of the path name preceding it is 
specific to your site.)

The scrolling list in the center changes to show a list of directories beginning 
the text ‘application.’

3 Double-click on the directory named ‘applications’ and then 
‘Oil_And_Gas_Exploration’ to open it. (Scroll if needed to view it first.)

The list of example algorithms for processing seismic horizon datasets displa

Note: If you do not see files ending with the extension “.alg,” select “Algorithm Data
View” from the File Type  list menu on the Open  dialog.

4 Double-click on the algorithm named ‘Seismic_Horizon.alg.’

ER Mapper runs the algorithm and displays an enhanced color image of an 
interpreted seismic horizon. Blues correspond to structural lows transitioning 
reds for structural highs. Notice also that the algorithm filename 
‘Seismic_Horizon’ now appears in the title bar of the image window.

Use the toolbar to open a different processing algorithm

1 Click the Open  button on the Standard toolbar.

click to open
algorithm
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The Open file chooser dialog box appears. (This toolbar button has the same
function as selecting Open...  from the File  menu.)

The algorithm named ‘Seismic_Horizon’ in the ‘Oil_And_Gas_Exploration’ 
directory is already highlighted since it is currently loaded into the image wind

2 Double-click on the algorithm named ‘Seismic_Horizon_Dip.alg.’

ER Mapper runs the algorithm and displays a greyscale image of seismic dip
calculated from the same horizon dataset (a different “view” into the same da
Notice that the title bar also changes to show the filename of the new algorith

Note: By default, ER Mapper runs the algorithm automatically for you when you ope
from disk. You can also reprocess the data at any time by clicking the Refresh 

 button.

3: Resizing windows and zooming/panning

Move the image window on the screen
1 Point the mouse at the image window title bar, then drag it to another part 

of the screen.

2 Drag the image back to the upper-left part of the screen.

Like dialog boxes, dragging images by the title bar is how you move them aro
the screen.

Resize the image window
1 Move the mouse pointer directly over the lower-right corner of the image 

window–the pointer shape changes to a window resize cursor.

2 Drag the lower-right corner to make the window about twice its original 
size, then release.

Dragging any side or corner of an image window lets you change the default 
window size as you desire. 

Objectives Learn to move and resize image windows, zoom (magnify) part of an image, 
pan (scroll) to other parts of an image.
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Note: When you resize a window, ER Mapper maintains the size of the image inside
window. Empty areas on the sides are filled with a cross-hatch pattern to indi
that no data is displayed there.

Set the mouse pointer to Zoom mode

1 On the Common Functions toolbar, click the Zoom Tool  button. 

This tells ER Mapper to use the mouse pointer for zooming when it is position
inside an image window. Also notice that the Zoom Tool button becomes 
depressed to indicate that it is the active pointer mode.

2 Move the pointer inside the image window.

The mouse pointer displays as a magnifying glass icon.

Zoom in and out of the image with the mouse
1 Position the pointer in the center of the image, and click the left mouse 

button.

The image zooms in by 50%.

2 Position the pointer in the center of the image, hold down the Ctrl. key while 
clicking the left mouse button.

The image zooms out by 50%.

3 Position the pointer in the image, and then drag it up and down.

As you drag the pointer down the image is magnified, i.e you zoom into it. Wh
you drag the pointer upwards, the image gets smaller, i.e you zoom out.

Set the mouse pointer to ZoomBox mode

1 On the Common Functions toolbar, click the ZoomBox Tool  button. 

This tells ER Mapper to use the mouse pointer for creating a zoom box when
positioned inside an image window. Also notice that the ZoomBox Tool button 
becomes depressed to indicate that it is the active pointer mode.

2 Move the pointer inside the image window.

The mouse pointer displays as a magnifying glass and box icon.
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Zoom in (magnify) an area of the image with the mouse
1 Position the pointer near the upper-left center of the image, then drag to the 

lower-right to define a box.

When you release the mouse, ER Mapper runs the algorithm again and magn
(or “zooms in”) on the area of the image you defined with the box. Dragging a
zoom box is a fast way to magnify an area of interest. (There are other zoom
functions you will learn about later.

Set the mouse pointer to Hand mode

1 On the Common Functions toolbar, click the Hand Tool  button. 

This tells ER Mapper to use the mouse pointer for panning when it is position
inside an image window. Also notice that the Hand Tool button becomes 
depressed to indicate that it is the active pointer mode.

2 Move the pointer inside the image window.

The mouse pointer displays as a hand icon.

Pan (scroll) the image within the window with the mouse
1 Click on the image. and drag it to a new position in the image window.

The hand pointer will grab the image and move it (pan) to the new location.

Zoom back out to view the full image extents
1 From the View  menu, select Quick Zoom  and then select Zoom to All 

Datasets .

ER Mapper runs the algorithm again and zooms back out to display the full ex
of the Seismic_Horizon image data. The Quick Zoom  submenu provides many 
options for zooming in or out to specific datasets, setting window geolinking, 
other options you will learn more about later.
34 ER Mapper Workbook -  Seismic Geophysics Applications



Chapter 2#User interface basics#z 3: Resizing windows and zooming/panning

 

2 Right-click inside the image window to open the shortcut menu, then select 
Quick Zoom  and then Zoom to All Datasets .

Zoom and pan using buttons for predefined options
In addition to using the mouse, ER Mapper also lets you zoom and pan using
buttons to invoke predefined zoom and pan functions. 

1 From the View  menu, select Geoposition... .

The Algorithm Geoposition Extents  dialog box appears.

2 Click on the Zoom  tab at the top to display zoom and pan options.

Right-click inside image
window to open 
shortcut menu
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The Zoom  tab options show sets of buttons for zooming and panning the ima
within the window.

3 In the buttons labelled ‘Zoom,’ click the Zoom out 50%  button. 

ER Mapper runs the algorithm and zooms out to 50% of the previous display 
resolution. 

Tip: For all icons on buttons under ‘Zoom’ and ‘Pan,’ the black square represents 
current image, and the white box represents how the size or position of the im
will change after the button is clicked.

4 In the buttons labelled ‘Set Extents To,’ click Previous .

ER Mapper zooms out to the previous image display extents.

5 Under ‘Zoom,’ click on the Zoom in 100%   button. 

ER Mapper magnifies the images to two times (100%) of the previous display
resolution (and keeps the image center point constant).

6 Under ‘Pan,’ click on the Pan left   button. 

ER Mapper pans or scrolls the image 50% to the left (the previous center poi
now on the far right side of the image).

7 Under ‘Pan,’ click on the Pan upper-right   button. 

ER Mapper pans the image 50% to the upper-right (the previous center point
now on the lower-left corner of the image).

Click to zoom out 50%

Click to zoom in 100%
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8 Experiment with other buttons under Zoom and Pan to see their effect.

9 Under ‘Set Extents To,’ click the All Datasets button.

ER Mapper resets the image extents to fit the entire dataset in the image win

10 Click Close  on the Algorithm Geoposition Extents  dialog to close it.

4: Managing multiple image windows

Open a second image window
1 From the File  menu, select New.

ER Mapper opens a new image window. As with all new image windows, it ha
algorithm data view loaded yet.

Open and display a processing algorithm in the new window
1 From the File  menu, select Open... .

The Open file chooser dialog box appears.

2 From the Directories  menu, select the path ending with the text 
\examples .

3 Double-click on the directory named ‘Applications’ and then 
‘Oil_And_Gas_Exploration’ to open it

The list of example algorithms for processing seismic datasets displays.

4 Double-click on the algorithm named ‘Seismic_Horizon.alg.’

ER Mapper runs the algorithm and displays the same color view of the horizo
dataset you opened earlier. You now have two views of the same dataset disp
in different image windows.

Move the greyscale window to overlap with the color window
1 Drag the image window titled ‘Seismic_Horizon’ to the center of the screen 

until it partially overlaps with the ‘Seismic_Horizon_Dip’ image window. 

Objectives Learn to open a second image window, specify overlap priority between 
windows, activate an image window, and close image windows.
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Your windows should be similar to the following diagram:

Select a window to be the “active” image window
The “active” image window is the one you want to currently work with, such a
zooming, opening a different algorithm, or editing the current algorithm. (You 
have many image windows open on the screen, but only one can be active.)

1 Click on the title bar of the window with the algorithm name 
‘Seismic_Horizon_Dip.’ 

The greyscale window moves in front of the color window where there is over

Notice also that the window title has three asterisks (***) on either side of the
title–this indicates that it is the “active” of the two image windows.

2 Click on the title bar of the window with the algorithm name 
‘Seismic_Horizon.’

The color window is now the active window and it moves in front of the greysc
window. Clicking on the title bar of a window both activates it and moves it in 
front of any other overlapping image windows.

3 Move the pointer inside the image area of the inactive window (titled 
‘Seismic_Horizon_Dip’). 

Seismic Dip
window

Seismic

(greyscale)

window
(color)

horizon
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The pointer shape changes to a pointing hand . This indicates that the win
you are pointing to is inactive, and clicking in the window or on the title bar wi
activate it. (You can activate a window by clicking on the title bar or inside the
image area of the window.).

Close both image windows
1 On the ER Mapper main menu, select Close  from the File  menu.

The active window closes and disappears from the screen.

2 Close the other image window using the controls on the window itself:

• For Windows, click the  Close  button in the upper-right window corner.

Tip: To close one of several image windows, it is easier to use the operating syste
controls on the window itself (step 2 above). You can also close the active win
using Close  from ER Mapper’s File  menu.

The window closes and disappears from the screen. Only the ER Mapper ma
menu is now open.

• Choose options from menus and toolbar buttons

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:

active of the
two windows
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• Access on-line help

• Display and hide toolbars

• Open an empty image window

• Open an image processing algorithm into a window

• Move and resize an image window

• Zoom and pan the image within the window

• Manipulate multiple image windows on the screen
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Pseudocolor
algorithms

This chapter introduces the basic concepts involved in creating a simple algo
data view that displays a seismic horizon dataset in greyscale or color. You le
about the interface ER Mapper provides for creating and editing algorithms (t
Algorithm  dialog), and how to control the color mapping and contrast 
enhancements used to display the image. You also learn to modify the algorith
view the image in 3D perspective.

About the algorithms concept
The goal of all image processing is to enhance your data to make it more 
meaningful and help you extract the type of information that interests you. To
make this procedure faster and easier, Earth Resource Mapping developed a
image processing technique called “algorithm data views.” Understanding ho
use algorithms is the key to understanding how to use ER Mapper effectively.

What is an algorithm data view?
An algorithm is a list of processing steps or instructions ER Mapper uses to 
transform raw datasets on disk into a final, enhanced image on your screen di
In this sense, algorithms let you define a “view” into your data that you can sa
reload, and modify at any time.
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You use ER Mapper’s graphical user interface to define your list of processing
steps, and you can save the steps in an algorithm file on disk. An algorithm file
store any of the following information about your processing:

• Names of dataset(s) to be processed and displayed

• Subsets of the dataset(s) to be processed (zoomed areas)

• Bands (layers of data) in the dataset(s) to be processed

• Color mapping and contrast enhancements (Transforms)

• Filtering to be applied to the data (Filters)

• Equations and combinations of bands or datasets used to create the image 
(Formulae)

• Color mode used to display the data (Pseudocolor, Red Green Blue, or Hue 
Saturation Intensity)

• Any vector datasets, thematic color, or map composition layers to be displayed
the raster image data

• Definition of a page size and margins (used for positioning the image on a pag
creating maps and printing)

• Viewpoint and other parameters when viewing the image in 3D perspective

By being able to apply a set of processing steps as a single entity, the comple
often associated with image processing is greatly simplified. In addition, you 
tremendous savings in disk space, since you do not need to store intermedia
processed copies of your original data on disk.

Building Algorithms in ER Mapper
There are three primary ways to build a processing algorithm in ER Mapper:

• Open a dataset directly (File Open ) and have ER Mapper automatically display th
dataset using a simple default algorithm

• Use the Algorithm  dialog options to build an algorithm by adding the desired typ
of layers, loading datasets, and specify processing steps for each layer.

• Use image wizards to have ER Mapper automatically create any of several typ
specialized algorithms for you. In this case, ER Mapper adds the appropriate l
to the Algorithm  dialog, prompts you to load a dataset, and possibly other opt
as well.

The majority of exercises in this workbook ask you to build algorithms from 
scratch so you become familiar with and thoroughly understand the basic conc
However, you will also use the automatic algorithm creation wizards from time
time to understand how they can save time.
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Using Algorithms as Templates
Once you have saved your processing instructions as an algorithm file, you ca
the algorithm as a “template” to easily apply the same processing to other dat
To use an algorithm as a template, simply load the desired dataset(s) to repla
default dataset(s) saved with the algorithm to apply the same processing to th
dataset(s). You may also need to adjust the transforms (color mapping) for the
datasets.

Any algorithm can be used as a template, and ER Mapper also provides man
template algorithms for common tasks. These include common display techn
(pseudocolor, colordrape, etc.), writing processed image files to disk, and sav
algorithms as “Virtual Datasets.” 

The Algorithm dialog
algorithms as “Virtual Datasets.” 

The Algorithm dialog
The Algorithm  dialog is a special dialog box that serves as your “command 
center” for creating and editing algorithms in ER Mapper. To open the Algorithm  
dialog, you can select Algorithm...  from the View  menu or click the Edit 

Algorithm   toolbar button. The key components of the Algorithm  dialog are 

labelled in the diagram below and described in the table that follows.

process diagram
for selected
layer

menu to add
or change
layers/surfaces

tab pages to select categories of options for
layer or surface (Layer tab page is selected)

data
structure
diagram

list of layers
in surface

view mode (2D or 3D)

surface

panel
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Data structure diagram Shows a list of surfaces and layers contained in the 
current algorithm using a hierarchy or “tree” structure
Select (click on) a surface or layer to change its optio
using the Tab pages.

Surface A group of raster and/or vector data layers that combi
to create a view or image. Algorithms can have multip
surfaces that become independent entities when view
in 3D mode.

Layers Components of a surface that contain data used to 
construct an image. Different layer types can contain 
raster or vector data, and processing for each overlay
controlled independently from the others.

View Mode Sets the manner in which data is displayed as two 
dimensions (2D) or three dimensions (3D).

Tab pages Display categories of options for controlling the image
display and processing techniques, such as Layer for
options for current layer, or Surface for options that 
apply to an entire surface.

Process diagram Used to control the processing operations applied to 
dataset(s) in the currently selected layer (displayed 
when Layer tab is selected).

The Process Diagram
When the Layer tab is selected, the horizontal row of buttons in the right-han
panel of the Algorithm  dialog are called the process diagram. They are used to 
define your image processing operations for the currently selected data layer.
button in the diagram controls a specific image processing function.

As the arrows indicate, the processing stream flows from left to right. Typicall
you may specify an image to be used, the bands within the image to be proce
then apply processing using formulae, filters, transforms or other options to c
your desired image. ER Mapper compiles all the processing steps you specif
and renders the resulting image to the screen display. The name and function
main processing stream buttons are as follows.

Button Function

Dataset Use to load an image from disk, or edit or view 
information or comments about an image. 

Band Selection Use to select one or more bands in the image for use 
in generating an image (a drop-down list). 
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Note: A cross or “X” through the button indicates that the function is not active in th
current data layer. In addition, there are other buttons for some layer types tha
will learn about later in this manual.

Hands-on exercises
These exercises show you how to initially display an dataset, use formulas an
color mapping, and save and reload a simple image processing algorithm. 

Note: These exercises briefly introduce concepts and procedures that are explained
more detail later in this manual. 

• Load a new dataset for display and processing

• Use the Algorithm  dialog to define a processing algorithm

• Add a formula to an algorithm

• Change the color lookup table used to display the image

• Use transforms to adjust the image contrast and color mapping

• Add text labels and comments to an algorithm

• Save the processing algorithm to disk

• Reload and view the saved algorithm

Formula Use to enter, load, or save a formula to perform image 
algebra and other arithmetic operations. 

Filter Use to add or delete one or more spatial filters. (There 
are both pre- and post-formula Filter buttons.) 

Transform Use to adjust image contrast and brightness. (There 
are both pre- and post-formula Transform buttons.) 

Sunshade Use to specify artificial illumination of the image to 
create shaded relief effects. 

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Button Function
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• View the algorithm in 3D perspective

1: Loading and displaying images

(Part 1 shows you how to load a dataset from disk and display it on-screen fo
initial look at the data. The dataset was previously imported from a magnetic 
or other media and now resides on the computer's hard disk. Available impor
formats and details on importing data are discussed briefly in Appendix C and
more detail in the ER Mapper manual set.)

Open an image window and the Algorithm dialog
1 From the View  menu, select Algorithm... .

A new empty image window opens in the upper-left corner of the screen, and
Algorithm  dialog opens.

Note that the Algorithm  dialog shows a default surface with one Pseudocolor 
layer in the left-hand panel (labelled “Pseudo Layer”), and a process diagram
that layer in the right-hand panel. The words “No Dataset” above the process
diagram indicate that no dataset is currently loaded into the layer.

Note: If you open the Algorithm  dialog when no image windows are currently open (
in this case), ER Mapper opens an empty image window for you automaticall
This shortcut saves you the step of opening a window. 

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to open an image window and the Algorithm  dialog, load a raster dataset,
and display the dataset on-screen. You will also learn to change the contrast 
(color mapping) of the image, and use a formula to invert the data range if 
needed.
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Load a raster dataset into the Pseudocolor layer

1 In the Algorithm  dialog, click the Load Dataset   button.

The Raster Dataset  file chooser dialog box appears.

2 From the Directories  menu (on the Raster Dataset  dialog), select the path 
ending with \examples . 

The scrolling list in the center now shows a list of directories containing exam
datasets supplied with ER Mapper (such as ‘application...’ and others).

3 Double-click on the directory named ‘Shared_Data’.

A list of raster datasets with the file extension “.ers” are displayed. (If you do 
see files with an .ers extension, open the Files of Type  menu and select 
‘ER Mapper Raster Dataset (.ers)’.)

4 Double-click on the dataset named ‘Seismic3D.ers’ to load it.

The file chooser dialog closes, and the dataset is loaded into the Pseudocolor
Note that the dataset name (‘Seismic3D.ers’) now appears above the proces
diagram.

The image initially displays as white in the image window–this is expected since 
the range of data values in this horizon dataset is different to the default rang
ER Mapper initially uses for display. (All data is mapped to the color white.) Y
will adjust this next.

Resize the Algorithm dialog to view all process option icons
1 Drag one side of the Algorithm  dialog to widen it until you can see all the 

option icons below:

Load Dataset  button
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Tip: When you resize or reposition a dialog box, ER Mapper automatically remem
this the next time you open it. This lets you setup your work environment as y
like.

Adjust the contrast to use the entire range of shades
1 In the Algorithm  dialog, click on the right-hand Edit Transform Limits 

 button (blue) in the process diagram. 

The Transform  dialog box opens. Note that the field “Actual Input Limits” value
at the bottom show a data range of about 1920 to 2230 (in exponential notati
This is the actual range of two-way time values in the seismic horizon. You ne
tell ER Mapper to map the colors (grayscale) in the lookup table to this range
instead of the 0 to 255 range currently shown as the default on the X-axis be

2 From the Limits  menu (on the Transform  dialog), select Limits to Actual .

The X axis data range changes to match the Actual Input Limits.

ER Mapper renders the image again, this time using the full range of shades 
display the image. This dataset shows two-way travel time values, so structur
lows (larger two-way time values) are shown as white transitioning into struct
highs shown as black.

In addition, a histogram showing the relative frequency of data values for the 
horizon dataset appears in the center of the Transform  dialog. Histograms often 
provides clues about features in a dataset.

Note: After loading and displaying a new seismic or other geophysical dataset, you
should always perform step 2 to match the input data range used for the tran
to the actual range of values in the dataset. (There are automated toolbar fun
that make this easier, and you will learn about them later.)

3 Click the Close  button on the Transform  dialog to close it.

Edit Transform Limits button
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Use a formula to invert the dataset values
In seismic horizon datasets that contain all positive data values (such as this o
is often helpful to invert the data values to make the structure easier to interpr
lower two-way time values correspond to structural highs, and higher values t
structural lows). You can do this easily by adding a simple formula to your 
processing algorithm.

1 In the Algorithm  dialog, click on the Edit Formula  button in the 
process stream diagram.

The Formula Editor  dialog box opens to let you use standard image process
formulas or create your own formulas. The menu bar at the top gives you fast
access to many formulas. Note that the current formula simply reads ‘INPUT1
meaning that the data values are not altered in any way.

2 In the Formula Editor  dialog, click to place the text cursor before the “I” in 
“INPUT1,” then type a minus sign (-) on your keyboard. Your formula should 
now look like this:

- INPUT1

This formula tells ER Mapper to negate (invert) all values in the dataset.

3 On the Formula Editor  dialog, click the Apply changes  button.

This tells ER Mapper to apply the changes and verify the formula syntax.

4 Click the Close  button to close the Formula Editor  dialog.

The image appears as black this time because you have inverted the data ran
need to adjust the transform to account for the new range of negative values 
produced by the formula.

Edit Formula button
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Adjust the contrast again to use the entire range of shades

1 In the Algorithm  dialog, click the right-hand Edit Transform Limits  
button. 

The Transform  dialog box opens. Note that the field Actual Input Limits now 
show a negative data range (produced by the formula), while the current X ax
display limits are still set to positive values (from the previous image).

2 From the Limits  menu (on the Transform  dialog), select Limits to Actual .

The X axis data range changes to match the Actual Input Limits.

ER Mapper renders the image again using the full range of colors to display t
image. Since you inverted the data values with a formula, structural lows (larg
two-way time values) are shown as black transitioning into structural highs sh
as white.

Tip: Use the STOP  button to halt all processing. This can be useful when you 

make a mistake, or when you want to take a quick look at the results without 

waiting for processing of the entire image to finish. Clicking Refresh   

restarts processing from the beginning.

3 Move the Transform  dialog box to the lower left area so it does not overlap 
with the image window or Algorithm  dialog.

Edit Transform Limits button
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2: Changing image colors and contrast

Change the color table to view the image in color
When you are using the Color Mode named Pseudocolor (as you are in this 
example), the color lookup table controls the set of colors ER Mapper uses to
display the image. Each lookup table contains a set of 255 colors that ER Ma
uses to display the image on-screen.

1 In the Algorithm  dialog, select the Surface  tab.

Options for Color Mode, Color Table, and Transparency now appear in the pa

Color Mode is set to “Pseudocolor” meaning that a color lookup table (LUT) is
used to control the image colors. The current color table is named “greyscale
(because it is the default color set), and it’s set of colors is shown in the color
on the left side of the Transform  dialog.

2 Click on the Color Table  drop-down list button.

A menu listing available color lookup tables appears.

3 From the Color Table  drop-down list, select rainbow1 .

This color table has colors similar to ‘pseudocolor,’ but also adds magenta at 
low end and white at the high end.

4 From the Color Table  list, select contour .

ER Mapper renders the image using a lookup table that contains blocks of so
colors (a contouring effect) rather than gradual transitioning between colors.

5 From the Lookup Table  list, select pseudocolor .

6 In the Algorithm  dialog, select the Layer tab again.

The process diagram is now displayed in the right-hand panel.

Objectives Learn to display an image in color, change the color lookup table (LUT) used
display the image, and modify the image contrast/color mapping.

Select Surface  tab
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Manually adjust the image contrast (color mapping)
1 Examine the contents of the Transform  dialog box. 

This dialog box lets you control how ranges of data values are mapped to dis
colors on the screen. The transform line controls how data values are mappe
display colors, and the color bar along the Y axis shows the colors contained i
current lookup table (‘pseudocolor’ in this case).

Up until now, you have displayed the dataset using a default linear transform 
(shown above), where a straight 45 degree line defines the mapping between
data values and output display colors. 

For example, the data value -2030 on the X axis is mapped to color number 1
(yellow) in the ‘pseudocolor’ lookup table as shown in the following diagram:

Y axis (display)
maximum field

click to choose
an automatic
transform options

choose X and Y
axis limits options

insert, delete,
or copy transforms

histogram of input
transform line
(drag to adjust

visual lookup table
for current layer

actual min & max
dataset values

dataset values

color mapping)

(editable text field)

-2227
0

255

-1916

-2227 -1916
data values range

0 255

LUT color range

-2030

156

transform line
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2 Move the mouse pointer around in the window containing the histogram.

The X-Y location of the current pointer position is shown in the upper-left part
the Transform  dialog (below “Histogram Style”). The X value is the data value
from the seismic horizon dataset (negated two-way time in this case), and the
value is the position in the set of lookup table colors (ranging from 0-255).

3 Point to the circle on the dotted transform line below, and drag the line up 
along the Y axis to exclude the blues from the image display.

ER Mapper updates the color mapping interactively, so the lower colors in the
lookup table (blues) are no longer used to display the image. (Only colors ab
80-255 are used to display the image, or cyan-green-yellow-red in this case).

4 On the Transform  dialog, click the Create default linear transform   
button (upper-left of the nine buttons together). 

-2227
0

255

-1916

-2227 -1916
data values range

0 255

LUT color range

Create default
linear transform
button
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ER Mapper resets the transform line back to a straight linear default and the i
colors update interactively.

5 Drag the transform line from the circled area down along the right-hand Y 
axis to exclude the reds from the image display.

Now higher colors in the lookup table (reds) are no longer used to display the
image. (Only colors about 0-200 are used to display the image, or blue-cyan-g
yellow in this case).

6 On the Transform  dialog, click Create default linear transform  . 

ER Mapper resets the transform line back to a straight linear default.

Highlight a time slice in the image
By adjusting the transform line, you can map any range of data values to any
desired range of colors, for example to highlight particular features visible in y
histogram.

-2227
0

255

-1916

-2227 -1916
data values range

0 255

LUT color range
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1 Drag the transform line at two points to map the central peak of data values 
in the histogram to all the display colors (see diagram below).

Now all colors are used to display only the time slice from about -2090 to -20
milliseconds. Time values greater than -2090 are all mapped to blue, and tim
values less than -2030 are all mapped to red.

Note: This technique is called histogram clipping, because it clips off the tails of the 
histogram and saturates those values to a single color. It can be effective for 
highlighting detail in specific features such as a narrow time slice.

2 On the Transform  dialog, click the Create default linear transform   
button again. 

Set exact input limits to highlight a time slice
The text boxes next to the X and Y axes of the histogram window let you cha
the minimum and maximum values. This offers another way to display exact 
ranges of data or use only specific colors for the image display.

1 Select the text in the X axis minimum text box (currently about -2227), and 
enter a value of -2090 (see diagram below). 

-2227
0

255

-1916

-2227 -1916
data values range

0
255LUT color range
ER Mapper Workbook -  Seismic Geophysics Applications 55



Chapter 3 Pseudocolor algorithms z 2: Changing image colors and contrast

030 
es 

nge. 
n 

ata 

.

2 Select the text in the X axis maximum text box (currently about -1916), and 
enter a value of -2030. 

Again, all colors are used to display only the time slice from about -2090 to -2
milliseconds. Time values greater than -2090 are all mapped to blue, and valu
less than -2030 are all mapped to red.

This is another method to map a specific range of data to the entire display ra
In this case, you are choosing to display only a specific data range, rather tha
moving the transform line to accomplish the task.

3 From the Limits  menu (on the Transform  dialog), select Limits to Actual .

The X axis data range changes back to match the Actual Input Limits (so all d
values will again be displayed).

ER Mapper renders the full image again with the default linear color mapping

Apply a Histogram equalize transform to the data

1 On the Transform  dialog, click the Histogram equalize   button (the 
center button in the set of nine buttons).

X axis maximum
text box

X axis minimum
text box

Histogram equalize  button
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Tip: Pass the mouse over the button to see the button name (tooltip).

ER Mapper creates a complex piecewise linear transform line and updates th
image. Notice that is this case contrast is maximized in the steepest slopes o
time surface, and detail is obscured in the structural highs and lows.

Histogram equalization (also called uniform distribution stretching) automatical
adjusts the transform line so that image values are assigned to display levels
on their frequency of occurrence. More display values are assigned to the mo
frequently occurring portion of the histogram, so the greatest contrast 
enhancement occurs in the data range with the most values (peaks in the 
histogram). Histogram equalization usually creates an image with very strong
contrast. In some cases, it can also saturate areas which can obscure detail.

Apply a Gaussian equalize transform to the data

1 On the Transform  dialog, click the Gaussian equalize   button. 

ER Mapper creates a complex piecewise linear transform line (sometimes wi
slight stair steps) and updates the image.

Gaussian equalization automatically adjusts the transform line so that image 
values are assigned as needed to make the output (display) values occur with
Gaussian distribution. A Gaussian, or “normal” distribution, is characterized a
producing a bell-shaped histogram (shown in the output histogram.) 

Gaussian equalization is useful when data is skewed in such a way that featu
could be abnormally saturated if stretched linearly. This technique tends to br
out more detail in areas with less frequently occurring data values so it is goo
emphasizing subtle features. (In this case it emphasizes the detail in the struc
highs and lows of the horizon, and suppresses detail in the mid-range).

Tip: You can set the number of standard deviations used for the Gaussian equaliz
function by double-clicking on the button. Smaller values produce more contr
and higher values less contrast. The default is 3 standard deviations.

2 On the Transform  dialog, click Create default linear transform  . 

Gaussian equalize  button
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Zoom in to view the data range within a specific area
It is sometimes helpful to view the range of time values in a specific area of th
image. You can do this by zooming in on the area.

1 If needed, click the Zoom Box Tool  button on the main menu.

This tells ER Mapper to use the mouse pointer for zooming and panning func

2 Inside the image window, drag a box to zoom in on an area of interest.

3 Examine the ‘Actual Input Limits’ fields on the Transform  dialog.

The ‘Actual Input Limits’ fields have changed to show the range of two-way tim
values only within the zoomed area currently displayed in the image window.

4 Click in the image window to pan the image to an adjacent area.

The ‘Actual Input Limits’ fields update again to show the new range. Zooming 
areas of interest and examining the Actual Input Limits is a fast way to view th
range of values in different parts of an image.

5 Click Close  on the Transform  dialog to close it.

Zoom back out to view the full image extents
1 From the View  menu, select Quick Zoom  and then select Zoom to All 

Datasets .

ER Mapper zooms out to display the full extents of the time horizon dataset.

3: Labelling and saving the algorithm

Enter a description for the Pseudocolor layer
1 In the Algorithm  dialog, click twice on the text “Pseudo Layer” in the left-

hand panel.

The text become reverse highlighted (shown above) indicating the text is edit

Objectives Learn to specify description labels, titles, and comments for an algorithm, and
save the algorithm processing steps to a file on disk for later use.

click twice to make
text field editable
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2 Backspace over or drag select the existing text, then type Inverted TWT 
in the field. Then press the Enter or Return key on your keyboard.

This text now becomes a visual description for the layer. 

Enter a description for the entire algorithm
1 In the Algorithm  dialog, select the text in the Description  text field (it 

currently reads ‘No Description’).

(To select the text, either drag through it, or triple-click to select the entire line

2 Type the following text, then press Enter or Return on your keyboard:

Horizon KA Pseudocolor

This text now becomes a brief description for the entire algorithm.

Save the processing steps to an algorithm file on disk
1 From the File  menu (on the main menu), select Save As... .

The Save Algorithm  file chooser dialog opens.

2 From the Directories  menu, select the path ending with the text 
\examples . (The portion of the path name preceding it is specific to your 
site.)

3 Double-click on the directory named ‘miscellaneous’ and then ‘tutorial’ to 
open it. 

4 In the Save As:  text field, click to place the cursor, then type in a name for 
the algorithm file. Use your initials at the beginning, followed by the text 
‘Horizon_KA_pseudocolor,’ and separate each word with an underscore 
(_). For example, if your initials are “JC,” type in the name:

JC_Horizon_KA_pseudocolor

(You will be asked to add your initials to all practice algorithm names to keep t
separate from other students.)

5 Click the Apply button to save the algorithm and leave the dialog open.

Your pseudocolor algorithm is now saved to an algorithm file on disk.

Add comments to the algorithm
1 On the Save As...  dialog, click the Comments...  button.

A dialog box appears titled with the algorithm path and file name, and a text a
to type comments about your algorithm. The cursor is already active in the up
left corner.
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2 In the comments dialog, type the following information to describe your 
algorithm:

This algorithm displays seismic horizon KA using the

‘pseudocolor’ lookup table. A negation formula is used

to invert the two-way time data for display, so structural

highs are shown as reds, and lows are shown as blues.

3 Click OK on the comments dialog to save your comments.

4 Click Cancel on the Save As...  dialog close it.

4: Reloading and viewing the algorithm

Open a second image window

1 On the Standard toolbar (on the main menu), click on the New  button. 

ER Mapper opens a new image window (this is a shortcut for selecting New from 
the File  menu). Drag the new window to the lower left part of the screen (so y
can see all or part of the other image window). 

Open the processing algorithm you created earlier

1 On the Standard toolbar, click on the Open  button. 

The Open file chooser appears. (This is a shortcut for selecting Open...  from the 
File  menu.)

2 From the Directories  menu, select the path ending with the text 
\examples .

3 Double-click on the directory ‘miscellaneous\tutorial’ to open it.

Your ‘Horizon_KA_pseudocolor’ algorithm name should appear in the list.

4 Click once on your algorithm name to highlight it (do not double-click).

5 Click the Apply  button to load and process the algorithm without closing 
the Open Algorithm  dialog box.

ER Mapper runs the algorithm and displays the processed horizon dataset in
image window. It looks identical to the other image since they both use the sa
algorithm and dataset.

Objectives Learn to reload and display the algorithm you just created, and to view the te
file on disk that defines the algorithm processing steps.
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View the algorithm comments
1 On the Open Algorithm  dialog, click the Comments...  button.

The dialog box opens showing the comments you entered for your algorithm.
These comments can be very helpful to others who use or display your algor
and they are a good way to document the procedures you used to create it.

2 Click Cancel  to on the comments dialog box to close it.

5: Viewing the image in 3D perspective

About 3D perspective viewing
Up until now you have viewed your images using conventional 2D planimetric
views. ER Mapper makes it very easy to view images in 3D perspective by sim
adding a height (or elevation) component to your algorithm. The following is a
very simple introduction to the 3D viewing features, and you will learn more ab
them in later chapters.

Duplicate (copy) the Pseudo layer of the algorithm
1 On the Algorithm  dialog, click once on the layer ‘Inverted TWT’ to select it, 

then click the Duplicate   button.

ER Mapper makes an exact copy of the layer below the original. (For example
layer contains the same dataset, formula and transform as the original.)

Objectives Learn to modify the algorithm you just created to view the image in 3D 
perspective.

select layer, click Duplicate
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Tip: To select a layer, click once on the left side. To change the layer’s text label, se
it first (if needed), then click once on the text label to make it editable.

Change the copied layer to a Height layer
1 Point to the copied (lower) layer, click the right mouse button, and select 

Height  from the short-cut menu:

The Pseudo layer changes to a Height layer and ER Mapper sets the layer 
description to “Height layer.” Your algorithm now contains two layers (Pseudo 
Height), shown in the layer list on the left panel of the Algorithm  dialog.

You have now duplicated the inverted two-way time layer and changed the lay
type to create a elevation component for your algorithm. (Note that the layer i
currently crossed out–this indicates that it is not active until you switch to 3D 
perspective View Mode.)

Select 3D perspective View Mode to view the image in 3D
1 From the View Mode  menu (on the Algorithm  dialog), select 3D 

perspective .

ER Mapper displays a message that the image is being processed, then disp
3D perspective view of the image in color. The message “Regenerating Terra
appears in the image window as ER Mapper performs iterations to increase t
resolution (detail) in the 3D image.

click to here select layer click here to label of selected layer

select Height  from
short-cut menu
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This 3D image uses color to denote absolute values of two-way time, and als
shows the structure of the horizon using a perspective view. The right-hand p
in the Algorithm  dialog now has two additional tabs–3D View  and 3D 
Properties . These contain controls specifically for 3D viewing of images.

Change the perspective viewing angle
1 Point to the lower part of the 3D image (the cursor changes to a hand), and 

drag down slightly to tilt the 3D view (see following diagram).

The 3D image tilts downward, so you are now looking more from an overhead
viewpoint. You can use the mouse to manipulate the viewpoint, zoom in and o
rotate the image, and other controls (to be discussed later).

This a simple 3D algorithm that contains only one surface (a time horizon in t
case). You can also build algorithms that let you view and manipulate multiple
surfaces simultaneously (for example multiple time horizons).

Select 2D View Mode to view the image in 2D again
1 From the View Mode  menu, select Normal .

ER Mapper redisplays the image in a two-dimensional planimetric view again

Note: This 3D exercise was a simple introduction to show how easy it can be to view
in 3D perspective in ER Mapper. You will learn more about the 3D capabilities 
controls later.

Close both image windows and the Algorithm dialog
1 Close the image window with the 3D view:

• For Windows, click the  Close  button in the upper-right window corner.

2 Close the other image window by repeating Step 1.

3 On the Algorithm  dialog, click the Close  button to it.

point to this area and drag down slightly to tilt 3D model down
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Only the ER Mapper main menu is now open on the screen.

• Load a new dataset for display and processing

• Use the Algorithm  dialog to define a processing algorithm

• Add a formula to an algorithm

• Change the color lookup table used to display the image

• Use transforms to adjust the image contrast and color mapping

• Add text labels and comments to an algorithm

• Save the processing algorithm to disk

• Reload and view the saved algorithm

• View the algorithm in 3D perspective

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Colordrape
algorithms

This chapter explains how to apply shaded relief effects to a dataset and crea
“colordrape” algorithms that drape color information over intensity (brightness
information. Shading and colordraping are two of the most powerful technique
presentation and analysis of interpreted seismic datasets.

About colordraping
The term colordraping refers to the technique of draping one set of image data
color over another set of data that controls the color brightness or intensity. T
allows you to effectively view two (or more) different types of data or methods
processing simultaneously in a combined display. Colordraping is usually difficult 
and time consuming using traditional image processing products, but ER Map
makes it very fast and interactive by providing the special Intensity layer type

The colordraping technique has become a very popular and powerful tool for 
visualization of interpreted surfaces. For example, combining two-way time 
images shown as both color and as structure lets you create a shaded relief i
that enhances subtle faults and color-codes their placement relative to depth.
these types of images, far more useful information can be derived than from 
conventional visualization techniques. 
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The Intensity Layer Type
ER Mapper provides a special type of layer named Intensity that is the key to
colordraping technique. When you add an Intensity layer to an algorithm, the
brightness (or intensity) of the image colors are automatically controlled by the
data loaded into the Intensity layer. Low data values in the Intensity layer pro
dark colors in the image, and high data values produce bright colors. 

The diagram above shows how algorithm Pseudocolor and Intensity layers ar
combined to create a single colordrape image. You will see for yourself how t
techniques work in the following exercises.

Hands-on exercises
These exercises give you practice creating colordrape algorithms to display t
surfaces as both shaded relief and color. You will also learn to drape data suc
seismic amplitude over a shaded time surface to aid analysis.

• Use Intensity layers to create shaded relief images that highlight structure

• Combine Pseudocolor and Intensity layers to create colordrape images

• Turn layers on (to process them) and off (to ignore them)

• Add new layers and move existing layers

• Control the color and intensity components to modify image displays

Note: Some of the following exercises repeat steps from the previous exercise to 
emphasize understanding of the fundamental concepts.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen.

Pseudocolor layer color image

Intensity layer brightness image

combined
colordrape

image
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1: Using shading to highlight structure

Open an image window and the Algorithm dialog

1 On the main menu, click the Edit Algorithm  button.

An image window and the Algorithm  dialog open. (This is a shortcut for 
selecting Algorithm  from the View  menu.)

Change the Pseudocolor layer to an Intensity layer
1 Point to the layer labelled “Pseudo Layer”, click the right mouse button, and 

select Intensity from the short-cut menu:

The Pseudo layer changes to an Intensity layer and ER Mapper sets the laye
description to “Intensity Layer.” 

Tip: Right-clicking any layer opens the short-cut menu that lets you quickly change
layer’s type, and turn it on or off.

Objectives Learn how to display a time dataset in an Intensity layer and apply sun angle
shading to create shaded relief effects that highlight structure. 

Edit Algorithm button

select Intensity from
short-cut menu
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Load the sample seismic dataset into the Intensity layer

1 In the Algorithm  dialog, click the Load Dataset   button in the process 
diagram (be sure the Layer  tab is selected first).

The Raster Dataset  file chooser dialog box appears.

2 From the Directories  menu, select the path ending with \examples . 

3 Double-click on the directory named ‘Shared_Data’

A list of raster datasets and algorithms is displayed.

4 Double-click on the dataset named ‘Seismic3D.ers’ to load it.

The dataset is loaded into the Intensity layer.

Use a formula to invert the dataset values
As in the previous chapter, you will invert the time horizon data values to make
structure easier to interpret (so lower two-way time values correspond to struc
highs, and higher values to structural lows).

1 In the Algorithm  dialog, click on the Edit Formula  button in the 
process diagram.

The Formula Editor  dialog box appears.

2 In the Formula Editor  dialog, click to place the text cursor before the “I” in 
“INPUT1,” then type a minus sign (-) on your keyboard. Your formula should 
now look like this:

- INPUT1

This formula tells ER Mapper to negate (invert) all values in the dataset.)

Load Dataset  button

Edit Formula button
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3 On the Formula Editor  dialog, click the Apply changes  button.

4 Click the Close  button to close the Formula Editor  dialog.

The image appears as black initially because you need to adjust the transform
account for the new range of negative data values produced by the formula. 

Adjust the color mapping (contrast) of the image

1 In the Algorithm  dialog, click the right-hand Edit Transform Limits  
button in the process diagram. 

The Transform  dialog box opens showing the negative data range produced 
the formula in the Actual Input Limits fields.

Note: If needed, make the Algorithm  dialog wider until you can see all the process 
stream icons shown above.

2 From the Limits  menu (on the Transform  dialog), select Limits to Actual .

The X axis data range changes to match the Actual Input Limits.

ER Mapper renders the image again, this time using the full range of grey sha
to display the image. Since you inverted the data values with a formula, struc
lows (larger two-way time values) are shown as dark greys transitioning into 
structural highs shown as lighter shades. (Intensity layers always render imag
greyscale.)

3 Click Close  on the Transform  dialog to close it.

Edit Transform Limits button
ER Mapper Workbook -  Seismic Geophysics Applications 69



Chapter 4 Colordrape algorithms z 1: Using shading to highlight structure

for 

 

Turn on sun shading and display the shaded relief image

1 On the Algorithm  dialog, click the Edit Realtime Sunshade  button in 
the process diagram.

The Edit Sun Angle  dialog box opens to let you specify shaded relief effects 
the Intensity layer.

2 Turn on the Do sun-shading  option.

ER Mapper applies an artificial illumination effect to clearly define structural 
features of the time surface.

Also notice that the Edit Realtime Sunshade icon in the process diagram is 

now a yellow sun  to indicate that shading is active for the Intensity layer.

3 Make the image window about 50% larger by dragging lower-right corner of 
the window border.

4 Right-click on the image and select Zoom to All Datasets  from the Quick 
Zoom  menu.

ER Mapper redisplays the image to show more detail.

Edit Realtime Sunshade button

click to turn
shading on/off

drag icon to
change sun
azimuth and
elevation

type in values
or click arrows
to increment

diagram showing
sun position
relative to horizon
(outer circle) or
overhead (center)
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Change the sun azimuth
1 In the Edit Sun Angle dialog, drag the small sun icon (the circle) to the 

upper-left quadrant of the circular grid. 

The shading angle of the image changes in real time to show the shading effe
if the sun were shining from the northwest. 

The azimuth (compass direction) from which the sun shines highlights structur
features normal to the sun angle. In this case, features trending in a northeas
southwest direction are now highlighted (since they are normal to the northwe
sun angle).

2 Drag the sun icon to shade from different compass directions (azimuths).

Structural features normal to your new sun azimuths are highlighted.

Change the sun elevation
1 In the Edit Sun Angle dialog, drag the sun icon near the outer rim of the 

circular grid. 

The image becomes darker overall and with larger areas of shadows. 

The elevation from which the sun shines determines the length of shadows in 
shaded relief image. In this case, the sun is shining from a very low sun angle
the horizon), so you get longer shadows just as you would see right after sunr
before sunset.

2 Drag the sun icon to the center of the circular grid.

Now the entire image has very little shadow, as if the sun is shining directly 
overhead during midday. This allows you to see terrain features without directi
shadowing introduced by shading from a specific azimuth. (For example, you
see both sides of a fault.)

3 Experiment by dragging the sun icon until you create an image that 
highlights structural features of interest. (Setting the sun elevation at 45 
degrees or greater is usually recommended to reduce shadowing.)
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Tip: You can also adjust the sun azimuth and elevation to exact values using the 
adjustment arrows next to the Azimuth and Elevation fields.

4 Click Close  on the Edit Sun Angle dialog to close it.

Applications of sun angle shading
ER Mapper’s sun angle shading feature is a very powerful tool for rapid 
identification of subtle features in time surfaces. It is commonly used for man
applications, including:

• identify small scale faulting, and relative through across faults

• identify subtle stratigraphic features (pinchouts, truncations, etc.)

• highlight data acquisition and/or processing artifacts

• highlight quality issues related to interpretation (in both time surface and attri
data)

2: Draping color on the image

Duplicate the Intensity layer and change it to Pseudocolor
1 On the Algorithm  dialog, select the Intensity layer (if needed), then click 

the Duplicate   button.

ER Mapper creates a copy of the Intensity layer below the original.

2 Right-click on the new duplicate layer, and select Pseudo .

The Intensity layer changes to a Pseudocolor layer. You will use this layer to 
display the time surface data in color over the shaded relief image.

Turn off sun shading for the Pseudocolor layer
1 With the Pseudo layer selected, click the yellow Edit Realtime Sunshade 

 button in the process diagram.

The Edit Sun Angle  dialog box opens. Since the layer was duplicated from th
Intensity layer, sun angle shading is still turned on.

Objectives Learn how to duplicate and modify the Intensity layer to create a Pseudocolo
layer, and how to combine the two layers to create a colordrape image. 
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2 On the Edit Sun Angle  dialog, turn off the Do sun-shading  option.

Sun angle shading is now turned off, and the Edit Realtime Sunshade icon in 

the process diagram shows a cross through it  to indicate this.

Note: Sun angle shading is usually applied only to time surface datasets displayed 
Intensity layers because two-way time describes structural features well. Sun
shading is not normally applied to amplitude or other attribute datasets which
generally displayed in color.

3 Click Close  on the Edit Sun Angle  dialog to close it.

4 Click on the Algorithm window Surface tab, and select ‘pseudocolor’ from 
the Color Table list.

5 Click on the Algorithm window Layer tab.

Note that by combining the two processing techniques into one image, you ca
simultaneously see structural features as brightness and relative depth as co
this case blues represents structural lows, and reds structural highs.

Tip: The colordrape technique you used here is one of the most important ER Ma
processing techniques used to visualize interpreted time surfaces.

Try different color mapping transforms for the color layer
1 In the Algorithm  dialog, select the Pseudo layer.

By selecting the Pseudo layer, you can now use the process diagram options
right-hand panel to control it separately from the Intensity layer.

2 Click on the right-hand Edit Transform Limits  button in the process 
diagram. 

The Transform  dialog opens showing the current color table and color mappi

3 On the Transform  dialog, click the Histogram equalize   button.

Histogram equalize  button

Gaussian equalize  button

Create default linear
transform  button
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ER Mapper applies a histogram equalization transform to the data. Notice tha
color mapping changes without affecting the shaded relief image in the Intens
layer. This shows how layers in an algorithm are independent of each other, a
can be modified individually to affect to overall image they combine to create.

4 On the Transform  dialog, click the Gaussian equalize   button.

ER Mapper applies a gaussian equalization contrast stretch to the data. This
maximizes color contrast in the structural highs and lows, but tends to flatten 
contrast in other parts of the image.

5 On the Transform  dialog, click the Create default linear transform   
button. 

ER Mapper resets the color mapping back to a straight linear default.

6 Click Close  on the Transform  dialog to close it.

Display the shaded relief and color images separately
1 Turn off the Pseudocolor layer by right-clicking the the layer and selecting 

the Turn Off option from the short-cut menu.

Only the structural component of the image displays since the color compone
the algorithm (the Pseudocolor layer) is turned off. 

2 Turn the Pseudocolor layer on again (right-click and select Turn On ).

3 Turn the Intensity layer off (right-click and select Turn Off ).

By turning layers on and off, you can see them independently of each other to
tune adjustments before adding them together again.

4 Turn the Intensity layer on again (right-click and select Turn On ).

Note: When a layer is turned off, the the layer label becomes dim and the icon next
changes to a question mark (?). If the layer is on, the icon displays a letter 
corresponding to the layer type, such as “P” for a Pseudocolor layer.

layer turned off

layer turned on
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3: Draping amplitude data in color

Add a second Pseudocolor layer to the algorithm
1 Select the Pseudo layer in the layer list.

2 From the Edit menu (on the Algorithm  dialog), select Add Raster Layer , 
then select Pseudo .

ER Mapper adds a second Pseudocolor layer to the layer list. New added lay
contain no dataset (shown by “No Dataset” above the process diagram).

Load the sample seismic dataset into the new layer

1 In the Algorithm  dialog, click the Load Dataset   button on the left side 
of the process diagram.

The Raster Dataset  file chooser dialog box appears.

2 From the Directories  menu, select the path ending with \examples .

3 Double-click on the directory named ‘Shared_Data’.

4 Double-click on the dataset named ‘Seismic3D.ers’ to load it.

The dataset is loaded into the new Pseudocolor layer, so all layers contain the
dataset.

Tip: The OK this layer only  or Apply this layer only  button on the Raster 
Dataset  dialog are designed to let you load a dataset into only the currently 
selected layer. This is useful when you want several layers of the same type 
different datasets in them. Double-clicking on the dataset name is the same a
clicking the OK button.

Objectives Learn how to add a second Pseudocolor layer to drape amplitude (or other da
as color over the shaded time, and how to use multiple Pseudocolor (or other
layer types) in the same algorithm.
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Change the dataset band for the new Pseudo layer
1 With the new (lower) Pseudo layer selected, click on the Band Selection  

drop-down list in the process diagram (it currently reads ‘B1:Two Way 
Time_ms’).

A list of two bands displays. This dataset has two layers of data (called “band
covering the same geographic area–a two-way time band and a seismic amp
band.

2 Click on the option labelled B2:Amplitude  to select it as the band to be 
processed in that layer.

Note: Some datasets can have multiple layers of data, and each layer is called a “ba
ER Mapper. For example, if the dataset contained four time horizons, you wo
select the one you want to view using the Band Selection  list.

Turn off the upper Pseudocolor layer and the Intensity layer
1 Turn off the upper Pseudo layer (right-click and select Turn Off ).

2 Turn off the Intensity layer (right-click and select Turn off ).

The two layers are now turned off and will be ignored during processing.

3 Click once on the lower Pseudo layer to select it.

The data initially appears as red over the shaded time image–you need to adju
transform (color mapping) to account for the data in the new layer.

Adjust the transform for the Amplitude color layer

1 Click on the right-hand Edit  Transform Limits  button in the process 
diagram. 

click to open Band Selection  list

right-click and turn
off top 2 layers
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The Transform  dialog box opens. Notice that the actual input limits range from
about -17000 to +30000.

2 From the Limits  menu, select Limits to Actual .

The amplitude data now displays using the full range of colors.

Note that the histogram for the amplitude data shows that most of the data va
are clustered in the center (a normal distribution). This is why the data are 
displayed primarily in greens and yellows since these are the middle colors in
lookup table.

3 On the Transform  dialog, click the Histogram equalize   button.

Histogram equalization increases the overall color contrast in the amplitude d
Areas of high amplitudes are shown as reds, and low amplitude in blues.

4 Click Close  on the Transform  dialog to close it.

Label the three algorithm layers to distinguish them
Since you now have three layers in your algorithm (and two Pseudo layers), i
helpful to labels to each so you can quickly distinguish between them.

1 Change the lower Pseudo layer’s label to Amplitude  (click on the existing 
label text, then select and replace it.)

2 Change the upper Pseudo layer’s label to Inverted TWT .

3 Change the Intensity layer’s label to Shaded TWT.

Your algorithm layer list labels should now look like this:

Display the amplitude and shaded time as a colordrape
1 Turn on the ‘Shaded TWT’ Intensity layer (right-click and select Turn On ).

This colordrape image lets you easily associate variations in amplitude with 
structural features shown by the shaded two-way time surface in the Intensity
layer. Using this technique, you can drape virtually any type of data in color o
the shaded time surface to aid interpretation of subtle relationships.
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Display the two-way time data again
1 Turn on the Pseudo layer labelled ‘Inverted TWT.’ 

2 Turn off the Pseudo layer labelled ‘Amplitude.’

The two-way time data again displays in color over the shaded relief data. You
now easily display either the time or amplitude data simply by turning on the 
desired layer.

Note: If you have more than one layer of the same type turned on, the layer on top 
has display priority over layers below it. In this case, for example, you would s
the two-way time data if both the ‘Inverted TWT and ‘Amplitude’ Pseudo layer
were turned on. (Data in lower priority layers is only displayed where they do 
spatially overlap with layers of the same type above them.)

3 Click once on the layer labelled ‘Inverted TWT’ to select it.

The Layer tab page in the right-hand panel changes to show only the process
diagram for the selected layer.

4: Saving the colordrape algorithm

Enter a description for the algorithm
1 In the Algorithm  dialog, select the text in the Description  field, then type 

the following:

Horizon KA time and amplitude colordrape

This text now becomes a brief description for the entire algorithm.

Save the processing steps to an algorithm file on disk
1 From the File  menu (on the main menu), select Save As... .

The Save As...  file chooser dialog box appears.

2 From the Directories  menu, select the path ending with the text 
\examples .

3 Double-click on the ‘miscellaneous\tutorial’ directory to open it. 

4 In the Save As:  text field, type in a name for the algorithm file using your 
initials at the beginning followed by the text ‘Horizon_KA_colordrape.’ 

Objectives Learn to save and add comments to the colordrape algorithm.
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Separate each word with an underscore (_). For example, if your initials are 
“DH,” type in the name:

DH_Horizon_KA_colordrape

5 Click the Apply button to save the algorithm and leave the dialog open.

Your pseudocolor algorithm is now saved to an algorithm file on disk.

Add comments to the algorithm
1 Click the Comments...  button.

A dialog box opens allowing you to type comments about your algorithm.

2 In the comments dialog, type the following description information:

This algorithm drapes time or amplitude data in color over

a shaded time surface. Sun angle shading is applied to the

time data in the Intensity layer to highlight structural

features. Two Pseudocolor layers are added to display either

time or amplitude to create a combined color/shaded relief image.

3 Click the OK button to save your comments with the algorithm and close 
the dialog.

4 Click Cancel  on the Save As...  dialog to close it.

Your algorithm is now commented for future users.

5: Working with layers

Collapse the data structure view of the surface
This algorithm data view is composed of a single surface that has three layer
Currently this surface is displayed in expanded mode so all the layers are list
the data structure diagram in the left-hand panel.

Objectives Learn how to collapse and expand the tree structure view of the algorithm. Al
learn to view the process diagram for any desired layers, and change layer pri
by moving layers up or down in the layer list.
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1 In the data structure (left-hand) panel, click once on the small “-” button left 
of the surface name.

The tree structure diagram collapses to show only the surface, and process 
diagrams for the three layers in the surface are now displayed in the Layer pa
the right. Collapsing surfaces can be helpful for navigating around in algorithm
that contain several surfaces.

2 Click once on the small “+” button left of the surface name.

The data structure diagram expands again to show all three layers.

3 Click once on the layer labelled ‘Inverted TWT’ to select it.

The Layer tab page in the right-hand panel changes to show only the process
diagram for the selected layer.

Choose to show process diagrams for two layers
If you have more than one layer in your surface, you can choose to display th
process diagram for any combination of them.

1 Ctrl-click once on the layer ‘Shaded TWT’ to select it. (Hold down the Ctrl 
key and click on the layer icon, not the label text field.)

Notice that the ‘Inverted TWT’ layer is still highlighted, and process diagrams
both layers are now displayed. 

2 Ctrl-click once on icon for the ‘Inverted TWT’ layer to de-select it.

Use Ctrl-click also to remove process diagrams for highlighted layers.

click to collapse or expand data structure diagram
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Note: Notice that the ‘Shaded TWT’ layer has a red arrow pointing to it–this indicate
that it is the selected layer. You may highlight several layers, but only one layer 
selected at a time. If you have a number of layers highlighted and open the 
Transform  dialog, its contents would apply only to the selected layer.

Move the Amplitude layer up change its priority
Right now, if both Pseudo layers were turned on, you would see the inverted 
way time data because it has a higher priority than the amplitude data layer (
above it in the layer list).

1 Right-click the ‘Amplitude’ layer and select Turn On .

You see the two-way time data draped over the shaded time because the ‘Inv
TWT’ layer is higher than the “Amplitude’ layer in the layer list.

2 Point to the icon for the ‘Amplitude’ layer and drag it above the ‘Inverted 
TWT’ layer.

Now the amplitude data displays in color over the shaded time because its la
now has display priority over the color time layer below it.

3 Click once on the ‘Amplitude’ layer to highlight it, then click the Move Down 

 button (in the row of buttons above the tabs).

The selected layer moves down below the ‘Inverted TWT’ layer.

You can move layers either by dragging them or selecting the layer and using 

the  or  buttons.

Tip: When selecting or dragging layers, always click on the layer’s icon, not on the 
label text field.

layer moves up
in layer list

click on layer icon to
select or drag
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  dialog to close it.

Only the ER Mapper main menu should be open on the screen.

• Use Intensity layers to create shaded relief images that highlight structure

• Combine Pseudocolor and Intensity layers to create colordrape images

• Turn layers on (to process them) and off (to ignore them)

• Add new layers and move existing layers

• Control the color and intensity components to modify image displays

Tips for colordrape algorithms
Generally the Intensity layer of a colordrape algorithm is used to show structu
features derived from two-way time data, and the color layers are used to sho
amplitude, azimuth, isochrons, or any other derivative or attribute images you
are useful. To use an existing algorithm as a “template” algorithm to apply the
same processing to different datasets, simply load new datasets into the Inte
and Pseudocolor layers and adjust the transforms to account for the data ran

One colordrape variation some researchers use is to display a dip image in 
Intensity instead of shading from a specific compass direction. A dip image m
delineate both sides of a fault more clearly, for example. (Generation of dip im
is explained in the chapter on formulas.)

Using algorithms with multiple layers
As you have seen in this exercise, a single algorithm can contain several layer
can be used to view the data in different ways. In this example, you had two 
Pseudocolor layers–one to display the two-way time in color and another to 
display the amplitude data in color. The ability to have access to many differe
views of the data in a single algorithm is a very powerful feature that lets you 
quickly visualize a wide variety of processing and enhancements.

As you learn to use ER Mapper, you may build algorithms that contain many
layers that process or integrate several different datasets. For example, you m
have several color layers that display different seismic attributes. Or, you mig

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
82 ER Mapper Workbook -  Seismic Geophysics Applications



Chapter 4#Colordrape algorithms#z 5: Working with layers

u the 
w the 
have several different time horizons, and simply turn on the layers that give yo
horizon and attributes you desire. (Using formulas, a single layer can also sho
result of calculations using more than one dataset, for example an isochron).
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HSI algorithms
This chapter explains how to create algorithms that allow you to display and 
manipulate data in Hue Saturation Intensity (HSI) color space. The HSI 
enhancement is an innovative analysis technique that goes one step beyond 
colordrape display, so you can visualize three variables simultaneously. (HSI 
also referred to as IHS, or Intensity Hue Saturation, in some circles.)

About the HSI Color System
In the Hue Saturation Intensity (HSI) color system, different colors are 
characterized by three measurable characteristics of a color: 

• Hue–The main attribute of a color that distinguishes it from other colors in the
spectrum. Hues are what you see in a rainbow, and are what we commonly th
as “color” (red, yellow, green, and so on). 

• Saturation–The amount of grey in a color or color “purity.” Colors with high 
saturation (little grey) are said to be pure or vivid. Colors with low saturation (m
grey) are pastel or dull colors. Completely desaturated colors are grey, no ma
what the hue. 

• Intensity–The relative brightness of a color. Colors with high intensity are brig
and colors with low intensity are dark.

The HSI color system is characterized as an “perceptual” color system becau
provides a more intuitive means of manipulating color than the RGB (electron
color system. ER Mapper implements the HSI color system by means of the C
Mode named Hue Saturation Intensity, and separate algorithm layer types for
Saturation, and Intensity.
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HSI Color Mode
To display data in HSI, you set the algorithm Color Mode to Hue Saturation 
Intensity, then load data into Hue, Saturation, and Intensity layers. In order to
produce color, all three layers types must be included in the same surface an
turned on. ER Mapper provides HSI template algorithms that let you quickly l
and display data using the HSI color system.

Note: Computer monitors use the RGB color system to actually display data, so 
ER Mapper automatically performs an internal translation of colors specified i
HSI back to colors specified in RGB for the monitor.

The Hue Layer
In an HSI image display, the Hue layer type controls the mapping of data valu
colors in the spectrum. In a typical display, the range of data values from low 
high is mapped through the progression of hues: red-yellow-green-cyan-blue
magenta.

The Saturation Layer
In an HSI image display, the Saturation layer type controls the mapping of da
the purity of colors in the image display (that is, the amount of grey in the colo
Low data values produce pastel or dull colors (much grey), and high data valu
produce pure or vivid colors (little grey).

The Intensity Layer
In an HSI image display, the Intensity layer type controls the mapping of data
the brightness of colors in the image display. Low data values produce dark co
and high data values produce bright colors.

Hue layer color image

Saturation layer color purity image

combined

Intensity layer brightness image

HSI
colordrape

image
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The diagram above shows how algorithm Hue, Saturation and Intensity layer
combined to create a single HSI colordrape image. You will see for yourself h
these techniques work in the following exercises.

Hands-on exercises
These exercises give you practice creating HSI colordrape algorithms and 
manipulating image display in HSI color space.

• Use the algorithm Color Mode named Hue Saturation Intensity

• Combine Hue, Saturation and Intensity layers to create HSI images

• Understand the basics for interpreting data displayed in HSI

• Control the hue, saturation and intensity components to modify image display

• Create a special effect HSI “wet look” algorithm

1: Creating the shaded relief image

Open an image window and the Algorithm dialog

1 Click the Edit Algorithm  button.

An image window and the Algorithm  dialog appear.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn how create an HSI algorithm by opening a new image window, creating
Hue, Saturation, and Intensity layers, and loading data into the H, S, and I lay
(The sample algorithm you will create displays two-way time as hues, amplitu
as saturation, and shaded two-way time as intensity.) 

Edit Algorithm button
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Change the Pseudocolor layer to an Intensity layer
1 Right-click the Pseudo layer and select Intensity from the short-cut menu:

The Pseudo layer changes to an Intensity layer and ER Mapper sets the laye
description to “Intensity layer.”

Load the sample seismic dataset into the Intensity layer

1 In the process diagram, click the Load Dataset   button.

The Raster Dataset  file chooser dialog box appears.

2 From the Directories  menu, select the path ending with \examples . 

3 Double-click on the ‘Shared_Data’ directory to open it.

4 Double-click on the dataset named ‘Seismic3D.ers’ to load it.

The dataset is loaded into the Intensity layer.

Use a formula to invert the dataset values
As before, it is often desirable to invert two-way time values, so larger time va
are displayed as structural lows and smaller values as highs.

1 In the Algorithm  dialog, click the Edit Formula   button in the process 
diagram.

2 In the Formula Editor  dialog, edit the text string “INPUT1” to add a minus 
sign (-) in front. Your formula should now look like this:

- INPUT1

This formula tells ER Mapper to negate (invert) all values in the dataset.

3 On the Formula Editor  dialog, click the Apply changes  button.

4 Click Close  on the Formula Editor  dialog to close it.

The image appears as black initially because you need to adjust the transform
account for the range of negative data values produced by the formula.

Adjust the color mapping (contrast) of the image

1 In the Algorithm  dialog, click the right-hand Edit Transform Limits   
button in the process diagram. 

The Transform  dialog box opens, and shows the negative data range produce
the formula in the Actual Input Limits fields.
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2 From the Limits  menu (on the Transform  dialog), select Limits to Actual .

The X axis data range changes to match the Actual Input Limits.

ER Mapper renders the image again, this time using the full range of grey sha
to display the image.

3 Click Close  on the Transform  dialog to close it.

Turn on sun shading and display the shaded relief image

1 On the Algorithm  dialog, click the Edit Realtime Sunshade  button in 
the process stream.

The Edit Sun Angle  dialog box opens to let you specify shaded relief effects 
the Intensity layer.

2 Turn on the Do sun-shading  option.

Sun angle shading is applied to the dataset to enhance the structural features
time surface.

3 Drag the small sun icon (the circle) around the circular grid until you find a 
shade angle that highlights structural features of interest. (Keep the sun 
elevation above 45 degrees to reduce shadowing.)

4 Click Close  on the Edit Sun Angle dialog to close it.

Label the Intensity layer to identify it
1 Change the Intensity layer’s text label to Shaded TWT.

(If desired, you could also add the shading angle, for example “NE shaded TW

2 Make the image window about 50% larger by dragging lower-right corner of 
the window border.

3 Right-click on the image and select Zoom to All Datasets  from the Quick 
Zoom  menu.

You have now created the shaded relief image to highlight structure. Next you
add Hue and Saturation layers to drape other data in color.
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2: Adding data in Hue and Saturation layers

Duplicate the Intensity layer and change it to Hue
1 On the Algorithm  dialog, select the Intensity layer (if needed), then click 

the Duplicate   button.

ER Mapper creates a copy of the Intensity layer below the original.

2 Right-click on the new duplicate layer, and select Hue.

The Intensity layer changes to a Hue layer. You will use this layer to display th
time surface data in color over the shaded relief image.

Note: Notice that the Hue layer has a red “X” through it. This indicates that the Hue l
type in not valid with the current algorithm Color Mode (which is Pseudocolor 
default). In order to use Hue layers in an algorithm, you must also set the Co
Mode named Hue Saturation Intensity.

Change the Color Mode to Hue Saturation Intensity
1 Click the Surface  tab in the Algorithm  dialog.

Options for Color Mode, Color Table and Transparency display.

2 From the Color Mode  drop-down menu, select Hue Saturation Intensity .

The Hue layer now becomes active, and the HSI color mode is also shown in
brackets next to surface name ([HSI]:Default Surface). Also notice that the Co
Table option disappears from the Surface tab (because a color lookup table is
used to control image colors with HSI color mode).

Tip: You can also change the Color Mode for a surface by right-clicking the surfac
name and selecting from the short-cut menu.

Objectives Learn how to build on your shaded relief Intensity image to create an HSI 
algorithm by adding Hue and Saturation layers. (The sample algorithm you w
create displays two-way time as hues, amplitude as saturation, and shaded t
way time as intensity.)
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Turn off sun shading for the Hue layer

1 With the Hue layer selected, click the Edit Realtime Sunshade   button 
in the process stream.

The Edit Sun Angle  dialog box opens. Since the layer was duplicated from th
Intensity layer, sun angle shading is still turned on.

2 On the Edit Sun Angle  dialog, turn off the Do sun-shading  option.

Sun angle shading is now turned off for the Hue layer (shading is not normall
used on color layers).

3 Click Close  on the Edit Sun Angle  dialog to close it.

4 Change the label for the Hue layer to Inverted TWT .

Add a Saturation layer and load the sample dataset
1 From the Edit menu (on the Algorithm  dialog), select Add Raster Layer , 

then select Saturation .

ER Mapper adds a new Saturation to the layer list. New added layers contain
dataset (shown by “No Dataset” above the process diagram). You will use this
layer to display the seismic amplitude data.

2 In the Algorithm  dialog, click the Layer  tab to see the process diagram.

3 Click the Load Dataset   button in the process diagram.

The Raster Dataset  file chooser dialog box opens.

4 From the Directories  menu, select the path ending with \examples .

5 Double-click on the directory named ‘Shared_Data’, then double-click on 
the ‘Seismic3D.ers’ to load it.

The dataset is loaded into the Saturation layer (all layers contain the same da

Tip: You can create new layers in an algorithm surface either by duplicating an exi
layer or by adding a new layer. Duplicating the Intensity layer and changing to
Hue layer earlier was easier because the Intensity layer already had the corre
dataset, invert formula, and transform input limits (since both layers display tw
way time). Sometimes it it easier to add a new layer (as you did above) than it
duplicate one and remove elements you don’t want (such as the invert formul
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Select the amplitude band and label the Saturation layer
1 With the Saturation layer selected, click the Band Selection  drop-down list 

in the process diagram, and select B2:Amplitude .

You have now chosen to display the amplitude data in the Saturation layer.

2 Change the text label for the Saturation layer to Amplitude .

You should now have Intensity, Hue and Saturation layers with these labels:

Note that the layer icons have a small letter (I, H, or S) next to them to help 
distinguish them from layers of other types.

You now have an image similar to the colordrape that shows structure (shade
way time) and depth (color-coded two-way time). Now you need to adjust the
transform of the amplitude data to make it clearly stand out against the color 
shading.

Apply a Histogram equalization to the amplitude data
1 With the ‘Amplitude’ Saturation layer selected, click the right-hand Edit 

Transform Limits  button in the process diagram. 

2 On the Transform  dialog, select Limits to Actual  from the Limits  menu.

The complete histogram for the amplitude data appears.

3 On the Transform  dialog, click the Histogram equalize   button.

The overall contrast in the amplitude data is increased, which appears as vari
in color saturation throughout the image. Notice, for example, that the V-shap
uplifted fault block in the upper-left shows high amplitudes as vivid colors and 
amplitudes as greyish colors.

You now have an image that shows three variables at once:

click to open, select B2:Amplitude
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• Structure is shown as intensity (brightness) by applying sun angle shading to
two-way time data. 

• Relative depth is shown as color (hues), where red indicates structural lows 
progressing through yellow, green, cyan, and blue to magenta for the structu
highs in the time surface. 

• The event amplitude is shown by variations in the saturation or purity of colors, 
where greyish or pastel colors indicate low amplitudes and vivid or rich colors
indicating high amplitudes. 

This type of display has become a popular ER Mapper processing technique
combined analysis of two-way time and amplitude data, as well as other 
combinations of time and seismic attribute data.

4 Click Close  on the Transform  dialog to close it.

Zoom in on upper-left portion of the image

1 On the Main Menu, click the Zoom Box Tool  button. 

You can now use the mouse for zooming and panning functions.

2 Inside the image window, drag a zoom box around the V-shaped structure 
in the upper-left portion of the image (the uplifted fault block in red and 
magenta).

ER Mapper zooms in on the defined area. Notice that the image takes on a sl
jagged or blocky look when you zoom in closely. (You can begin to see the lim
of the seismic data resolution, or the actual pixels that comprise the dataset.)

3 On the Algorithm  dialog, turn on the Smoothing   option, then 
Notice that the image becomes noticeably smoother. The Smoothing 
option applies a bilinear interpolation to the image display. This is often 
useful for reducing the jagged look and helps make overall features easier 
to interpret.

Also notice that you can now clearly see the pattern of low and high amplitude
the uplifted block and surrounding areas. High amplitude areas have very rich
colors, and low amplitudes occur along the faults (shown by the low saturatio
greyish colors in those areas).

4 From the View  menu (on the main menu), select Quick Zoom , then select 
Zoom to All Datasets .

ER Mapper zooms back out to the full image extents.
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Tip: The Smoothing  option is most useful when you zoom in very closely on an a
of interest, and can be turned on or off as desired. It usually has little noticea
effect until you zoom in close to the pixel resolution.

3: Saving the HSI colordrape algorithm

Enter a description for the surface
1 Change the surface description text to TWT & amplitude  (it currently 

reads ‘Default Surface’).

It is often helpful to label each surface in an algorithm, as well as the individu
layers that comprise the surface. (This is especially true for multi-surface 
algorithms.)

Enter a description for the algorithm
1 In the Algorithm  dialog, select the text in the Description  field, then type 

the following:

TWT and amplitude HSI enhancement

This text now becomes a brief description for the entire algorithm.

Save the algorithm to disk

1 On the main menu, click the blue Save As...  button.

The Save As...  file chooser dialog box appears. (This toolbar button is a short-
for selecting Save As...  from the File  menu.)

2 From the Directories  menu, select the path ending with the text 
\examples .

Objectives Learn to save and add comments to the HSI colordrape algorithm.

when selected, click on
text field to change label
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3 Double-click on the ‘miscellaneous\tutorial’ directory to open it. 

4 In the Save As:  text field, type in a name for the algorithm file using your 
initials at the beginning followed by the text ‘Seismic_HSI_enhancement.’ 
Separate each word with an underscore (_). For example, if your initials are 
“TL,” type in the name:

TL_Seismic_HSI_enhancement

5 Click the Apply button to save the algorithm and leave the dialog open.

Your HSI algorithm is now saved to an algorithm file on disk.

Add comments to the algorithm
1 Click the Comments...  button to add comments.

2 In the comments dialog, type the following description information:

This algorithm displays time and amplitude data in hue

saturation intensity (HSI) color space. Sun angle shading is 
applied to the time data in the Intensity layer to highlight 
structure. Time is displayed as color in the Hue layer, and

event amplitude is displayed as variations in color saturation

in the Saturation layer.

3 Click the OK button to save your comments with the algorithm and close 
the dialog.

4 Click Cancel  on the Save As...  dialog to close it.

Your algorithm is now commented for future users.

4: (Optional) Creating a “wet look” image

Note: The following technique uses a fast method to build the “wet look” algorithm 
using already existing algorithms. You will use existing algorithms as template
more as you become familiar with ER Mapper.

Objectives Learn to create an HSI algorithm that creates a special shiny look similar to a
plastic raised relief map. This type of image is very popular for presentations 
hardcopy map prints.
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Open an existing colordrape algorithm

1 On the main menu, click the Open  button. 

2 From the Directories  menu (on the Open  dialog), select the path ending 
with the text \examples .

3 Double-click on the ‘Applications\Oil_And_Gas_Exploration’ directory to 
open it.

4 Double-click on the algorithm ‘Seismic_Horizon_Colordrape.alg’ to open it.

ER Mapper displays a horizon colordrape image similar to the one you create
previous lesson. (Two-way time is draped in color over shaded two-way time.

Open a second image window

1 On the main menu, click the New  button.

A second image window appears. Drag it down below the 
‘Seismic_Horizon_Colordrape’ image window.

Open an existing “wet look” algorithm

1 On the main menu, click the Open  button. 

2 From the Directories  menu, select the path ending with the text 
\examples .

3 Double-click on the ‘Applications\Oil_And_Gas_Exploration’ directory to 
open it.

4 Double-click on the algorithm ‘Seismic_Horizon_Colordrape_HSI.alg’ to 
open it.

This colordrape shows the same data as the other image window (two-way tim
color over shaded two-way time), but with a special enhancement that create
illusion of a reflected light source. (The shiny surface is created by removing 
saturation from the color in the brightest sun-shaded areas so they look brigh
white.) This specialized enhancement technique is not normally used for 
interpretation, but is sometimes used to make “glossy” images for presentatio

A short-cut way to create a “wet look” image with your own data (a complete 
explanation is beyond the scope of this workbook):

• Create and save a colordrape algorithm with one Intensity and one Pseudoco
layer (use the ‘Seismic_Horizon_Colordrape’ algorithm as an example).

• Open the existing wet look algorithm ‘Seismic_Horizon_Colordrape_HSI.’ Yo
will use this algorithm as a template to apply the same processing to your da
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• Load your colordrape algorithm into the ‘Seismic_Horizon_Colordrape_HSI’ 

algorithm. (Load the algorithm just like a dataset using the Load a Dataset   
button in the process diagram on the Algorithm  dialog.)

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  dialog to close it.

Only the ER Mapper main menu should be open on the screen.

• Use Intensity layers to create shaded relief images that highlight structure

• Combine Pseudocolor and Intensity layers to create colordrape images

• Turn layers on (to process them) and off (to ignore them)

• Control the color and intensity components to modify image displays

• Create a special effect HSI “wet look” algorithm

Tips for HSI Algorithms
Displaying data in Hue Saturation Intensity color space is one of the newer 
techniques in the analysis of interpreted time surfaces. It is helpful to have ba
understanding of the way the HSI color system works to help you interpret da
presented in this way.

Using the previous HSI image as an example, color is used to indicate absolu
depth, or the structural highs and lows in the time surface. The event amplitu
not related to any specific color or hue (red, blue, etc.), but only to the saturation 
of the color. For example, areas of the time surface with similar amplitudes m
have completely different colors, but will have the same degree of color satur
or purity.

This example used time in the hue layer and amplitude in the saturation layer
you could just as easily switch them or substitute any other types of data inst
Shaded two-way time data is generally always used in the intensity layer. (To
switch them, you would simply right-click the Hue layer and then select Satura
and vice versa. Then structural lows would be shown by weak colors and high
vivid colors. The actual colors would show variations in amplitude.) 

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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The steps you followed in this exercise showed how to create an HSI algorith
from scratch, in part to illustrate the use of certain features in ER Mapper. W
you learn to use ER Mapper, you can create these types of algorithms more 
quickly by using an existing algorithm as a template, or using a toolbar button
automatically create certain types of commonly used algorithms.

Modifying color mapping in HSI mode
The set of hues used to display data in HSI can be envisioned as color whee
where the output data range 0-255 is mapped to the cycle of hues as shown 
following diagram. (The normal 0-360 azimuth range is compressed to 0-255
simplify mapping to computer displays.):

For example, input data values that are mapped to the output value 128 (by t
transform) are displayed using a cyan hue in the image. This is a fixed set of 
colors, but you can exclude colors either at the bottom or top of the range to 
modify the colors in the displayed image.

Since the color wheel wraps around on itself, both the very lowest values and
highest values are assigned the color red in the image by default. (You can se
in the sample HSI algorithm you created in this chapter.) You can avoid this b
opening the Transform  dialog and changing the output maximum field to 240. 
This tells ER Mapper not to use the red hues (240-255) for high data values,
instead map the highest values to the hue magenta. (As another example, th
“wet look” algorithm also excludes some hues using this method.)

Tip: To see the progression of colors used in HSI mode, display a dataset in 
Pseudocolor mode and select the color table named “hue.” Then open the 
Transform  dialog and view the color progression of hues on the Y axis color 

red

yellow

green

cyan

blue

magenta

64192

128

0 & 255
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Viewing dataset
values

This chapter shows you the options ER Mapper provides for viewing dataset 
values and coordinate locations. These include cell (pixel) values, neighborho
signatures, traverse extraction, and scattergrams. You also learn how to mea
distances between two points on an image. 

About viewing data values
Viewing image data values is one of the fundamental ways to assess data qu
and the particular characteristics of features in an image. Options for viewing
values and geographic locations in ER Mapper include:

Cell values The data value associated with each cell or pixel in th
dataset, or the data values of that cell in each band o
multi-band dataset.

Neighborhoods An array of data values surrounding a pixel.

Signatures The data values of a pixel in all bands shown in a line
graph format.

Traverse extraction A profile of data values occurring along a line or 
polygon drawn on the image. 
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Scattergrams An X-Y plot showing the relationship between data 
values in two bands of an image.

Histograms A plot showing the range of data values on the X axis
and their relative frequency on the Y axis

Hands-on exercises
These exercises show you various ways of viewing data values, coordinate 
locations, and geographic distances between two points on an image.

• View image data values in text format

• View distances between any two points on an image

• View image data values along a transect profile line

• View two bands of image data values as an X-Y scattergram

• Highlight image areas that correspond to scattergram point clusters

1: Viewing cell values and locations

Open and display the sample colordrape algorithm

1 On the main menu, click the Open  button.

An empty image window and the Open dialog box appear.

2 From the Directories  menu, select the path ending with the text 
\examples .

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_Colordrape.alg’ to open and display it.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn to view image data values in a text format, neighborhood format, and 
signature (line graph) format. Also learn to view the geographic locations and
distances in both 2D and 3D images.
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This algorithm drapes two-way time in color over shaded two-way time to prov
structural relief (similar to one you created in an earlier chapter).

View cell values for the time and amplitude dataset bands
1 From the View  menu, select Cell Values Profile... .

The Cell Values Profile  dialog box appears. Drag it by its title bar next to the 
image window. This dialog has three display windows, any of which can be tu
on or off at any time.

By default, all three options are turned on (Values , Signature  and Neighbors .) 

2 If needed, resize the dialog until all fields are visible as shown above.

3 Turn off the Signature  and Neighbors  options (deselect their option 
buttons).

Those windows disappear from the Cell Values Profile  dialog.

4 On the main menu, click the Pointer Tool  button.

The Pointer Tool is used to view data values. 

5 Point inside the image window, and press and drag the mouse pointer 
through the image (or just click on any pixel).

The Cell Values Profile  dialog displays the data values in both the time and 
amplitude bands in the seismic dataset for the current cell (pixel) location in t
image. The data values are updated as you drag the mouse to new locations

option to turn
window on/off

drag to make
window areas

Values
window

Neighbors
window

Signature
window

larger or
smaller on
the dialog
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View a neighborhood of cell values
1 In the Cell Values Profile  dialog, turn on the Neighbors  option.

The Neighbors window is again added to the dialog, with a drop-down menu 
select a dataset band.

2 Point inside the image window, and drag the mouse pointer through the 
image (or just click on any pixel). 

A three-by-three neighborhood of cell values displays as you drag the mouse
center pixel in the three-by-three array is the current pixel, and the surroundin
eight pixels are its neighbors. This feature is useful to viewing the local varianc
texture in various parts of an image.

3 From the Band  drop-down list, select B2:Amplitude .

4 Drag again through the image.

The data values for band 2 of the seismic dataset (amplitude in this case) disp
the three-by-three neighborhood. (The 3 by 3 neighborhood can only be show
one band at a time.)

View a signature of cell values
Note: The Signature option is not useful with this sample dataset–the followin
section describes how you might use it with your datasets.

1 In the Cell Values Profile  dialog, turn on the Signature  option.

A third window is added to the Cell Values Profile  dialog, with a row of buttons 
on top. This option shows the same data as displayed in the Values window, 
line graph format.

open Band  menu and
select Amplitude band
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Notes about using signatures with geophysical data
The Signature option is designed for use with datasets that contain multiple b
and would not normally be used with datasets that contain one or two bands 
this sample one does). It can be very useful, for example, with datasets that co
multiple horizons or multiple attributes to see graphically how the data values
various bands relate to each other. Following are general procedures for usin
Signature feature:

• To view a signature, click on one of the option buttons above the Signature win
and drag through the image or click on a feature. The data values for all band
the dataset will appear as a line graph (a “signature”) in the Signature window

• The buttons above the Signature window set a color for the graph line(s). To 
second signature in a different color, click on another button above the Signa
window and drag or click on a feature in the image. A second graph line in a 
different color will appear. (Each of the buttons starts a new color graph line.)

• To view a signature showing the accumulated average of all the data values over 
the area where you dragged, click on the Average option before dragging. A 
thickened graph line will appear to indicate that this signature is an average, an
can add to the average signature by continuing to drag. (This allows you to vie
average signature over a broad feature area instead of a single pixel at a tim

2 Click the Close  button on the Cell Values Profile  dialog box to close it.

Note: The data values shown in the Cell Values Profile  dialog are taken directly from 
the dataset on disk. Therefore, any processing you apply in your display algo
(such as a formula or filter) do not affect the data values you see here. (For 
example, the two-way time data used here is shown with its original positive d
range, even though a formula is used to negate it for display.)

View geographic coordinates in the image
1 From the View  menu, select Cell Coordinate... .

The Cell Coordinates  dialog appears. Drag it next to the image window.

2 Point to the image window, and drag the pointer through the image.
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The dataset and geographic location of the current cell appear, and are upda
you drag the mouse.

The upper three fields of this dialog show the location of the current pixel in 
dataset column (X) and row (Y) coordinates, and the Eastings/Northings and 
Latitude/Longitude coordinate systems.

Note: The Easting Northing and Latitude Longitude fields only display valid values if 
dataset is registered to a map projection. Unregistered (raw) datasets display
values in these fields.

View distances between points in the image
The lower three fields of the Cell Coordinate  dialog show distance between the
point where you first depress the mouse button and the point where you relea
Distances are shown as Imperial distance (feet and miles), Metric distance (m
and kilometers), and Dataset distance (number of cells in the X and Y directio

1 Point to the image window, and click on any point in the image.

The Imperial, Metric, and Dataset distance fields are cleared to zero values.

2 Pick out two features in the image, then drag the mouse between them.

The distance between those two points is displayed when you release the mo
button. Measuring the distance between two points is called mensuration.

(The Terrain Height field is active when the image is viewed in 3D.)

geographic coordinates
of current pixel

distance between two
points on the image
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Open and display the sample 3D horizon algorithm

1 On the main menu, click the Open  button.

2 From the Directories  menu (on the Open  dialog), select the path ending 
with the text \examples .

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_3D.alg’ to open it.

4 On the main menu, click the Edit Algorithm  button to open the 
Algorithm  dialog.

5 From the View Mode  menu (on the Algorithm  dialog), select 3D 
Perspective .

ER Mapper renders the two-way time horizon in 3D perspective.

Query cell values and coordinates on the 3D image
1 From the View  menu, select Cell Values Profile... .

Both the Cell Values Profile and Cell Coordinates  dialog should be open.

2 Drag inside the image window, and view the cell values and coordinates.

Notice that the mouse cursor becomes a cross that conforms to the 3D surfa
you drag on the image. The arrow on the cursor points north. Querying cell va
and coordinates works essentially the same in 3D view mode as it does in 2D

3 Click Close  on the Cell Values Profile  and Cell Coordinates  dialogs to 
close them.

4 Click Close  on the Algorithm dialog.

2: Viewing traverse profiles

Open the sample colordrape algorithm again

1 On the main menu, click the Open  button.

2 From the Directories  menu (on the Open  dialog), select the path ending 
with the text \examples .

Objectives Learn to view image data values for multiple bands as a profile or transect alo
line or polygon drawn on the image (called traverse extraction).
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3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_Colordrape.alg’ to open and display it.

Set up to draw traverse profile lines
1 From the View  menu, select Traverse... .

The New Map Composition and Traverse  dialogs open.

2 On the New Map Composition dialog, be sure the Vector File  option is 
selected, then click OK.

The annotation Tools  dialog appears, along with an ER Mapper  warning dialog 
box.

3 Click Close  on the ER Mapper  warning dialog to close it. (When using 
annotation tools for other purposes Page Setup is recommended, but it is 
not important for this exercise.)

You will use the vector annotation tools in the Tools  dialog to draw traverse lines
on the image.

Draw a traverse line on the image

1 On the Tools  dialog, click the Poly Line  button (use the tooltips for 
buttons if needed).

2 Inside the image window, define a straight line across the red uplifted block 
in the image. Click once at the start point, once at the end point, then 
double-click to end the line definition.

click once to

click once to define
second line node,
then double-click to
finish line

start line
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A profile line appears inside the Traverse  dialog. This line displays the change in
the values of pixels underneath the traverse line you drew. By default, values
dataset band 1 (two-way time) are shown as a black profile line.

Note: As with the Cell Profiles, traverse profiles show the data values actually store
the dataset on disk. Therefore algorithm formulas, transforms, and so on do n
affect the data values shown in traverse profiles. (For example, structural high
(smaller time values) are shown as the dip in the profile above.)

View the amplitude data along the same traverse line

1 On the lower part of the Traverse  dialog, click the Bands:  button.

The Traverse Band Selection  dialog opens.

2 Click on B2:Amplitude in the list to select it.

3 Click OK on the Traverse Band Selection  dialog.

A profile of the amplitude data along the same line appears in the Traverse  
dialog.

You can also view profiles for multiple dataset bands at one time by selecting

desired bands using the Bands:  button. The profile line for each band 

appears in a different color with corresponding legend labels in the upper left
corner of the Traverse  dialog.

band/color
legendscale of

dataset
values graphical

plot of change
in values
along traverse

geographic
extent of
traverse line

click to select dataset bands
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Draw a second traverse line on the image
1 Inside the image window, define a second line across a different area. 

(Click once at the start point, once at the end point, double-click to end.)

The new amplitude profile lines appear inside the Traverse  dialog. You can draw 
as many different traverse lines on the image as you desire.

Tip: You can also drawn polylines (lines with multiple nodes) that, for example, zig-
back and forth across a feature like a fault. (Just click once at each node, the
double-click to end the line.)

Alternate between the two traverse lines

1 On the Tools dialog, click the Select and Edit Points Mode  button.

2 Inside the image window, click on the first traverse line you drew.

The line becomes selected (it shows nodes at the end points) and its correspo
profile again appears in the Traverse  dialog. You can view the profile for any 
traverse line you’ve drawn by simply selecting it as shown here.

Revise the location of a traverse line
1 Drag one of the nodes (endpoints) of the selected line to a new location on 

the image.

When you release the mouse button, the profile is automatically updated in th
Traverse  dialog. You can modify the location and length of any traverse line b
following these steps.

2 If needed, revise one of your lines so it traverses across one of the major 
faults in the V-shaped uplifted block in the upper-left part of the image.

Notice that you can easily see the strong dip in amplitude where the line cros
the fault. Traverse extraction can be very useful for clearly associating visual 
features on an image with patterns or anomalies in data values.
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Tip: If desired, you could save the current annotation layer and reload it later, and
can also save the traverse profiles to an XYZ format text file on disk for expor
other analysis software if desired..

Close Traverse Extraction
1 Click Close  on the Traverse  dialog to close it.

2 Click Close  on the Tools  dialog. When asked to save the current 
annotation, click No.

Notes on viewing multiple profile lines
As described earlier, you can view profiles lines for multiple attributes or horiz
by selecting them using the Bands  button on the Traverse  dialog. Following are 
some helpful tips on this:

• All attributes or horizons to be viewed simultaneously must be stored as band
single ER Mapper dataset.

• Since the data ranges of various seismic attributes can vary greatly, you may 
helpful to normalize the attributes into a common range. Otherwise, the attrib
with the greatest range dominates the range of graph lines on the Traverse  dialog, 
and other attributes with smaller ranges may appear as nearly flat lines in 
comparison. One simple way to do this is to create a new dataset that uses th
transforms to rescale the data into a 0-255 range in the output dataset. (The 
procedure is similar to that shown in Chapter 12 except that you do not delete
transforms.) There are also other more sophisticated ways to resale the data
formulas.

click to save traverse lines as XYZ ASCII file
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3: Viewing image scattergrams

A scattergram allows you to graphically see the correlation between the data 
values in two dataset bands. Values for one band are plotted on the Y axis an
other on the X axis. These two numbers locate each pixel in the two-dimensio
measurement space of the X-Y graph.

Open a Scattergram dialog box
1 From the View  menu, select Scattergrams... .

The Scattergram  dialog and New Map Composition dialog boxes open.

2 Be sure the Raster Region  option is selected on the New Map 
Composition  dialog, then click OK.

The Tools  dialog opens.

3 On the Scattergram  dialog, click the Setup  button.

The Scattergram Setup  dialog opens. Arrange the dialogs and image window
on the screen as shown below:

Set the X and Y axis limits to display the scattergram
The Scattergram  dialog automatically references the dataset in the active im
window (‘Seismic3D.ers’). A scattergram does not initially appear because th
values for band 1 in this dataset fall outside the default data range of 0-255.

1 In the Scattergram Setup dialog, click the Limits to Actual button.

Objectives Learn to view the relationship between image data values in two bands as a 
two-dimensional plot called a scattergram (or scatter diagram). Also learn to 
define areas the scattergram and view the corresponding pixels on the image
define areas on the image view their data value locations on the scattergram.

colordrape
image window

Scattergram Scattergram
Setup

Tools
110 ER Mapper Workbook -  Seismic Geophysics Applications



Chapter 6#Viewing dataset values#z 3: Viewing image scattergrams

lues 
xis. 

) axis 
rious 

 
e 
 

 

n the 
ram 
t the 

ing 
e 
The X and Y axis limits are reset, and a scattergram appears in the Scattergram  
dialog window. This plot shows the relationship between the two-way time va
(plotted on the horizontal X axis) and the amplitude values plotted on the Y a

By default, a new scattergram plots band 1 of the dataset on the X (horizontal
and band 2 on the Y (vertical) axis, and the cluster of points is shown using va
colors inside the scattergram window. The colors represent the accumulated 
frequency (or “density”) of data values in both bands. Areas of the scattergram
with the highest densities of points are shown in colors in the upper part of th
color bar (red and yellow), and low density areas in the lower colors (blue and
magenta). Typically, high density areas will be a feature comprising a large 
number of pixels in both bands.

2 Without depressing the mouse, move the cursor around inside the 
scattergram.

The current X-Y location of the cursor is shown in the upper-left corner of the
Scattergram  dialog.

The wide dispersion of points indicates that there is a weak correlation betwee
time and amplitude values. The frequency of points and shape of the scatterg
can reveal anomalies in the dataset that may not be apparent when looking a
data in other ways.

Draw a box on the scattergram to highlight amplitude ranges
By defining a region box on the scattergram, you can highlight the correspond
pixels in the image window. For example, suppose you want to highlight all th
area that exceed a certain threshold of amplitude.
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1 In the Scattergram  dialog, drag to define a large box around the 
uppermost spread of points (see the diagram below).

When you release the mouse, ER Mapper runs the algorithm again and then 
a solid color over pixels in the image window whose data values fall within the
limits you defined on the scattergram (in this case event amplitudes exceedin
about 20000). By default, the overlay is drawn in red.

Move the region box to highlight low amplitudes

1 In the Scattergram  Setup  dialog, turn on the Defer Display option. 

This tells ER Mapper to delay updating the scattergram or region overlay until
finish changing the desired options (moving the region box in this case).

2 In the Scattergram  dialog, point inside the box you drew and drag it down 
to cover the points for the lowest amplitudes (see the diagram below).

3 After moving the box, click the Display  button in the Scattergram  Setup  
dialog. 

drag a box to
enclose points
representing
high amplitudes

move the box to
enclose points
representing
low amplitudes
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ER Mapper runs the algorithm again to color the pixels falling within the box’s
new data limits (areas with lowest event amplitudes this time).

Change the color of the image overlay
1 In the Scattergram Setup  dialog, click the Set color...  button next to 

Region Display Color .

The Color Chooser  dialog opens.

2 Choose magenta (purple) as your region overlay color, then click OK to 
close the Color Chooser  dialog.

3 Click Display  in the Scattergram  Setup  dialog. 

ER Mapper redraws the image overlay in magenta, so you can more easily se
low amplitude areas are generally associated with faults.

Revise the region box to highlight a time slice
Notice that the region box on the Scattergram  dialog is selected (it has “handles
at the four corners). You can move or resize the box by dragging the handles

1 On the Scattergram dialog, resize and shape your region box by dragging 
any of the four handles to enclose a specific range of time values (see the 
diagram below).

2 After revising the box, click Display  in the Scattergram  Setup  dialog. 

ER Mapper updates the color overlay to highlight the range of time values fal
within the box’s data limits (in this case about 2050 to 2075 milliseconds).

revise the box to
enclose points
representing
a time slice
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Tip: The scattergram overlays feature described above also works when viewing im
in 3D perspective mode. However, you cannot view an image in 3D when usin
annotation Tools  dialog (as you will next).

Delete the scattergram region
1 On the Scattergram Setup  dialog, click Delete Region , then click Display .

ER Mapper deletes the region box from the scattergram, then redraws the im
without the color overlay.

Note: The scattergram region box must be selected before you can move, resize or
it (click on any box border until selection handles appear).

2 Turn off the Defer Display option on the Scattergram Setup  dialog.

Draw a region on the image
ER Mapper also lets you define a region on the image, and view the mean va
and standard deviation ellipse on the scattergram for data values that fall insid
region on the image.

1 On the Scattergram Setup  dialog, turn on the Show Means and 95% 
ellipses  option.

2 On the Tools  dialog, click the Polygon  button.

turn on Show Means and
95% ellipses  option
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3 Inside the image window, define a polygon around a feature of interest. 
Click once at the start point, once at each node, then double-click to end 
the polygon definition

ER Mapper displays a mean and 95% confidence ellipse for the data values t
fall inside the region you drew. This is a easy way to see where the region occ
the range of possible dataset values shown on the scattergram.

Close the scattergram dialogs
1 Click Close  on the annotation Tools dialog to close it.

2 Click Cancel  on the Scattergram  Setup dialog to close it, then click 
Cancel  to close the Scattergram  dialog.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  window to close it.

Only the ER Mapper main menu should be open on the screen.

• View image data values in text format

• View image data values in multiple bands as a signature

• View image data values in multiple bands along a profile line

• View two bands of image data values as a scattergram

• Highlight image areas that correspond to scattergram point clusters

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Using spatial
filters

This chapter explains how to modify raster image data using spatial filtering t
highlight structural features, suppress gridding artifacts or noise, and perform 
enhancements to improve visual interpretation. It introduces concepts associ
with spatial filtering and gives you practice using ER Mapper’s Filter options. 

Note: For information on frequency domain filtering (Fourier Transforms), see the 
ER Mapper User Guide.

About spatial filtering
Spatial filtering is a common operation applied to raster image data to enhanc
suppress spatial detail to improve visual interpretation. Common examples inc
applying filters to enhance edge detail in images, or to remove or decrease n
patterns or gridding artifacts in an image. Spatial filtering is called a “local 
operation” in image processing because it modifies the value of each pixel in 
dataset according to the values of the pixels surrounding it. Filters work by 
removing certain spectral or spatial frequencies to enhance features in the 
remaining image. 
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Spatial frequency 
A characteristic common to all types of raster data is spatial frequency, which 
defines the magnitude of changes in data values per unit distance for any part
part of an image. Areas of an image with small changes or gradual transition
data values over a given area are termed low frequency areas (such as a smooth 
lake surface). Areas with large changes or rapid transitions are termed high 
frequency areas (such as an urban area with dense road networks). Spatial filt
can be divided into three broad categories: 

• Low pass filters emphasize low frequency detail to smooth out image noise o
reduce spikes or gridding artifacts in the data. Since they de-emphasize detai
image, low pass filters are sometimes called smoothing or averaging filters.

• High pass filters emphasize high frequency detail to enhance or sharpen linea
features like faults. High pass filters are sometimes called sharpening filters be
they are generally used to enhance detail without affecting low frequency por
of the image.

• Edge detection filters emphasize edges surrounding objects or features in an im
to make them easier to analyze, for example faults. Edge detection filters usu
create an image with a grey background and black and white lines surroundin
edges of objects and features in the image.

How convolution filters work 
Spatial filtering is accomplished by passing a two-dimensional rectangular arr
(or window) containing weighting values over the image data at each pixel 
location. The pixel in the center of the window is evaluated according to the 
surrounding pixels and weighting values defined for each cell in the array, the
new output pixel value is calculated. The window then shifts over to the next p
and performs the same operation. This process of evaluating the weighted 
neighboring pixel values is called two-dimensional convolution, and the filter a
is often called a convolution kernel.

The Edit Filter buttons
By default, each raster layer in ER Mapper has two Edit Filter (Kernel) buttons 
in the algorithm process diagram. One lets you apply a filter before a formula (pre- 
formula), and the other after a formula (post-formula). You can also insert 
additional filters in either location to create sequential filtering operations. 

post-formula filterpre-formula filter
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The Filter editor dialog box
To add a filter into the process stream, or create a new filter, click on the desi
Edit Filter (Kernel) button to open the Filter  dialog box. ER Mapper provides a
wide variety of standard spatial filters, including low and high pass filters, 
directional edge enhancement filters, and special filters for classification 
smoothing and for geophysical and seismic data. 

ER Mapper also lets you use filters that are written in C code, and provides se
C filters as examples. Using C allows you implement more complex or specia
filtering techniques that are not possible with simple convolution kernels. The
no limit to the dimensions of filters that can be defined and used in ER Mappe

Hands-on exercises
These exercises give you practice applying filters in ER Mapper, and explain 
to insert and delete filters in the process stream using the Filter buttons. You 
try various types of filters to evaluate their results. 

• Insert and delete filters in the algorithm process diagram

• Apply different types of common filters interactively to see their results

• Edit the transform to enhance the contrast of filtered images

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Make sure all image ER Mapper image windows and dialog boxes are closed
Only the main ER Mapper menu should be open.

click to view
previous or next
filter in current
layer

load and save
filters
add or delete
filters in layer

click to view
filters in other
layers

array of filter
weight values
(can be edited)
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1: Applying low pass (smoothing) filters

Open and display the seismic dip algorithm

1 Click the Open  button on the main menu. 

An image window and the Open file chooser open.

2 From the Directories  menu, select the path ending with the text 
\examples .

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory open the algorithm 
’Seismic_Horizon_Realtime_Sun_Shade.alg.’

ER Mapper displays the sample seismic horizon dataset processed to show t
seismic two-way time surface illuminated from the northwest.

4 Drag the image window by its lower-right corner to make it about 50% 
larger.

5 Right_click over the image and select Zoom to All Datasets  from the 
Quick Zoom  menu.

Apply a 3x3 low pass (smoothing) filter to the image

1 On the main menu, click the Edit Algorithm  button.

The Algorithm  dialog opens.

2 In the algorithm process diagram, click the post-formula Edit Filter 

(Kernel)  button.

The Filter  dialog box appears. This dialog allows you to load standard filters 
supplied with ER Mapper, and create and save your own filters.

3 From the File  menu (on the Filter  dialog), select Load... . 

The Load filter  file chooser dialog box opens.

Objectives Learn to how to insert and delete a filter in the algorithm process stream.

click to load post-formula filter
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4 From the Directories  menu, select the path ending with the text \kernel .

5 Double-click on the ‘filters_lowpass’ directory to open it.

6 Double-click on the filter ’avg3.ker’ to load it.

The filter settings are displayed in the dialog box fields. The array (or matrix) 
nine weighting values defining the 3 by 3 filter appear in the central scroll wind
(the “filter matrix window”).

Note: After you load a filter, notice that the icon for the Edit Filter (Kernel)  button in 

the process diagram changes to  . This indicates that a filter is currently b

used in that part of the algorithm.

The low pass filter creates a blurring or averaging effect. In general, low pass
filters work by taking the average value of all pixels in the matrix and assignin
to the center pixel, thus smoothing out jumps or spikes in the data. Low pass f
can be useful for reducing periodic noise or gridding artifacts to make it easie
interpret the major features in the image.

Replace the 3x3 filter with a 5x5 smoothing filter
You can easily experiment with new filters simply by loading a different filter to
replace the current one.

1 On the Filter  dialog, click the  button next to Filter filename .

The Load filter  file chooser dialog box appears. (This is the same as selectin
Load  from the File  menu.)

2 Double-click on the filter ’avg5.ker’ to load it.

The new filter settings are displayed in the dialog box fields. This filter has a 
matrix of 15 weighting values shown in the filter matrix window. (You use the 
scroll bars to view the matrix cells currently not displayed.)

The smoothing effect is stronger this time. In general, the larger the filter mat
the stronger the effect of the filter.

Replace the 5x5 with a horizontal smoothing filter

1 Click the  button next to Filter filename .

2 Double-click on the filter ’avg_hor.ker’ to load it.

The filter settings are displayed in the dialog box fields. This is a 3x3 filter wit
even weighting values, so it only averages pixels in the horizontal direction.
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Features occurring in the horizontal direction are smoothed, while vertical fea
remain unchanged for the most part. Horizontal, vertical, and diagonal smoot
filters can be useful for reducing gridding artifacts occurring in specific directio

Tip: The filter array fields are editable, so you can easily experiment and create yo
own filters with custom weighting coefficients and parameters and save them
later use.

Replace the horizontal filter with a 3x3 median filter

1 Click the  button next to Filter filename .

2 From the Directories  menu, select the \kernel  path.

3 Double-click on the ‘usercode’ directory to open it.

4 Double-click on the filter ’median.ker’ to load it.

Notice that this filter is coded as a C program, so an array of weighting values
not appear. Filters that work in more complex ways are usually coded in C, an
you can add your own filters in this way too.

High frequency or noisy features are again suppressed in the image. Median 
work by assigning the center pixel the median value of all pixels within the arr
(3x3 in this case). They are often used on seismic data because they are ver
effective for reducing noise without the “blurring” effects of simpler averaging 
filters you applied earlier.

Delete the median filter from the process stream
1 From the Edit menu (on the Filter  dialog), select Delete this filter . 

The contents of the Filter  dialog clear and the filter is deleted from the process

diagram (shown by the  icon).

The image is rendered without the averaging filter, so it appears as it did origin
As you can see, experimenting with various filtering techniques is simply a m
of loading or deleting filters from the process diagram.

2 Click Close  on the Filter  dialog to close it.

Tip: You can also load filters before a formula (using the pre-formula filter button in
process diagram), and apply a sequence of filters in a row.
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2: Applying edge detection filters

Open and display the pseudocolor horizon algorithm

1 Click the Open  button on the main menu. 

2 From the Directories  menu, select the \examples  path.

3 In the directory ‘Applications\Oil_And_Gas_Exploration’ load the algorithm 
’Seismic_Horizon.alg.’

ER Mapper displays the sample seismic horizon dataset (the two-way time da
a simple pseudocolor image. (This is similar to the algorithm you made earlie

4 Click on the Intensity layer in the data structure diagram to select it, then 

click the Cut  button above it. (You do not need it for this exercise).

Change the color table to greyscale
1 On the Algorithm dialog, click the Surface  tab.

2 Select greyscale  from the Color Table  drop-down menu.

ER Mapper displays the image in greyscale. (This is recommended when app
edge detection filters.)

Apply a northerly dip edge detection filter
1 On the Algorithm dialog, click the Layer tab.

2 Click the post-formula Edit Filter (Kernel)  button in the process 
diagram. 

The Filter  dialog box opens.

3 Click the  button next to Filter filename .

4 From the Directories  menu, select the \kernel  path.

5 Double-click on the ‘filters_seismic’ directory to open it.

6 Double-click on the filter ’Northerly_dip.ker’ to load it.

Objectives Learn to apply filters to detect edge features in an image, and to adjust the 
transform to account for the effects of the filter.
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The image initially appears white–this is expected because the effects of the 
have changed the data range, so you need to adjust the transform (color map
to restore the contrast. (This was not needed for the low pass filters you appl
previously because they only slightly altered the original data range.)

Adjust the contrast of the filtered image
1 On the Algorithm  dialog, click the post-formula Edit Transform Limits 

 button in the process diagram.

Note the Actual Input Limits are about -56 to +26. This is the new data range
created by applying the edge detection filter to the original seismic two-way ti
data.

2 On the Transform  dialog, select Limits to Actual  from the Limits  menu. 

The X axis limits change to match the Actual Input Limits.

The image contrast is enhanced and most pixels are assigned a mid-grey col
the greyscale lookup table. Notice that the histogram shows that most data va
are grouped in the center (so they are mapped to a mid-gray shade), with a f
outlying data values (representing the edge features or faults) mapped to bla
white.

3 On the Transform  dialog, click the Create autoclip transform  button. 

ER Mapper redisplays the image with enhanced contrast. This filter highlights
northerly dipping surfaces, where strong northerly dip is shown as dark greys
strong southerly dip as light greys. Surfaces with no strong dip are shown as 
level greys. Edge detection filters are often used in geophysical applications t
highlight faults and lineaments occurring in a specific compass direction.

4 Click Close  on the Transform  dialog to close it.

Note: As shown here, applying filters to your data often produces a different data ra
which initially creates a low contrast image. For many filters, you will common
need to adjust the transforms for each layer after applying a filter.

click to open post-formula Transform
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Apply an easterly dip edge detection filter

1 On the Filter  dialog, click the  button next to Filter filename .

2 Double-click on the filter ’Easterly_dip.ker’ to load it.

This time easterly dipping surfaces are highlighted in dark grey, and westerly
dipping surfaces in light greys. This filter provides a better enhancement of fa
in this time surface than the northerly dip filter because most of the faults occ
a north-south direction.

Note: Since the data range produced by applying the Easterly_dip filter is similar to
produced by Northerly_dip, you do not need to adjust the transform.

3: Applying filters in sequence

Notice that the easterly dip filtering operation has created some minor “salt a
pepper” noise in the image. You can add a second filter to help smooth the no

Append a second filter to follow the first one
1 From the Edit menu (on the Filter  dialog), select Append new filter . 

Notice that a second filter button has been added to process diagram. (This i
adding a placeholder for a new filter.) When you append a new filter, a “defau
kernel” is loaded which has no filtering effect (shown in the Filter  dialog).

Load a median filter to follow the easterly dip filter

1 Click the  button next to Filter filename .

2 From the Directories  menu, select the \kernel  path.

3 Double-click on the ‘usercode’ directory to open it.

Objectives Learn to append and insert filters to apply a sequence of filtering operations t
dataset, and to move between filters in the process diagram.

appended filter icon in process diagram
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4 Double-click on the filter ’median.ker’ to load it.

A noise reduction effect is applied to the image produced by the easterly dip f
The median filter suppresses “salt and pepper” noise patterns without blurring
subtle structural details.

Move between filters in the process diagram
On the Filters  dialog, note the two arrow buttons near the lower-right corner. 
These buttons let you easily move to view or edit the contents of any filter in t
current algorithm layer. 

1 On the Filters dialog, click the Move to previous Filter in layer  
button. 

ER Mapper moves one filter to the left in the process diagram, so the Filter  dialog 
contents show the easterly dip filter.

2 Click the Move to previous Filter in layer  button again.

ER Mapper again moves one filter to the left, so it now displays the contents o
per-formula filter (empty since no filter is loaded in that position).

3 Click on the three Edit Filter (Kernel)  icons in the process diagram one by 
one. 

The contents of the Filter  dialog update each time to show the filter loaded in th
position in the diagram. 

Tip: As shown, you can move between filters either by clicking icons in the proces

diagram, or by using the Previous   and Next   buttons in the Filter  

dialog.

click on any filter icon in process 
diagram to see contents in Filter  dialog
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Delete the median filter from the process diagram
1 Click on the second post-formula filter icon again. 

The contents of the median filter are displayed in the Filter  dialog.

2 From the Edit menu (on the Filter dialog), select Delete this filter . 

The median filter is deleted from the process diagram, and its button is remov
from the process diagram. ER Mapper automatically moves to the previous filt
the diagram (the easterly dip filter).

3 Click Close  on the Filter  dialog to close it.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  window to close it.

Only the ER Mapper main menu should be open on the screen.

• Insert and delete filters in the process stream diagram

• Apply different types of filters interactively to see their results

• Edit the transform to enhance the contrast of filtered images

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:

click to view second post-formula filter
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Using formulas
This chapter explains how to use formula processing in ER Mapper to perform
mathematical operations on raster datasets. You learn how to create and edit
formulas, and use the standard formulas and functions provided in ER Mappe

About formula processing
Formulas are commonly used in image processing of seismic data to highligh
certain ranges of data, create derivative images such as azimuth or isochrons
other tasks. Formula processing can range from simple subtraction or thresho
of data to complex spatial modelling and “if-then-else” condition testing. 

Formula processing is a “point operation” in image processing because it app
mathematical function to each pixel in the dataset. Common uses of formulas
seismic image processing include:

• data corrections, such as for polarity of data as shown in earlier chapters;

• transforming and/or combining raw datasets to create derivative images such a
azimuth, isochrons, isopachs, and so on;

• overlaying thematic data, such as highlighting a specific data range or attribu
color over a backdrop image;

• isolating specific data ranges or geographic areas of interest using threshold
region (polygon) masking, and other functions;
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Formula processing in ER Mapper
Many common types of data transformations can be implemented in ER Map
using formula processing. Since formulas are part of the algorithm processing
stream, you can see the results in real time, and interactively modify the formu
quickly fine tune it.

ER Mapper provides a complete set of standard operators and functions you 
reference in formula processing. You can also use dataset statistics, special 
functions, and functions defined with your own C or Fortran user code. See th
relevant sections and chapters in the ER Mapper User Guide for complete 
information.

The Formula Editor dialog box
When you click on the Edit Formula  button in the process stream diagram, 
ER Mapper opens the Formula Editor  dialog box. This dialog lets you create, 
edit, load, and save formulas, and it has the following components:

Tip: For any algorithm, you can open the Formula Editor dialog box from two places: 
using the Formula  buttons in the process diagram on the Algorithm  dialog, or 
using the Edit Formula  toolbar button on the main menu.

Generic formula
(type in text or

Relations area
(assign inputs to
bands, regions
to names, etc.)

Specific formula
(shows complete
formula to be
processed)

click to view
formulas for
other layers

load and save
formulas

reset formula or
change dialog
design

click to view or
add comments

menu bar to load
standard formulas

load from file)
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The formula relations concept
The key concept of relations is a very powerful feature that makes ER Mapper’s
formula processing very flexible and interactive. When you enter or load a gen
formula, you may include one or more generic specifications that refer to any
arbitrary dataset band, region polygon, dataset filename, or variable. You the
the Relations window to choose relations between actual dataset band numb
region names, etc. and the generic specifications in the formula. The actual 
assignment of references to dataset bands, region names, and so on is then 
in the Specific formula window. 

There are four types of generic specifications (where “n” is an integer value):

Formula inputs are also shown graphically in the algorithm process diagram. 
example, the following process stream shows that two inputs are being used 
formula, and that they are both assigned to dataset band 1. As indicated, eac
can be modified using filters and transforms before being piped through the 
formula processing. 

To select the specific bands to be used in a formula, you can either use the Band 
Selection  drop-down list in the process diagram, or select bands inside the 
Relations window of the Formula Editor dialog box.

Reference Notation in generic formula Function

Input 
specifications

INPUTn, In (or lowercase) References any band in a
dataset.

Region 
specifications

REGIONn, Rn (or lowercase) References any region 
polygon defined for a 
raster dataset.

Dataset 
specifications

DATASETn, Dn (or lowercase) References any raster 
dataset (an actual disk 
file with “.ers” 
extension).

Variable 
specifications

VARIABLEn, or any text not 
reserved for ER Mapper 
functions (for example “density” 
or “threshold”)

References any real 
number or value to be 
used as an equation 
variable.
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Hands-on exercises
These exercises introduce you to the basic features of the Formula  Editor dialog 
box and procedures for creating and implementing simple formulas.

• Type and edit a formula, and test formula syntax

• Use generic references for inputs, variables, and regions in a formula

• Assign dataset bands, variables, and region names to generic references

• Create a thematic color overlay and specify transparency between surfaces

• Draw polygons to define regions of interest in an image

• Use formulas to process areas of interest (regions) in a dataset

• View formulas to generate dip and azimuth images

1: Entering and testing a formula

Load a Pseudocolor algorithm with the default formula

1 Click the Edit Algorithm  button on the main menu.

An image window and the Algorithm  dialog box appear.

2 Click the Open  button on the main menu. 

3 From the Directories  menu, select the \examples  path.

4 Double-click on the directory ‘Data_Types’ to open it.

5 Double-click on the directory ‘Magnetics_And_Radiometrics’ to open it.

6 Double-click on the algorithm named ‘Magnetics_Pseudocolor.alg.’

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to enter simple formulas and test formula syntax.
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The algorithm displays an image of airborne magnetics data acquired over 
northeastern Australia. The data represents the strength of the magnetic field
this area of the earth's surface, and is scaled to a data range of 0-255. Using
Pseudocolor lookup table, blues correspond to lower field strengths and yello
and reds to higher field strengths.

Enter a simple formula and test for syntax errors

1 On the Algorithm  dialog, click the Edit Formula  button in the process 
diagram.

The Formula Editor dialog box opens. Note that the generic formula window 
contains the text “I1,” and that I1 (Input 1) is assigned to dataset band 1 in th
Relations window.

2 Edit the formula text to read as follows (this purposely has an error):

input1 - input3

3 Click the Apply changes  button to test the formula.

ER Mapper issues an error message warning that the formula has a syntax e
(In this case you tried to subtract an input number that was out of sequence; 
must also have an “input2” before using an “input3.” 

click to open Formula Editor  dialog

edit formula in Generic
formula window
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Note: The Apply changes  button automatically tests for syntax errors in the Generi
formula. You must make any corrections before continuing.

Revise the formula to subtract a value
1 In the Generic formula window, edit the formula text to read:

input1 - 100

(This subtracts 100 from each pixel in the dataset band assigned to input1.)

2 Click the Apply changes  button to test the formula.

The formula syntax is approved, and ER Mapper translates the generic formu
into a specific formula (displayed in the lower window).

Delete the formula and test the syntax
1 In the Generic formula window, edit the formula to remove all text (select 

the existing text and press the Backspace or Delete key on your keyboard).

2 Click the Apply changes  button to test the formula.

ER Mapper issues an error message regarding the formula syntax.

Caution: ER Mapper considers no formula at all an error in syntax. At a minimum, the 
Generic formula window must always contain the text “I1” or “input1” to speci
at least one input dataset band to be processed.

3 In the Generic formula window, edit the formula text to read:

input1

4 Click the Apply changes  button to test the formula.

ER Mapper accepts the formula.

Tip: Under the Formula Editor dialog’s Edit  menu, you can select Clear  to clear all 
text from the Generic formula window, or select Default  the restore the default 
formula ‘INPUT1.’

5 Click Close  on the Formula Editor  dialog to close it.
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2: Creating a threshold formula

Open the sample sun shade algorithm

1 On the main menu, click the Open  button.

The Open dialog box appears.

2 From the Directories  menu, select the \examples  path.

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_Realtime_Sun_Shade.alg’ to open and 
display it.

This algorithm displays the sun shaded two-way time data to enhance structu
features.

Enter a simple threshold formula

1 On the Algorithm  dialog, click the Edit Formula  button in the process 
diagram. 

The Formula Editor dialog box opens.

2 In the Generic formula window, edit the formula text to read:

if -input1 > -2030 then -input1 else null

This formula ER Mapper “if the (inverted) two-way time value is greater than 
negative 2030, then process it, else assign it a value of null.” (Any dataset pix
assigned a value of null is excluded from further processing and does not app
the final image.)

3 Click the Apply changes  button to verify the formula syntax and process 
the algorithm.

Only areas of the image with data values greater than -2030 (structural highs
displayed, while data values less than -2030 display with no color (they appe
black).

4 Click the post-formula Edit Transform Limits  button in the process 
diagram.

Objectives Learn how to enter a simple threshold formula and use boolean “if-then-else”
logic in a formula. Also learn about null dataset values, and how to use a varia
in a formula.
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In the Transform  dialog, the Actual Input Limits range is -2030 to -1916. This
expected since data values greater than -2030 are set to null (no value) by th
formula and are thus excluded from further processing. The shape of the histo
also reflects the clipping of the data at the -2030 level.

5 Click Close  on the Transform  dialog to close it.

Substitute a variable for the value -2030
1 In the Generic formula window, edit the formula text to substitute the word 

“variable1” for the value -2030. Your formula should read:

if -input1 > variable1 then -input1 else null

Your formula now includes a variable that you can set in the Relations  window.

2 Click the Apply changes  button.

Two things change: the Variables  button above the Relations window becomes
active, and the value of “variable1” becomes zero in the Specific formula wind

3 Click the Variables  option button in the Relations window.

The Relations  window shows that the value of “variable1” is set to zero.

4 Edit the value of “variable1” text field to read -1970 then press the Return 
or Enter key on your keyboard to validate your text.

This time only areas with time values greater than -1970 are displayed.

5 Change the value of “variable1” to -2050 , then press Return or Enter 
again to view the new threshold image.

click Variables
option button

current value of
variable, edit to
set a new value
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As you can see, using references to variables in your formula (instead of actu
values) can speed experimentation. (This becomes more apparent when you
the same variable several times in a formula.)

Tip: You can have several different variables in a formula, and name them nearly 
word without spaces (for example threshold or my_value). Be sure the names do 
not conflict with text strings ER Mapper uses for standard functions (such as 
“input1” or “region1”).

Load a standard formula from the ER Mapper library
1 From the File menu (on the Formula Editor  dialog), select Open... .

The Open Formula  dialog box appears listing directories of standard formula
supplied with ER Mapper.

2 From the Directories  menu, select the \formula  path.

3 Double-click on the formula directory named ‘standard’ to open it.

A list of standard formulas for many different image processing functions disp

4 Double-click on the formula ‘invert.frm’ to load it.

The invert formula (-INPUT1) replaces your threshold formula. (You could jus
easily have edited the threshold formula text, but this shows you how to load 
formula from ER Mapper’s formula library.)

Tip: You can also load many standard formulas using the menu bar at the top of t
Formula Editor  dialog. To create your own formula, type it in, then use File/
Save As  to save it to one of the ER Mapper formula directories.

5 Click Close  on the Formula Editor  dialog to close it
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3: Creating a thematic color overlay

Note: The following technique shows you how to manually define an overlay similar
the one you created earlier using scattergrams.

Add a Classification layer and load the sample dataset
1 Open the Algorithm  dialog’s Edit  menu, choose Add Raster Layer , then 

choose Classification .

A Classification layer is added to the algorithm layer list on the left.

2 Click the Load a dataset  button in the process diagram for the new 
layer to open the file chooser dialog. 

3 From the Directories  menu, select the \examples  path.

4 In the directory named ‘Applications\Oil_And_Gas_Exploration’ load the 
dataset named ‘Seismic3D.ers’ .

This is the same dataset loaded in the Pseudocolor layer of the algorithm. Yo
use a formula to define a threshold of amplitude values and display the result
color overlay.

Define a formula to highlight a specific amplitude range

1 With the Classification layer selected, click the Edit Formula  button in 
the process diagram to open the Formula Editor dialog box.

2 In the Generic  formula window, edit the formula text to read:

if input1 > 18000 then 1 else null

This formula tells ER Mapper “if the image data values in the selected band a
greater than 18000, then set the value to 1, else set it to null.”

3 Click the Apply changes  button to validate the formula.

Objectives Learn how to add a Classification layer to an algorithm, and use a formula to 
highlight a specific range of values in a dataset as a color overlay. Also learn 
put the layer into it’s own surface in the algorithm, so you can change the 
transparency of the overlay color.
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4 In the Relations window, select B2:Amplitude from the INPUT1 drop-down 
list.

The threshold formula now references band 2 of the seismic dataset (which 
contains the event amplitude data). This tells ER Mapper to apply the formula
the values in the Amplitude band.

5 Click Close  on the Formula Editor  dialog to close it.

Choose a layer color and name and display the image

1 In the process diagram, click the Edit Layer Color  button.

2 Choose a red color, then click OK to close the Color chooser dialog.

3 In the data structure diagram on the left, change the Classification layer’s 
text label to high amplitudes .

The areas exceeding amplitude values of 18000 are highlighted in a red mas
(areas where band 2 values meet the criteria of being greater than 18000). O
areas that do not meet that criteria are assigned the value null by the formula
the shaded greyscale image created by the Pseudocolor layer “shows throug
red mask in those areas.

open INPUT1 list and
select B2:Amplitude

click to choose color for Classification layer
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4 If desired, edit the formula to try other values between 12000  and 18000 , 
then click Apply changes  to see the results.

5 Edit the formula value to 11000 , then click Apply changes .

if input1 > 11000 then 1 else null

Amplitudes above 11000 cover much of the image. Making the color transluc
would aid interpretation by showing structures underneath. The following is on
several ways to do this.

6 Click Close  on the Formula Editor  dialog to close it.

Split the two layers into separate surfaces
By splitting the two layers into separate surfaces, you can set transparency 
between the grayscale image and the color overlay image. The following is o
way to accomplish this.

1 Select the surface icon in the data structure diagram, then click the 

Duplicate   button.

A copy of the surface is added to data structure diagram. The idea here is to 
two separate surfaces–one to contain only the color overlay (Classification la
and another to contain only the shaded greyscale image (Pseudo layer).

2 Select the ‘Shading’ layer in top surface and click the Cut  button, then 
select the ‘high amplitudes’ layer in the bottom surface and cut it also.

select surface, then click
Duplicate  button

select layer first,

select, then Cut

then Cut
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Your data structure diagram should now look like this:

3 Click GO –the image should not change if your layers are set up 
correctly.

Set transparency for the color overlay
1 Select the ‘high amplitudes’ layer in the data structure diagram.

2 Select the Surfaces  tab on the Algorithm dialog.

3 Move the Transparency  slide bar right to its mid-point.

The red color over becomes partially transparent, so the underlying structure o
shaded time horizon shows through.

4 Try other Transparency  settings to see their effect. A zero setting makes 
the red color opaque, and a 100 setting makes it invisible.

Note: If you use this technique, it is best that the surface containing the Classificatio
layer be above the surface containing the shaded Pseudocolor layer in the da
structure diagram. If you moved the lower surface up, you would be setting 
transparency of the greyscale image to see the color underneath. The transp
feature is also very useful when viewing multiple surface in 3D (as you will se
later). The “colordrape” techniques you used earlier are another way to comb
color and structure images.

Notes about Classification layers
The previous example was very simple example of using Classification layers
you may find it easier to use a scattergram to accomplish thresholding tasks 
this. You may add additional Classification layers to display overlays in other 
colors. You can use more complex conditional tests involving many data laye
attributes, or other tests for a wide range of modelling tasks.

If you have more than one Classification layer in a surface, the layer on top h
display priority over others below them. For example, if two Classification laye
would cover overlapping areas, the color of the layer on top covers the color i
layer below it where the two overlap. The color of the lower layer is only visib
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where there is no overlap. Classification layers always have a solid, opaque c
unless you use the technique described previously to divide the image into se
surfaces so you can change the transparency.

4: Creating a polygon mask

Note: To complete this exercise, you must use a practice copy of the “Seismic3D.er
dataset to which you have read/write access. This practice file is assumed to
named “Seismic_practice.ers” residing in the ‘tutorial’ directory. See Appendix
in this workbook for information on setting up the practice dataset.

Re-open the sample sun shade algorithm

1 On the main menu, click the Open  button.

2 From the Directories  menu (on the Open  dialog), select the \examples  
path.

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_Realtime_Sun_Shade.alg’ to open and 
display it.

This is the same sun shading algorithm you started with previously.

Load the practice dataset into the current algorithm
1 In the Algorithm  dialog, click the Layers  tab.

2 Click the Load a Dataset   button in the process diagram.

3 From the Directories  menu, select the path ending with \examples . 

4 Double-click on the ‘miscellaneous\tutorial’ directory to open it.

5 Double-click on the dataset named ‘Seismic_practice.ers’ to load it.

The practice dataset is loaded into the Pseudocolor layer. 

The image appears unchanged because the dataset you loaded is an exact c
the previous one. (You need to use you own copy of the dataset for the next s
you don’t conflict with other users.)

Objectives Learn how to create a polygon defining an area of interest in a dataset (a 
“region”), and to use ER Mapper’s “inregion” function in a formula to reference
region for masking purposes.
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6 Drag the image window by the lower-right corner to make it about 50% 
larger.

7 Right-click on the image and select Zoom to All Datasets  from the Quick 
Zoom  menu.

Next you will draw a polygon on the image to define a region of interest.

Add a vector layer for region definition to your algorithm
1 From the Edit menu, select Edit/Create Regions... . 

The New Map Composition dialog box opens.

2 In the New Map Composition  dialog, make sure the Raster Region 
option is selected.

The Raster Region  option tells ER Mapper that the annotation tools will be us
to create regions for a raster dataset (to define an area of interest in this case

3 Click OK on the New Map Composition  dialog.

ER Mapper opens the Tools  palette dialog box. Also notice that a vector layer 
titled ‘Region Layer’ has been added to the layer list in the Algorithm  dialog.

Draw and name a polygon to define a region of interest

1 On the Tools  palette dialog, click the Polygon   button.

Find a large feature of interest in the image, such as the V-shaped fault block

2 Point to the area of interest and draw a polygon around it by clicking once 
at each point, then double-clicking to close the polygon. (Make your 
polygon fairly large.)

The polygon is selected by default when you close it (it has selection handles
each node). 

3 Double-click the Polygon   button, choose a red color in the Line Style  
dialog, then click Close .

The polygon now displays in red on the image.

4 On the Tools dialog, click the Display/Edit Object Attributes  button 
to open the Map Composition Attribute  dialog box.
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5 In the Object Attribute  dialog, enter a name for the region in the text field 
at the bottom. Use your initials at the beginning and separate each word 
with an underscore (_). 

6 Click Apply  to apply the name to the region polygon.

Your name is assigned to the region in the upper part of the dialog.

Define a second region of interest

1 On the Tools  palette dialog, click on the Polygon   button.

2 Draw a polygon around the second feature in the image by clicking once at 
each point, then double-clicking to close the polygon. 

The second polygon is selected by default when you close it.

3 In the Map Composition Attribute  dialog, enter a name for the second 
region in the lower part of the dialog.

4 Click Apply  to apply the name to the region polygon.

5 Click Close  on the Map Composition Attribute  dialog to close it.

The two region polygons you drew now have a text attribute assigned so you 
refer to them by name.

Save the two regions in the practice dataset

1 On the Tools  palette dialog, click the Save file  button.

A dialog asks if you wish to proceed with the overwrite of the practice dataset

1 - type a region name

2 - then click Apply
144 ER Mapper Workbook -  Seismic Geophysics Applications



Chapter 8#Using formulas#z 4: Creating a polygon mask

have 

f the 
 

to 

 used 

s 
2 Click OK to overwrite the practice dataset.

ER Mapper displays a message dialog showing that the regions you defined 
been added to the practice dataset.

Note: The definition of a region (its polygon and name) is saved in the header file o
dataset. When you save it, the header file is overwritten to add the new region
information. (The raster data file itself is not changed.)

3 Click Close  on the ER Mapper Message dialog to close it.

4 Click Close  on the Tools  palette dialog to close it.

You have now defined two named regions of interest, and can use a formula 
display or process them separately from other portions of the dataset.

Turn off the Region Layer
Notice that when you closed the Tools  dialog, the regions you drew are 
redisplayed along with the names next to them. The Region layer type can be
to display and edit the regions and region names defined in a dataset.

1 Right-click the layer labelled ‘Region Layer (Outline)’ and select Turn Off .

Enter a formula using the “inregion” function
1 Select the Pseudo layer labelled ‘Shading’ in the layer list.

2 In the process diagram, click the Edit Formula   button. 

3 In the Generic formula window, edit the formula text to read:

if inregion(region1) then -input1 else null

This formula tells ER Mapper “if the area of the image is within the boundarie
defined by region1, then process it, else assign it null.”

4 Click the Apply changes  button to verify the formula syntax.

The generic formula is converted to a specific formula. Also notice that the 
Regions button above the Relations window is now active.
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Assign the “region1” argument to a region name
1 Above the Relations window, select the Regions  option, then select one of 

your region names from the REGION1 list.

You have now selected your region name to be assigned to the “region1” argu
in the generic formula.

Note: Every dataset has a default region named All which is simply the extents of th
entire image.

Only the area inside the region name you selected is processed, and all othe
of the image are assigned null values (so they appear black). By using the inr
function in your formula, you have created a “mask” to process only data with
certain geographic part of the image. 

Display the second region you defined
1 From the REGION1 drop-down list, select your second region name.

Only the area inside your second region is processed, and all other areas of 
image are assigned null values (so they appear black). By using the drop-dow
you can easily change this formula to reference any region defined in a datas

Modify the formula to display areas outside your region
1 In the Generic formula window, edit the formula text to read as follows (add 

“not” before “inregion”):

select Regions  option

select a region name
from REGION1 list
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if not inregion(region1) then -input1 else null

This formula tells ER Mapper “if the area of the image is not within the boundaries 
defined by region1, then process it, else assign it null.”

2 Click the Apply changes  button to verify the formula syntax and process 
the image.

Only the area outside the region you defined is processed and displayed. You
inverted the region mask to process only data outside the region.

Revise the formula to display areas inside both regions
1 In the Generic formula window, edit the formula text to read as follows:

if inregion(r1) or inregion(r2) then -input1 else null

This formula uses two separate inregion statements that refer to two different
generic regions. (Note that you can use “r2” as shorthand for “region2” as sho

2 Click the Apply changes  button to verify the formula syntax.

The Relations window now shows drop-down lists for two regions–REGION1 
REGION2.

3 Select one of your regions from the REGION1 list, and select the other 
from the REGION2 list.

Only the areas inside the two regions you defined appear in the image.

4 Click Close  on the Formula Editor  dialog to close it.

5: Using more complex formulas

Load the sample algorithm that generates a dip image

1 Click Open  on the main menu. 

2 From the Directories  menu, select the path ending with the text 
\examples .

3 Open the ‘Applications\Oil_And_Gas_Exploration’ directory then double-
click on the algorithm named ‘Seismic_Horizon_Dip.alg’ to open it.

Objectives View algorithms used to create dip and azimuth images, to see how filters an
formulas can be combined to create more complex derivative images.
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Dip images (or dip attributes) highlight the major structural trends in a two-wa
time surface. The dip is the amount of inclination in the horizon surface. This 
algorithm uses a greyscale color table, so areas with strong dips (steep slope
appear in darker greys. (Shaded time images with the sun positioned directly
overhead create images with similar characteristics in ER Mapper, such as in
sample ‘Seismic_Horizon_Realtime_Sun_Shade’ algorithm.)

Examine the filters used to generate the dip image
Notice that this algorithm has two inputs in the process stream diagram leadi
into the formula. Both process the two-way time data (band 1) and each inpu
stream has a pre-formula filter applied.

1 Click on the uppermost of the two pre-formula Edit  Filter (Kernel)  
buttons.

The Filter  dialog shows that the first input has an Easterly dip filter applied to 

2 Click on the lower of the two pre-formula Edit  Filter (Kernel)  buttons.

The Filter  dialog changes to show the contents of that filter, a Northerly dip fil

3 Click Close  on the Filter  dialog to close it.

Examine the formula used to process the two inputs

1 In the process diagram, click the Edit Formula   button. 

click to view upper pre-formula filter
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This formula operates on two inputs–values produced by the easterly dip filte
(INPUT1) and northerly dip filter (INPUT2). It then combines them to create a
true dip image. For each “input” number statement in your formula, you creat
pre-formula input stream in the process diagram

Dip images are useful for highlighting features such as the strike of faults, an
you view both sides of a fault. Dip images are sometimes used in an Intensity 
in colordrape algorithms in place of sun shaded two-way time.

Load the sample algorithm that generates an azimuth image

1 Click the Open  main menu button. 

2 Double-click on the algorithm ‘Seismic_Horizon_Azimuth.alg.’ to open it.

This image is displayed with the special ‘azimuth’ color table that has four co
(blue, yellow, white and black). Each color highlights a direction of inclination
the time surface from a local reference direction (north in this case). Azimuth
images (or azimuth attributes) highlight the major structural relationships in a 
way time surface.

Notice that this algorithm also has two inputs in the process stream diagram 
leading into the formula. Both process the two-way time data (band 1) and ap
the same Easterly and Northerly dip filters used to create the dip image.

3 Examine the formula used to process the two inputs.

Like dip, the azimuth formula operates on two inputs (values produced by the
easterly and northerly dip filters), and combines them to create an image with
colors representing the four primary directions of inclination. White shows 
westerly inclination, black easterly, blue northerly, and yellow southerly. In 
particular the interrelationships of faults and direction of throw can be determ

4 Click Close  on the Formula Editor  dialog.

Tip: To generate dip or azimuth images from your own two-way time datasets, sim
load your dataset into the existing algorithm and choose the appropriate two-
time band.

-sqrt(I1 * I1 + I2 * I2) / 200
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  window to close it.

Only the ER Mapper main menu should be open on the screen.

• Type and edit a formula, and test formula syntax

• Use generic references for inputs, variables, and regions in a formula

• Assign dataset bands, variables, and region names to generic references

• Create a thematic color overlay and specify transparency between surfaces

• Draw polygons to define regions of interest in an image

• Use formulas to process areas of interest (regions) in a dataset

• View formulas used to generate dip and azimuth images

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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3-D perspective
viewing

This chapter explains how to view and manipulate images in 3D perspective t
gain a better understanding of terrain features, relationships, and other aspec
your data. ER Mapper lets you quickly change between 2D and 3D views of y
data, stack multiple surfaces in a single view, set transparency between surfa
and many other features.
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About perspective viewing

Viewing images in three-dimensional perspective is a valuable tool that helps
increase understanding of features and relationships in datasets. Many types
earth science datasets can be integrated to create 3D scenes that show featu
anomalies much more clearly than traditional two dimensional views. To crea
3D view, you simply add a Height layer to your 2D algorithm (such as two-wa
time), then change the View Mode to 3D perspective or 3D flythrough.

ER Mapper’s 3D viewing capabilities are extensive and easy to use, including

• view any dataset in 3D, and quickly switch between 2D and 3D views

• use static 3D perspective or real-time “flythrough” modes

• stack multiple surfaces (for example, several time horizons) in a single view

• set transparency between surfaces to view underlying features

• incorporate vector data in 3D, such as interpreted faults or lease boundaries

• generate top quality, high resolution 3D hardcopy prints

Hands-on exercises
These exercises give you practice setting up algorithms for 3D viewing, and 
manipulating the images using the viewing and display controls in ER Mappe
D perspective viewer.

• Prepare an algorithm for 3D viewing by adding a Height layer

• Change the viewpoint, zoom level, and other 3D view parameters

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in
ER Mapper:

Two-dimensional (planimetric) view Three-dimensional perspective view
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• Use the 3D Flythrough viewing mode

• Stack multiple surfaces in a 3D view and set surface offset and transparency

• Merge separate algorithms into surfaces in a single algorithm

1: 3D viewing basics

Open a color two-way time algorithm

1 On the main menu, click the Open  button.

An empty image window and the Open dialog box appear.

2 From the Directories  menu, select the path ending with the text 
\examples .

3 In the ‘miscellaneous\tutorial’ directory, double-click on the algorithm 
‘Horizon_KA_Pseudocolor.alg’ preceded by your initials to open it. (You 
created this algorithm in Chapter 3.)

This algorithm is a simple color display of the inverted time data. Reds corresp
to structural highs, and blues to structural lows.

Duplicate the Pseudo layer to create a Height layer
1 On the Algorithm  dialog, select the layer ‘Inverted TWT,’ then click the 

Duplicate   button.

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen.

Objective Learn to prepare an algorithm for 3D viewing by adding a Height layer that 
contains the desired elevation data. Also learn to use 3D perspective view mo
and control the viewpoint and display parameters of the 3D scene.

select layer, click Duplicate
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ER Mapper makes an exact copy of the layer below the original.

2 Right-click on the duplicate layer, and select Height  from the short-cut 
menu.

The Pseudo layer changes to a Height layer. Your algorithm now contains two
layers (Pseudo and Height), shown in the layer list on the left panel of the 
Algorithm  dialog.

3 If necessary, change the label of the new layer to “Height”.

You have now duplicated the inverted two-way time layer and changed the lay
type to create a elevation component for your algorithm. The layer is currently
crossed out–this indicates that it is not active until you switch to 3D perspecti
View Mode.

Note: You could also use the Edit  menu to add a new Height layer and load the datas
but duplicating and changing is easier because the layer already contains the
desired dataset, band, and invert formula.

Select 3D Perspective mode to view the image in 3D
1 From the ‘View Mode’ menu (on the Algorithm  dialog), select 3D 

Perspective .

ER Mapper displays a message that the image is being processed, then disp
3D perspective view of the image in color. The message “Regenerating Terra
appears in the image window as ER Mapper performs iterations to increase t
resolution (detail) in the 3D image.

Tilt the image forward or backward

1 On the main menu, click the Hand (Roam) Tool  button.

2 Point to lower edge of the time surface image and drag slightly downward.

The image moves into a more overhead view perspective, and regenerates d
when you release the mouse button. 

3 Point to lower edge of the image and drag slightly upward.

The image moves into a flatter, side view perspective. Dragging the image up
down tilts the 3D model forward or backward (rotate it around its X axis).
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Note: If you accidently change the 3D view too much, click the 3D View  tab in the 
Algorithm  dialog, then click the Reset View  button. This resets the the image t
a standard default view.

Rotate the image around its center point
1 Point to lower edge of the image and drag slightly right.

The image rotates to the right around its center point.

2 Point to lower edge of the image and drag slightly left.

The image rotates to the left around its center point. Dragging the image left 
right lets you view it from a side angle (rotate around the Z axis).

Zoom the image in and out
1 Point to the center of the image. Then press right mouse button and drag 

slightly upward.

As you drag, ER Mapper zooms out so the image redraws at a smaller size.

2 Point to the image center again, press right mouse button and drag slightly 
downward.

ER Mapper zooms in so the image redraws at a larger size.

Pressing the right mouse button and dragging up or left zooms the image out
dragging down or right zoom the image in.

3 Set the zoom extents for the image so it fills as much of the window as 
possible.

Rotate the image side to side
1 Point to the center of the image. First depress the left mouse button, then 

the right button (hold down both), then drag slightly to the right.

ER Mapper rotates the image to the right.

2 Point to the image center again, depress the left then the right mouse 
buttons, and drag slightly to the left.

The image rotates left. Pressing the left then the right mouse buttons and draggin
left or right is how you rotate the image side to side (around its Y axis).
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Pan (scroll) the image within the window
1 Point to the center of the image. First depress the right mouse button, then 

the left button (hold down both), then drag slightly upward.

ER Mapper pans (or scrolls) the image upward without changing the perspec

2 Point to the image center again, depress the right then the left mouse 
buttons, and drag around inside the window.

The image repositions as you drag. Panning in 3D is useful when want to 
reposition the image in the window without changing the zoom factor or viewi
perspective.

Summary of 3D movement procedures
• To tilt the image backward or forward, press left mouse button and drag towar

top of the image window (to tilt backward) or bottom (to tilt forward).

• To tilt the image side to side, press left mouse button followed by right mouse
button and drag to the left (to tilt left) or right.

• To the zoom the image in or out, press right mouse button and drag toward th
bottom of the image window (to zoom in) or top (to zoom out).

• To rotate the image around it center axis, press left mouse button and drag th
or right side of the image (or bounding box) toward the edge of the image win

• To move the entire image within the window (without changing size or 
perspective), press right mouse button followed by left mouse button and dra
the desired location in the image window.

Change the color table for the 3D image
1 Select the Surface  tab in the Algorithm  dialog.

The Surface  tab page now includes additional options for Z scale  and Z offset . 
(These options only appear when 3D Perspective or 3D Flythrough is selecte
the View Mode.)

2 From the Color Table drop-down menu, select rainbow1 .

ER Mapper regenerates the 3D image using colors in the ‘rainbow1’ color tab

3 Click on the Color Table menu, then select pseudocolor again.

ER Mapper lets you change many parameters of the image display while view
in 3D mode the same way you can when viewing the image in 2D. These incl
transforms, filters, formulas, sun angle shading, and more.
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Increase the vertical exaggeration of the image
1 Move the Z scale  slider bar slightly to the right.

The image redisplays with increased vertical exaggeration, so structural high
lows in the image become more apparent. 

2 Try different exaggerations by moving the the Z scale  slider bar.

You can also type in an exact value in the Z Scale%  field, and set new minimum 
and maximum values for the range.

Apply different rendering modes for the 3D image
1 Select the 3D View tab in the Algorithm  dialog.

The 3D View tab page provides draw mode, terrain detail, lighting, and other 
options. These setting affect the entire 3D image (which can contain multiple
surfaces as you will see later).

2 From the Draw Mode  drop-down list, select WireFrame .

ER Mapper redisplays the image as a mesh connected grid lines.

3 For Draw Mode , select Textured .

ER Mapper redisplays the image in blocks using a texture algorithm. (This mo
requires the most calculations and may take some time for large images.)

4 For Draw Mode , select Smooth Shaded again.

ER Mapper redisplays the image with a smooth, solid fill. (Smooth shaded is 
generally the best choice for geophysical data such as time surfaces.)

Use the Lighting and Bounding Box options
1 Turn off the Lighting option.

The image redraws without illumination from a light source.

2 Turn the Lights option on again.

slide bar right to increase
vertical exaggeration,
left to decrease (flatten)
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The image redraws with shading effects from a light source. (Lighting is 
recommended for geophysical datasets that have no natural shadowing.)

3 Turn on the Bounding Box  option.

The image redraws with a bounding box surrounding it. The box shows the ex
of the image in the X, Y and Z (vertical) directions.

4 Turn off the Bounding Box  option.

Tip: The Draw Mode  named Auto  tells ER Mapper to choose a draw mode 
automatically based on the characteristics of your computer hardware. For se
surfaces, Smooth Shaded mode with Lighting on is usually the best choice.

Adjust the Terrain Detail control
1 Move the Terrain Detail slider all the way to the left.

The image redraws with less detail in the time surface terrain.

2 Move the Terrain Detail slider to the right until the message below it reads 
“2 Mb of memory required for 255x255 terrain detail”.

When the image finishes regenerating, it displays with increased terrain deta

Terrain Detail refers to the resolution, or amount of detail, at which the image
be rendered. As you increase the detail, the rendering time and amount of sy
memory needed also increase. It is recommended that you start at low detail
settings, then slowly increase the detail to get a more accurate, high resolutio
image.

Save the 3D algorithm
1 Adjust the viewpoint of the image to a pleasing position.

2 In the Algorithm  dialog, change the Description  field text to:

Horizon KA in 3D perspective

3 On the main menu, click the blue Save As  button.

4 From the Directories  menu (on the Save As... dialog), select the path 
ending with the text examples .

5 Double-click on the ‘miscellaneous\tutorial’ directory to open it. 

6 In the Files of Type: field, select ‘ER Mapper Algorithm (.alg)’.
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7 In the Save As:  text field, enter a filename with your initials followed by the 
text ‘Horizon_KA_3D.’ Separate each word with an underscore (_). For 
example, if your initials are “TL,” type in the name:

TL_Horizon_KA_3D

8 Click OK to save the algorithm.

Your 3D perspective algorithm is now saved to an algorithm file on disk. The n
time you open it, the image automatically displays in 3D with the same viewp
and rendering parameters.

2: 3D flythrough basics

In 3D Flythrough mode, it is as though the ground is stationary and you move
around it, exploring the terrain. You depress the mouse button to begin your f
through the image, and the area where you position the mouse cursor contro
direction and speed of your flight.

Select 3D Flythrough mode to move through the image in 3D
1 From the ‘View Mode’ menu (on the Algorithm  dialog), select 3D 

Flythrough .

Change the viewing altitude
By default, you may initially see only part or an edge of the image. You can us
right mouse button to adjust your viewing altitude as desired.

1 Point to the center of the image window and depress the right mouse 
button.

The mouse cursor changes to a double-headed arrow pointing up and down.

2 With the right button depressed, drag slightly upward.

Your altitude increases, so you look more down on the 3D image. Dragging u
down with the right button depressed lets you change viewing altitude.

Objective Learn to view an image in 3D Flythrough mode, and control the viewpoint and
flight parameters.
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3 Adjust your viewing altitude up (drag upward) or down (drag downward) 
until the image fills the lower portion of the window as shown below:

Fly through at different directions and speeds
To fly through the image, depress the left mouse button and point to an area 
image window to control the direction and speed of the flight. As you fly throu
the image, the terrain will appear to move in the opposite direction of your mo

1 Point to the lower center of the image window and depress the left mouse 
button.

You fly backward away from the image.

2 Point to the upper center of the image and depress the left button.

You fly forward toward the image.

3 Point to the right center of the image and depress the left button.

You fly toward the right side of the 3D horizon.

4 Point to the left center and depress the left button.

You fly again toward the left side of the 3D horizon.

5 Point to the lower-right corner of the window and depress the left button.

You fly backward and to the right away from the 3D horizon.

6 Point slightly above the center point of the window and depress the left 
button.

You fly forward slowly into the 3D horizon. To fly slowly, point near the window
center. To fly faster, point further out toward the window edges.
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Summary of 3D Flythrough controls
• To fly forward or backward, press the left mouse button in the top half of the im

window (to fly backward) or bottom half (to fly forward).

• To fly left or right, press the left mouse button in the left half of the image wind
(to fly left) or right half (to fly right).

• To the change viewing altitude, press the right mouse button and drag up or 

• To control the speed of flight, point close to the center of the window for slow
speed, and further out toward the window edges for progressively faster spee

3: Viewing multiple surfaces in 3D

Up until now, you have created algorithms that contained only one surface. .I
sense, you can think of each surface as a separate image, or a separate view
data. Since you use an algorithm to create a certain type of image, you can co
merge different types of algorithms as separate surfaces in a single algorithm
stack the images in a single 3D view. Stacking multiple surfaces into a single
view can be an especially powerful feature for analyzing time surface and attr
data because it lets you quickly see relationships and anomalies.

Open the sample 3D horizon algorithm

1 On the main menu, click the Open  button.

2 From the Directories  menu, select the \examples  path.

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_3D.alg.’

This algorithm is a simple color display of the inverted time data, and it is initia
displayed in the 2D planimetric view.

Open another algorithm into the current one as a second surface
You can easily add a surface to an existing algorithm by opening another algo
as a separate surface.

1 On the main menu, select Open into New Surface from the File  menu.

The Open into New Surface  file chooser dialog opens.

2 From the Directories  menu, select the \examples  path.

Objective Learn to view two or more surfaces in 3D perspective, and control the offset, 
transparency, and other parameters of the view.
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3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_3D_amplitude.alg.’

ER Mapper loads the four layers of the new algorithm into a second surface i
existing algorithm. Your algorithm now has two surfaces:

Notice that the two surfaces have different color modes (indicated in the surfa
name–[Ps] for Pseudocolor and [HSI] for Hue Saturation Intensity).

View the two surfaces in 3D perspective
1 On the Algorithm  dialog, select 3D Perspective from the View Mode  

menu.

Initially you see only the image created by one surface because both occupy 
same 3D space. (This image is similar to the HSI image you created earlier w
low amplitudes are shown as greyish colors and high amplitudes as vivid colo

2 On the Algorithm  dialog, select the top surface ([Ps:Default Surface]) icon 
in the data structure diagram, then select the Surface tab.

3 Move the Z Offset  slider to the right.

first surface (from
original algorithm)

second surface (added
from second algorithm)

select top surface, then Surface  tab
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The image created by the top surface slides above the other image, so you no
two separate images.

4 Move the Z Offset  slider to the far left.

The top surface image slides underneath the other image. To move a surface
relative to other surfaces in an algorithm, select the surface in the data struct
diagram, then move the Z Offset  slider.

5 Move the Z Offset  slider right to raise the top surface above again.

Note: As you’ve seen, surfaces can be moved above or below each regardless of w
surface is on top in the data structure diagram.

Change the transparency of the top surface

1 If needed, click the Hand (Roam) Tool  button and tilt the 3D image 
downward slightly until the top surface partially covers the one below.

2 Move the Transparency slider right to its midpoint.

The top surface becomes semi-transparent, so the image below shows throu

The Transparency  setting ranges from 0-100 to specify how the image is 
“blended” with other surfaces in the window. Zero displays the full image, 50 
represents 50% transparency, and 100 makes the image invisible. Each surfa
have it own transparency setting independent of others.

3 Move the Transparency slider to the far left to make the image fully visible.

Turn individual surfaces on and off
1 Right-click on the icon for the top surface, and select Turn Off from the 

short-cut menu.:

ER Mapper renders only the lower surface image.

right-click and
select Turn Off
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2 Turn the top surface on again.

Both surfaces are again rendered.

Delete the lower surface from the algorithm
1 Select the lower surface in the data structure diagram, then click the Cut 

 button (above the diagram) to delete it.:

Open a second image window and algorithm

1 On the main menu, click the New  button.

Drag the new window down below the first one.

2 On the main menu, click the Open  button.

3 From the Directories  menu, select the \examples  path.

4 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_3D_amplitude.alg.’

This is the same algorithm you viewed earlier, and it is initially displayed in the
planimetric view.

Copy and paste the surface into the first algorithm

1 Select the surface icon in the 2D algorithm, then click the Copy  button 
(above the data structure diagram).

The surface and its layers are copied into the clipboard.

2 Activate the 3D image window (click inside once).

select lower surface,
then Cut  button to delete
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3 Select the surface icon in the 3D algorithm, then click the Paste  
button.

The surface and its layers are pasted into the algorithm as a second surface.

Tip: To add surfaces to an existing algorithm, you can choose Open into New 
Surface  from the File  menu, or copy and paste surfaces between image windo
You can also copy and paste layers or surfaces within the same algorithm an
modify them as desired, or a new empty surface and load datasets and speci
processing as needed (using Edit/Add New Surface  on the Algorithm  dialog).

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  window to close it.

Only the ER Mapper main menu should be open on the screen.

• Prepare an algorithm for 3D viewing by adding a Height layer

• Change the viewpoint, zoom level, and other 3D view parameters

• Use the 3D Flythrough viewing mode

• Stack multiple surfaces in a 3D view and set surface offset and transparency

• Merge separate algorithms into surfaces in a single algorithm

General procedures and considerations

Notes about processing speed
ER Mapper can render very large image files quickly in 3D due to it’s progres
rendering technology (i.e., starting with a low resolution view and progressive
increasing detail with subsequent processing iterations). However, large files 
take much longer to render, especially at higher Terrain Detail settings and us
Textured draw mode. The speed at which the image renders in 3D is proporti
to the processing speed of your computer and the 3D capabilities of your gra
display card.

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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ER Mapper’s 3D viewer features are designed take full advantage of the lates
graphics hardware rendering technologies. If your graphics card has 3D 
acceleration, images will render much faster when using ER Mapper’s 3D vie
modes. Be sure to turn on 3D acceleration if your graphics card supports it.
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Geolinking
images

This lesson explains how to use ER Mapper’s geopositioning controls to disp
images with exact geographic extents, and use the Geolinking controls to 
geographically link two or more image windows. Geolinking is a powerful 
visualization technique that can help you analyze the same geographic area u
variety of different datasets or processing techniques (including 2D and 3D vi

About Geopositioning
In ER Mapper, the term “geopositioning” refers to specifying the position and 
extents of an image in geographic coordinate space. This can be useful for cre
maps that cover an exact area, for example. Once an image is registered to a
projection, its display can be controlled using ER Mapper’s geopositioning 
options. If the image is not rectified to a map projection, its extents can be 
controlled in terms of the row and column numbers of the dataset pixels.

About Geolinking
gIn ER Mapper, the term “geolinking” refers to linking two or more image 
windows in geographic coordinate space. This can be useful for viewing the s
geographic area with different types of datasets or processing algorithms, an
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other applications. Once a dataset is registered to a map projection, it can be
geographically linked with other image windows using ER Mapper’s geolinkin
options. ER Mapper provides the following geolinking modes:

Window Link two or more image windows to show the same 
geographic extents. Zooming or panning in one windo
triggers the same operation in other linked windows.

Screen Link image windows to one “master” image that acts 
like a virtual map sheet on the screen. Linked window
display the geographic extents of their datasets relati
to the master window.

Overview Zoom Link image windows to one “master” overview control
window. Defining a zoom box on the control window 
causes the other windows to zoom to the defined are

Overview Roam Link image windows to one “master” control window. 
Dragging the mouse to pan in the control window caus
other windows to pan (or “roam”) so their center point
matches the mouse position in the control window.

The Algorithm Geoposition Extents Dialog Box
The Algorithm Geoposition Extents  dialog box lets you precisely control the
geographic extents and display resolution of images, and geographically link 
(geolink) two or more image windows together. The dialog has five tab pages
display different sets of functions as follows:

Zoom Lets you use buttons to zoom or pan the image in the
window by predefined amounts, or zoom to the exten
of specific datasets, page extents, or page contents.

Geolink Lets you set up geolinking between two or more imag
windows, and set the window size and display resoluti
of any image window.

Extents Lets you view or specify geographic display extents fo
an image using Latitude/Longitude, Eastings/Northing
or dataset X (column) and Y (row) values.

Center Lets you view or specify the center point for the imag
display using Latitude/Longitude, Eastings/Northings,
or dataset X (column) and Y (row) values.

Mouse info Shows quick help for using the mouse and keyboard 
keys to zoom and pan.
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Hands-on exercises
These exercises introduce you to many of the basic features of the Algorithm 
Geoposition Extents dialog box and how to use them to control image displ
extents and set up geolinking between windows.

Note: The sample “Seismic3D” dataset used in the following exercises was previou
rectified to a datum and map projection. If two or more datasets are to be disp
in separate windows and you wish to geolink them, the datasets must be rectif
a common datum and map projection.

• Display images with exact geographic extents and display resolutions

• Link image windows (2D and 3D) to show the same geographic extents

• Link image windows to a virtual map sheet window

1: Geopositioning images

Open the sample TWT colordrape algorithm

1 On the main menu, click the Open  button. 

An image window and the Open dialog box appear.

2 From the Directories  menu, select the \examples  path.

3 In the directory named ‘Applications\Oil_And_Gas_Exploration,’ open the 
algorithm named ‘Seismic_Horizon_Colordrape.alg’

This algorithm displays two-way time in color draped over shaded two-way tim
enhance structural features in the horizon.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to use the Geoposition controls to display an exact geographic are
an image, specify an image center point, and change window sizes and displ
resolutions.
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Open the Algorithm Geoposition Extents Dialog Box
1 From the View  menu, select Geoposition... .

The Algorithm Geoposition Extents  dialog box appears. If needed, drag the
dialog to the right side of the screen.

Tip: You can also open the Algorithm Geoposition Extents  dialog by clicking the 

Geoposition Window   button on the Algorithm  dialog.

Display an exact area by entering geographic values
1 .In the Algorithm Geoposition Extents  dialog, select the Extents  tab.

The contents of the dialog change to show a group of text fields for entering 
coordinate values. Note that the current dataset extents (shown in the Size fie
show approximately 6 minutes 52 seconds of Latitude and 9 minutes 58 secon
Longitude.

2 Edit the value in the Latitude  and Longitude Size  field as follows.

Latitude/Size = 0:5

Longitude/Size = 0:5

3 Click the Apply  button to apply your new values..

The image redisplays with your new image extents–an area exactly 5 minute
Latitude by 5 minutes of Longitude. (By default ER Mapper keeps the same u
left coordinate, so you “zoomed” on the upper-left portion of the dataset.)

change to 0.5 click Apply  to apply
changes to image
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Display an exact part of the dataset by entering cell values
1 Edit the contents of the four fields as listed below to display an exact 

portion of the dataset using cell X (column) and cell Y (row) values:

Cell X/Top Left = 500

Cell Y/Top Left = 100

Cell X/Bottom Right = 1000

Cell Y/Bottom Right = 200

2 Click the Apply  button to apply your new values.

ER Mapper reprocesses the algorithm with your new dataset extents and disp
an area 500 pixels (cells) wide by 100 pixels in height. The origin (upper-left 
corner) is at dataset cell column (X) 500 and dataset cell row (Y) 100.

Note: This dataset has greater cell resolution in the X (horizontal) direction than the
(vertical) direction, so these extents yield an approximately square image.

Center the image on an exact point
1 In the Algorithm Geoposition Extents  dialog, select the Center tab..

The contents of the dialog change to show a text fields for entering the center 
of the image in geographic or dataset X and Y values.

2 .Edit the value in the Easting and Northing field values as follows:

Easting = 376700

Northing = 7822000

(ER Mapper adds the “E” and “N” to the string automatically.)

3 Click the Apply  button to apply your new center point values.
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ER Mapper reprocesses the algorithm and centers the image on the location 
defined (the tip of the V-shaped uplifted fault block). Centering can be useful 
viewing the exact center point of an image, or for centering on an exact featu
interest or geographic location for map production.

2: Linking windows to common extents

Open the amplitude colordrape algorithm

1 Click the Open  button on the main menu. 

2 Open the algorithm ’Seismic_Horizon_Dip.alg.’

This algorithm processes the two-way time data to derive an image showing 
dip of the time surface (dark greys are steep slopes).

Open a second window and algorithm

1 On the main menu, click the New  button. 

A second image window opens on the screen.

2 Click the Open  button on the main menu. 

3 Open the algorithm ’Seismic_Horizon_twt_amplitude.alg.’

This algorithm drapes amplitude in color over the shaded two-way time. Reds
yellows indicate strong amplitudes, blues indicate weak amplitudes.

Objectives Learn to link image windows in Geolink “Window” mode, so each linked 
window displays the same geographic extents.
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Resize and position the two windows
1 Reposition the two windows as shown in the following diagram, and resize 

them if needed. (You must able to view the contents of each window 
clearly.)

You should now have two image windows of about the same size next to each
in the upper part of the screen, and Geoposition  dialog below them.

Set the Dip image window to Geolink Window mode
1 Click inside the ‘Seismic_Horizon_Dip’ image window to activate it (three 

stars (***) should appear next to the title).

2 On the Algorithm Geoposition Extents  dialog, select the Geolink tab.

The contents of the dialog show ‘Geolink mode’ option buttons on the left sid

3 Select the Window  option button, then click the Apply  button. 

The title bar of the ‘Seismic_Horizon_Dip’ image window indicates that it is no
set to “WINDOW” geolink mode.

seismic dip
window

amplitude
window

Geoposition
dialog box

select Window
option
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Set the amplitude image window to Geolink Window mode
1 Click once inside the ‘Seismic_Horizon_twt_amplitude’ image window to 

activate it.

2 In the Geoposition  dialog, select the Window  option, then click Apply . 

The amplitude image is now also set to geolink Window mode. Since the two
windows are linked, any changes you make to the extents in one window will 
automatically duplicated in the other.

Zoom and pan in both images

1 On the main menu, click the Zoom Box Tool  button.

The mouse is now set to perform zoom and pan functions in image windows.

2 Click inside the ‘Seismic_Horizon_Dip’ image window to activate it, then 
drag a zoom box to magnify the central portion of the image.

The images in both windows automatically zoom to share the same extents.

3 Click once inside the ‘Seismic_Horizon_twt_amplitude’ image window to 
activate it, then click on the right part of the image to pan to the right. 

Both images pan to the right.

4 On the Algorithm Geoposition Extents  dialog, select the Zoom  tab. 

5 Under ‘Pan,’ click the Pan upper-left   button. 

Both images pan 50% to the upper-left (the previous center point is now on th
lower-right corner of the image).

6 Under ‘Set extents to,’ click the Raster Datasets button. 

Both zoom out to their full extents (the same since they both use the same da

Tip: Geolink Window mode is a helpful way to view the same geographic area of t
single dataset processed in different ways (as shown here), or entirely differe
datasets that share the same map projection. You can link as many image win
as desired. The order in which windows are linked does not matter.

Add a third window and 3D image

1 On the main menu, click the New  button. 

A third image window opens, drag it to an open area. (Resize the windows to m
them smaller if needed.)
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2 Click the Open  button on the main menu. 

3 Open the algorithm ’Seismic_Horizon_3D.alg.’

This algorithm shows two-way time in color. It also contains a Height layer so 
can view it in 3D perspective.

4 On the main menu, click the Edit Algorithm  button.

5 On the Algorithm  dialog, select 3D Perspective  from the View Mode  
menu.

The image redisplays in 3D perspective.

6 Click Close  on the Algorithm  dialog.

7 If desired, manipulate the 3D view to get a better perspective.

8 On the Algorithm Geoposition Extents  dialog, select the Geolink tab. 

9 In the Geoposition  dialog, select the Window  option, then click Apply . 

The 3D view image is now also linked with the other two in Window mode.

Zoom and pan in all three images
1 Click inside the ‘Seismic_Horizon_Dip’ image window to activate it, then 

drag a zoom box to magnify part of the image.

The portion of the horizon shown in the 3D view is “trimmed” to match the exte
of the 2D views. (Its viewing perspective does not change.)

2 Zoom or pan to other areas in either the ‘Seismic_Horizon_twt_amplitude’ 
or ‘Seismic_Horizon_Dip’ image windows.

The extents of the 3D view change to match them.

Note: As shown, image windows displaying 3D views can be controlled by zoom an
pan operations in 2D windows geolinked in “Window” mode. However, zoomin
or panning in the 3D window does not affect images in 2D windows.

3 Select the Zoom  tab (in the Geoposition  dialog), then click the Raster 
Datasets button. 

All three windows zoom out to display the full dataset extents.

Close the 3D view image window
1 Close the ‘Seismic_Horizon_3D’ image using the window system controls:
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• For Windows, click the  Close  button in the upper-right window corner.

3: Linking windows to the screen

.Set both windows to Geolink None mode

1 On the main menu, click the Pointer Tool   toolbar button.

The mouse is now set as a pointer. (This prevents accidentally panning or zoo
when you click inside a window to activate it.)

2 On the Algorithm Geoposition Extents  dialog, select the Geolink tab.

3 Click inside the ‘Seismic_Horizon_Dip’ image window to activate it.

4 In the Geoposition  dialog, select the None  option button, then click Apply . 

The words “WINDOW:geolink” disappear from the window title, indicating tha
the window is no longer geolinked.

5 Click inside the ‘Seismic_Horizon_twt_amplitude’ image window to activate 
it.

6 Select the None  option button, then click Apply . 

Tip: Image windows can also be geolinked and unlinked using the View/Quick Zoom  
menu on the main ER Mapper main menu.

Objectives Learn to link image windows in Geolink “Screen” mode, so a “master” image 
window becomes a virtual map sheet on the screen. The screen assumes the
coordinate space of the master image window. Other windows subsequently 
the “screen” mode display the geographic extents of their datasets relative to
master window.
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Resize and position the two windows
1 Resize and reposition the two windows as shown in the following diagram. 

(You must be able to view the contents of each window clearly.)

2 Right-click over each image and select Zoom to All Datasets  from the 
Quick Zoom menu.

You should now have a smaller ‘Seismic_Horizon_twt_amplitude’ window 
partially overlaying the larger ‘Seismic_Horizon_Dip’ window, and the 
Geoposition  dialog in the lower-right corner.

Set the large Dip image window to Geolink Screen mode
1 Click inside the large ‘Seismic_Horizon_Dip’ image window to activate it.

2 In the Geoposition  dialog, select the Screen option button.

3 Click the Apply  button. 

The window title indicates that it is now set to “SCREEN” geolink mode. This 
the first window assigned to Screen mode, it becomes the “master” window a
the entire screen assumes its coordinate space (shown clearly later).

Seismic Dip
“map sheet”

window
amplitude

window

Geoposition
dialog box

select Screen
option
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Set the Amplitude window to Geolink Screen mode
1 Click inside the ‘Seismic_Horizon_twt_amplitude’ window to activate it.

2 Select the Screen option button.

3 Click the Apply  button. 

The ‘Seismic_Horizon_twt_amplitude’ window is now linked to the “master” 
window, and it automatically redraws to show its portion of the larger “map sh
window. 

Move the Amplitude window over the Dip master window
1 Drag the smaller ‘Seismic_Horizon_twt_amplitude’ window by its title bar to 

the left side of the larger window.

The amplitude image automatically redraws to show its new extents in the co
of the Dip “map sheet” window. By comparing the two images, you can clearly
how variations in event amplitude correspond to structural features described
the two-way time dip image.

Tip: It helps to think of the larger “master” window as a paper map sheet. Any othe
windows moved on top of the map sheet act like a viewing port into a differen
dataset or processing technique over the same geographic area.

Zoom in on the Amplitude window

1 On the main menu, click the Zoom Box Tool  button.

The mouse is again set to perform zoom and pan functions in image windows

2 Inside the ‘Seismic_Horizon_twt_amplitude’ window, drag a zoom box to 
magnify part of the image.

The images in both windows automatically zoom in the same amount.

3 On the Algorithm Geoposition Extents  dialog, select the Zoom  tab. 

4 Under Pan, click the Pan right  button. 

Both images pan 50% to the right (the previous image center point is now on
left side of the both windows).

5 Under Zoom , click the Zoom out 50%  button. 

Both images zoom out 50% from their previous magnification level.
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6 Experiment by moving or resizing the smaller window to view the amplitude 
data over corresponding areas of the seismic dip image.

Note: ER Mapper also two other geolinking modes named Overview Zoom and 
Overview Roam. These are designed to allow detailed analysis of small area
zoom windows by controlling interactive image zooming and panning function
from a master window. See the ER Mapper Tutorial and User Guide manuals for 
details.

Close all image windows and the Geoposition window
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm Geoposition Extents  dialog to close it.

Only the ER Mapper main menu is now open.

• Display images with exact geographic extents and display resolutions

• Link image windows (2D and 3D) to show the same geographic extents

• Link image windows to a virtual map sheet window

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Algorithm
wizards

This chapter shows you how to use ER Mapper’s toolbars and wizards to auto
the creation of many types of common image processing algorithms. Using 
toolbars and wizards greatly increases the speed and efficiency with which yo
ER Mapper.

About algorithm toolbars and wizards
Up until now, you have learned to develop your own algorithms by loading 
datasets, creating algorithm layers, and modifying the process diagram in ea
layer. This is necessary so that you understand how ER Mapper works and h
apply the different types of processing functions. You have also used the Stan
and Common Function toolbars on the main ER Mapper menu to open image
windows, save algorithms, and other simple tasks (as an alternative to acces
those functions from menus).

However, ER Mapper also provides other toolbars that let you develop algorit
quickly and easily with a few mouse clicks. For example, if you want to create
greyscale algorithm, you can just click the Image Display and Mosaic Wizard  
toolbar button, select the desired dataset, and let ER Mapper do the rest. 
ER Mapper also provides image “wizards” that guide you step-by-step through
process of creating specific types of algorithms.
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Under the Toolbar  menu, ER Mapper provides several toolbars to automate 
specific tasks and image processing techniques and applications. In this case
will using the toolbars named “Oil and Gas” and “Geophysics.”

The toolbar functions are implemented using scripts written in ER Mapper’s b
scripting language. When you initiate the selected toolbar function, ER Mapp
runs the associated batch script in the background and performs the desired 

Note: With a bit of simple programming knowledge, you can also create your own b
scripts and wizards. This gives you fast access to site specific functions and 
processing techniques, and also lets you give less sophisticated users acces
these functions without the need for them to understand the processing in de
(Use the existing scripts and Customizing ER Mapper documentation as a guide 
for creating your own.)

Hands-on exercises
These exercises show you how to use ER Mapper toolbar buttons and image
wizards to automate the creation of several types of common algorithms. 

• Open a dataset directly (ER Mapper creates a simple display algorithm)

• Use toolbar buttons to create pseudocolor and colordrape algorithms

• Use toolbars to create specialized processing algorithms

• Use image wizards to create customized algorithms

What you will 
learn...

After completing these exercises, you can perform the following tasks in 
ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen. 
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1: Open a dataset directly

Up until now, you have created algorithms by loading a dataset into the 
Algorithm  dialog box and setting appropriate processing options. For fast 
viewing, however, you can simply open the dataset directly and have ER Map
automatically create a simple algorithm based on the number of bands in the
dataset, cell size and other characteristics.

Open the sample Seismic3D dataset

1 On the main menu, click the Open  button.

An image window and the Open dialog box appear.

2 From the Directories  menu (on the Open  dialog), select the \examples  
path.

3 Double-click on the ‘Shared_Data’ directory to open it.

The Open  dialog can be set to display files with certain extensions, or all files
previous exercises, you have using the Open  dialog to load algorithm (.alg) files.

4 From the Files of Type  drop-down list, select ‘ER Mapper Raster Dataset 
(.ers)’.

The contents now show only files with “.ers” file extensions. There are other ra
files on disk, or ER Mapper Virtual Datasets (you will learn about these later).

5 Double-click on the ‘Seismic3D.ers’ dataset.

ER Mapper automatically loads the dataset and creates a simple greyscale 
algorithm. This procedure is a fast way to view any geophysical dataset that h
only one or two bands (such as a seismic grid or aeromagnetics image).

Note: If the dataset has three or more bands, ER Mapper creates an RGB algorithm
This is typically used to display satellite images and airphotos.

6 Select Close  from the File  menu to close the image window.

Objectives Learn to open a dataset directly and have ER Mapper automatically create a 
simple display algorithm for it.
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2: Using the Oil and Gas toolbar

Open an image window and Algorithm window

1 Click the Edit Algorithm  button on the main menu. 

ER Mapper opens a new image window and the Algorithm  window.

Display the Oil and Gas toolbar
1 From the Toolbars  menu (on the main menu), select Oil and Gas .

ER Mapper adds a third row of toolbar buttons to the main menu. These butto
are designed to help you create algorithms with processing techniques speci
Oil and Gas seismic applications.

2 Point to the buttons on the Oil and Gas toolbar.

A “tooltip” description of each button’s function displays next to it.

Create a seismic azimuth algorithm

1 On the Oil and Gas toolbar, click the Horizon Azimuth  button (the 
yellow horizon). 

Objectives Learn to use the Oil and Gas toolbar buttons to have ER Mapper automatical
create Pseudocolor, colordrape, and other algorithms for you.

Oil and Gas toolbar

Horizon Azimuth
button
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The Select a Dataset dialog box appears to prompt you for a dataset.

2 On the Select a Dataset  dialog, click the Load dataset  button.

3 From the Directories  menu on the Select File dialog, select the path 
ending with \examples . 

4 Double-click on the directory ‘Shared_Data’ to open it, then double-click on 
the ‘Seismic3D.ers’ dataset to load it.

5 Click the OK button on the Select a Dataset  dialog.

ER Mapper executes a batch script that loads the Seismic3D dataset into the
Pseudocolor layer of the algorithm, sets the Color Table to ‘azimuth’ and add
appropriate filters and azimuth formula in the process diagram.

Convert the azimuth image to a realtime shade image

1 On the Oil and Gas toolbar, click the Horizon RTS  button. 

ER Mapper executes a batch script that deletes the filters and formula used f
azimuth algorithm, sets the Color Table to ‘greyscale’ and turns on sun angle
shading for the layer. It also opens the Edit Sun Angle  dialog automatically so 
you are ready to change the sun angle as desired.

2 Experiment with different sun angles (if desired).

As you can see, using automatic toolbar functions can save time for quickly 
viewing datasets in many different ways. (Note that you may need to adjust th
default algorithms they create to match bands or other characteristics of your
datasets.)

3 From the Toolbars  menu (on the main menu), select Oil and Gas .

The Oil and Gas toolbar is hidden (only the Standard and Common Functions
toolbars should be displayed).

Horizon RTS
button
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Note: The Pseudocolor and Colordrape toolbar buttons on the Oil and Gas toolbar 
specialized for processing geophysical data, so they behave differently than t
similar looking ones on the Common Functions toolbar. For seismic data you
should always use the buttons on the Oil and Gas toolbar.

3: Using an image wizard

Image wizards are more sophisticated versions of the toolbar buttons you use
previously. One wizard can be used to create many different types of algorith
depending upon the options you choose as you proceed.

Close image windows and dialogs
1 Close the image window by selecting Close  from the File  menu.

2 Click Close  on the Edit Sun Angle  and Algorithm  dialogs to close them.

Display the Geophysics toolbar
1 From the Toolbars  menu (on the main menu), select Geophysics .

ER Mapper adds a third row of toolbar buttons to the main menu. These butto
are designed to help you create common types of algorithms used to enhanc
geophysical data (seismic, magnetics, gravity and so on).

Objectives Learn to use an image wizard to have ER Mapper automatically guide you 
through the process of creating several types of algorithms for geophysical da
such as interpreted seismic.

Geophysics toolbar
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Start up the Geophysical Images wizard
1 On the Geophysics toolbar, click the Common Geophysical Images 

Wizard  button. 

ER Mapper opens the Common Geophysical Images Wizard  dialog.

Create a pseudocolor two-way time image
1 On the Common Geophysical Images Wizard  dialog, select the ‘Density 

sliced (pseudocolor)’ option box. 

2 Click the Load dataset  button.

3 From the Directories  menu, select the \examples  path.

4 Double-click on the directory Shared_Data’ to open it, then double-click on 
the ‘Seismic3D.ers’ dataset to load it.

5 Click the Next> button.

ER Mapper displays the Image Properties  panel in the wizard to ask for 
additional information.

Common Geophysical
Images Wizard  button

select Density
Sliced option

click to load
dataset
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Select additional properties and create the image
1 Select the ‘Band is seismic two-way time data’ option box. 

This tells ER Mapper that the selected band is two-way time, so it will the inve
the data by adding the “-input1” formula to the algorithm. (If you were display
amplitude or other attributes you would not usually do this.)

2 From the ‘Color lookup table to use’ list, select pseudocolor . 

3 Click the Finish  button to create the image. 

ER Mapper opens an image window, creates the algorithm according to your i
then displays the image. At the end, it opens the Transform  dialog to let you 
make any desired color mapping enhancements.

Close the Transform dialog and image window
1 Click Close  from the Transform dialog.

2 Select Close  from the File  menu to close the image window.

Use the wizard to create linked colordrape and 3D images
1 On the Geophysics toolbar, click the Common Geophysical Images 

Wizard  button again 

2 On the Common Geophysical Images Wizard  dialog, select both the 
‘Colourdraped’ and ‘3D Perspective’ options.

select option
when using

select
pseudocolor
color table
from list

two-way time
data

click Finish  to create image
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3 Click the Load dataset  button, then select the \examples  path from 
the Directories  menu (on the Select File dialog).

4 Double-click on the directory ‘Shared_Data’ to open it, then double-click on 
the ‘Seismic3D.ers’ dataset to load it.

5 Select the ‘Link the windows’ option.

This tells ER Mapper to geolink the two image windows together.

6 Click the Next> button.

7 Select the ‘Band is seismic two-way time data’ option box. 

8 From the ‘Color lookup table to use’ list, select pseudocolor .

9 Click the Finish button.

ER Mapper first opens an image window and creates a colordrape image, the
opens a second window and creates 3D perspective image of the same data
ER Mapper has done most of the work for you, now you can “fine tune” the 
images as you desire. Also notice that the two image windows are automatic
geolinked in “Window” mode, so any zoom or pan operation performed in the
window is replicated in the 3D window.

As you can see, using image wizards can greatly increase the speed and effi
with which you use ER Mapper.

Hide the Geophysics toolbar again
1 From the Toolbars  menu (on the main menu), select Geophysics .

The Geophysics toolbar is hidden (only the Standard and Common Functions
toolbars should be displayed).

Close both image windows and the Algorithm dialog
1 Close both image windows using the window system controls or by 

selecting Close  from the File  menu.

Only the ER Mapper main menu is now open.

• Open a dataset directly (ER Mapper creates a simple display algorithm)

• Use toolbar buttons to create pseudocolor and colordrape algorithms

• Use toolbars to create specialized processing algorithms

• Use image wizards to create customized algorithms

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Saving images to
disk

This chapter explains how to send the processing results of an algorithm to a 
output file on disk, and calculate and view statistics for the new file. 

About Writing Images to Disk
Up until this point you have not needed to write image files to disk since you h
been doing all processing interactively directly to the display (using ER Mapp
algorithms). In general, processing your data interactively to the display is 
preferred since it is faster, easier, and takes full advantage ER Mapper’s flexib
and the processing power of your computer. 

However, there are times when you may want to save your processing results
separate raster dataset file on disk:

• If you are using very complex, compute-intensive algorithms, you may want t
write a processed copy of the data to disk at some point so it does not need t
recomputed each time.

• Saving your processing as an image file is sometimes necessary if you want 
the processed image in another software application.
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• Merging multiple datasets into one dataset, for example, merge three horizon
stored as separate files into a single file with three bands. This speeds access
data and lets you use features like Traverse to profile all three horizons at once
the Notes section at the end of this chapter for more information.)

To have ER Mapper send the output from an algorithm to a disk file, set up yo
algorithm with the appropriate layers and processing, then select Save As... from 
the File  menu or click the Save As toolbar button. 

Raster layers in the Algorithm  dialog can be combined when output, or they ca
be output to separate bands in the output dataset file. The layers in the Algorithm  
dialog are processed as follows:

• Non-Classification raster layers with no layer description or the same layer 
description are combined upon output. 

• Non-Classification raster layers with unique layer descriptions are written as 
separate band in the output dataset. 

• All Classification raster layers are processed into a single band in the output da

You can save the image in a number of different formats. These are:

• ER Mapper Raster Dataset (.ers)

• ECW v2 Compressed (.ecw)

• ESRI BIL and GeoSPOT (.hdr)

• Windows Bitmap (.bmp)

• GeoTIFF (TIFF)

• JPEG (.jpg)

• UDF (.ers)

The format you use depends on what you are going to do with the image. Th
ER Mapper Raster Dataset has the header file which contains georeferencing
statistical information about the image. The ER Mapper ECW compressed fo
also has a separate header file which can be discarded. This information will n
saved with the image if you save another format. 

Note: There are a number of free plugins available that allow you open images in 
ER Mapper native formats in other GIS applications.
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Hands-on exercises
This exercise demonstrates the procedure for sending algorithm output to a f
disk, and to calculate and view datasets statistics. 

• Create an algorithm to send output to a raster dataset on disk

• Specify output dataset parameters and write the dataset to disk

• Calculate and view statistics for the new dataset

• View information about the output dataset

1: Saving a dataset to disk

Load a Pseudocolor algorithm

1 On the main menu, click the Edit Algorithm  button.

An image window and the Algorithm  dialog appear.

2 On the main menu, click the Open  button. 

3 In the Files of Type:  field, select ‘ER Mapper Algorithm (.alg)’.

4 From the Directories  menu, select the \examples  path.

5 In the ‘Applications\Oil_And_Gas_Exploration’ directory, open the 
algorithm ‘Seismic_Horizon.alg.’

The algorithm displays an enhanced color image of an interpreted seismic hor
Blues correspond to structural lows transitioning into reds for structural highs.
will zoom in to define a smaller portion of the image, and save the subset to a
raster dataset on disk.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen. 

Objectives Learn how to send algorithm processing output to a raster dataset on disk. In
case, you will create a subset of the “Seismic3D” sample dataset that include
two bands (inverted time and amplitude).
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Delete the Intensity layer from the algorithm
This algorithm contains an Intensity layer that is currently turned off, you will 
delete it since it is not needed for this exercise.

1 On the Algorithm  dialog, select the Intensity layer (in the data structure 
diagram on the left).

2 Click the Cut  button to delete the layer.

Zoom in to define a subset of the image

1 On the main menu, click the Zoom Box Tool  button to set the mouse 
for use as a zoom tool.

2 Position the mouse pointer in the upper-left corner of the image, then drag 
a zoom box around the V-shaped uplifted block displayed in red tones. 
(This should be about 50% of the original image area.)

ER Mapper zooms in on the defined area. This is the portion of the original da
that you will save to a separate raster file.

Tip: You can also use the Algorithm Geoposition Extents  dialog to crop an area by
exact geographic coordinates (select View/Geoposition ).

Label the layer to indicate its contents
Notice that the layer already has dataset band 1 (two-way time) selected. Wh
creating an algorithm to write an output dataset, you usually need to enter a l
for each layer that describes its contents.

1 Change the layer’s label from ‘Pseudo Layer’ to Inverted TWT (ms)  and 
press Enter of Return.

Create a second layer for the amplitude data
1 In the Algorithm  dialog, click the Duplicate  button.

A second Pseudocolor layer is added, and it already contains the ‘Seismic3D
dataset since it is a duplicate.

Tip: Another option for adding the second layer would be selecting Edit/Add Raster 
Layer/Pseudo  on the Algorithm dialog and loading the ‘Seismic3D’ dataset.
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Select the amplitude band and label the new layer
1 With the new (lower) layer selected, choose B2:Amplitude  from the Band 

Selection  drop-down list in the process diagram.

The new layer now contains the amplitude data.

2 Change the new layer’s label to read Amplitude , then press Enter or 
Return.

Reset the invert formula from the amplitude layer
Since this algorithm was originally designed to display the time data, it contai
formula to invert the dataset values (so larger time values are color-coded as
structural lows). It is important to reset the formula in the new layer so the 
amplitude data does not get inverted as well in the output dataset.

1 With the ‘Amplitude’ layer selected, click the Formula   button in the 
process diagram.

2 In the Formula Editor  dialog, select Default  from the Edit  menu.

ER Mapper resets the formula back to the default “INPUT1.” (This formula 
performs no changes to the original data.)

3 Click Close  on the Formula Editor  dialog.

4 Click on the surface icon in the data structure diagram–you should then see 
the process diagrams for both layers.

You have now created an algorithm that will output both bands from the origin
dataset (the time and amplitude data). By zooming in, you have defined a sub
the image, and only that area will be saved to the output dataset. The descrip
you specified for each layer will become the labels for each band in the outpu
dataset. (Using a formula to reverse the polarity of the time data was optiona
may be desirable in many cases.)

The order of layers in the algorithm determines the order of bands in the outp
dataset (the first layer becomes the first dataset band). In addition, make sure
layers to be output are turned on (turned off layers are ignored when creating
output datasets).

Specify a filename for the output dataset
1 On the main menu, select Save As...  from the File  menu (or click the Save 

As  button).

The Save As... dialog box appears. This dialog lets you specify a path and na
for your output disk file, and options for creating the new dataset.
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2 On the Save As...  dialog, select ‘ER Mapper Raster Dataset (.ers)’ in the 
Files of Type: field.

3 From the Directories  menu, select the \examples  path. 

4 Double-click on the ‘miscellaneous\tutorial’ directory to open it.

5 In the Save As:  text field, type a name for the disk file using your initials 
followed by the text ‘horizon_subset,’ and separate each word with an 
underscore (_). For example, if your initials are “CJ,” type in the name:

CJ_horizon_subset

6 Click OK to close the file chooser dialog.

The Save As ER Mapper Dataset dialog opens. 

Choose options for the output dataset

1 Click the Defaults  button.

ER Mapper automatically fills in appropriate values in the Width  and Height  
fields by examining the extents of the area you zoomed on, and figuring the 
corresponding numbers of actual dataset pixels to be output.

Notice also that the Output Data Type  has been set to IEEE4ByteReal . 
ER Mapper determined this by examining the data type of the original 
‘Seismic3D’ dataset. (You could change this to another type if desired, but it i
usually best to maintain the native data type and precision.)

The fields on the Save As ER Mapper Dataset  dialog are:
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• Output Type is the number of bands in the saved dataset. It can be other mu
layer or have a Red Green and Blue (RGB) layer. 

• Data Type  is the data format for the new output dataset. For example, if your
dataset is type real (or algorithm processing produces floating point data usin
formula), you should get a real data type after clicking Defaults . (If desired, you 
could change the data type to signed or unsigned integer).

• Null Value  specifies a cell value that will be interpreted as “null” in the output
dataset. Null cell values are ignored during processing, and are often used to
a specific background value that you wish to ignore.

• Width  and Height  specify the width and height of the new output dataset in pix
Clicking the Defaults  button tells ER Mapper to figure out the number of cells 
the input dataset based on the area currently displayed, then fill those values
automatically (recommended). If desired, you can enter any size and ER Map
automatically subsamples or supersamples the original image data to fill the 
requested dimensions.

Tip: It is recommended that you always use the Defaults  button to automatically set 
the output data type and cells across and down to the correct values for the c
algorithm. If desired, you can then change the output data type or size by sele
different options or values.

• Maintain aspect ratio  maintains the symmetry of the image. If you alter the 
Width or Height the other dimension will change to keep the aspect ratio.

• Delete output transforms  automatically deletes any transforms in the 
algorithm.

Note: If you want to maintain the native data range of the input dataset when writing
output datasets to disk, you should always delete the transforms for each ras
layer in the algorithm first. Otherwise, the output data will be scaled or clipped
according to the current transform. (There are times, however, when rescalin
range of an output dataset can be desirable.)

Write the output disk file
1 Click OK on the Save As ER Mapper Dataset  dialog.

A dialog box appears to show the progress of the write to disk operation, then
confirmation dialog appears when the process is complete.

2 Click OK on the confirmation dialog to close it.
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Display the new dataset and adjust the color mapping

1 Click the New  button on the main menu, then drag the new window 
below the first one.

2 On the Algorithm  dialog, click the Load Dataset  button in the process 
diagram. 

3 From the Directories  menu, select the \examples  path.

4 In the ‘miscellaneous\tutorial’ directory, double-click on your new dataset to 
load it (it will have a ‘.ers’ file extension).

5 Select the Surface  tab in the Algorithm  dialog, then select the Color 
Table  named pseudocolor .

The image appears blue initially because you need to adjust the color mappin

6 In the process diagram, click the right-hand Edit Transform Limits  
button.

7 From the Limits  menu (on the Transform  dialog), select Limits to Actual .

The X axis data range changes to match the Actual Input Limits.

The image redisplays showing the same area as the zoomed in area of the o
algorithm in the other window.

View the amplitude band in the new dataset
1 Select the Layers tab in the Algorithm  dialog.

2 Open the Band Selection  drop-down list in the process diagram to see the 
two bands in your output dataset.

Notice that the band labels are the same as the layer descriptions you entere
previously in the first algorithm.

3 From the Band Selection  drop-down, select B2:Amplitude .

The layer now contains the amplitude data.

4 From the Limits  menu (on the Transform  dialog), select Limits to Actual .

The X axis range changes to match the Actual Input Limits of the amplitude d

The amplitude data redisplays with enhanced color contrast.

5 Click Close  on the Transform dialog to close it.
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View information on the new dataset

1 On the Algorithm  dialog, click the Load Dataset  button in the process 
diagram.

2 On the Raster Dataset  file chooser dialog, click the Info...  button.

The Dataset Information  dialog displays showing the map projection, numbe
of bands (2), X and Y pixel dimensions, and file size. Information such as the 
projection was carried over from the source ‘Seismic3D’ dataset.

Tip: You can edit the information in the ER Mapper header file (.ers file) by clicking
Edit  button on the Dataset Information  dialog.

3 Click Close  to close the Dataset Information  dialog.

4 Click Cancel  to close the Raster Dataset  file chooser dialog.

Calculate statistics for the new dataset
When a new dataset is imported or created in ER Mapper, some minimal stat
such as those shown in the previous Dataset Information  dialog are created. 
You can also generate detailed statistics to provide in depth information about
band in the dataset.

1 From the Process  menu (on the main menu), select Calculate 
Statistics... .

click Info  to view dataset information
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The Calculate Statistics  dialog box opens. Your ‘horizon_subset’ dataset 
should be chosen by default because it is the dataset used in the current algo
(If it is not chosen, load it from the ‘tutorial’ directory).

2 Set the Subsampling Interval  to 1.

(For very large datasets it can take quite a bit of time to calculate statistics. T
subsampling option lets you sample fewer pixels to decrease calculation time 
expense of slightly less accurate statistics.)

3 Select the Force Recalculate stats option (to calculate statistics again in 
case they have previously been calculated).

4 Click OK to start the statistics calculation.

5 When the calculation is finished, click OK in the dialog indicating 
successful completion, then close the other statistics dialogs with Close  or 
Cancel .

View tabular statistics for the new dataset
1 From the View menu, select the Statistics , then select Show Statistics .

The Statistics Report dialog box appears. The ‘horizon_subset’ dataset shou
be selected by default. You can choose to view statistics for selected regions
bands in the dataset, or for all regions and bands.

2 Click OK to display statistics for all bands in the dataset.

The Display Dataset Statistics  dialog opens showing statistics for all your 
regions in both dataset bands.

3 Scroll through the list to view statistics (you can make the dialog larger if 
needed).

You can view simple statistics such as the minimum, maximum, and mean va
in each band, correlation and covariance matrices, and other calculations.

Note: The region named ‘All’ is the entire dataset. If there were additional regions 
defined in the source dataset, they would be carried on to the new dataset an
statistics would appear here as well. (For example you could easily see the a
size of a region.)

4 When finished viewing statistics, click Close on the Statistics Report  
dialog to close both dialogs.

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:
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• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm dialog to close it.

Only the ER Mapper main menu should be open on the screen.

• Create an algorithm to send output to a raster dataset on disk

• Specify output dataset parameters and write the dataset to disk

• Calculate and view statistics for the new dataset

• View information about the output dataset

Notes on combining datasets
Sometimes when you import interpreted seismic horizons and attribute grids 
ER Mapper, the horizons and attributes import as single-band datasets. For 
example, if you have three horizons to import, you may end up with each hor
being a separate raster file in ER Mapper format.

It is often desirable to combine these separate single-band files into one file t
has multiple bands. Each horizon would become a band in the new combined
dataset. This gives you several advantages:

• You have faster access to the data (instead of managing and loading three da
you only have one).

• Math functions (formulas) can now be easily carried out between the differen
horizons and/or attributes. For example, you can create an isochron by subtra
one horizon (band) from another. (This is also possible using the Virtual Data
feature described later.)

• You can use the Cell Profiles  and Traverse  features and see the values and 
traverse profile of all horizons and/or attributes simultaneously.

Procedure to combine datasets
To merge or combine several single-band datasets into one multi-band datase
follow basically the same steps as described in this chapter. That is, do the 
following:

• Load each dataset into its own raster layer in the algorithm. (Use the OK this layer 
only  or Apply this layer only  buttons when loading the datasets.)

• Enter a unique label for each layer that describes the dataset it contains

• Delete the post-formula transform for each layer

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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• Choose View/Quick Zoom/Zoom to All Datasets  (this is important to 
determine the full geographic extents of the datasets in all layers).

• Use the File/Save As.... option as described here

• Save the image in an appropriate format.

Normalizing data ranges of attributes
If you are combining multiple attribute grids into a single dataset, it can be us
to normalize the range of values in each attribute to a common data range.  T
especially helpful for using the traverse profile feature (View/Traverse ), so you 
can easily see the change in magnitude and relationship between various attr
across any profile.

Normalization is helpful because various attributes often have very different d
ranges.  For example, some have large positive-to-negative ranges, some ve
small negative ranges, some large negative ranges, and so on.  If you display
attributes with very different ranges in the same traverse profile, the profile is 
dominated by the attribute with the greatest range.  Attributes with smaller ran
may end up looking like flat lines at the top or bottom of the profile display, so
direct comparison of the changes in magnitude is not possible.

One simple way to normalize your data into a common range is to use a trans
in each layer (do not delete the transforms as described previously). Modify t
procedure in the previous section “Procedure to combine datasets” as follows

• Do not delete the transforms from each layer

• The Zoom to All Datasets  step will generate a histogram for the attribute data
in each layer (needed).

• Open the Transform  dialog  and select Limits/Limits to Actual  for the 

final transform in each layer of your algorithm.  (On the Transform  dialog, you 

can use the  button to move between the layers and do this for each one

When you save the output dataset (the last step), each attribute band will be 
rescaled in a zero-to-255 (0-255) data range to allow direct comparison in tra
profiles.

You can also use a formula in each layer to normalize your data, for example
divide by the standard deviation.  (If you do this, you should delete the transfo
from each layer before saving the new dataset.)
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Note: When you normalize the data ranges, you lose the original data range associ
with each attribute.  You may want to create two datasets–one with the origin
data ranges, and another special version with normalized ranges for use in tra
profiling.
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Virtual datasets
This chapter explains how to create and use a special type of algorithm called
Virtual Dataset. Virtual datasets are a very powerful ER Mapper feature that a
you to work with data in an intermediate processed state without actually nee
to write the results to a file on disk.

About virtual datasets
A Virtual Dataset (“VDS” for short) is a special type of algorithm that can be u
as if it were a file on disk, except that the data is computed on demand so it t
no additional disk space. Virtual Datasets are an extension of the algorithms 
concept, so you can carry out processing on a raw dataset, then save the resu
“virtual” dataset for use as input for another algorithm. By saving processing 
results in a Virtual Dataset, you can define “views” into your data that can be 
in subsequent processing as if they were real datasets on disk. 

Virtual Datasets offer many advantages: 

• Reduced data complexity–layers that process combinations of bands can becom
single band of data in the virtual dataset. (For example, an isochron created f
two horizons.)

• Reduced disk storage–virtual datasets are computed on demand, so no extra d
storage is needed.

• Virtual image mosaics–two or more adjacent images can be merged and proce
as if they were a single image. (For example, horizons from adjacent surveys c
referenced as a single entity.)
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Note: The Image Balancing Wizard does not support Virtual Datasets, so the algori
would have to be balanced before being saved as a Virtual Dataset.

• Linking multiple datasets–link several datasets on disk together so they can be
accessed and processed as if they were bands in a single dataset. (For exam
multiple horizons stored as single-band files can be merged into one multiple-
file.)

• New types of data–datasets with different characteristics can be merged to cre
hybrid virtual datasets.

All of these types of operations can be saved as Virtual Datasets, thereby ma
the processing techniques used to create them transparent to the user.

Note: Virtual Datasets have restrictions to their usage. See the ‘Notes about using V
Datasets’ section at the end of this chapter for details.

Hands-on exercises
These exercises give you practice creating Virtual Datasets and understandin
to use them in subsequent image processing algorithms.

• Prepare an algorithm to be saved as a Virtual Dataset 

• Create algorithm layers for time, amplitude, dip, and azimuth computations, a
save them as pre-computed bands in a single Virtual Dataset 

• Load and use a Virtual Dataset 

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen.
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1: Creating a multiple band VDS

Open the sample seismic dip algorithm

1 Click the Edit Algorithm  toolbar button. 

An image window and the Algorithm  window appear.

2 On the main menu, click on the Open  button. 

3 From the Directories  menu, select the \examples path.

4 In the ‘Applications\Oil_And_Gas_Exploration’ directory, open the 
algorithm named ‘Seismic_Horizon_Dip.alg.’

This algorithm uses a formula operating on two inputs (values produced by 
easterly and northerly dip filters), and combines them to create a true dip ima
Dip images are useful for highlighting features such as the strike of faults, an
you view both sides of a fault. 

Prepare the Dip layer to be saved in a Virtual Dataset
Preparing an algorithm to be saved as a Virtual Dataset is very similar to prep
one for use in saving a new dataset to disk as you did earlier. You typically ne
define a description label to each layer, and delete the transform used to enh
the color mapping to the display.

1 On the Algorithm  dialog, change the ‘Pseudo Layer’ label to seismic 
dip then press Enter or Return.

By saving this layer as a band in a VDS, the filtering and formula calculations 
to produce the dip image will become transparent to the user.

Create a second layer that generates seismic azimuth

1 With the ‘seismic dip’ layer selected, click the Duplicate   button on the 
Algorithm  dialog.

A copy of the layer is added to the algorithm. Since the azimuth calculation w
on the same two easterly and northerly filters already used for the dip calcula
you can simply change the formula in the new layer to create an azimuth ima

Objectives Learn to create a Virtual Dataset (VDS) with four bands: inverted time, 
amplitude, dip, and azimuth. Also learn how to prepare an algorithm for use a
VDS, and save and use the VDS.
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2 In the new (lower) layer, change the current description label to read 
seismic azimuth , then press Enter or Return.

3 With the ‘seismic azimuth’ layer selected, click the Edit Formula   
button in the process diagram.

4 In the Formula Editor  dialog, select Azimuth from the Seismic menu.

ER Mapper replaces the previous dip formula with the formula that generates
seismic azimuth.

5 Click Close  on the Formula Editor  dialog to close it.

You have now added a second layer that processes the two-way time data to
perform the azimuth calculation. It will appear as the ‘seismic azimuth’ band i
your Virtual Dataset.

Create a third layer for the amplitude data
Since the other layers had filters and formulas already added, it is easier to a
empty new layer (rather than duplicating one) so you don’t have to delete the f
and formula that you don’t want for the amplitude data. You will need to load 
dataset and delete the transform again.

1 On the Algorithm  dialog, click the Edit  menu, choose Add Raster Layer , 
then choose Pseudo .

A third Pseudocolor layer (empty) is added to the algorithm layer list. 

2 With the new (empty) layer selected, click the Load Dataset   button in 
the process diagram.

3 From the Directories  menu, select the \examples  path. 

4 In the directory ‘Shared_Data’, double-click on the dataset ‘Seismic3D.ers’ 
to load it.

5 With the new layer still selected, choose B2:Amplitude  from the Band 
Selection  drop-down list in the process diagram.

The new layer is now set to process the amplitude data.

6 Enter the description label amplitude  for the new layer.

You have now created a third layer from scratch to process the amplitude data
no modifications. It will appear as the ‘amplitude’ band in your Virtual Dataset

Create a fourth layer for the inverted time data
Since the ‘amplitude’ layer already has the desired dataset, you can simply 
duplicate it, select band 1 (time), and modify the formula to invert the data.
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1 With the ‘amplitude’ layer selected, click the Duplicate   button on the 
Algorithm  dialog.

A copy of the ‘amplitude’ layer is added to the algorithm layer list. 

2 With the copied layer selected, choose B1:Two Way Time_ms from the 
Band Selection  drop-down list in the process diagram.

The new layer is now set to process the two-way time data.

3 In the new (lower) layer, change the description label to read inverted 
TWT (ms)  then press Enter or Return.

4 Click the Edit Formula   button in the process diagram.

5 In the Formula Editor  dialog, edit the text string “INPUT1” to add a minus 
sign (-) in front. Your formula should now look like this:

- INPUT1

6 Click Apply changes  on the Formula Editor  dialog.

7 Click Close  on the Formula Editor  dialog to close it.

You have now created a fourth layer to process and invert the two-way time da
will appear as the ‘inverted TWT (ms)’ band in your Virtual Dataset.

Reorder the layers in the algorithm
Because of the types of operations you were performing, it was easiest to crea
four layers in the current order. Now you can use buttons or drag-and-drop la
to put them in any order you prefer. (The order of the layers is the same as th
order of bands in the subsequent Virtual Dataset.)

1 Drag the ‘inverted TWT (ms)’ layer above the ‘seismic dip’ layer.

The time layer is now on top of the layer list.

2 Select the ‘amplitude’ layer, then click the Move Up   button twice to 
move it up two layers.

The ‘amplitude’ layer moves up two positions in the layer list. Your layer list in 
data structure diagram should now look like this:
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(If your list has a different order, drag-and-drop the appropriate layers or use 

Move Up  or Move Down  buttons until they are in the right order.)

You have now prepared an existing algorithm to be saved as a Virtual Datase
four layers are:

• ‘inverted TWT (ms)’–the original two-way time data, but inverted using a form
to reverse the polarity.

• ‘amplitude’–the original amplitude data with no modifications.

• ‘seismic dip’–a dip image derived from the two-way time data using the approp
filters and a formula.

• ‘seismic azimuth’–an azimuth image derived from the two-way time data using
appropriate filters and a formula.

Each layer has a description that will become its band label in the Virtual Dat
(‘amplitude,’ etc.), and each layer has the transform deleted to prevent rescal
the original or created data range.

2: Saving and using a VDS

Save the algorithm as a Virtual Dataset

Note: Before saving an algorithm as a Virtual Dataset, make sure all algorithm layers 
you wish to use are turned on. Layers that are turned off cannot be accessed in 
Virtual Dataset.

1 On the main menu, select Save as... .from the File  menu (or click the 

Save As...  button).

The Save As... dialog box opens.

2 In the Files of Type: field, select ‘ER Mapper Virtual Dataset (.ers)’.

3 From the Directories  menu, select the \examples  path. 

4 Double-click on the ‘miscellaneous\tutorial’ directory to open it.

5 In the Save As:  text field, type a name for the Virtual Dataset using your 
initials followed by the text ‘seismic_processing_VDS,’ and separate each 

Objectives Learn to save a Virtual Dataset and display and process it using another 
algorithm.
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word with an underscore (_). For example, if your initials are “DJ,” type in 
the name:

DJ_seismic_processing_VDS

Tip: It is often helpful to append the text “VDS” on the end of the name you assign
Virtual Dataset. This helps you easily determine that the dataset is virtual, and not 
an actual dataset file on disk.

6 Click OK to save the Virtual Dataset and close the file chooser dialog.

7 Click on the Yes button to query about deleting the output transforms.

Note: When creating algorithms for use as Virtual Datasets, you should usually dele
transforms for each raster layer to maintain the native data range of the input
dataset. Otherwise, the output data will be scaled or clipped according to the
current transform. (You can, however, use a transform to rescale the data if 
desired.)

The Virtual Dataset is actually saved as a small ASCII text file on disk that 
describes the processing and dataset used in each layer (very similar to an 
algorithm file). Because of this, it consumes almost no additional disk space.

Open a new window to display your Virtual Dataset
1 Close the current image window by selecting Close  from the File  menu.

2 On the main menu, click the New  button.

A new empty image window opens on the screen.

Load the Virtual Dataset into the algorithm

1 In the Algorithm  dialog, click the Load Dataset   button in the process 
diagram.
ER Mapper Workbook -  Seismic Geophysics Applications 211



Chapter 13 Virtual datasets z 2: Saving and using a VDS

k. 

fter 

ve 

t up in 
2 From the Directories  menu, select the path ending with \examples . 

3 Double-click on the ‘miscellaneous\tutorial’ directory to open it.

4 Double-click on your ‘seismic_processing_VDS.ers’ dataset to load it.

Note: Virtual Datasets have ‘.ers’ file extensions the same as actual datasets on dis
Therefore using “VDS” makes it easy to distinguish them quickly.

View the inverted time band in your Virtual Dataset
By default, the first band in a dataset (inverted time in this case) is selected a
loading it.

1 On the main menu, click the 99% Contrast Enhancement  button.

Band 1 of the Virtual Dataset (the inverted time data) displays.

Tip: The 99% Contrast Enhancement  toolbar button automatically sets the 

transform limits to actual and applies a 99% clip transform to the data (you ha
been doing this manually using the Transform  dialog previously). This shortcut 
lets quickly view each band with a basic color mapping enhancement.

View images for other “virtual” bands
1 Open the Band Selection  drop-down list in the process stream to see the 

four bands in your Virtual Dataset.

The band order and labels are the same as the layer order and labels you se
the algorithm you built earlier.

2 From the Band Selection  drop-down, select B2:amplitude .

3 On the main menu, click the 99% Contrast Enhancement  button.

99% Contrast 
Enhancement button
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The amplitude data (band 2) displays with a basic color mapping enhanceme

4 From the Band Selection  drop-down, select B3:seismic dip .

5 On the main menu, click the 99% Contrast Enhancement  button.

The seismic dip image displays with a basic color mapping enhancement. 
ER Mapper automatically creates the dip image on demand using the proces
steps (filters and dip formula) you set up when creating your Virtual Dataset.

6 From the Band Selection  drop-down, select B4:seismic azimuth .

7 On the main menu, click the 99% Contrast Enhancement  button.

The seismic azimuth image displays with a basic color mapping enhancemen
with the dip image, ER Mapper automatically creates the azimuth image on 
demand using the processing steps saved as part of your Virtual Dataset.

(You may wish to display the dip and azimuth images using the greyscale and
azimuth color tables respectively–click the Surface  tab to do this.)

By saving the dip and azimuth calculations as a Virtual Dataset, you have red
the complexity of the data, and no longer need to use the filters and formulas
future algorithms to generate these images. (ER Mapper does this for you 
automatically. This makes it easier for advanced users to quickly visualize an
manipulate data, and also for setting up data viewing for less sophisticated u

View information on the Virtual Dataset
1 On the Algorithm  dialog, click the Layer  tab (if needed), then click the 

Load Dataset  button. 

2 On the Raster Dataset  file chooser, click the Info...  button.

The Dataset Information  dialog indicates that the dataset is Virtual. Since it i
not actually a dataset on disk, it cannot be edited using the dataset header e

3 Click Cancel  to close the Dataset Information  dialog.

4 Click Cancel  to close the Raster Dataset  file chooser dialog.

Tip: If you need to edit a Virtual Dataset, re-open it using Open from Virtual 
Dataset  from the File  menu. The VDS will open into its original algorithm, so 
you can add or delete layers, make changes, and then re-save it again (usingFile/
Save As... ).
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  dialog to close it.

Only the ER Mapper main menu should be open on the screen.

• Prepare an algorithm to be saved as a Virtual Dataset 

• Create algorithm layers for time, amplitude, dip, and azimuth computations, a
save them as pre-computed bands in a single Virtual Dataset 

• Load and use a Virtual Dataset

Notes about using virtual datasets
From the user’s point of view, a Virtual Dataset is very similar to saving a data
to disk, but it uses only a few kilobytes of disk space. By saving the algorithm
processing steps as a Virtual Dataset, you have greatly simplified the complex
the data and gained faster access to it. For example, ER Mapper now perform
dip calculation automatically “behind the scenes” so you don’t need to use th
filters and formula in your display algorithm. Or, the two-way time data is now
automatically inverted, so no negation formula is needed to perform that oper

Virtual Datasets do have some limitations. You may consider saving the algor
as an actual dataset on disk if these are important. These limitations include:

• You cannot use the Cell Value Profile  or Traverse  features under the View  
menu. You can only use these features on real raster datasets stored on disk

• You cannot perform a rectification on a Virtual Dataset (see the ‘Map Projecti
chapter), or export a VDS using the Utilities/Export  options.

• The Virtual Dataset header file (for example ‘seismic_vds.ers’) contains pointe
the actual datasets. For example, the VDS you created in this exercise referen
actual dataset ‘Seismic3D.ers.’ If you were to move this dataset to a different
directory, you could no longer use the Virtual Dataset as is. The solution is to
File/Open from Virtual Dataset  option, then reload the dataset from its new
directory (to update the pointer) and re-save the VDS.

• If you zoom into an area and then save the algorithm as a Virtual Dataset, 
ER Mapper assumes the zoom extents to be the entire extents of the Virtual Da
(After loading the VDS, you cannot zoom back out to the original dataset’s exte
This is a useful feature for map making, but one to be aware of when saving a

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Compressing
images

This chapter shows you how to save your images in ECW compressed forma

About ECW compression
ER Mapper compresses images using wavelet compression technology whic
offers very high quality results at high compression rates.  You can typically 
compress a color image to less than 2% to 5% of its original size (50:1 to 20:
compression ratio) and compress a grayscale image to less than 5% to 10% 
original size (20:1 to 10:1 compression ratio). 

This means that, at 20:1 compression, 10GB of color imagery will compress d
to 500MB, which is small enough to fit on to a single CD-ROM. You may actua
achieve higher compression rates where your source image has a structure w
suited to compression.

In addition to reducing storage requirements, you can also use the free image
plug-ins for GIS and office applications to read the compressed imagery in a 
range of software applications such as ArcView®, AutoCAD MAP®, MapInfo®
ER Viewer, Photoshop™, Microsoft Office® and Excel®, and other software 
applications. 
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Saving a compressed image to disk

Input image to be compressed
1 From the main ER Mapper File  menu, select Open from a Virtual 

Dataset...

2 From the Open  dialog Directories  menu, select the \examples  path.

3 Open the ‘Miscellaneous\Tutorial’ directory, then double-click on the 
‘Seismic_Processing_VDS.ers’ virtual dataset you created in the previous 
exercise.

This will open the algorithm that you used to create the Virtual Dataset, and no
Virtual Dataset itself. This enables you to make any changes before compres
the image.

4 Click on the Standard  toolbar 99% Contrast Enhancement   button.

This will make the image visible.

Note: It is not generally advisable to do a 99% Contrast Enhancement on an image
before compressing it because the compressed image will be different to the 
original. 

5 From the main ER Mapper File  menu, select Save as a Compressed 
Image .

Objectives Learn how to save multiband images in compressed format using the ER Map
ECW compression.
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The Compression Wizard  will open.

6 Select the Use the current algorithm window option as the source of the 
image(s) to be compressed and click on the Next >  button.

In addition to using an algorithm as the source image to be compressed, you 
specify any other file format supported by ER Mapper, such as ESRI BIL, TIF
JPG as the input.

Compressed image file name

7 In the Output file:  field, click the Select File  button. 

8 From the Directories  menu, select the \examples  path.

9 In the Select File  dialog, choose ER Mapper compressed images (.ecw) in 
the Files of Type  field.

10 Open the ‘Miscellaneous\Tutorial’ directory.

11 In the Open:  text field, enter the text 
<your initials> _seismic_processing_compressed , and 
separate each word with an underscore (_).

12 Click OK on the Select File dialog.

Your file name appears as the Output File  name with a ‘.ecw’ extension. 
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ER Mapper will save the compressed image as a header (.ers) and a compre
data (.ecw) file. You can use File / Open  or one of the wizards to open the head
(.ers) or data (.ecw) file just like any other image file supported by ER Mappe

Note: The data (.ecw) file contains embedded georeferencing information, so the h
(.ers) file can be dispensed with if the compressed image is to be used in 
applications other than ER Mapper. 

Compress to Grayscale, RGB or Multi
13 In the Compress to:  field, select the Multiband  option.

The compression engine will compress all four bands of the multi-band image
This is a unique feature of ECW v2 compression in that it allows you to acces
individual bands in a hyperspectral compressed image rather than just enabli
you to view the image as color RGB or Grayscale.

Other compression options available are:

Grayscale The compression engine constructs and compresses
grayscale view of your input image data using the 
normal formula for Intensity from Red, Green and Blu

Color (RGB) The compression engine internally converts the RGB
color image into YUV color space, specifically the one
defined as the "JPEG Digital version of YUV".  YUV is
a color space that separates out intensity (Y) from 
chromatic or color changes (U and V). This enables 
more efficient compression of color imagery, ensuring
that detail is preserved.  The RGB to YUV conversion
(and back again for decompression) is automatic; the
user always sees the file as a RGB file.

14 Click on the Next >  button to continue
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15 Check the Compress for Internet  usage box.

This option is for compressed images to be served on an ER Mapper Interne
Server (IWS). The transfer rate over a network for images compressed with t
option is higher, thus allowing faster zooming and roaming. However, the actu
compression ratio achieved will be less than that for images compressed with
this option. For more information on the IWS, refer to the ER Mapper web site
http://www.ermapper.com.

16 If necessary change the Colorscale ratio:  to 10  and click on the 
Recompute desired output size  button.

This value is the desired compression ratio that you would like to achieve.  Fo
example, you might specify a ratio of 20:1 for an input file of 1,000MB to achie
a desired a 50MB compressed image (so the output image is 5% of the size 
input image).

The Compression Wizard uses the Target Compression ratio as a measure o
much information content to preserve in the image; i.e as a quality indicator.  
however, your image has areas that are well suited to compression, a greater 
compression may be achieved while still achieving the desired information 
content. The actual compression ratio could also be less than the target if you
compressing small files. The Compression Wizard uses multiple wavelet enco
techniques at the same time, and adapts and chooses the best technique de
on the area currently being compressed.
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Note: The image in this example is too small to really show the ECW compression 
capabilities. 

17 Click on the Finish  button to start the compression process.

Compression process
A status dialog will display the progress of the compression. When the 
compression is complete, a dialog will display the Target and Actual compres
rates.

The actual compression ratio achieved is 1.6:1, which is not particularly good.
is because the input image file size is much smaller than what you would norm
compress. ECW compression is most effective on images with very large file 

Except when compressing very small files (less than 2MB in size), the Actual
compression ratio will generally be greater than the Target compression ratio

Open a new window to display your compressed image

1 On the main menu, click the New  button.

A new empty image window opens on the screen.

Load the compressed image into an algorithm

1 Click on the Edit Algorithm   button on the Common Functions  
toolbar to open the Algorithm dialog.

2 In the Algorithm  dialog, click the Load Dataset   button in the Pseudo 
Layer process diagram.

3 From the Directories  menu, select the path ending with \examples . 

4 Double-click on the ‘miscellaneous\tutorial’ directory to open it.
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5 Double-click on your ‘seismic_processing_compressed.ecw’ image to load 
it.

View images for compressed bands
1 Open the Band Selection  drop-down list in the process stream to see the 

four bands in your compressed.

The labels are the same as the those you set up in the original algorithm. The
order is reversed.

2 From the Band Selection  drop-down, select B4:inverted TWT (ms) .

3 The inverted TWT data (band 4) displays with a basic color mapping 
enhancement.

4 From the Band Selection  drop-down, select B3:amplitude .

The amplitude data (band 3) displays with a basic color mapping enhanceme

5 From the Band Selection  drop-down, select B2:seismic dip .

The seismic dip image displays with a basic color mapping enhancement. 

6 From the Band Selection  drop-down, select B1:seismic azimuth .

The seismic azimuth image displays with a basic color mapping enhancemen

(You may wish to display the dip and azimuth images using the greyscale and
azimuth color tables respectively–click the Surface  tab to do this.)

View information on the compressed image
1 On the Algorithm  dialog, click the Layer  tab (if needed), then click the 

Load Dataset  button. 

2 On the Raster Dataset  file chooser, click the Info...  button.

The Dataset Information  dialog displays the image information which you ca
edit using the dataset header editor.

3 Click Cancel  to close the Dataset Information  dialog.

4 Click Cancel  to close the Raster Dataset  file chooser dialog.
ER Mapper Workbook -  Seismic Geophysics Applications 223



Chapter 14 Compressing images z Saving a compressed image to disk

 in 
Close the image windows and dialog boxes
1 Close the image windows using the window system controls:

• For Windows, click the  Close  button in the upper-right window corner.

2 Click Close  on the Algorithm  dialog.

Only the ER Mapper main menu should be open on the screen

• Save the image in compressed format using the ECW compressor.

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Map projections
This chapter explains concepts related to geometrically correcting datasets to
world coordinate systems and map projections, and how to transform a datas
from one projection system to another.

Note: For more information on registering images to map projections in ER Mapper
the section ‘Notes on dataset registration’ at the end of this chapter and the 
ER Mapper User Guide manual.

About map projections
Whenever accurate area, direction and distance measurements are required,
image data must usually be processed to remove geometric errors and rectify
image to a real world coordinate system. Seismic datasets are usually correc
and registered to a specific datum and map projection during the processing 
performed in gridding and interpreting the raw seismic data. Sometimes, how
you may need to rotate a dataset to re-orient it, or transform the dataset from
projection system to another. ER Mapper also provides the capability register
dataset to another by choosing common points (called ground control points,
GCPs) on both images.

ER Mapper provides a library of over 700 standard map projections for large a
or specific regions of the world. You can use any of the standard datums and 
projections, and add your own datums and projections to ER Mapper’s library
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ER Mapper’s Geocoding utilities are commonly used to perform different type
operations:

• Image to map rectification–using triangulation or polynomial (control point) 
warping to rectify an image to a datum and map projection using GCPs.

• Image to image rectification–using triangulation or polynomial (control point) 
warping to rectify one image to another using GCPs.

• Orthorectification -a more accurate form of rectification that takes into accoun
terrain variations and camera characteristics. This is normally used for airpho

• Known point registration - registering a point (normally cell 0,0) on an image t
world coordinate values.

• Map to map reprojection–transforming a rectified image from one datum/map
projection to another.

• Image rotation–rotating an image any number of degrees.

For seismic horizon datasets, the last two functions are most commonly used
(since the datasets are usually already transformed into a specific projection)
can also use ER Mapper’s Geocoding utilities to simply resample a dataset fr
one cell size to another without performing any geometric correction or rotatio

Hands-on exercises
These exercises give you practice using ER Mapper’s Rectification features.

• Choose a particular datum and map projection

• Transform a dataset from one map projection to another

• Rotate an image any number of degrees

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen.
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In some cases you may find it necessary to transform a dataset from one ma
projection to another. For example, if your seismic horizon and another datase
in two different map projections, you would need to transform them to a comm
projection so the datasets could be accurately combined or overlaid.

Run the Geocoding Wizard
1 From the Process menu, select Geocoding Wizard, or click on the Ortho 

and Geocoding Wizard   button on the Common Functions  toolbar.

The first page of the Geocoding Wizard opens. This allows you to enter the fi
name of the image to be geocoded and to specify the type of geocoding.

Enter the image file name

1 Click the File chooser  button.

2 From the Directories  menu, select the \examples path .

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_Realtime_Sun_Shade.alg’ to select it.

The geocoding wizard Input File  field will indicate that the ‘Seismic3D.ers’ 
dataset is selected.

4 Select Map to map reprojection  for the Geocoding Type .

Objectives Learn how to use ER Mapper’s Geocoding utilities to perform a map-to-map 
reprojection.
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View the datum and map projection of the dataset
1 On the Geocoding Wizard. dialog, click the 2) Map to Map Setup  tab.

The Input Coordinate Space field shows that the dataset is rectified to the 
‘AGD66’ datum (Australian Geodetic Datum 1966) and the ‘TMAMG56’ map 
projection (Australian Map Grid Transverse Mercator, Zone 56).

Tip: To find the actual datum and projection names associated with the ER Mappe
mnemonic strings, see Appendix D in the ER Mapper User Guide.

Setup the TMAMG66 to UTM projection transformation
For this example, assume that you have several other associated datasets al
registered to the UTM (Universal Transverse Mercator) map projection system
You want to transform the ‘Seismic3D’ dataset to the appropriate UTM projec
so it can be combined or overlaid with the other datasets.

The Output Coordinate Space box lets you define the output datum and ma
projection.

1 Click the Projection   file chooser button.

The Projection Chooser  dialog opens. Directories of projection types are 
shown in the left column, and specific projections within the selected directory
shown on the right.

2 Scroll down to the bottom of the left column, then click on the ‘utm’ 
directory to open it.
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3 In the list of UTM projections on the right, scroll down to one named 
‘SUTM55’ and double-click on it to select it.

SUTM55 (South Universal Transverse Mercator, Zone 55) is the appropriate U
map projection for this part of the world. (Assume the datum is already consis
with the other datasets, so you won’t change it here.)

Note: The Optimize speed  option is designed to speed the transformation process
at the expense of slightly less absolute accuracy. When transforming very lar
datasets speed can be an issue, in this simple example it does not matter.

Perform the projection transformation
1 Click the Geocodiing Wizard 3) Rectify  tab.

2 Click the File   file chooser button on the Output Info  box.

3 From the Directories  menu, select the \examples  path. 

4 Double-click on the ‘miscellaneous\tutorial’ directory to open it.

5 Enter the filename ‘Seismic3D_UTM’ (prefix the name with your initials), 
then click OK.

6 Leave the Cell Attributes box fields as they are.

7 Do not select the Display rectified image  option.

This option causes the wizard to display the reprojected image on completion
the reprojection. For this exercise, we will display the dataset later in an algor

8 Click the Save Files and Start Rectification.

ER Mapper opens a status dialog to indicate the progress of the rectification.
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ER Mapper saves the new projection information in the ‘Seismic3D.ers’ head
file, and creates a new dataset ‘Seismic3D_UTM.ers’ that has the new projec

9 When the operation finishes, click OK of the successful completion dialog. 
Then click Close on the Geocoding Wizard dialog.

You have now transformed the Seismic3D dataset and created a new datase
rectified to the UTM map projection system.

Display the new UTM-projected dataset

1 On the main menu, click the Open   button.

An empty image window and the Open dialog box appear.

2 In the Files of Type: field, select ‘ER Mapper Algorithm (.alg)

3 From the Directories  menu, select the \examples path.

4 In the ‘Applications\Oil_And_Gas_Exploration’ directory, double-click on 
the algorithm ‘Seismic_Horizon_Realtime_Sun_Shade.alg’ to open it.

The algorithm will display the image with the original ‘Seismic3D.ers’ dataset

5 On the main menu, click the Copy Window  button.

ER Mapper makes a copy of the current algorithm in a new image window. M
the new window so you can see the original underneath.

6 On the main menu, click the Load dataset   button.

The Raster Dataset  file chooser appears. You will load your UTM dataset into
the copied algorithm to compare it with the original.

Copy Window 
 button

Load dataset button
230 ER Mapper Workbook -  Seismic Geophysics Applications



Chapter 15#Map projections#z 2: Dataset rotation

inal. 
rid 

p 
on or 
 

Tip: The second set of buttons on the Common Functions toolbar have the same 
function as the corresponding buttons on the Algorithm  dialog. It is often faster to 
access those functions directly as you are doing here.

7 From the Directories  menu, select the \examples  path. 

8 Double-click on the ‘miscellaneous\tutorial’ directory to open it, then 
double-click on the ‘Seismic3D_UTM.ers’ dataset with your initials to load 
it.

Notice that the new image is slightly rotated and skewed compared to the orig
This is the effect of transforming the dataset from the original Australian Map G
projection system to the UTM system.

Close the image window containing the UTM dataset
1 Using the window system controls, close the image window containing the 

transformed UTM dataset:

• For Windows, click the  Close  button in the upper-right window corner.

2: Dataset rotation

In some cases you may find that a dataset has the appropriate datum and ma
projection, but has been rotated a number of degrees from north for one reas
another. (Sometimes datasets are rotated by ER Mapper during the importing

Objectives Learn how to use ER Mapper’s Rectification utilities to rotate a dataset any 
number of degrees.

Seismic3D Seismic3D_UTM
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process to make them fit in the most efficient file size.) This example shows ho
perform a simple rotation of dataset while keeping the same projection and c
size.

Setup the dataset rotation
1 From the Process  menu, select Geocoding Wizard... ,

The Geocoding Wizard dialog box opens on the first page that allows you to
enter the file name of the image to be rotated, and select the type of geocodin
which, in this case, is Rotation.

2 Click the Input File   file chooser button.

3 From the Directories  menu, select the \examples  path. 

4 Double-click on the ‘Shared_Data’ directory to open it, then double-click on 
the dataset ‘Seismic3D.ers’ to load it.

5 Select Rotation  for the Geocoding Type .

6 Click the Geocoding Wizard 2) Rotation Setup tab.

The Rotation Setup wizard page lets you define the number of degrees of 
rotation.

7 In the Rotation  field, type the value 45 , then press Return or Enter to 
validate.

This tells ER Mapper to rotate the dataset 45 degrees counter-clockwise. (To 
clockwise 45 degrees, you would enter -45 .)

Perform the dataset rotation
1 Click the Geocoding Wizard 3) Rectify tab.

2 Click the output info File   file chooser button.

This enables you to specify the file name of the rotated dataset.

3 From the Directories  menu, select the \examples  path. 

4 Double-click on the ‘Miscellaneous\Tutorial’ directory to open it.

5 Enter the filename ‘Seismic3D_45_rotated’ (prefix the name with your 
initials), then click OK.

6 Click the Save File and Start Rectification  button to start the rotation.

ER Mapper opens a status dialog to indicate the progress of the rectification.

7 When the operation finishes, click OK of the successful completion dialog. 
Then click Cancel  on the Rectify Dataset  dialog.
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You have now created a new dataset rotated 45 degrees counter-clockwise.

8 Click the Geocoding Wizard Close button to exit the wizard.

Display the new rotated dataset

1 On the main menu, click the Copy Window  toolbar button.

ER Mapper makes a copy of the current algorithm in a new image window. M
the new window so you can see the original window underneath.

2 On the main menu, click the Load dataset   toolbar button (it has a 
yellow background).

The Raster Dataset  file chooser appears. You will load your rotated dataset in
the copied algorithm to compare it with the original.

3 From the Directories  menu, select the \examples  path. 

4 Double-click on the ‘miscellaneous\tutorial’ directory to open it, then click 
once  on your ‘Seismic3D_45_rotated.ers’ dataset to select it.

5 Click the Apply  button to load the dataset without closing the dialog.

The new dataset is rotated exactly 45 degrees counter-clockwise from the ori
The rotated dataset appears smaller, but it actually has the same cell size as
original. Null cells have been added around the edges of the new dataset to f
the raster grid to a rectangle, so the actual file size is larger than the original.

View information on the new dataset
1 On the Raster Dataset  dialog, click the Info...  button.

The Dataset Information  dialog displays. The information shows that the 
dataset has the same projection and other parameters as the original dataset
that it has been rotated 45 degrees.

Note: Rotating a dataset does not change the geographic location of the dataset ce
pixels. To verify this, select Cell Coordinate  from the View  menu and compare 
the coordinate locations of the same features in the two image windows.

2 Click Cancel  on the Dataset Information  and Raster Dataset  dialogs to 
close them.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls or by selecting 

Close  from the File  menu.

Only the ER Mapper main menu should be open on the screen.

• Choose a particular datum and map projection

• Transform a dataset from one projection to another

• Rotate an image any number of degrees

Notes about registering datasets

When you open or import a dataset in ER Mapper, sometimes the map projec
details are not carried through to the ER Mapper format file. The main reason
this is lack of a standard way of encoding map projections that all software 
products can understand. If the map projection details are not carried through
can edit the ER Mapper dataset header (.ers) file to add them. Typically you n
to query this information from your seismic interpretation software, then transf
into ER Mapper.

There are four key pieces of information that ER Mapper needs in order to 
properly register a dataset:

Datum & Projection–The geodetic datum and map projection to which the 
seismic grid has been registered. You must choose a specific text string from
ER Mapper’s library that represents the correct datum and projection (see theUser 
Guide manual). You can also add datums and projections to ER Mapper’s libra
the ones you need are not already provided (most already are).

Rotation–The number of degrees the dataset has been rotated from north. 
ER Mapper always records this information during import (no editing needed)

Registration point–The true earth location of one pixel in the dataset. You nee
four values here: a registration cell (row and column location of the pixel) and
registration coordinate (the true earth location of that pixel, usually expressed
Lat/Long or Eastings/Northings). Usually this information is transferred to the
ER Mapper file during import, however it is possible you may need to edit it 
occasionally.

Cell size–The dimensions that a single pixel occupies on the earth (pixel size 
ground sample distance). Usually this information is transferred to the ER Ma
file during import, however it is possible you may need to edit it occasionally. T
value is always expressed in meters. (The only exception is decimal degrees
geodetic map projection.)

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Editing the ER Mapper header (.ers) file

In the most typical case, you will need to edit the ER Mapper file to add the co
Datum and Projection. Some ER Mapper import utilities prompt you to specify
Datum and Projection during the import process, in which case the informatio
will be added to the header file automatically. Occasionally you may also nee
add the registration point and cell size information.

To edit the header file and add or change the registration information, first ope

Raster Dataset  dialog using the Load Dataset   button. Click once on the 

dataset name (.ers file) to select it, then click the Info  button to display the 
Dataset Information dialog (as you did in the previous exercise). Then use t
following sequence of buttons to access the appropriate editor fields to add o
change the information:

• To edit the datum and/or projection name, select Edit->Coordinate Space

(You will need to consult the ER Mapper Reference manual for the text strings 
ER Mapper uses for specific datums and projection first.)

• To edit the registration point, select Edit->Raster Info->Registration Point

• To edit the cell size, select Edit->Raster Info->Cell Size

When finished, click OK on all dialogs to save the new information.
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Vector and
tabular data

This chapter explains how to use ER Mapper to add overlays of vector and ta
data from external products and sources.

About vector data and Dynamic Links
In addition to drawing your own annotation using ER Mapper’s drawing tools, 
can also display vector data imported from other applications, and link directl
data in external formats without translation. These functions can be useful for
overlaying geological interpretations stored in vector format, or linking to and 
displaying tabular data (such as well locations) or vector data (such as lease 
boundaries) in external formats.

Vector data can come from GIS products or external file formats such as DXF
Postscript. Typical uses for vector Dynamic Links include displaying subsurfa
geological interpretations, surface geology, or cultural data such as lease 
boundaries or road networks. You also use ER Mapper’s contours feature to 
automatically create contours and labels for horizons or other datasets.

Tabular data can come from database products or tabular data files. ER Mapp
display tabular (point) data as colored circles of varying sizes. This capability
useful for applications such as plotting the locations of wells, drill sites, samp
sites, and so on.
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Hands-on exercises
These exercises introduce you to the basic features for displaying vector and
tabular data in ER Mapper.

Note: Most of the following exercises uses a satellite image as the reference raster 
for overlaying vector and tabular data, but the same concepts apply to using 
seismic or other geophysical datasets.

• Add annotation layers to display vector data stored in ER Mapper format (.erv

• Add Tabular Data layers to display data stored in tabular text format (.tbl)

• Add Dynamic Link layers to display data stored in an external vector GIS form

• Generate a contour layer and labels

• Change the order and display priority of vector layers

1: Overlaying vector data

Load a greyscale satellite image algorithm

1 On the main menu, click the Edit Algorithm  button.

An image window and the Algorithm  dialog box appear.

2 Click the Open  button. 

3 From the Directories  menu, select the \examples  path.

4 Open the ‘Data_Types’ directory, then open the ‘SPOT_Panchromatic’ 
directory.

5 Double-click on the algorithm named ‘Greyscale.alg.’

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Mapper:

Objectives Learn to add a layer to an algorithm to display vector data imported from an 
external format. In this case you will overlay vectors for a road network 
previously imported using ER Mapper’s vector import utilities.
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The algorithm displays a satellite image of the San Diego, California area from
SPOT satellite system. The dataset has 10-meter spatial resolution, so it prov
good detail and is often used for base mapping applications.

Display the GIS toolbar
1 On the main menu, select GIS from the Toolbars  menu.

ER Mapper adds a third row of toolbars buttons to the main menu. These but
give you fast access to features for displaying and editing vector and tabular 
datasets.

Add an Annotation layer and display a vector roads dataset

1 On the Common Functions toolbar, click the Annotate Vector Layer   
button.

The New Map Composition  dialog opens.

GIS toolbar

Annotate Vector
Layer  button
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2 With the ‘Vector File’ option selected, click the  button to the right of the 
‘Load from File’ field.

The Load Map Composition File  dialog opens.

3 From the Directories  menu, select the \examples  path.

4 Open the ‘Shared_Data’ directory, then double-click on the dataset 
‘San_Diego_roads.erv’ to load it.

5 Click OK on the New Map Composition  dialog.

ER Mapper runs the algorithm again and displays a vector road network as a 
overlay. The Tools  dialog also opens to let you edit the vectors to add, delete 
modify them if desired. Also notice that an ‘Annotation layer’ has been added
the algorithm layer list. 

(This is a vector dataset of roads in the greater San Diego area. It was previo
imported from a Digital Line Graph (DLG) file format using the ER Mapper 
import utilities and converted to an ER Mapper format vector file with an “.erv
file extension.)

Label the vector layer and choose a color
1 Click Close  on the Tools  dialog to close it.

(Use of the annotation tools is covered in the chapter on Map Composition.)

Notice that the process diagram for the vector layer includes only three button
The image processing options such as formulas and transforms do not apply
vector layers.

2 Change the Annotation layer’s label text to San Diego roads and press 
Enter or Return.

3 In the process diagram, click the Edit Layer Color  button.

select Vector File

click to load vector 
dataset
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4 Choose a red color, then click OK to close the Color  chooser dialog.

The roads redraw in red this time. Vector layers are designed to show line da
such as interpreted faults or lease block boundaries on a time surface.

2: Overlaying tabular data

Turn off the vector roads layer
1 Turn off the vector ‘San Diego roads’ layer by right-clicking the layer and 

selecting Turn Off .

(This will make it easier to see the tabular data where there is overlap.)

Add a Tabular Data layer and load a sample dataset

1 On the GIS toolbar, click the Show Tabular Data  button.

The Tabular Dataset  dialog opens.

2 On the Tabular Dataset  dialog, click the Load Dataset   button.

3 From the Directories  menu, select the \examples  path.

4 Open the ‘Data_Types\SPOT_Panchromatic’ directory, then double-click on 
the dataset ‘San_Diego_Fire_Stations.tbl’ to load it.

5 Click OK on the Tabular Dataset dialog.

ER Mapper runs the algorithm and displays the location of each fire station a
white circle. Also notice that a ‘Table of Data as Circles’ layer has been adde
the algorithm layer list. (To display the circles, ER Mapper is accessing data i
external ASCII text file with an Easting and Northing value for each location a
other information.)

Objectives Learn to add a layer to an algorithm to display point data stored in a tabular 
format. (The examples used here are fire station locations, but they could jus
easily be well locations on an interpreted time surface.)

Show Tabular
Data button
ER Mapper Workbook -  Seismic Geophysics Applications 241



Chapter 16 Vector and tabular data z 3: Overlaying GIS vector data

s. 

ed to 

 
 can 
 text 

d 
ill 
Label the tabular layer and choose a color
Notice that the process diagram for the tabular layer includes only two button

You can use the Edit Dynamic Link   button to choose a different tabular 

dataset, or the Edit Layer Color   button to change the color.

1 Change the Table of Data layer’s label text to fire stations and press 
Enter or Return.

2 In the process diagram, click the Edit Layer Color  button.

3 Choose a cyan (light blue) color, then click OK to close the Color chooser 
dialog.

The table data circles redraw in cyan this time. Tabular data layers are design
show point data, such as the locations of wells on a time surface.

Tip: ER Mapper looks for files with the extension “.tbl” for Table of Data layers. To
view the format of these files, open any of the sample files in a text editor. You
create your own table data files by converting your data into this simple ASCII
format and naming the file with a “.tbl” extension.

3: Overlaying GIS vector data

Turn off the Tabular Data layer
1 Turn off the vector ‘fire stations’ layer by right-clicking the layer and 

selecting Turn Off .

(This will make it easier to see the GIS data where there is overlap.)

Add an ARC/INFO layer and link to a workspace

1 On the Common Functions toolbar, click the Annotate Vector Layer   
button.

The New Map Composition  dialog opens.

Objectives Learn to add a Dynamic Link layer to an algorithm to display vector data store
in an external GIS product format (ARC/INFO in this case). In this case, you w
display a network of roads stored in an ARC/INFO format coverage file.
242 ER Mapper Workbook -  Seismic Geophysics Applications



Chapter 16#Vector and tabular data#z 3: Overlaying GIS vector data

e 
.

re, 

 area 
2 Select the ‘ARC/INFO Coverage’ option, then click the  button to the 
right of the ‘Load from File’ field.

The ARC/INFO Chooser dialog opens to let you choose the workspace and 
coverage you want to link.

3 On the ARC/INFO Chooser  dialog, click the ‘Workspace’  button.

The ARC/INFO Workspaces  dialog opens to let you specify the location of th
workspace directory containing the ARC/INFO coverage files on your system

4 From the Directories  menu, select the \examples  path.

5 Click on the ‘Shared_Data’ directory to select it.

6 Click only once on the directory named ‘arc_info_workspace’ to select it, 
then click the Select  button.

The ARC/INFO Chooser dialog now shows the selected workspace, and the 
‘Coverage’ drop-down list shows the available GIS vector coverages.

Note: To view ARC/INFO coverages, you select (not open) a directory as shown he
then ER Mapper will displays a list of coverages in the directory.

Choose a workspace and coverage to display
1 From the ‘Coverage’ drop-down list, select lajollards .

This coverage contains vectors representing the road network for the La Jolla
of San Diego (covering the northern portion of this SPOT satellite image).

2 Select 1.0 from the Line Width drop-down list.

3 Click OK on the ARC/INFO Chooser  dialog.

select ARC/INFO

click to load
coverage

Coverage
ER Mapper Workbook -  Seismic Geophysics Applications 243



Chapter 16 Vector and tabular data z 3: Overlaying GIS vector data

ds in 

at an 

and 

rs.

dless 
or 
r or 

now 
4 Click OK on the New Map Composition dialog.

ER Mapper runs the algorithm again and displays a large area network of roa
the La Jolla area (upper half of the SPOT image). The Tools  dialog also opens to 
let you edit the vectors and attributes of the coverage if desired. Also notice th
‘ARC/INFO Layer’ has been added to the algorithm layer list.

(This data was accessed directly from an ARC/INFO coverage file, so no file 
translation was needed to display it. You can also edit ARC/INFO coverages 
save them back to coverage format.)

Label the layer and choose a line color
1 Click Close  on the Tools  dialog to close it.

2 Click the Edit Layer Color  button in the ARC/INFO layer’s process 
diagram.

3 Choose a yellow color, then click OK to close the Color chooser dialog.

4 Change the ARC/INFO layer’s label text to La Jolla roads and press 
Enter or Return.

Turn on all three color layers
1 Turn on the ‘San Diego roads’ and ‘fire stations’ layers (right-click them and 

select Turn On ). 

The algorithm now includes the vector, tabular and ARC/INFO direct link laye

Note: Vector layers always appear on top of any raster layers in an algorithm, regar
of their position in the layer list. Relative to each other, the uppermost vector 
tabular layer has display priority where there is spatial overlap with other vecto
tabular layers.

2 Move the ‘fire stations’ layer to the top of the layer list by dragging and 
dropping it.

The ‘fire stations’ tabular layer moves above the other two vector layers, so it 
has the highest display priority.

The circles representing fire station now appear on top of the vector roads 
overlays.
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4: Overlaying contour lines and labels

Open the sample TWT colordrape algorithm

1 On the main menu, click the Open  button. 

2 From the Directories  menu, select the \examples  path.

3 In the ‘Applications\Oil_And_Gas_Exploration’ directory, open the 
algorithm named ‘Seismic_Horizon_Colordrape.alg’

This algorithm displays two-way time in color draped over shaded two-way tim
enhance structural features in the horizon.

Add a Contours layer to the algorithm
1 On the Algorithm  dialog, open the Edit  menu, choose Add Vector Layer , 

then choose Contours .

A ‘Contours’ layer is added to the algorithm layer list.

Specify the dataset and parameters for contouring

1 On the Algorithm  dialog, click the Dynamic Link Chooser  button in 
the process diagram. 

Objectives Learn to add a Contours layer to an algorithm to automatically generate conto
lines and labels.
ER Mapper Workbook -  Seismic Geophysics Applications 245



Chapter 16 Vector and tabular data z 4: Overlaying contour lines and labels
The Contouring Wizard dialog opens.

2 Click the File:   file chooser button.

3 From the Directories  menu, select the \examples  path.

4 In the directory named ‘Shared_Data’, double-click on the ‘Seismic3D.ers’ 
dataset to load it.

5 Deselect the Make contours multi-color  option and select the Label 
contours  option.

6 Click on the Next>  button.

7 In the Set contours style  dialog, set the Contour Interval  to 50 .

8 Click the Finish button.
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Black contour lines are drawn over the image at 50 unit spacing (the spacing
two-way time data values). The lines have labels to indicate the contour level

Change the contouring interval and coloring
1 Right-click the ‘Pseudo Layer’ in the layer list and select Turn Off .

The image will now be displayed in greyscale (since the color layer is off).

2 Select the ‘Contours’ layer again, then click the Dynamic Link Chooser 

 button in the process diagram to open the Contouring Wizard.

3 On the Contouring Wizard dialog, select both the Make contours multi-
color  and Label contours  option.

4 Click on the Next>  button.

5 For Contour Interval, enter 25 .

6 Click the Finish button.

The image first displays as greyscale (since you turned off the Pseudocolor la
then contour lines are drawn at 25 unit intervals with a different color for each
interval. 

Close all image windows and dialog boxes
1 Close the image window using the window system controls or by selecting 

Close  from the File  menu.

2 Click Close  on the Algorithm  dialog to close it.

3 On the main menu, select GIS from the Toolbars  menu to hide the GIS 
toolbar.

Only the ER Mapper main menu should be open on the screen.

• Add annotation layers to display vector data stored in ER Mapper format (.erv

• Add Tabular Data layers to display data stored in tabular text format (.tbl)

• Add Dynamic Link layers to display data stored in an external vector GIS form

• Generate a contour layer and labels

• Change the order and display priority of vector layers

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Composing
maps

This chapter explains how to use ER Mapper’s Page Setup and Map Compos
tools to create top quality cartographic maps. You will learn about setting up a
page size, scale and extents for your map, how to draw vector interpretations
add map objects such as coordinate grids and scale bars, and considerations
printing to hardcopy devices. 

Note: The following exercise is a simplified example of creating a map. More details
some aspects are provided at the end of the chapter, and you are referred to ER 
Mapper User Guide manual for more complete information.

About map composition
ER Mapper provides a complete set of map composition tools that let you eas
transform images into top quality image maps. Your maps can include comm
map objects such as coordinate grids, scale bars, symbols, legends, north ar
and more. You can use the annotation tools to draw lines, text, shaded polygo
and other vector objects. Your maps can also include other layers to add vec
data from GIS systems, tabular data, or other external data. 
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ER Mapper’s map composition also has an open design and is user-extendab
You can add your own Postscript map objects to ER Mapper's map object libr
such as company logos or north arrows, include external text or graphic imag
files, and many other types of data. You can also modify the default attributes
map objects and save them under your own unique names for later use.

The following diagram shows the general procedure for creating and printing 
map in ER Mapper:

Hands-on exercises
These exercises give you practice setting up an algorithm to create a map, de
Page Setup parameters, and composing the map by adding map objects and
annotation.

What you will 
learn...

After completing these exercises, you will know how to perform these tasks in
ER Mapper:

Image

Page

Compose

Save

Create the desired image using algorithm

Specify page setup parameters for the

Compose the map by dragging and dropping map

Save the vector map composition file, then save

processing

setup

map

processing and any dynamic link vector
or tabular overlays to be included.

algorithm to define the position of the image on an

objects, specifying object attributes, and 
drawing annotation such as lines and text.

Print
Print the map on your hardcopy device, or

map
to an external file format (TIFF, CGM, etc.).

algorithm
the algorithm containing the annotation/map
composition layer and raster layers.

output page, margins, background color, etc.
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• Define Page Setup parameters for an algorithm

• Add an Annotation/Map Composition layer to an algorithm

• Draw annotation objects (lines, text, polygons, etc.) on your map

• Place map objects (grids, scale bars, etc.) on your map

• Specify color and other attributes for annotation and map objects

1: Setting up the page

Note: The following example is a simple exercise that is designed to familiarize you 
basic procedures for producing a map. It does not cover all possible modes a
options. See the ER Mapper User Guide manual for details.

Display the sample seismic colordrape algorithm

1 On the main menu, click the Open  button. 

An image window and the Open dialog box appear.

2 From the Directories  menu, select the \examples  path.

3 Open the ‘Applications\Oil_And_Gas_Exploration’ directory, then double-
click on the algorithm ‘Seismic_Horizon_Colordrape.alg’ to open it.

This algorithm displays the two-way time data draped over shaded two-way t
to enhance structural features. This is the image you will use to create your m

Display the Annotation toolbar
1 On the main menu, select Annotation  from the Toolbars  menu.

ER Mapper adds a third toolbar with buttons for quick access to common func
used for annotation and map composition.

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen.

Objectives Learn to use ER Mapper’s Page Setup options to define the position of an im
on an output page, and specify other options such as map scaling parameter
background color. In this case, you will create a 1:100,000 scale map to be 
printed on a hardcopy device that uses an A3 size page.
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Specify Metric or Imperial units for page setup
1 On the main menu, select Preferences from the Edit menu.

The Preferences  dialog opens providing General , 3D Options , and 
Advanced tab pages.

2 Select the General tab page (if needed), then select either Metric  or 
Imperial  from the ‘Display Units’ drop-down list (whichever you prefer).

3 Click Close on the Preferences  dialog to close it.

All values regarding the plot size, margin sizes and other page setup parame
will be displayed in the measurement units you selected.

Open the Page Setup dialog box
1 From the File  menu, select Page Setup (or click the Setup Algorithm 

Page Size   button on the Annotation  toolbar).

The Page Setup  dialog box opens. This dialog provides controls for you to 
choose a default hardcopy device, position and scale your image on the outpu
area, specify a background color and more.

The area on the left side shows the size and shape of the plot in red (the “pag
extents”), and the relative size and position of the algorithm image within the 
area in blue (the “contents extents”).

page contents
outline (blue box)

page extents
outline (red box)

specify exact
map scale

apply settings
to current
algorithm

overall size
of page extents
(plot size)

select predefined
plot sizes

size of borders
surrounding
page contents

select default
hardcopy devicenumber of pages

hardcopy device
will print using
current settings
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Select the destination hardcopy device
1 Select the ‘Hardcopy Control Files’ option at the top (if it is present).

This tells ER Mapper to use its own set of device drivers. (If you are running 
ER Mapper on a PC, you are advised to use the Windows drivers.)

2 Click the Default Hardcopy  file chooser button.

The Default Hardcopy dialog opens to let you select the type of printer or 
graphics file that you will be using.

3 From the Directories  menu, select the \hardcopy  path.

A list of directories for categories of hardcopy devices and file formats display

4 Double-click on the directory named ‘HP’ to open it and view a list of 
available options for Hewlett-Packard printers.

5 Double-click on the entry ‘HP_DesignJet_300dpi_A1.hc’ to select it.

This device is now selected as your default hardcopy device, and we will assu
that your example map will be printed on it. It is a good idea to choose the de
you intend to print on so you can see how large your plot will be later.

(The HP DesignJet is a large format color inkjet plotter. The entry you selecte
designed to tell the printer to print at 300 dots per inch on an A1 size area (22
inches or 56 cm wide) of the device’s total printable area.

Specify how the page or map contents can be scaled
The Constraints  drop-down list lets you specify how map objects are scaled 
relative to the output page. Typically you need to decide which parameters ar
most important for your map: a fixed page size, fixed borders, or a fixed map s

1 From the Constraints  drop-down list, select Auto Vary:Page .

The outlines representing the page extents (red) and page contents (in blue) 
down to the center of the white area on the Page Setup dialog, and the Border  
and Scale  fields are now editable.

Auto Vary:Page  mode tells ER Mapper that it can automatically change the s
of the image extents (size) to accommodate any changes you make to the m
scale or the size of borders surrounding the image. (Other Constraints  options 
will automatically change plot borders or map scale if other parameters are 
changed.)

Snap Shot the current algorithm extents
1 Click the Snap Shot Current Extents button.
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ER Mapper updates the values in the Contents Extents  fields. (For example if 
you had zoomed in or out in your algorithm, Snap Shot  updates the contents 
extents to match the current display extents of your algorithm.)

Specify the output map scale
1 In the Scale - 1: text field, enter the value 50000  then press Enter or 

Return to validate.

ER Mapper sets the size of the page contents (the physical size of the image 
page) to print at 1:50,000 map scale.

Specify borders surrounding the page contents
Right now the page extents and page contents are the same size. Next you w
borders around the contents (the seismic image) so you have space to add a
scale bar, map grid, and other items.

1 In the text fields under ‘Borders,’ enter the following values for each field in 
the units you are using (press Enter or Return after each to validate):

Top: 63.5 (mm) or 2.5 ( inches) 

Left: 63.5 (mm) or 2.5 ( inches)

Right: 63.5 (mm) or 2.5 ( inches)

Bottom: 76.2 (mm) or 3( inches) 

By adding borders, you increased the total plot size to 477.38 by 390.70 mm 
18.79 by 15.38 inches). The blue outline shows the relative size and position o
page contents in the new, larger plot size. The physical size of the seismic im
(page contents) has not changed, it will still print at 1:50,000 scale.

Tip: After setting the desired map scale and border values, notice that the Hardco
Pages Across and Down fields show the percentage of device’s the A1 size p
area that the plot will occupy (85% of the width of an A1 page in this case). If y
total plot size (page extents) is larger than the print area of your device, these
values will be greater than one, indicating that ER Mapper would divide the p
and print each portion on a separate page or strip.

Set the background color to white
1 Select the text in the Background Color field, type white , and press 

Enter or Return to validate.
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ER Mapper sets the page background color to white (the areas of the page 
surrounding the page contents). If you will be printing on a device that has a w
background, it is often helpful to set the background color to white while you 
composing the map to get a better idea of the final output. (You can use the Set 
Color  button as well to choose any arbitrary background color.)

Your Page Setup  dialog should now look like this (units shown are Metric):

Save the algorithm with the Page Setup parameters
1 Click OK on the Page Setup  dialog to close it.

ER Mapper redisplays the colordrape image to show the white page border a
that you added in Page Setup .

2 From the File  menu, select Save As...  to save the algorithm under your 
own name.

3 In the Files of Type  field, select ‘ER Mapper Algorithm (.alg)’.

4 From the Directories  menu, select the \examples  path. 

5 Double-click on the ‘miscellaneous\tutorial’ directory to open it.

6 In the Save As:  text field, type a name using your initials at the beginning, 
followed by the text ‘horizon_map.’ Separate each word with an underscore 
(_). For example, if your initials are “JR,” type in the name:

total size of plot

percentage of A1 size
area the plot will fill

size of page contents
(image) relative to
total size and shape
of plot (page extents)
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7 Click OK to save the algorithm, which now includes your page setup 
parameters.

2: Drawing interpretations on the image

Zoom to the Page Contents and Page Extents
Currently the image is zoomed out to show the page extents and the relative 
position of the image within it.

1 On the Annotation toolbar, click the Zoom to Contents Extents  
button.

The image zooms in to the extents of the page contents (the extents of the se
image itself).

2 On the Annotation toolbar, click the Zoom to Page Extents  button.

The image again zooms out to the extents of the page defined for the algorith
and the image (the page contents) appears with the surrounding white borde

Objectives Learn to use ER Mapper’s Annotation tools to draw interpretations and 
annotation objects such as polylines, polygons, and text. Also learn to zoom 
image in or out to the page extents or page contents.

Zoom to Contents
Extents  button

Zoom to Page
Extents  button
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3 Click the Zoom to Contents Extents  button again.

The image zooms in to the extents of the page contents again. (Since you will
interpretations on the image, it is helpful to maximize the area on the screen 
for the image. Later you will zoom to the extents again to add map objects in 
border areas.)

4 Expand the image window size to make it slightly larger. (Try to shape the 
window so it approximately matches the shape of the image).

Note: ER Mapper should have automatically set the View Mode  in the Algorithm dialog 
to ‘Page Layout’. If it is set to ‘Normal’, then Zoom to Page Extents  will 
display the contents, and not the full page.

Add a vector layer for map annotation

1 On the Common Functions toolbar, click the Annotate Vector Layer  
button, or, from the Edit menu (on the main menu), select Annotate 
Vector Layer... . 

The New Map Composition dialog box opens to ask what type of annotation
you want to create. You can create a vector file, raster regions (as you did in 
earlier exercise), or an ARC/INFO GIS coverage file.

2 Make sure the Vector File  option is selected, then click OK on the New 
Map Composition  dialog.

ER Mapper opens the Tools  dialog containing your drawing tools. Move the 
Tools  dialog next to the right side of your image.

Label the annotation layer

1 Click the Edit Algorithm  button on the main menu.

On the Algorithm  dialog, notice that ER Mapper has added an ‘Annotation 
Layer’ to the algorithm layer list to display the interpretations you create.

2 Change the annotation layer’s label to interpretations .

3 Click Close on the Algorithm  dialog to close it.

Draw a polyline to trace linear features

1 On the Tools dialog, click once on the Polyline   button.
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2 Point to a linear feature inside the image (such as a fault). Then draw a line 
to trace the feature by clicking once at each point, then double-clicking to 
end the line.

A line appears on your image to highlight the linear feature. Note that marker
appear on the line at each node to indicate that the line is “selected.”

View and modify the attributes of the polyline

1 On the Tools dialog, double-click on the Polyline   button.

The Line Style  dialog box opens to let you choose attributes for your polyline

2 Click the Set Color  button, choose any contrasting color, then click OK to 
close the Color chooser dialog. (Black or white are good choices.).

The line color on the image changes to your selected color.

3 Click the Width  drop-down list and choose 3.0 to increase the line width.

4 Click on a dashed line style under Line Pattern  to select a line style.

The attributes for your selected polyline change interactively.

5 On the Tools dialog, click on the Edit Object Extents  button.

The Map Composition Extents  dialog opens to show information about the 
polyline object. It shows the line length in map units, and other attributes such
the number of vertices, geographic extents, and so on.

6 Click Close  on the Object Extents dialog.

Tip: To draw a straight line with an arrowhead, use the Polyline   tool to draw the 

line, then turn on the ‘Start’ or ‘End’ option under ‘Arrow at:’ in the Line Style  
dialog.

Draw a second polyline and modify it
1 Draw a second polyline to define another linear feature of interest (click 

once at each point, then double-click to end the line).

The new polyline inherits the current attributes set in the Line Style  dialog.

2 Click the Set Color  button, choose a different color for the new line, then 
click OK.

3 On the Tools dialog, click the Select/Edit Points Mode  button.
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4 Drag any node of the selected polyline to move it.

When a polyline is selected and Select/Edit Points Mode   is active, you 

can reshape the line as desired by dragging the line nodes. (You will learn ho
move entire objects later.)

5 Click on your first polyline to select it (selection handles should appear).

The Line Style  dialog changes to show the attributes of the first (selected) 
polyline. 

6 In the Line Style  dialog, turn on the ‘Curved’ option.

ER Mapper applies a spline function to the selected line and reshapes it into 
smooth, rounded curves. This can be helpful to create more visually pleasing
when tracing faults and other linear features.

7 Turn off the ‘Curved’ option.

The line returns to its original appearance with straight segments at each nod

8 Click Close  on the Line Style  dialog.

Draw a shaded polygon around a feature

1 On the Tools dialog, click on the Polygon   button.

2 Point to the V-shaped uplifted block in the upper-left part of the image. 
Then draw a polygon around the feature by clicking once at each point, 
then double-clicking to close the polygon.

The polygon object appears surrounding the fault block, and it is selected. By
default, your polygon displays the currently selected line color, thickness, etc

3 On the Tools dialog, double-click on the Polygon   button.

The Line Style  dialog box opens to let your set polygon attributes. (The same
dialog is used for polylines, rectangles, and other vector objects.)

4 Click the Set Color  button, choose a cyan (light blue) color, then click OK 
to close the Color  chooser dialog.

5 Under Fill Pattern , click on one of the diagonal line fill patterns.

The pattern you choose appears in the Current Fill  window on the dialog. The 
polygon is filled with a diagonal cyan shade pattern.

6 Click Close  on the Line Style  dialog.

7 On the Tools dialog, click on the Edit Object Extents  button.
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The Object Extents  dialog opens to show information about the polygon obje
including the perimeter length and area.

8 Click Close  on the Object Extents dialog to close it.

Tip: To delete a node from an existing polyline or polygon, use Select/Edit Points 

Mode  to select it, click on the node to delete, then click the Delete Point 

 button. To add a node, click the Add Points Mode   button, then click 

on the line to add a node at that point.

Draw a shaded oval and move and resize it

1 On the Tools dialog, click the Oval  button.

2 Point anywhere inside the image, drag an oval shape and release.

A shaded cyan oval appears. By default, the oval is selected.

3 On the Tools dialog, click the Select and Move/Resize Mode  button.

Select and Move/Resize Mode  lets you move and/or resize the selected obje
Notice that the oval’s selection handles change–now there are eight handles.

4 Drag one of the selection handles to increase the oval size.

5 Point inside the oval, and drag it to a new location.

When an object is selected and Select and Move/Resize Mode  is active, 

you resize or reshape the object by dragging a handle, or move the object by
dragging it from inside.

6 In the Tools  dialog, click the Delete Object   button.

The selected oval object disappears from the image. Selecting an object and

clicking Delete Object  is how you delete any vector annotation object.

object handles –drag to rezize
object as desired
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Tip: If you delete an object by mistake, immediately click the Undo Last Delete   

button to restore it.

Tips for selecting objects
ER Mapper’s annotation tool set provides two “select” tools for different tasks

• Use the Select/Edit Points Mode  button to select a polyline or polygon 

object when you want to move the individual line nodes, or select nodes.

• Use the Select and Move/Resize Mode  button to select any annotation 

object when you want to move the entire object (drag from the center) or resiz
entire object (drag one of the yellow handles).

• To select multiple objects at once, choose the Select and Move/Resize Mode 

 button. Then either drag a marquee box around all the objects, or select

one at a time by holding down the Shift key and clicking on them.

Draw and modify a text string

1 On the Tools dialog, click the Text Object  button.

The Text Style dialog box opens.

2 Drag a box inside the image with the same height as desired for the text.

3 In the Text Style  dialog, click in the Text  field at the bottom to position the 
cursor, then type gas bearing block . 

The text appears on the image as you type.

4 In the Text Style  dialog box, select the following text attributes:

Size: 48.0

Color:  choose any bright color

Font Type: PostScript Stroke

Font:  Helvetica-Bold

Notice that the text object automatically updates as you change the attributes

5 Click the Select and Move/Resize Mode  button, then drag the text in 
the image to cover the V-shaped fault block.
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Draw and rotate a text string
1 Drag a box in another part of the image near the center.

2 In the Text Style  dialog, click in the Text  field to position the cursor, then 
type rotated text .

3 From the Angle (deg) drop-down list, select 45.0.

The text string rotates 45 degrees counter-clockwise, so it now points down to
the upper right. (Text strings rotate around their origin in the upper-left corner

4 On the Tools dialog, click the Select and Move/Resize Mode  button.

5 Point to the text block, and drag it to any desired position.

You have now learned to draw and modify simple annotation objects such as 
polygons, and text. Next you will add map objects to your page.

Tip: Text drawn as annotation can be set to always print at an exact point size (th
Fixed Text option on), or to automatically scale up or down proportionally at 
whatever size the image is printed (Fixed Text option off).

6 Click Close  on the Text Style dialog to close it.

Tip: To duplicate an object, select it and click the Clone Object   button. This can 

useful, for example, for copying blocks of text or creating exact copies of 
polygons, ovals, and so on.

Save the interpretations to an annotation file

1 On the Tools dialog, click the blue Save As  button.

The Map Composition Save As  dialog opens.

2 Make sure the ‘Vector File’ option is selected, then click the  button next 
to ‘Save to File.’

3 From the Directories  menu (on the file chooser dialog) , select the 
\examples  path. 

4 Double-click on the ‘Miscellaneous\Tutorial’ directory to open it.

5 In the Save As:  text field, type a name using your initials at the beginning, 
followed by the text ‘interpretations.’ For example, if your initials are “CR,” 
type in the name:
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6 Click OK to validate the filename.

7 Click OK on the Map Composition Save As  dialog.

Your vector annotation objects are saved to an ER Mapper format vector file (
on disk.

8 Click Close on the Tools dialog.

3: Defining map objects

Up until this point, you have used ER Mapper’s vector annotation tools to dra
line, polygon, and text objects. Now you will use the Map Composition tools t
automatically create complex color map objects that you can position on the 

Zoom to the Page Extents to view the entire map page

1 On the Annotation toolbar, click the Zoom to Page Extents  button.

The image zooms out to the extents of the page defined for the algorithm, an
shows the white border areas where you will place map objects.

2 On the Tools dialog, click on the Map Rectangle  button.

The Map Object Select  and Map Object Attributes dialog boxes open on the
right side of the screen. These dialog boxes let you drag and drop map object
the page in your image window, and specify attributes for the objects.

Objectives Learn to use ER Mapper’s Map Composition tools to place and modify map 
objects such as scale bars, coordinate grids, north arrows, and others.
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Layout the types and positions of map objects
Before creating your map, it is a good idea to determine which types of map 
objects you want to use, and their relative sizes and positions on the page. In
exercise, you will create a map with the following objects similar to this one

You will define these objects on your image window “page” in two ways:

• draw a bounding box and drag-and-drop the object into it; or

• drag-and-drop the object onto the page and resize the bounding box afterwar

Refer back to the diagram above as a guide for the size and position of map o
you are asked to create in the next sections.

Add a second vector layer for map annotation

1 On the Common Functions toolbar, click the Annotate Vector Layer  
button.

The Open Map Composition dialog box opens showing the name of the first
annotation file you created. You want to create a second new one.

2 Click New on the Open Map Composition  dialog.

3 On the New Map Composition  dialog that opens, make sure the Vector 
File  option is selected, then click OK.

ER Mapper opens the Tools  dialog containing your drawing tools.

Company
logo

North
arrow

Lat-Long
grid and
labels Z-scale

color bar

Well symbol

Scale bar

Map title
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Add a scale bar below the image

1 On the Tools dialog, click on the Map Rectangle  button.

The Map Object Select  and Map Object Attributes dialogs open. These 
dialogs let you drag-and-drop map objects onto your page and specify color, 
style, and other attributes.

2 In the Map Object Select  dialog, select Scale Bar from the Category  
drop-down list.

Previews of the various types of scale bar objects appear. The name of the ob
shown in the status line at the bottom of the dialog when you point to it.

3 Point to the icon titled Scale_Bar/Box , then drag and drop it into a position 
below the color image.

The scale bar object is “dropped” onto the page and it draws a few seconds l
Notice that the scale bar is contained inside a box defined by four selection 
handles. This is called the object bounding box, and it lets you control the size and
position of the map object on the page.

The default attributes for the scale bar appear in the Map Object Attributes 
dialog box.

Zoom in on the scale bar and change the attributes

1 On the Tools  dialog, click the ZoomBox Mode  button.

2 Inside the image window, drag a box around the scale bar object to zoom in 
on it.

3 On the Map Object Attributes dialog, change the following attributes for 
your scale bar:

Labels Color: black

drag and drop object
onto map page (image
window)
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Labels Font:  Helvetica-Bold (Font Type: PostScript Stroke) (select 
from pop-up fonts dialog)

Units Font:  Helvetica-Bold (Font Type: PostScript Stroke)

Notice that the scale bar object automatically updates as you change the attr

4 On the Annotation toolbar (on the main menu), dialog, click the Previous 

Zoom  button.

ER Mapper zooms out to the previous zoom level (the page extents).

5 On the Tools dialog, click the Select and Move/Resize Mode  button.

6 Drag your scale bar object into the desired position, or resize it by dragging 
one of the selection handles.

If you resize the scale bar (make it wider or narrower), ER Mapper automatic
adjusts the scale and divisions (it is a “smart” map object).

Tip: To resize or move any map object, select it first using the Select and Move/

Resize Mode  button, then move or resize it as desired.

Add a z-scale color bar next to the image

1 On the Tools dialog, click the Map Rectangle  button.

2 Drag a tall narrow box along the right side of the image.

A dotted bounding box appears, and it is selected by default.

In this case, you are defining the desired size and position of your map objec
by drawing a bounding box, then you will drag the object inside it.

drag a box next
to the image
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3 In the Map Object Select  dialog, select ZScale from the Category  
drop-down list.

A list of various types of z-scale color bar objects appears.

4 Point to the icon titled ZScale/Algorithm_LUT  (top left icon), then drag and 
drop it into the bounding box you drew.

A z-scale color bar draws to fill the box. (Note that the box must be selected f
before you can drop an object into it.)

5 On the Map Object Attributes dialog, change the following attributes for 
your z-scale color bar:

Color: black

Units: type the text TWT (ms)  then press Enter or Return

You now have a z-scale color bar with labels to indicate how two-way time va
are mapped to the lookup table colors used to display the image. 

Tip: To make a horizontal z-scale color bar, simply make your bounding box wider 
it is tall. As with most map objects, z-scale color bars are smart, so the colors
change automatically if you change the color table in your algorithm.

Add a north arrow on the lower-right
1 In the Map Object Select  dialog, select North Arrow from the Category  

drop-down list.

A list of icons representing various types of north arrows appears.

2 Point to the compass north arrow (North_Arrow/Compass ), and drag it to 
a position in the lower-right of the page.

The north arrow object drops onto the page. 

3 Click the Select and Move/Resize Mode  button (on the Tools dialog), 
and resize and position the north arrow as desired.

Tip: ER Mapper’s north arrows are “smart” and will always point to north on a rectif
image.

Add a company logo on the lower-left
1 In the Map Object Select  dialog, select Logo from the Category  

drop-down list.
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A list of icons showing some sample company logos appears.

2 Point to the ER Mapper  logo icon, and drag-and-drop it onto the lower-left 
part of the page.

The logo object drops onto the page. Resize or position it if desired.

Tip: You can add your own company logos as Postscript files and access them fro
standard Logos category used here.

Add a well symbol to the image

1 On the Tools dialog, click on the Map Rectangle  button.

2 Drag a square bounding box on the V-shaped red fault block in the image

3 In the Map Object Select  dialog, select Wells from the Category  
drop-down list.

A list of icons showing standard well symbols appears.

4 Point to the Wells/Symbol16  icon, and drag-and-drop it onto your 
bounding box.

The well symbol object drops onto the page. Resize or position it if desired. 
(Symbol 16 is the symbol for a Suspended Gas Condensate well as shown in
Map Object Attributes  dialog.)

Add a main title above the image

1 On the Tools dialog, click on the Map Rectangle  button.

2 Drag a bounding box centered at the top of the image window (leave some 
space below it for grid labels).

3 In the Map Object Select  dialog, select Title from the Category  
drop-down list.

4 Point to the icon titled Title/Scaling , drag it into the bounding box you 
defined above the image.

(The default title color is white so it does not appear initially.)

5 On the Map Object Attributes dialog, change the following text and 
attributes for your title:

Title: Horizon KA Colordrape (press Enter or Return afterward)

Font Color:  blue
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The title object automatically updates as you change the attributes.

Define a Latitude/Longitude coordinate grid over the image
1 In the Map Object Select  dialog, select Grid from the Category  

drop-down list.

2 Point to the Grid/LatLong icon, drag it into the image.

The grid map object draws on the image.

3 On the Map Object Attributes  dialog, click the Fit Grid button.

ER Mapper automatically resizes and positions the bounding box for the grid 
exactly to the extents of the page contents (image) on the page.

4 On the Map Object Attributes  dialog, turn on the Fast Preview option.

Fast Preview  tells ER Mapper not to update the object interactively as you 
change the attributes.

5 On the Map Object Attributes dialog, change the following attributes for 
your grid (use defaults for all others):

Grid Style:  Full Grid

Grid Spacing X:  2 minutes)

Grid Spacing Y:  2 minutes

Top labels orientation:  Horizontal Right

6 On the Map Object Attributes dialog, turn off the Fast Preview  option.

The grid map object is rendered using the attributes you defined.

Tip: The Fast Preview  option is very useful for working with complex map objects
that take time to redraw (such as a grid or algorithm image). This lets you cha
all the attributes you desire or fine tune object size/position without ER Mapp
trying to update the object on the screen each time.

Adjust the size or position of any object
If desired, you can easily resize or position any map object by moving or resi
the bounding box that contains it.

1 In the Tools  palette dialog, click the Select and Move/Resize Mode  
button.
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2 Click on any map object to select it (the handles will appear), and drag the 
bounding box to reposition it or change the size by dragging a handle.

Save the map composition file to disk

1 On the Tools dialog, click the blue Save As  button.

The Map Composition Save As  dialog opens.

2 Make sure the ‘Vector File’ option is selected, then click the  button next 
to ‘Save to File.’

3 From the Directories  menu (on the file chooser dialog) , select the 
\examples  path. 

4 Open the ‘miscellaneous\tutorial’ directory.

5 In the Save As:  text field, type a name using your initials at the beginning, 
followed by the text ‘map_composition.’ For example, if your initials are “JT,” 
type in the name:

JT_map_composition

6 Click OK to validate the filename.

7 Click OK on the Map Composition Save As  dialog.

Your map objects are saved to an ER Mapper format vector file (.erv) on disk

8 Click Close on the Tools dialog.

Note: When you close the Tools  dialog (exit edit mode), ER Mapper redisplays the 
image exactly as it will look when printed. (During edit mode, line thickness is
slightly exaggerated to help editing and modifications.)

Label the map composition layer

1 Click the Edit Algorithm  button on the main menu.

On the Algorithm  dialog, you now have two annotation layers–your first 
‘interpretations’ layer and your map composition layer (labelled ‘Annotation 
Layer’ by default).

2 Change the ‘Annotation Layer’ label to map composition .

3 Click Close on the Algorithm  dialog to close it.
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Tip: It is often helpful to separate different types of annotation into separate files as
did here–one for interpretations and another for map objects. This makes it e
to work with the data, and you can simply turn the desired vector layers on/of
display/not display those items in your algorithm. (You could have saved both 
vector interpretations and map objects in the same file.

Save the algorithm to update the changes

1 On the main menu, click the Save  toolbar button.

2 When asked to confirm the overwrite, click OK.

Your algorithm can now be printed using the Print   toolbar button or by 

selecting Print  from the File  menu. 

Note: It is important to remember to save your algorithm after defining map objects.
Otherwise the annotation layers and files will not be part of the algorithm whe
you go to print it later.

Close all image windows and dialog boxes
1 Close the image window using the window system controls or by selecting 

Close  from the File  menu.

Only the ER Mapper main menu should be open on the screen.

• Define Page Setup parameters for an algorithm

• Add an Annotation/Map Composition layer to an algorithm

• Draw annotation objects (lines, text, polygons, etc.) on your map

• Place map objects (grids, scale bars, etc.) on your map

• Specify color and other attributes for annotation and map objects

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ER Mapper:
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Additional features of Map Composition
The preceding simple example covered only the basics of using ER Mapper’s
Composition, and following are some additional features. Refer to the chapte
creating maps in the ER Mapper User Guide for complete information.

• If you drag an object into a bounding box that already contains an object, the
object is replaced by the new one. This is an easy way to try several north ar
for example.

• Objects that are dragged and dropped to replace a current object automatica
inherit any common attributes from the previous object. For example, if you ha
red north arrow in a bounding box and then drag in a scale bar object, the sca
automatically inherits the red color (since both objects have the “Color” attribu
common).

• You can modify the default attributes of map objects and save them under you
names (using Save As  on the Map Object Attributes  dialog).

• You can draw other image processing algorithms you’ve created as map obje
the page (using the Category: Algorithm  on the Map Object Select  dialog). 
This is useful for drawing inset images that show an overview map, inset imag
other types of processing techniques or data of the same area.

• You can plot objects from external files like TIFF, EPS, or Targa (using the 
Category: Image  on the Map Object Select  dialog)

• You can import text directly from ASCII text files and plot it on your map page
(using the Category: Text  on the Map Object Select  dialog)

Page Relative and Map Unit Relative map objects
The vector map objects you defined in this exercise have their position and si
specified relative to the page, rather than to map units (such as Latitude 
Longitude). This allows you to create standard map sheets with objects that re
in a fixed size and position on the page, regardless of how the page is scaled
extents of the datasets used in the page contents are changed.

You can also specify the position of map objects in geographic coordinate un
The position of each object is tied to a particular geographic location and map
sheet size.

To specify a map object as map unit relative, turn off the Page Relative  option on 
the Map Object Attribute  dialog box. The page relative attribute can be assign
either before or after the object is dragged-and-dropped onto the page. See t
ER Mapper User Guide for more information.
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Page Setup Constraints options
In the previous simple example, you chose the ‘Auto Vary:Page’ option, althou
you could have chosen others as well. The Constraints options you can use a
summarized briefly below:

• Fixed Page:Extents from Zoom–This is the default setting for all new algorithms
where the contents scale and borders are taken from the current zoom extents
algorithm. For map making purposes, Extents from Zoom is not recommende
because it can effect line thickness and text sizing.

• Auto Vary:Page–This mode allows ER Mapper to automatically vary the page s
to account for any changes made to the map scale or page borders. This mo
easiest, for example, to print a map at an exact scale without regards to constr
it to a specific page size. If you want to place map objects outside the image (
contents) area, enter the desired border sizes to create space for them. (This
good initial choice when you are prompted to change the mode when using th
annotation tools.)

• Auto Vary:Borders–This mode allows ER Mapper to automatically vary the pa
borders to account for any changes made to the map scale or page size. This
is most useful for printing at both an exact map scale and exact plot size.

• Auto Vary:Scale–This mode allows ER Mapper to automatically vary the map
scale to account for any changes made to the page size or page borders. Thi
is useful, for example, for printing an image at various sizes when exact map 
is not important.

Printing your map
When you want to print your final map algorithm (using File/Print or the Print  

 button), ER Mapper asks for the name of the algorithm. When the print 

operation begins, ER Mapper automatically locates, processes and renders a
datasets used in the algorithm into one final print image. In this case, your ma
algorithm uses two datasets–a seismic horizon raster dataset, and a vector m
annotation dataset (which you created).

Since the map algorithm is made of several layers (and datasets), you can ea
change it. For example, to print the image without the map annotation, simply
off that layer in the algorithm, resave it, and print it.

seismic
dataset(s)

map comp
dataset(s)

Horizon Map
algorithm

printer

file (TIFF,
CGM, etc)

or
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Tip: If you select Print  while your algorithm is open on the screen, ER Mapper mak
a temporary copy of the algorithm in memory and automatically loads it into t
Print  dialog. This lets you print the current algorithm, even if you have not re-
saved it after you added vector layers.
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Gridding
This chapter explains how to use ER Mapper’s Gridding Wizard to create grid
raster images from different types of data.

Overview
There are many instances where you require data to be in a regularly spaced
but is only available as samples taken at irregularly spaced locations. 

A gridding process will use irregularly spaced data to create a gridded raster 
image. It does this by laying a regularly spaced grid over the whole area and 
calculating a value for each cell in the grid. The accuracy of these calculation
depends on the method used and the density and spacing of the input data.

The diagram below illustrates how a set of sample measurements taken at dif
spots along a road network are used by a gridding process to create a gridded
image of the whole area. As can be seen, there are large areas on the output
no input data is available.

Gridding
process
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Geologists, mainly those in the mining industry, would use a gridding process
manipulate or “grid up” random geochemical samples.

You can use the ER Mapper Gridding Wizard to extract regularly gridded rast
files from a combination of any or all of the following types of data.

• Random line data 
• Contour data, with faults, streamlines, ridgelines, and breaklines
• Random point data 
• Regular line data
• Regularly gridded raster file 

The output data is a raster (.ers) file with single or multiple bands containing 
regularly spaced grids.

Gridding methods
Gridding produces a regularly spaced array of Z (e.g. height) values from 
irregularly spaced XYZ data. It does this by extrapolating or interpolating Z va
at the regularly spaced locations where the data is missing.

XYZ data designates the location and the value of measurement or sample p
in a dataset. The XY component specifies the coordinates of the position of th
measurement point and the Z component is the value at that point. This value
depends on the application. An example would be height. 

The diagram below is a simplified illustration showing how the locations and 
values of measurement points, A,B,C and D are represented as XYZ data:

ER Mapper supports two gridding techniques:

• Triangulation

• Minimum Curvature Under Tension
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Triangulation 
This method generates the gridded image in two steps. The first step constru
TIN (Triangulated Irregular Network) from the set of input points, with the 
vertices of each triangle corresponding to and having the same height value a
input point. This produces an irregular ungridded DEM. The second step 
“regularizes” the grid by using a linear approximation for each triangle to calcu
values at grid points.

Triangulation works best when the input points are evenly distributed over the
area. If the data sets contain areas with widely distributed points, then a surfa
plot or contour map will have distinct triangular facets.

Triangulation has the advantage of being very quick to process. However, bec
it only takes information from three neighboring points, it cannot take into acco
any form of spatial variation.

Minimum Curvature
The minimum Curvature interpolation method generates a surface similar to a
linearly elastic plate passing through each of the input points. It generates the
smooth surface by repeatedly applying an equation over the grid. This contin
until either the user specified maximum number of iterations is reached or the
successive changes in the values are less than a pre-set convergence limit.

A common drawback of this method is that it may have large oscillations and
extraneous inflection points particularly in sparse data areas. ER Mapper use
Boundary and Interior tension parameters to minimize this problem. 
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The diagram below illustrates the differences between the Triangulation and 
Minimum Curvature methods.

Without tension

Irregularly spaced

Regularly spaced

input points

output points
With tension

Triangulation Minimum Curvature
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Gridding Wizard
The ER Mapper Gridding Wizard creates a project file which specifies how on
a number of input data sources are to be used to develop a raster gridded im
file. It then uses this or a previously saved project file to create the gridded im
file.

Project File
The Gridding Wizard requires you to specify a Project File before it can perfo
the gridding. If you do not specify the name of an existing project file, the 
Gridding Wizard will create a new one for you to enter the necessary 
specifications. You can save this project file for future use. 

You can use a previously saved Project File to re-generate a gridded output f
without having to re-enter the specifications. You can also edit existing projec
files to create new gridded images.

Input sources
You can use point, line and polygon data from one or more sources. ER Map
will automatically handle any of the input formats listed below.

• Generic ASCII XYZ

• DXF

• USGS contour format (DLG-3)

• Any raster formats directly readable by ER Mapper (including .ers) 

• ER Mapper .erv format

An ER Mapper point extractor converts the above formats into XYZ triplets, wh
is the required format for the gridding process. 

Output gridded image
The ER Mapper gridding facility differs from many other products in that you c
use it to generate a multiband raster image file. Where you have specified mu
input sources, you can select one of the following options:

Project (.egp) File

Input
data
sources

Gridding
Wizard

Output raster
gridded image
(.ers) file
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• Each input source goes to its own output band, thus creating a number of the
overlays.

• All input sources are combined into a single mosaiced output band.

• You can customize the output by assigning specific input sources to any numb
output bands. 

You can then collectively or separately specify the gridding method (i.e. 
Triangulation or Minimum Curvature) for each output band.

Creating a gridded image file
Creating a gridded image file involves the following steps using the Gridding 
Wizard.

• Choose the input data sources

• Setup the output bands by allocating the input sources to them.

• Select the gridding method to be used (Triangulation or Minimum Curvature)

• Setup the output information and create the gridded file.

If you have an existing project file you can open it in the Gridding Wizard, mod
it, if necessary, and create the gridded image. If required, you can save the p
file under a new name. Otherwise you can use the Gridding Wizard to create 
project file from scratch.

Hands-on exercise
These exercises give you practice in using the Gridding Wizard to create a gr
raster image. 

1: Create a gridded image from text files

Open the Gridding Wizard

1 Click the Gridding Wizard button on the Common Functions  toolbar. 

Before you 
begin...

Before beginning these exercises, make sure all ER Mapper image windows 
closed. Only the ER Mapper main menu should be open on the screen.
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The Gridding Wizard dialog opens with the 1)Introduction  tab selected. 

2 Select the New grid project  option.

Notice that the Grid project file:  field is grayed out. This is because you are 
creating a new project file. Therefore, you do not have to specify an existing o

3 Click on the Next>  button or select the 2) Data Sources  tab.

Both actions will take you to the next step by opening the Data Sources tab

Select the input data source.

This tab allows you to enter one or more data sources for gridding. The data 
sources can be from the same or adjacent areas. For this example we are go
choose a number of text files as data sources. 

The list of data sources should be empty because we have not yet entered an

1 Click on the Add...  button to enter a data source.

A file chooser dialog should open.

Data source
list
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2 In the chooser dialog Files of Type  field, select AsciiXYZtext(.txt) .

3 From the Directories  menu, select the path ending with the text \examples

4 Double-click on the directory named ‘Functions_And_Features’ and then 
on the ‘Gridding’ directory.

The directory has five text files, supplied with the permission of the Geologica
Survey of Western Australia, that list geochemical sample readings at locatio
specified by Easting/Northing coordinates. An extract from the 
‘Peak_Hill_Al203.txt’ file listing aluminum oxide sample readings is shown bel

The information contained in the file is known as ASCIIXYZ data. The X Y 
components are the Easting/Northern coordinates of the locations, and the Z
component is the aluminum oxide reading at each of the X Y locations. 

The other three files are ‘Peak_Hill_CaO.txt’, ‘Peak_Hill_Fe203.txt’ and 
‘Peak_Hill_MgO.txt’ which list traces of calcium oxide, copper oxide and 
magnesium oxide respectively.

In this exercise we will use the Gridding Wizard to create a gridded raster ima
with separate bands each showing overall concentrations of aluminum oxide,
calcium oxide, copper oxide and magnesium oxide.

5 Click on the file named ‘Peak_Hill_Al203.txt, and then click Apply .

The Ascii Projection Details dialog box should open.

#Easting Northing Al203

679346 7186699 11

675848 7182842 10.4

675882 7180203 7.22

680312 7182703 8.76
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6 Check that the projection details are as shown above and then click on the 
OK button to return to the data source chooser.

If the projection details are not as shown above, use the file chooser buttons 
on the Geodetic datum  and Geodetic projection  fields to select ‘AGD66’ for 
the datum, and ‘TMAMG50’ from the ‘tranmerc’ projection list. Set 
Coordinates  to ‘Easting/Northing’.

7 Repeat steps 5 and 6 to add the following files to the data source list:

• Peak_Hill_CaO.txt

• Peak_Hill_Fe203.txt

• Peak_Hill_MgO.txt

Click OK instead of Apply  after selecting the last file.

The file names will appear in the source list box.

8 Click on the Next>  button to go to the 3) Output Bands  tab.
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Define the output bands

The output gridded raster image can have one or more bands of information.
“Output Bands’ tab allows you to specify how the input sources are to be map
to these output bands. There are three main options:

1 Select the default option Create a separate band from each data source.

The list box will show:

You will not be able to edit the entries in the list box.

2 Click on the Next>  button to go to the 4) Grid Type tab.

Create a separate band 
from each data source

Each input source is allocated to a separate band.
This creates an output gridded image with multiple
bands as thematic overlays.

Mosaic all data sources 
into a single band

All the input sources are allocated, i.e. mosaiced, 
into a single band. This creates a single band outp
gridded image.

Custom Enables the toolbar buttons for you to customize th
output. You can specify the number of output band
and their descriptions, and then allocate individual
or combinations of input sources to the output 
bands.

Output band
Gridded Data:1
Gridded Data:2
Gridded Data:3
Gridded Data:4

Data source
Peak_Hill.Al203.txt
Peak_Hill.MgO.txt
Peak_Hill_Fe203.txt
Peak_Hill.CaO.txt
284 ER Mapper Workbook -  Seismic Geophysics Applications



Chapter 18#Gridding#z 1: Create a gridded image from text files

a. 
t the 

s 

ch 

t 
Select the gridding method

There are two gridding methods available, viz. Triangulation and Minimum 
Curvature. Triangulation is simpler and works best with evenly distributed dat
Minimum Curvature has a number of parameters which you can adjust to sui
input data. 

The ‘Grid Type’ tab allows you to set the gridding method for the output band
collectively or individually.

We will set all the bands to Triangulation.

1 Click on the All Triangulation (TIN)  button to set the gridding method to 
Triangulation.

You could also have selected Triangulation from the drop-down list next to ea
band description.

Notice that the Advanced...  buttons are grayed out. This is because you do no
have to set any further parameters for Triangulation.

2 Click on the Next>  button to go to the 5) Create Grid  tab.
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Create the gridded image

The ‘Create Grid’ tab allows you to specify the file name and define the Exten
Projection and Cell attributes of the output gridded file. You can also select ho
you want the gridded image to be displayed.

1 Click on the File Chooser  button to open the Gridding Wizard Output 
File  chooser dialog box.

2 From the Directories  menu, select the path ending with the text \examples

3 Double-click on the directory named ‘Miscellaneous’.

4 Double-click on the directory named ‘Tutorial.’

5 Enter ‘minerals_triangulated_grid_ <your initials> ’ in the 
chooser Save as: field, and click on the OK button.

The name with its path and a ‘.ers’ extension will be inserted in the File: field of 
the ‘Create Grid’ tab. When you create the gridded image it will be saved to th
file name.

6 Click on the Set Projection...  button to open the Grid Output Coordinate  
Space  dialog.

This dialog allows you to select a Geodetic datum, Geodetic projection and 
Coordinate type for the output gridded image. For this example we will use de
values.
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7 Click on the Defaults  button to select the default values.

8 Click on the Cancel button to return to the Gridding Wizard.

9 Click on the Edit Extents... button to open the Grid Output Extents  dialog 
box.

This dialog box allows you to specify the area to be included (extents) in the o
gridded image. If you select the Maximum extents  option, the output image will 
include the full extents of all the data sources. If you select the Custom extents  
option, you can then enter the top left and bottom right coordinates of the grid
image in the units you specified in the Grid Output Coordinate Space dialog. 
Generally this is in Eastings/Northings Longitude/Latitude or meters. This ena
you to limit the extents of the gridded image to an area of interest.

10 Select the Maximum extents  option.

11 Click on the OK button to return to the Gridding Wizard.

12 Check that the number of cells and lines in the Cell attributes  box show 
reasonable values. 

13 If the size of the output file is larger than 12 Mb, increase the Cell size X: 
and Cell Size Y: values until the size is less than 12Mb.

Cell size values of 150 should result in the file size shown below

14 Select the following  display option:
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• Display gridded image with input overlaid as points

15 Select the Save Grid Project File  button the open the chooser dialog.

All the grid data sources and settings you entered are stored in a project file w
you can save and re-use.

16 From the Directories  menu, select the path ending with the text \examples

17 Double-click on the directory named ‘Miscellaneous’.

18 Double-click on the directory named ‘Tutorial.’

19 Enter ‘grid_project_1_ <your initials> ’ in the chooser Save as: 
field, and click on the OK button.

The project file is saved to the file name with a ‘.egp’ extension.

20 Click on the Finish  button to generate the gridded image and close the 
Gridding Wizard

A Status dialog will indicate the progress of the gridding. On completion, 
ER Mapper will display an image window displaying the following algorithm;

• The gridded image in a pseudo layer and a grid datasource points vector laye

21 Click on the Close  button to close the Status  dialog.

View an algorithm with the gridded image
1 Click on the image window title bar to make it active.

2 Open the Algorithm dialog by clicking on the Edit Algorithm button  on 

the Common Functions toolbar.

The algorithm has a surface with Pseudo and a Grid Datasource Points vecto
layer. 

3 Select the Pseudo layer

This layer contains band B1 Gridded Data:1 of the raster image you created. Thi
displays the overall traces of aluminum oxide gridded from the 
‘Peak_Hill_Al203.txt’ data source
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4 Select bands B2 to B4.

The image window will display the gridded trace of mineral associated with th
band.

5 Select the Grid Datasource Points layer.

Notice that this layer is a Dynamic Link to the Project File you created. It show
point locations for the layer 1 (aluminum oxide) sample readings.

6 Click on the Dynamic Link Chooser  button in the layer process diagram 
to open the Display grid datasource  points dialog box.

7 Select ‘Gridded Data:2’ from the Grid Layer  drop-down list, and click on 
the Finish  button to exit the dialog.

The image window will now show the point locations for the layer 2 (calcium 
oxide) sample readings.1

Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, select Close  from the window control-menu.

Only the ER Mapper main menu should be open on the screen.

2: Create a gridded image using Minimum 
Curvature

In this exercise, we will create the same gridded image as we did previously. 
Instead of using Triangulation for all the bands we will now use Minimum 
Curvature for two of them. We will also gave the bands more meaningful nam
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Open the Gridding Wizard

1 Click on the Gridding Wizard  button on the Common Functions  
toolbar. 

The Gridding Wizard dialog opens with the 1)Introduction  tab selected. 

2 Select the Existing grid project  option.

3 Select your previously saved ‘grid_project_1_<your initials>.egp’ project 
file from the ‘\examples\Miscellaneous\Tutorial’ directory.

4 Click on the Gridding Wizard Next>  button or select the 2) Data Sources  
tab.

Both actions will take you to the next step by opening the ‘Data Sources’ tab

5 The list of data sources should show the four ‘Peak_Hill’ text files you 
selected in the previous exercise.

Leave the data sources unchanged.

6 Click on the Next>  button to go to the 3) Output Bands  tab.
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Define the output bands

1 Select the option Custom.

This should already be the default selection because we are using an existing
Project File. The toolbar buttons will now be visible. 

We want to give the output bands more meaningful names.

2 Select the ‘Gridded Data:1’ entry under Output band .

3 Click on the Edit output band description   button.

The Edit band description dialog will open.

4 In the Band description  field, enter the text “Al203 - triangulated”. Make 
sure that the ‘Peak_Hill_Al203.txt’ data source is allocated to this output 
band. If not, change the name accordingly.

5 Click on the OK button to return to the Gridding Wizard.

The Output band name will have changed to “Al203 - triangulated”.

6 Repeat the previous two steps and rename the other bands, “CaO - 
triangulated”, “Fe203 - MinC” and “MgO - MinC”.
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You should now have the following entries in the list:

7 Click on the Next>  button to go to the 4) Grid Type tab.

Select the gridding method

We will set two bands to Triangulation, and the others to Minimum Curvature.

1 Select Triangulation from the drop-down list next to ‘Al203 - triangulated’ 
and ‘CaO - triangulated’.

2 Select Minimum Curvature  from the drop-down list next to ‘Fe203 - MinC’ 
and ‘MgO - MinC’.
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3 Click on the Advanced...  button next to the ‘Fe203 - MinC’ entry to open 
the Minimum Curvature Parameters  dialog.

4 Use the sliders to set the Boundary tension(%)  and Interior tension(%)  
to 25.

Boundary and Interior tension
These parameters are used to suppress spurious 
oscillations particularly where the input points are far 
apart. This can create non-existent peaks and trough
the output image. Adding tension smooths out these 
ripples. Too much tension can create a “pin-cushion” 
effect.

Boundary tension is effective around the edges of the
image, while interior tension operates inside the imag

Convergence speed  This parameter is used to accelerate the convergenc
value of 0% iterates the equations exactly, and will 
always assure stable convergence. Larger values will
reach a solution more rapidly but may become unstab
If you use a large value for this factor, it is a good idea
monitor each iteration in the ER Mapper Status windo

Convergence limit. The convergence limit is a threshold value which is us
to determine whether the gridding is complete. After 
each iteration the gridding process checks the absolu
change in the grid value against this threshold. When
falls below the convergence limit, the process is 
assumed to be complete and the iterations will cease

Insufficient tension Correct tension Too much tension
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Maximum number of iterations
Iteration will cease when the convergence limit is 
reached or when the number of iterations reaches thi
parameter value. 

Aspect ratio If desired, you can specify a y to x value anistropy rat
This affects the way the gridding is done by giving mo
weighting to points located along one axis than those
located along the other axis. The default value of 1 giv
equal weighting to both axes.

This parameter does not affect the aspect ratio of the
output image cells. 

Note: You should generally not change these values from the defaults unless you a
advanced user and have a good reason for doing so. 

This will create the ‘Fe203 - MinC’ band with Minimum Curvature under tensio
and the ‘MgO - MinC’ band with Minimum Curvature.

5 Click on the OK button to close the dialog and return to the Gridding 
Wizard.

6 Click on the Next>  button to go to the 5) Create Grid  tab.

Create the gridded image

The ‘Create Grid’ tab allows you to specify the file name and define the Exten
Projection and Cell attributes of the output gridded file. You can also select ho
you want the gridded image displayed.
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1 Click on the File Chooser  button to open the Gridding Wizard Output 
File  chooser dialog box.

2 From the Directories  menu, select the path ending with the text \examples

3 Double-click on the directory named ‘Miscellaneous’ and then select the 
‘Tutorial’ directory.

4 Enter ‘minerals_MinC_grid_ <your initials> ’ in the chooser Save 
as: field, and click on the OK button.

The name with its path and a ‘.ers’ extension will be inserted in the File: field of 
the ‘Create Grid’ tab. When you create the gridded image it will be saved to th
file name.

5 Select all the display options:

• Display gridded image

• Display gridded image with sunshading

• Display gridded image with input overlaid as points

The image will be displayed in three separate image windows.

6 Select the Save Grid Project File... button to open the chooser dialog.

All the grid data sources and settings you entered are stored in a project file w
you can save and re-use.

7 From the Directories  menu, select the path ending with the text \examples

8 Double-click on the directory named ‘Tutorial.’

9 Enter ‘grid_project_2_<your initials>’ in the chooser Save as: field, and 
click on the OK button.

The project file is saved to the file name with a ‘.egp’ extension.

10 Click on the Finish  button to generate the gridded image and close the 
Gridding Wizard

A status dialog will indicate the progress of the gridding. 

On completion, ER Mapper will display three image windows displaying the 
following algorithms;

• The gridded image in a pseudo layer

• The gridded image in a pseudo layer and an intensity layer with sunshading o

• The gridded image in a pseudo layer and a grid datasource points vector laye

View an algorithm with the gridded image
1 Click on the ‘pseudo layer’ image window title bar to make it active.
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2 Open the Algorithm dialog by clicking on the Edit Algorithm button  on 

the Common Functions  toolbar.

The algorithm has a surface with Pseudo layer. 

3 Select the Pseudo layer

This layer contains band B1:Al203 - triangulated of the raster image you created
This displays the overall traces of aluminum oxide gridded from the 
‘Peak_Hill_Al203.txt’ data source.

4 Select the B3:Fe203 - MinC band from the drop -down list.

The image window will now display the overall iron oxide traces gridded from 
‘Peak_Hill_Fe302.txt’ data source using the Minimum Curvature method.
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Close all image windows and dialog boxes
1 Close all image windows using the window system controls:

• For Windows, select Close  from the window control-menu.

Only the ER Mapper main menu should be open on the screen.

• Use the Gridding Wizard to create a multi-band gridded image from text files.

• Select some of the output bands to use Triangulated gridding, and others to u
Minimum Curvature and Minimum Curvature under tension.

What you 
learned...

After completing these exercises, you know how to perform the following task
ER Mapper:
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System setup
This appendix describes the steps needed to set up your system for students
perform the hands-on exercises in this manual. The copying files section is div
into separate sections for users of ER Mapper running on Windows and 
ER Mapper running on Unix platforms. There are three tasks: 

• Installation of sample datasets

• Copying the sample file for the region definition exercise (Chapter 8)

In order to carry out the following instructions, you should have some basic 
knowledge of copying files in Windows or Unix and setting file permissions (if
needed).

1: Installation of “application” datasets
All of the hands-on exercises in this workbook require students to access the
sample images supplied on the ER Mapper CD-ROM. You must install the 
‘\examples\Applications\.Oil_And_Gas_Exploration’ and the 
examples\Shared_Data directories.

2: Copying files to the ‘tutorial’ directory
The exercises using regions in Chapter 8, “Using formulas” require that each
student have their own copy of the dataset “Seismic3D” under the name 
“Seismic_practice” in ER Mapper’s ‘tutorial’ directory. (The ‘tutorial’ directory i
created automatically during the ER Mapper installation.) Follow these steps 
copy and rename the header file and data file.
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Note: Users must have read and write access to the practice dataset. Set the file 
permissions appropriately if needed. If you have multiple users sharing the sa
‘tutorial’ directory, it is recommended that you make a copy under a different n
for each student and notify them which one to use.

Copying files for Windows installations
1 Use the Windows Explorer to copy and rename the following files in the 

‘examples\Shared_Data’ directory to the ‘examples\Miscellaneous\Tutorial’ 
directory as indicated:

Shared_Data\Seismic3D.ers  copy to Miscellaneous\Tutorial\Seismic_practice.ers

Shared_Data\Seismic3D  copy to Miscellaneous\Tutorial\Seismic_practice
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Reference texts
This appendix provides references to journal articles describing application o
image processing techniques to interpreted seismic datasets. These articles m
helpful to those new to seismic image processing, or those who want details 
image processing techniques as applied to real world oil and gas exploration
applications. Also refer to the ER Mapper Applications Manual for examples and 
information about image processing for many earth science applications.

McQuaid A. S. J., and J. Bradley. “Surely That’s Not Seismic! The Benefits of
Image processing” In publication, reference available from Earth Resource 
Mapping upon request.

Paterson, G. A. D. “A New Approach to Signature Analysis in Seismic 
Interpretation Using an Interactive Workstation” Landmark Research Laborato
Dept. of Exploration Geophysics, Curtin University of Technology, 1 Kent St., 
Bentley, Western Australia 6102.

Pettifer, G., A Tabassi, and B. Simons. 1991. “A New Look at the Structural 
Trends in the Onshore Otway Basin, Victoria, Using Image Processing of 
Geophysical Data” The Australian Petroleum Exploration Association Journa
1991, pp. 213-227.

Tilbury, L. A., and D. Bush. 1991. “Image Processing of Interpreted 3D Seism
Data to Enhance Subtle Structural Features/Lineations” Exploration Geophys
(1991), Vol. 22, pp. 391-396.
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Importing data
ER Mapper allows you to import data from the following Schlumberger Geoqu
and Landmark Graphics formats. These formats are those commonly used in
seismic industry, and they are accessed using the Utilities menu on the ER M
main menu.

You will commonly need to specify datum and map projection information to E
Mapper either during the import or afterward (by editing the .ers header file).
more information on these imports please see the relevant sections in the 
ER Mapper User Guide and under the Help menu. 
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Schlumberger/Geoquest formats

Landmark Graphics raster formats

Landmark Graphics vector formats

Format Menu option under ER Mapper Utilities menu

Mapview Import Schlumberger Formats/GeoQuest (IESX) 
Mapview

GeoQuest (IESX) 
ASCII Grid Dump

Import Schlumberger Formats/GeoQuest (IESX) ASCII 
Grid Dump

Format Menu option under ER Mapper Utilities menu

Zycor ASCII Grid Import Landmark Formats/ Zycor ASCII Grid

Format Menu option under ER Mapper Utilities menu

OpenWorks 3.1 
Wells

Import Landmark Formats/OpenWorks 3.1 Wells

Seisworks Fault 
Polygons

Import Landmark Formats/ SeisWorks Fault Polygons

Seisworks Manual 
Contours

Import Landmark Formats/SeisWorks Manual Contours
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About this section
This section of the manual is intended to help explain the problems and soluti
sharing imagery throughout your enterprise, and focuses on free software plu
provided by Earth Resource Mapping. The hands-on exercises in this docume
require that certain software and sample data be installed beforehand. Please
the introduction to each chapter for more information.

Chapter contents
Most chapters in this section give you hands-on experience using the ER Map
software plug-ins inside of the host application, such as ArcView GIS, MapInfo
Autodesk World, and office and word processing applications. In general, eac
chapter is independent of the others. 

The emphasis is on learning and using the ER Mapper software plug-ins, not 
teaching image processing and remote sensing concepts. For more detailed 
information on the principles of image processing or remote sensing for speci
applications, please refer to the ER Mapper Applications Manual, or any of the text 
books available. 
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Enterprise Wide
Imagery

Enterprise wide imagery is the concept of making imagery easily available and 
accessible to all users and software applications within your organization. Thi
chapter explains how you can use free ER Mapper tools to overcome problems
using and sharing imagery. It also includes a short introduction to imagery, an
overview of the capabilities of the ER Mapper software.

Using imagery within your organization
Many groups within an organization can benefit from the use of imagery such
aerial photographs and satellite images in their everyday work. These include
departments such as engineering, marketing, mapping/GIS, graphics, publica
and others. Because these groups use a wide range of software applications,
been difficult to share imagery across an entire enterprise. Two primary reaso

• Incompatible file formats–Images used by one group cannot be used by other
groups because the file format is not compatible with their software. 

• Large file sizes–Even when your software can read an image file’s format, it of
cannot process large image files. Large image files, such as airphotos, are 
increasingly demanded by clients to show high levels of detail and coverage of 
geographic areas of interest.
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• Images served over the Internet–Images that you access over the internet have
retrieved via a browser and stored locally before you can use them in your sof
application. It would be far more efficient to be able to access images from wi
the software application by specifying their URL (Universal Resource Locator
you would with an Internet browser like Internet Explorer.

Now ER Mapper provides free software solutions to help you overcome these 
problems. Anyone who wants to use imagery can do so without having to con
between formats, reduce file sizes, learn complex imaging products, and so o

Enterprise wide imagery
Enterprise wide imagery is the concept of making imagery easily available and 
accessible to all users and software applications within your organization. The
applications include desktop mapping and GIS products, graphics and presen
products, word processing products, database products, and others. 

ER Mapper’s free imagery products provide solutions to the two main problem

• Incompatible file formats–Images used by one group can now be used by all 
groups because ER Mapper’s free solutions allow most products to read an ind
standard set of imagery formats. For example, word processing or graphics 
applications can now directly display satellite images in their native formats.

Sharing Imagery Throughout an Enterprise

Imagery Files
(TIFF, BMP, JPEG, HDR,

ERS, ECW, ALG)

Engineering
(CAD software, AutoCAD,

AutoCAD Map)

Graphics
(Photoshop, Powerpoint,

Corel Draw, etc.)

Publications
(Word, FrameMaker,

AmiPRO, etc.)

Mapping/GIS
(ArcView, ARC/INFO,

Intergraph, etc.)

Business/Marketing
(MapInfo, spreadsheet,

database, etc.)
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• Large file sizes–ER Mapper’s free solutions allow your applications to read ima
files of virtually any size very quickly. Mosaics of aerial photographs, for exam
often require 100’s of megabytes (even gigabytes) of disk space. ER Mapper’s
solutions handle the underlying technology, so even simple word processors c
display very large image files in a snap.

• Images served over the internet–ER Mapper 6.1 allows you to directly access 
images served over the internet by specifying their URL. The free plug-ins allo
most other GIS and Office products to do the same.

ER Mapper free imagery solutions
ER Mapper’s free Enterprise Wide Imagery solutions are tightly integrated 
software tools and plug-ins that let you share images throughout your enterpr

• ER Viewer–A free image viewer that lets you view ER Mapper images and 
algorithms, TIFF and GeoTIFF files, Windows BMP, JPEG, Universal Data For
(UDF), ESRI BIL, and SPOTView image formats.

• Imagery plug-in for Office users–Users of office products (word processing, 
graphics, spreadsheets, etc.) can use ER Viewer’s OLE capabilities to directly
display large imagery files quickly within their applications.

• ER Mapper Imagery Extension for ArcView GIS–A free extension that lets 
ArcView GIS users display ER Mapper format images and smart data algorith

• MapImagery plug-in for MapInfo –A free plug-in that lets MapInfo users displa
and enhance the same image formats supported by ER Viewer.

• AutoCAD Map plug-in –A free plug-in that lets AutoCAD Map users display th
same image formats supported by ER Viewer.

• Autodesk World imagery viewer–Autodesk World lets users display any image
supported by ER Viewer (this functionality is embedded in the World software

Using ER Mapper for imaging
By using the plug-ins and tools in conjunction with ER Mapper, you gain acces
the powerful capabilities of this leading integrated mapping and image proces
application. ER Mapper can be used as a central depository for all image data
where it can be processed as needed before passing on to other applications
organization via the plug-ins and tools.

Adding ER Mapper to your enterprise gives you capabilities to:

• Import and display over 100 different image formats
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• Directly read TIFF, GeoTIFF, BMP, ER Mapper images and algorithms, ESRI B
SPOTView and Universal Data Format (UDF) imagery without the need for im
or conversion

• Easily view the entire project area in one image–no limits on image file sizes

• Geocode and orthorectify imagery easily to precisely register with GIS vector 

• Automatically display, mosaic and color balance numerous images

• Combine imagery, vector and tabular data from any number of sources

• Create and edit vector data over imagery backdrops, and highlight features of
interest and save them as vectors with ER Mapper’s raster to vector conversio

• Use advanced image processing functions such as contrast enhancement, 
multispectral classification, vegetation indexes, color shaded reliefs, filtering, 
merging images, and many others.

ER Mapper can serve as a central hub for all the image data, so you can proce
enhance images if needed before passing them onto other applications in you
enterprise.

ER Mapper image compression
ER Mapper also lets you create and distribute royalty-free compressed image
using the patent pending ER Mapper ECW Compression facilities and the free
plug-ins for other applications. You can now achieve significant compression ra
with no noticeable deterioration in image quality.

ER Mapper
(image processing, mosaicing,
geocoding, map production,

3D visualization...)

ER Viewer
(image viewing)

Office applications

ArcView GIS

MapInfo

Autodesk World

AutoCAD MAP

airphotos
satellite images

digital elevation models
geophysical data
ASCII and binary

(over 100 image formats)
312 Enterprise Wide Imagery



Chapter 19 Enterprise Wide Imagery ● Working with large images

and 
mple, 

ver 
Working with large images
When working with satellite imagery, airphotos, scanned topographical maps 
other types of imagery, the size of image files can become very large. For exa
it takes 3 terrabytes (3,000GB) of color imagery to take aerial photographs of 
typical city at 3 inch resolution. It takes 1.5TB (1,500GB) of color imagery to co
all of California at a resolution of one meter. 

Compression of imagery offers several advantages including:

• reduced image file size

• faster access

• easier distribution

• the ability to work with imagery covering larger areas
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Using ER Viewer
This chapter explains how to use the free ER Viewer application to display and
analyze several types of image files. ER Viewer is a free Windows application 
can be installed from the ER Mapper installation CD-ROM or downloaded from
the ER Mapper website at www.ermapper.com.

About ER Viewer
ER Viewer is a free, easy to use image viewing application featuring interactiv
roaming and zooming of very large image files. It also acts as an OLE server 
application to let you view images inside your favorite Windows applications. 
ER Viewer offers unequalled stability and supports a wide range of image form
including: 

• Universal Data Format (UDF) images

• ER Mapper compressed and uncompressed images

• TIFF and GeoTIFF images

• Windows BMP images

• SPOTView images

• ESRI BIL (ARC/INFO and ArcView) images

• Smart Data ER Mapper algorithms
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Hands-on exercises
These exercises show you how to use ER Viewer to display image files and pe
zooming, roaming and measuring distances.

• Use ER Viewer to display images in several different formats

• Interactively zoom and roam images

• View geographic coordinates and measure distances on an image

• Print an image (optional)

Note: The following examples use image files supplied with ER Mapper as sample d
If it is not possible to install ER Mapper, you must have a sample TIFF or BMP
image file to use for the exercises.

1: Using ER Viewer to display images

Start ER Viewer

1 Start ER Viewer by double-clicking the  icon on your desktop or 
selecting Start/Programs/ER Mapper/ER Viewer .

ER Viewer starts up and displays the Getting Started information dialog that 
contains basic instructions for using ER Viewer.

2 Click Close  on the Getting Started With ER Viewer  dialog.

3 Click the Maximize   button in the upper-right corner of the ER Viewer 
window (if it is not already maximized)

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ER Viewer and OLE-enabled Windows applications:

Before you 
begin...

Before beginning these exercises, you must have installed ER Viewer on your
system. You can download it free of charge from the ER Mapper web site at 
www.ermapper.com if needed.

Objectives Learn how to use ER Viewer to display images, zoom and roam around the 
images, and measure distances on geocoded images.
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ER Viewer expands to fill your desktop.

About the ER Viewer interface
The ER Viewer user interface has the following components:

Tip: To get help on using any ER Viewer component, click the What’s this?   

button then and click on the component of interest.

Open an ER Mapper-format image file

1 Click the Open  toolbar button (or select File > Open ).

2 On the Open algorithm or image files dialog, open the Files of type  
menu.

coordinates of current
mouse position and
distance measurement

status bar

main menu

toolbar

image window
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A list of image formats supported by ER Viewer displays. You can open 
ER Mapper-format images and algorithms, graphics formats like TIFF and BM
satellite image formats such as GeoSPOT and ESRI BIL, and others.

3 Select the All image files option.

4 Navigate to the directory where ER Mapper is installed. Open the 
‘examples\Shared_Data’ directory. Double-click on the file ‘airphoto.ers.’

ER Viewer displays an aerial photograph of the San Diego, California area. (T
file was previously imported and saved in ER Mapper ‘.ers’ image file format.)

Note: If the ER Mapper sample data is not installed, navigate to a directory containin
image in TIFF, BMP or other supported format an open it instead.

Enlarge the image window
1 Drag the image window by a corner to make it larger.

2 From the Zoom  menu, select Data Extents .

The image expands to fill the new image window size.

Use the Zoom Tool to zoom freely in and out

1 Click the Zoom Tool   button on the toolbar (or press F6).

2 Point to the center of the image, then drag downward to zoom in.

3 Point to the center of the image, then drag upward to zoom out.

By dragging up or down, you can zoom in or out by any amount. When you rel
the mouse, ER Viewer refreshes the image detail as needed.

Use the Zoom Tool to zoom by fixed amounts
1 From the Zoom  menu, select Data Extents .

The airphoto image zooms out to show the entire image extents.

2 Click on the center of the image to zoom in.

The image zooms in to twice (200%) the previous magnification.

3 While holding down the Ctrl key, click the image center again.

The image zooms out to half (50%) of the previous magnification. With the Zoom 

Tool   selected, clicking zooms in and Ctrl-clicking zooms out by fixed 

amounts.
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Use the Zoom Box Tool to zoom on an exact area
1 From the Zoom  menu, select Data Extents .

The image zooms out to show the entire image extents.

2 Click the ZoomBox Tool   button (or press F5).

3 Drag a box around the central portion of the image.

ER Viewer zooms in to display the area you defined with your box. Use the 
ZoomBox Tool tool to zoom in on an exact area of interest.

Use the Hand Tool to roam around (pan) the image

1 Click the Hand Tool   button (or press F7).

2 Drag the airphoto within the image window.

ER Viewer roams (or pans) to display the adjacent area of the image. Use the Hand 
Tool tool to roam around and quickly view adjacent areas of the image.

Tip: When the Zoom Tool   is selected, pressing Shift temporarily enables the 

Hand Tool  .

View geographic locations on the image
1 Without depressing the mouse, point to different locations on the image.

The geographic locations of the current mouse position are shown in the lower
part of the ER Viewer window. (Locations are shown in the units of the map 
projection. This airphoto is registered to the UTM coordinate system, so the 
locations are in meters of Easting and Northings.)

Note: Geographic locations only display when your image has been registered to a 
projection. If your image in unregistered, the locations appear as row and colu
(cell) values instead.

Use the Measure Tool to measure distances in the image

1 Click the Measure Tool   button (or press F8).
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2 Drag a line between two points on the image.

ER Viewer shows the distance between the start and end points on the right s
the status bar. 

3 While keeping the mouse button depressed, drag to different points on the 
image.

The distances are updated interactively as you move the mouse. As with loca
distances are shown in the units of the map projection (in this case meters).

Tip: Ctrl-Shift temporarily enables the Measure Tool   when the Zoom Tool  

, ZoomBox Tool   or Hand Tool   is selected.

Open a second ER Mapper image file

1 Click the Open  button.

drag a line, distance
is shown in status bar
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2 Navigate to the directory where ER Mapper is installed. Open the directory 
‘examples\Applications\Land_Information.’

Tip: The ‘Automatically adjust contrast on dataset load’ option enhances the contra
any image you open automatically. You should usually leave this option turned

3 Double-click on the file ‘SPOT_XS_07Aug88.ers’ to display it.

ER Viewer displays a SPOT XS satellite of the San Diego, California area in a
image window. This is a color infrared image, so vegetated areas are shown i
tones.

4 Make the image window two times larger, then select Zoom > Data 
Extents .

5 Zoom in to an area of interest using the Zoom Tool   or ZoomBox Tool 

.

6  Pan or scroll the image as desired using Hand Tool  .

View properties of the image file
1 From the View  menu, select Properties .

ER Viewer displays tab pages showing properties of the image file.

2 On the Properties  dialog, click the Registration tab.

The geodetic datum, map projection, units and other georeferencing informat
about the image file is shown.

3 Click Cancel  on the Properties  dialog.

Preview a hardcopy print of the image

1 Click the Print Preview  button.

ER Viewer redisplays the image to show how it would be sized and positioned
your default printer. ER Viewer tries to center the image on the page and fill th
printable area.

Tip: Only the area you zoomed into will be printed, so you can easily print any por
of a large image.
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2 Click Close  or click the  button on the image window.

The image redisplays in normal mode for zooming and roaming.

Print of the image (optional)

1 Click the Print  button.

The Windows Print  dialog for your default printer opens to let you select a print
change the properties, and print the image.

2 If desired, select the printer and properties, then click OK to print the image. 
Otherwise click Cancel  to close the Print  dialog.

Close ER Viewer

1 Click the Close  button on the ER Viewer window (or select File > Exit ).

• Use ER Viewer to display images in several different formats

• Interactively zoom and roam images

• View geographic coordinates and measure distances on an image

• Print an image (optional)

What you 
learned

After completing these exercises, you know how to perform the following tasks
ER Viewer:
322 Enterprise Wide Imagery



 to 
out 

wer 
ou 
t 
21

Office applications
(OLE)

This chapter explains how you can use your office software’s OLE capabilities
easily display and manipulate large images inside Windows applications (with
having to save the image as part of the file). 

Note: To use the OLE capabilities described here, make sure you first install ER Vie
and perform the exercises in the previous chapter to become familiar with it. Y
can install ER Viewer from the ER Mapper installation CD-ROM or download i
from the ER Mapper website at www.ermapper.com.
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What is OLE?
Many Windows applications support OLE–Object Linking and Embedding. OLE is 
a program-integration technology developed by Microsoft that lets you easily s
information between programs. This capability allows you to insert an object (s
as an image) into any OLE-enabled application. Most office applications runni
under Microsoft Windows support OLE. 

With a linked object, information is created in one file (the source file) and inserted 
into another file (the destination file) while maintaining a connection or “link” 
between the two files. When you save the destination file (such as a word 
processing document), you save only the link to the source file and do not em
the image as part of the document. 

For example, several different documents can display the same image, all via
to the single source image file. If the source image file is modified, the linked 
image objects in the destination files are also automatically updated to reflect 
changes.

Sharing image files using OLE
In addition to letting you view images, ER Viewer also acts as an OLE server 
application to let you view images inside your favorite Windows applications. 
Using ER Viewer’s OLE capabilities provides many advantages for sharing lar
image files throughout your enterprise, including:

• You can display image files much larger than the application itself is capable 
displaying (for example a 500MB airphoto) since ER Viewer performs the 
processing (not the application where the image is displayed)

• Much faster display of large image files in documents, since ER Viewer perfor
the processing (not the application where the image is displayed)

Image file
(source file)

spreadsheet
document

image
object

word
processing
document

image
object

presentation
document

image
object
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• Word processing documents, spreadsheets, presentations, and other applicatio
all share a single copy of the original imagery files

• Documents can display images in many additional image formats not support
the destination application, but that are supported by ER Viewer

• Images can be displayed in the application without having to permanently em
and save the image files as part of the document (so the documents remain s
size)

• You can access the power of ER Mapper Smart Data Algorithms to apply com
processing enhancements that create beautiful images interactively without 
changing the original image files

Hands-on exercises
These exercises show you how to insert an image into another Windows applic
as a linked OLE object using ER Viewer as the source application.

• Insert an image as a linked OLE object into another Windows application

• Edit the image object within the application using the ER Viewer toolbar

• Copy and paste an OLE image form one area to another

Note: The following examples use image files supplied with ER Mapper as sample d
If it is not possible to install ER Mapper, you must have a sample TIFF or BMP
image file to use for the exercises.

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in OLE-enabled Windows applications:

Before you 
begin...

Before beginning these exercises, you must have installed ER Viewer on your
system.
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1: Using OLE to display images

In the past, it was usually necessary to embed large image files in word proce
documents, spreadsheets or presentations in order to display and print them 
resolution. Since the image file was saved as part of the document, it createdvery 
large document files and the data could not be edited once it was inserted.

With Object Linking and Embedding (OLE), you can use ER Viewer as a powe
image viewing engine to display and edit large image files directly inside your
Windows applications. This allows you to display images in many formats that
cannot be read by the application itself, and also makes the document files m
smaller because only a link to the image file is saved with the document.

The following example uses Microsoft Word as the example OLE-enabled 
application. You can use any other OLE-enabled word processing application 
desired (WordPerfect, Framemaker, and so on).

Start Microsoft Word (or other OLE-enabled word processor)
1 Start up the Word application on your system (or another OLE-enabled 

word processor).

2 Type the text San Diego Airphoto as the first line of your document, 
then press Enter to create a new line.

Open the Windows Explorer
1 Open the Windows Explorer application (select Start > Programs > 

Windows Explorer ).

2 Open the ER Mapper installation directory. Then open the directory 
‘examples\Applications\Airphoto\1_Geocoding.’

You should see a list of files beginning with ‘San_Diego_Airphoto.’

3 Move the Word application window and the Explorer window side by side 
(resize them if needed).

Objectives Learn how to use ER Viewer as an OLE server to display and edit large image
files within OLE-enabled Windows applications.
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Drag an image file into the Word document
1 Drag the file ‘San_Diego_Airphoto_36_rectified.ers’ from the Explorer 

window and drop it into the Word document window.

After a short time, the image file displays in your document.

2 In the word processor, click once on the image to select it, then drag the 
lower-right corner handle to make it much larger.

The image redisplays at the larger size. This image is a color aerial photograp
the San Diego, California area. The source image file is over 34MB in size.

Zoom and roam using the ER Viewer toolbar
1 In Word, double-click on the image.
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The word processor’s native toolbar changes to display the ER Viewer zoom a
roam tools. When you double-click on a linked object, the object’s server 
application (ER Viewer) is temporarily enabled inside the container application 
(the word processor) so you can edit the object.

2 Click the ZoomBox Tool   button, then drag a box to enclose the area of 
white buildings in the lower central portion of the image.

3 ER Viewer zooms in to display the area you defined with your box. 

4 Click the Hand Tool   button, then drag the image.

5 ER Viewer roams (or pans) to display the adjacent area of the image.

Return to the Word application
1 In the word processing document, click outside the image area.

The usual word processor toolbar and interface returns, and the image is upda
the new extents you defined.

Drag and drop a second image into the document
1 Press Enter twice to create two new lines below the image, then type the 

text Mount St. Helens Volcano .

ER Viewer toolbar
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2 In the Explorer window, open the ER Mapper home directory, then open the 
directory examples\Applications\Mt_St_Helens.

3 Drag the file ‘2D_after_eruption.alg’ from the Explorer window and drop it 
into the word processing document window.

After a short time, the image file displays in your document.

4 Click once on the image to select it, then drag the lower-right corner handle 
to make it larger.

This is an image of the Mount St. Helens Volcano in the state of Oregon, USA 
an eruption that blew out the central portion of the mountain. The image data 
which this is created is a Digital Elevation Model (DEM) where each pixel valu
represents a terrain elevation. The special processing technique is called a 
“colordrape” that combines a color image that shows elevation with a shaded 
image that shows terrain features. 

In this case, the image file you linked to is an ER Mapper Smart Data Algorith
(.alg). The algorithm file runs the ER Mapper processing engine in the backgro
to interactively create the enhanced colordrape image from the original DEM 
image data.

Tip: Most OLE-enabled applications also let you insert a linked OLE object into a 
document using a menu command (as an alternative to the drag and drop me
shown in the previous example).

Zoom into and center the volcano image
1 Double-click on the inserted image to display the ER Viewer toolbar.
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2 Use the Zoom Tool   to zoom in on the central portion of the image (the 

volcanic caldera), then use the Hand Tool   to drag the image and 
center it.

3 When finished, click outside the image to return to the word processing 
application.

Copy and paste the volcano image
1 Click once on the volcano image to select it.

2 Press Ctrl+C (or select Edit > Copy ) to copy it.

3 Press Enter twice to create two new paragraphs in your document.

4 Press Ctrl+V (or select Edit > Paste ) to paste the volcano image into the 
new location.

It is sometimes useful to copy and paste OLE images from one part of your 
document to another. For example, you might insert an airphoto covering a la
area, then copy and paste it to different parts of the document and zoom in to
different areas of interest.

 Use tools to zoom
in and center image
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(Optional) Save your word processing document.
1 Save your document, then close the application.

Note: If you check the file size of your word processing document, it should only be 
about 1MB. Yet this document displays images that are created from almost 4
of image files. This is one of the big advantages of OLE–you can display very l
image files inside a document very quickly without having to embed the image
files. (That is, images are not saved as part of the document, only the link to th
saved.)

• Insert an image as a linked OLE object into another Windows application

• Edit the image object within the application using the ER Viewer toolbar

• Copy and paste an OLE image from one area to another

What you 
learned

After completing these exercises, you know how to perform the following tasks
OLE-enabled Windows applications:
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ArcView GIS
Users

This chapter explains how to use the free ER Mapper Imagery Extension for 
ESRI’s ArcView GIS software. It also explains how to obtain and install the 
extension, and the additional imaging capabilities ArcView users can gain by u
the extension in conjunction with ER Mapper.

Note: You must have a licensed copy of ArcView GIS version 3.1 or greater to install
run the ER Mapper Imagery Extension. You do not need to have a copy of 
ER Mapper installed, but this is recommended to gain access to sample ER M
imagery and algorithms used in the following tutorial. (You can order the free 
ER Mapper installation CD-ROM from www.ermapper.com.)

About the ER Mapper Extension for ArcView GIS
As imagery data sources become more important for GIS applications, the ne
efficiently process, enhance and display large image files also becomes more
important. Earth Resource Mapping (developers of ER Mapper) provides a fre
extension (or “plug-in”) that lets ArcView GIS users directly display ER Mappe
imagery and algorithms. With the ER Mapper Imagery Extension, ArcView GIS
users are no longer restricted by limited image handling capabilities. In additio
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you can experience the full power of ER Mapper algorithms from within ArcVie
GIS, and give your vector GIS data real world meaning by presenting it over im
backdrops.

Using the extension with ER Mapper
By using the extension in conjunction with ER Mapper, ArcView GIS users ga
access to the extensive capabilities of this powerful integrated mapping and im
processing software, including:

• Import and display over 100 different image formats

• Directly read TIFF, GeoTIFF, BMP, ER Mapper images and algorithms, ESRI B
SPOTView and Universal Data Format (UDF) imagery without the need for im
or conversion

• Easily view the entire project area in one image–no limits on image file sizes

• Geocode and orthorectify imagery easily to precisely register with GIS vector 

• Automatically display, mosaic and color balance numerous images

• Combine imagery, vector and tabular data from any number of sources

• Create and edit vector data over imagery backdrops, and highlight features of
interest and save them as vectors with ER Mapper’s raster to vector conversio

• Use advanced image processing functions such as contrast enhancement, 
multispectral classification, vegetation indexes, color shaded reliefs, filtering, 
merging images, and many others.

How to obtain the ER Mapper Imagery Extension
You can obtain the free ER Mapper Imagery Extension from two sources:

• The ER Mapper installation CD-ROM–The extension can be installed as a 
separate component from the ER Mapper installation CD-ROM. (It is recommen
that you also install ER Mapper to gain access to a wide variety of sample dat
test drive the software in free evaluation mode to see what it can do for you.)

• The ER Mapper web site–You can download the latest version of the extensio
from the ER Mapper web site at www.ermapper.com. Navigate to the “free 
software” area and download the ArcView GIS plug-in.
334 Enterprise Wide Imagery



Chapter 22 ArcView GIS Users ● Hands-on exercises

n 
e 

 

r 
Hands-on exercises
These exercises show you how to use the ER Mapper Imagery extension for 
ArcView GIS.

• Enable the ER Mapper Imagery Extension after starting ArcView GIS

• Display an ER Mapper image file (.ers) as an Image Data Source

• Display an ER Mapper algorithm file (.alg) as an Image Data Source

• Display a vector theme on an ER Mapper image

1: Using the ER Mapper extension

Start ArcView GIS
1 Start the ArcView GIS software on your system.

2 If the Welcome to ArcView GIS dialog appears, click Cancel .

3 Click the Maximize   button in the upper-right corner of the ArcView GIS 
application window (if it is not already maximized)

ArcView GIS expands to fill your desktop.

Load the ER Mapper extension
1 From the File  menu, select Extensions... .

2 On the Extensions  dialog, click on the box next to ‘ER Mapper Algorithms 
and Imagery’ (a check mark should appear).

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in ArcView GIS using the ER Mapper Imagery Extension:

Before you 
begin...

Before beginning these exercises, you must have installed ArcView GIS versio
3.1 or higher and the ER Mapper extension for ArcView on your system. Thes
exercises use sample ER Mapper imagery and algorithm files from the 
ER Mapper installation CD-ROM. You may also follow the general procedures
using your own ER Mapper imagery (.ers) or algorithm (.alg) files.

Objectives Learn to enable the ER Mapper extension for ArcView and display ER Mappe
imagery (.ers) files and algorithm (.alg) files.
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3 Turn on the ‘Make Default’ option, then click OK.

The ER Mapper Imagery Extension for ArcView GIS loads. You can now displ
ER Mapper algorithm and imagery files. Since you selected ‘Make Default,’ th
extension will load automatically each time you start ArcView GIS.

Open an ER Mapper-format (.ers) image file
1 If the Project window is not open, select File > New Project .

2 On the Project window, click New to open a View window. (It should titled 
‘View1’.)

3 Click the Add Theme   button (or select View > Add Theme ). 

4 On the Add Theme  dialog, select ‘Image Data Source’ from the ‘Data 
Source Types’ list. (ER Mapper imagery and algorithms are always image 
data sources in ArcView GIS.)

5 Double-click on the folder where ER Mapper is installed. Then open the 
‘examples\applications\land_information’ folder.

A list of ER Mapper imagery (.ers) and algorithm (.alg) files appears.

turn on ER Mapper
extension

load extension
on startup
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6 Scroll down to the bottom, then double-click on the file 
‘spot_xs_07aug88.ers.’

7 Click the check box next to the ‘Spot_xs_07aug88’ theme to turn it on.

ArcView GIS displays a SPOT XS color satellite image of the San Diego, 
California area. This is a 3-band color infrared image, so vegetated areas app
red tones. 

load image

turn on theme
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This image file is in ER Mapper’s native ‘.ers’ imagery format. The extension 
enables ArcView GIS to read it as one of its native formats. (ER Mapper’s ima
format is composed of a binary data file and an ASCII header ‘.ers’ file similar
the ‘.hdr’ files also used by ESRI products.)

8 Resize the ‘View1’ window to make the image larger.

Zoom, pan and measure the image

1 Click the Zoom In  tool, then drag a box over the central part of the 
SPOT image to zoom into it.

2 Click the Pan  tool, then drag the image to view adjacent areas.

3 Click the Measure  tool, then drag a line to view distances across an 
area.

The line length appears in the lower-left corner of the ArcView GIS dialog.

4 Move the mouse pointer around inside the image. 

Geographic coordinates appear in the upper-right area indicating that the ima
georeferenced. (In this case to the UTM projection, so units are meters of Eas
and Northings.)

Tip: When you load an ER Mapper imagery (.ers) file, the contrast is automatically
enhanced by the ER Mapper Imagery Extension (using a 99% linear contrast 
stretch). You can further adjust image contrast if desired using Theme > Edit 
Legend , however this is usually not necessary.

Open an ER Mapper algorithm (.alg) file
In ER Mapper, an algorithm is a list of processing steps or instructions ER Mapp
uses to transform a raw imagery file into a final, enhanced image on your scre
printer. Algorithms let you define a “view” into your data that you can save, relo
and modify at any time. By using the ER Mapper Imagery Extension, you can
display ER Mapper algorithms just like an other image data source.

Tip: You need a license for ER Mapper to create algorithms, but you only need the
ER Mapper Imagery Extension to view them in ArcView GIS. This means that
anyone using ER Mapper can create algorithms and send them to you for view
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1 From the Edit  menu, select Delete Themes . When prompted to delete the 
theme ‘Spot_xs_07aug88.ers’ click Yes.

The theme is deleted from your view.

2 Click the Add Theme   button (or select View > Add Theme ). 

The files in the ‘land_information’ directory should be displayed.

3 Open the ‘applications\airphoto\3_balancing’ folder.

A list of ER Mapper imagery (.ers) and algorithm (.alg) files appears.

4 Scroll down to the bottom, then double-click on the file 
‘san_diego_airphoto_34_36_balanced_mosaic.alg’ (the next to last file).

5 Click the check box next to the theme to turn it on.

ArcView GIS displays a mosaic of two orthorectified color airphotos of the 
downtown San Diego, California area. This image is created from an ER Map
algorithm, so it has several processing enhancements applied to the two airph
imagery (.ers) files used as input:

• brightness and color variations within each image are normalized to remove 
“hotspots” or light-to-dark variations across each photo

• the contrast and brightness of the two normalized images are then balanced t
other ensure uniform color and brightness across the mosaic

• the seam between the two images is feathered to ensure a smooth transition b
the two images and make the mosaic truly “seamless”

6 Click the Zoom In  tool, then drag a box over the central part of the 
mosaic image to zoom into it.

7 Click the Pan  tool, then drag the image to view adjacent areas.

balanced mosaic algorithm
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This example shows how you can access the power of ER Mapper algorithms
apply complex image enhancements and display them directly with ArcView G
This example uses only two airphotos, but you could just as easily display a m
algorithm containing 100’s of megabytes (even gigabytes) of airphoto images.

Add a second view to display a merged satellite image

1 Click the Minimize   button on the ‘View1’ window to minimize it (or 
close it if desired).

2 On the Project window, click New to open a new View window. (It should be 
titled ‘View2’.)

3 Click the Add Theme   button (or select View > Add Theme ). 

The files in the ‘3_balancing’ directory should be displayed.

4 Open the ‘examples\functions_and_features\data_fusion’ folder.

A list of ER Mapper algorithm (.alg) files appears. These algorithms all show 
different ways of merging (or “fusing”) two different images into one.

5 Double-click on the file ‘brovey_transform.alg.’

6 In the ‘View2’ window turn on the ‘Brovey_transform’ theme.

ArcView GIS displays a color image of the San Diego, California area. This is
merge of a Landsat TM satellite image (bands 5, 4 and 2) and a SPOT 
Panchromatic satellite image. By merging the two types of data, you get the h
spatial detail provided by the SPOT Pan image (10-meter resolution) with the 
multispectral color information provided by the Landsat TM image (seven band
30-meter resolution). 

The Brovey Transform is a mathematical way of combining the two images th
also greatly enhances the color. Merging or fusion techniques like this are use
combine the strengths of different satellite sensors and create up-to-date view
the earth’s surface.

7 Enlarge the ‘View2’ window to make the image larger.

8 Zoom in and pan to different parts of the image using the Zoom In  and 

Pan  tools.

The image shows a high resolution, color-enhanced view of the area. As with 
airphoto mosaic, the ER Mapper algorithm creates this image interactively from
two separate Landsat and SPOT satellite imagery files. (The Brovey Transform
technique usually requires up to three intermediate image files to be created w
using traditional imaging software, but ER Mapper performs the processing in
time from the two source images without creating intermediate files.)
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9 Click the Zoom to Full Extent  button (or select View > Full Extent ) to 
zoom out to the full image extents again.

Add a second theme (algorithm) showing thematic land cover

1 Click the Add Theme   button (or select View > Add Theme ). 

The files in the ‘data_fusion’ directory should be displayed.

2 Open the ‘functions_and_features\classification_display’ folder.

3 Double-click on the file ‘isoclass_classification.alg.’

4 In the ‘View2’ window turn on the ‘isoclass_classification’ theme.

ArcView GIS displays a thematic color image of the same area of San Diego. 
Different colors correspond to different types of landuse in the area. This imag
was created from a 1985 Landsat TM satellite image using ER Mapper’s 
ISOCLASS unsupervised classification feature. Classification groups pixels w
similar spectral values into classes that can represent different types of landu
land cover. 

5 Turn the ‘isoclass_classification’ theme on and off to compare it with the 
‘brovey_transform’ merged satellite image theme.

Adding several themes showing different types of data or processing techniqu
backdrop images can be very helpful to aid analysis of your vector GIS data.

Add a third theme (algorithm) showing topography

1 Click the Add Theme   button (or select View > Add Theme ). 

The files in the ‘classification_display’ directory should be displayed.

2 Open the ‘examples\data_types\digital_elevation’ folder.

A list of ER Mapper algorithm (.alg) files appears. These algorithms all show 
different ways displaying and processing digital elevation model (DEM) data f

3 Double-click on the file ‘colordrape.alg.’

4 In the ‘View2’ window turn on the ‘Colordrape.alg’ theme.

ArcView GIS displays a color shaded relief (or “colordrape”) image of the sam
area of San Diego. Colors represent elevation (reds are highest) and the shad
effect highlights topographic features such as hills and valleys. This image is 
illuminated from the northeast, so shadows appear on the southwest side of t
features. ER Mapper has a built-in “realtime shading” feature that lets you 
interactively change the shading parameters without creating output files.
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5 Turn the three themes on and off to compare them (if more than one is on, 
the top theme covers the others).

Add a third view to display an image and vector data

1 If desired, click the Minimize  button on the ‘View2’ window to minimize 
it.

2 On the Project window, click New to open a new View window. (It should be 
titled ‘View3’.)

3 Click the Add Theme   button (or select View > Add Theme ). 

The files in the ‘digital_elevation’ directory should be displayed.

4 Open the ‘examples\shared_data’ folder.

A list of ER Mapper image (.ers) and algorithm (.alg) files appears.

5 Double-click on the file ‘airphoto.ers.’

6 In the ‘View3’ window turn on the ‘Airphoto’ theme.

ArcView GIS displays a color aerial photo of a small area near downtown San
Diego, California. 

turn on any
theme (drag
and drop to
reorder)
342 Enterprise Wide Imagery



Chapter 22 ArcView GIS Users ● 1: Using the ER Mapper extension

ported 
ay a 

F 

ithms 

served 
u 
rver 

that 
RLs 
Overlay vector roads (in DXF format) on the airphoto
You can display any vector data such as shapefiles, coverages, and other sup
vector formats on your ER Mapper image data. In this example, you will overl
vector roads file of the corresponding area stored in DXF format.

1 From the File  menu, select Extensions... .

2 Click on the box next to ‘Cad Reader’ (if not already turned on), then click 
OK.

This enables the CAD Reader extension, so ArcView GIS can now display DX
and DWG vector files.

3 Click the Add Theme   button (or select View > Add Theme ). 

The files in the ‘shared_data’ directory should be displayed.

4 Open the ‘examples\data_types\autocad_dxf’ folder.

5 On the Add Theme  dialog, select ‘Feature Data Source’ from the ‘Data 
Source Types’ list.

6 Double-click on the file ‘roads.dxf.’

7 In the ‘View3’ window turn on the ‘Roads.dxf’ theme.

ArcView GIS displays a vector roads coverage over the airphoto. 

8 If desired, select ‘roads.dxf’ theme and change the vector color and line 
size to make them more visible. (Select Theme > Edit Legend , then 
double-click on the vector in the Symbol column).

9 Close the views by clicking the Close   button on the view windows.

These simple examples show how you can use the power of ER Mapper algor
showing various “views” of your image data, and display them directly inside 
ArcView GIS.

Open a URL file
The ER Mapper extension enables you to open an ECW compressed image, 
via an ER Mapper Image Web Server, inside arcview by specifying its URL. Yo
can then zoom into and roam over this image in real time. The Image Web Se
sends the compressed image blocks as they are requested. 

The extension includes the facility to store image URLs in a ‘Favorites’ list so 
they can easily be accessed in later ArcView® sessions. You can also select U
from a ‘History’ list that displays the last 20 URLs requested.
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In order for you to do these exercises, the PC in which ArcView is installed mu
have access to an Image Web Server over the Internet or private intranet. In t
example we will use the public ‘www.earthetc.com’ web site.

1 On the Project window, click New to open a new View window. (It should be 
titled ‘View1’.)

2 Click the Add ECW Image Theme from an Image Web Server URL  

button (or select View > Add URL Theme ). 

This should open the Image Theme URL  dialog box.

3 Enter the following URL in the URL: field.

ecwp://www.earthetc.com/images/world/gtopo30.ecw

This URL will access the gtopo30.ecw compressed image file at the Earth 
Resource Mapping www.earthetc.com web site. The protocol to be used is EC
(Enhanced Compression Wavelet Protocol).

Note: This step requires your PC to have Internet Access. If you are accessing anot
Image Web Server on a local network, you must change the URL accordingly.

The 1 Km resolution image of the world was created by using the ER Mapper
Image Display and Mosaic Wizard to mosaic 30 gtopo DTMs (Digital Terrain 
Maps). The resultant 2.8GB image was then compressed to 50 MB using ECW
compression.

4 Click on the OK button.

The image will be loaded as theme via the Internet. If you have a slow connec
to the Internet this step could take a few minutes. If your PC is not able to acc
the www.earthetc.com web site, it will display an error message.

5 In the ‘View1’ window turn on the ‘Gtopo30.url’ theme.
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ArcView GIS displays the world image. 

6 In the ‘View1’ window, select the ‘Gtopo30.URL’ theme and then select 
Edit > Delete Themes  to remove the theme. Answer Yes to the Delete 
Themes  query.

7 Click the Add ECW Image Theme   button (or select View > Add URL 
Theme ) to reopen the Image Theme URL dialog box. 

The URL: field should now be blank.

8 From the History:  list select the ‘ecwp://www/earthetc.com/images/world/
gtopo30.ecw’ entry.

The History:  list contains the last 20 URLs entered. This saves you from havin
type in the full URL to re-open a recently accessed image.

The URL:  field should now contain the URL that you selected from the History:  
list. If you were to click on the OK button, it would re-load the image as a theme 
the ‘View1’ window.

9 Click on the Add to Favorites  button to open the Add to Favorites dialog 
box.

Turn on the theme
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This box allows you to select a directory and file name to store URLs that you
likely to access again. The file names all have a .url extension.

You should note that there is already a ‘gtopo30.url’ entry in the 
‘arcview\averm\urls’ directory. The ER Mapper extension automatically create
these files in the default directory whenever you access a URL. The Add to 
Favorites  facility is really only required if you want to save the URL to anothe
directory and/or under another name.

10 Select the default directory, which should be ‘ARCVIEW\averm\urls’.

11 Enter World_ <your initials>.url in the File Name: field and click on the 
OK button to return to the Image Theme URL  dialog box. 

12 Click on the Open from Favorites  button.

This opens the Open From Favorites  dialog box

13 Select the ‘arcview\averm\urls’ directory if it is not already selected.

14 Select the ‘World_<your initials>.url’ file which you previously added. There 
should also be ‘gtopo30.url file’ that was automatically created by the 
ER Mapper extension.

15 Click on the OK button to return to the Image Theme URL dialog.

The URL: field should now contain he full URL .

16 Click on the OK button.

The image will be loaded as theme via the Internet. If you have a slow connec
to the Internet this step could take a few minutes. If your PC is not able to acc
the www.earthetc.com web site, it will display an error message. 

You should also note that the theme name is now the same as that you entere
the ‘Favorites’ file.

Default favorites
directory

Your entry

Automatically
created entry
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17 In the ‘View1’ window turn on the ‘World_<your initials>.url’ theme.

The same world image will open with the new theme name.

Zoom, pan and measure the image

1 Click the Zoom In  tool, then drag a box over the central part of the 
image to zoom into it.

2 Click on the Refresh View   button to improve the image resolution.

Tip: If you are connected to the Internet via a slow link, you may have to click on th
Refresh View button a number of times to get the best resolution. This is beca
ArcView® may display the image before it is fully downloaded from the server
The Refresh View  button reloads the image with all new information that has 
been cached on the PC.

3 Click the Pan  tool, then drag the image to view adjacent areas.

4 Click on the Refresh View   button to improve the image resolution.

5 Click the Measure  tool, then drag a line to view distances across an 
area.

The line length appears in the lower-left corner of the ArcView GIS dialog.
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Close ArcView GIS
1 If desired, save your views as an ArcView project using File > Save Project 

As....

2 Close ArcView GIS by clicking the Close   button on the application 
window or selecting File > Exit .

• Enable the ER Mapper Imagery Extension after starting ArcView GIS

• Display an ER Mapper image file (.ers) as an Image Data Source

• Display an ER Mapper algorithm file (.alg) as an Image Data Source

• Display a vector theme on an ER Mapper image

• Display an ER Mapper URL file (.ecw) as an Image Data Source.

What you 
learned...

After completing these exercises, you know how to perform the following tasks
ArcView GIS using the ER Mapper Imagery Extension:
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MapInfo Users
This chapter explains how to use the free MapImagery plug-in for MapInfo 
software to view ER Mapper imagery and algorithm files. (The free MapImage
plug-in is developed by GID Australia.) It also explains how to obtain and insta
the plug-in, and the additional imaging capabilities MapInfo users can gain by
using the plug-in in conjunction with ER Mapper. 

Note: You must have a licensed copy of MapInfo version 4.5 or greater to install and
the MapImagery plug-in. You do not need to have a copy of ER Mapper instal
but this is recommended to gain access to sample ER Mapper imagery and 
algorithms used in the following tutorial. (You can order the free ER Mapper 
installation CD-ROM from www.ermapper.com.)

About the MapImagery plug-in for MapInfo
As imagery data sources become more important for GIS applications, the ne
efficiently display, process and enhance large image files also becomes more
important. GID Australia provides a plug-in that lets MapInfo users directly disp
ER Mapper imagery and algorithms. This plug-in uses the ER Mapper proces
engine to display imagery within MapInfo. 

Using the plug-ins, MapInfo users can choose from three levels of imagery sup

• Level 1 (using the free MapImagery plug-in)–By installing the free MapImagery
plug-in, MapInfo users can directly display ER Mapper imagery and algorithm
from within MapInfo. You can also use the plug-in to display other imagery form
directly supported by ER Mapper such as GeoTIFF, BMP, GeoSPOT and oth
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• Level 2 (using the commercial MapImagery plug-in)–By installing the 
commercial version of MapImagery plug-in, MapInfo users add advanced ima
processing capabilities to MapInfo. These include contrast enhancement, 
convolution filtering, image mathematics functions, color lookup tables, and m
more. The commercial version can also create ER Mapper algorithms. For 
information on the commercial version, contact GID Australia at their web site
www.gid.com. (GID Australia also makes other ER Mapper and MapInfo tools. 
their website for information.)

• Level 3 (using the free MapImagery plug-in with a licensed copy of 
ER Mapper)–By purchasing a license for ER Mapper, MapInfo users can acce
the full range of high-level ER Mapper image processing functions, and display
images within MapInfo using the free or commercial MapImagery plug-in. 
ER Mapper provides functions for easily creating seamless, color balanced mo
of many large image files such as airphotos. It also provides advanced image
processing functions such as orthorectification, image reprojection, multispec
classification, color shaded reliefs, raster to vector conversion, image merging
fusion, support for over 100 imagery formats and over 200 hardcopy printing 
devices, and much more.

How to obtain the free MapImagery plug-in
You can obtain the free MapImagery plug-in from three sources:

• The GID Australia web site–GID Australia regularly updates the MapImagery 
plug-in and posts the latest version on their web site at www.gid.com. Naviga
the “products and services” area and download the free MapImagery plug-in.

• The ER Mapper web site–You can download the plug-in from the ER Mapper we
site at www.ermapper.com. Navigate to the “free software” area and downloa
MapInfo plug-in.

• The ER Mapper installation CD-ROM–The plug-in can be installed as a separa
component from the ER Mapper installation CD-ROM. (Note that this may not
the latest version. Check the GID Australia web site for the latest update.)

Hands-on exercises
These exercises show you how to use the free MapImagery plug-in for MapIn

• Display an ER Mapper image file (.ers) as a MapInfo table

• Display an ER Mapper algorithm file (.alg) as MapInfo table

• Overlay MapInfo vector and tabular table data on an ER Mapper image

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in MapInfo using the free MapImagery plug-in:
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• Choose MapImagery setup options to control image display and printing

Note: These exercises use sample ER Mapper imagery and algorithm files from the
ER Mapper installation CD-ROM. You may also follow the general procedures
using your own ER Mapper imagery (.ers) or algorithm (.alg) files.

1: Open an ER Mapper image file

Note: You can use the following procedure to open any image formats supported by
MapImagery, including TIFF, Windows BMP, JPEG, SPOTView, ESRI BIL, and
others. (Additional formats are added periodically, so make sure you are using
latest version of MapImagery.)

Start MapInfo
1 Start the MapInfo software on your system.

2 If the Quick Start  dialog appears, click Cancel  on it.

Before you 
begin...

Before beginning these exercises, you must have installed MapInfo version 4.5
higher and the free version of the MapImagery plug-in on your system.

Objectives Learn to use the MapImagery plug-in to display ER Mapper imagery (.ers) file
and to zoom, pan and measure distances on the image.
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In the MapInfo application window, you should see the MapImagery plug-in 
enabled as both a floating toolbar and menu:

3 Click the Maximize   button in the upper-right corner of the MapInfo 
application window (if it is not already maximized)

MapInfo expands to fill your desktop.

Open an ER Mapper-format (.ers) image file

1 Click the Open Image   button on the MapImagery  toolbar (or select 
MapImagery > Open Image ).

The option lets you open several types of imagery files directly inside MapInfo

2 On the Open Image Files  dialog, open the ‘Files of Type’ list.

MapImagery menu and toolbar

Open Image
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A list of all the supported imagery formats displays. You can open ER Mapper
imagery (.ers) and algorithm (.alg) files, as well as TIFF and BMP and compre
formats such as ER Mapper’s compressed wavelet (.ecw), and JPEG. (Make 
the ‘All Image Files’ option is selected when closing the list.)

3 Double-click on the folder where ER Mapper is installed. Then open the 
directory ‘examples\Applications\Land_Information.’

A list of ER Mapper imagery (.ers) and algorithm (.alg) files appears.

4 Scroll down to the bottom, then double-click on the file 
‘SPOT_XS_07Aug88.ers.’

5 If you see a message asking to overwrite the existing .alg file, click Yes.

The Choose Algorithm Style  dialog appears. This lets you select how you wa
MapImagery to display the image.

6 Select the ‘Automatic contrast stretching’ option, then click OK.

7 If you see a message asking to overwrite the previous .tab file, click Yes.

The MapImagery Projection dialog appears.

8 Select the correct MapInfo projection items (as follows), then click OK:

• MapInfo Category–>Universal Transverse Mercator (NAD27 for US)

• MapInfo Category Members–>UTM Zone 11 (NAD27 for US)

• MapInfo Units –meters

MapImagery displays a SPOT XS color satellite image of the San Diego, Califo
area in a new map window. This is a 3-band color infrared image, so vegetate
areas appear in red tones. The spatial resolution (pixel size) is 20 meters.

Note: When you open image or algorithm file, MapImagery creates a MapInfo table (
file to allow correct coordinates and georeferencing. You may be prompted to 
overwrite this file; see “Table (.tab) files created by MapImagery” in part 3 in th
chapter for details on when and why to do this.

Zoom, pan and measure the image

1 Click the Zoom-in  button on the Main  toolbar, then drag a box around 
the central part of the SPOT image to zoom in on it.

2 Click the Grabber  tool, then drag the image to view adjacent areas.

3 Click the Ruler  tool, then drag a line between two points on the image 
and double-click to end it.
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The distance along the line is displayed in the pop-up Ruler  dialog.

4 Select Map > View Entire  Layer, then click OK on the pop-up dialog.

The image zooms out to the full extents of the SPOT satellite image.

View geographic coordinates on the image
1 Select Map > Options .

2 On the Map Options  dialog, select degrees  or meters  for ‘Coordinate 
Units’ (whichever you prefer).

3 Under ‘Display in Status Bar,’ click ‘Cursor Location.’ Then click OK.

4 Move the cursor around inside the satellite image.

Geographic coordinates appear in the Status Bar (lower-left area). The coord
are in Latitude/Longitude (if you chose degrees) or meters of Eastings and 
Northings in the UTM projection (if you chose meters).

5 Select File > Close All  to close all current tables (in case any others were 
also open).

2: Open ER Mapper algorithm files

Open an ER Mapper algorithm (.alg) file
In ER Mapper, an algorithm is a list of processing steps or instructions ER Mapp
uses to transform a raw imagery file into a final, enhanced image on your scre
printer. Algorithms let you define a “view” into your data that you can save, relo
and modify at any time. By using the MapImagery plug-in, you can display 
ER Mapper algorithms just like any other imagery file.

Tip: You can create algorithm files with ER Mapper or with the commercia
version of the MapImagery plug-in. You only need the free MapImagery plug-i
view algorithm files in MapInfo.

Objectives Learn to use the MapImagery plug-in to display ER Mapper algorithm (.alg) file
and to add several images as different layers in your map.
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1 Click the Open Algorithm   button on the MapImagery  toolbar (or 
select MapImagery > Open Algorithm ).

The files in the ‘Land_Information’ directory should be displayed.

2 Backup one directory (to ‘Applications’). Then double-click on the ‘Airphoto’ 
folder, then double-click on the ‘3_balancing’ folder.

A list of ER Mapper imagery (.ers) and algorithm (.alg) files appears.

3 Double-click on the ‘San_Diego_Airphoto_34_36_Balanced_Mosaic.ers’ 
file.

4 If you see a message asking to overwrite the previous .tab file, click Yes.

5 The correct MapInfo projection parameters are displayed, then click OK.

MapImagery displays a mosaic of two orthorectified color airphotos of the 
downtown San Diego, California area. This image is created from an ER Map
algorithm, so it has several processing enhancements applied to the two airph
imagery (.ers) files used as input:

• brightness and color variations within each image are normalized to remove 
“hotspots” or light-to-dark variations across each photo

• the contrast and brightness of the two normalized images are then balanced t
other ensure uniform color and brightness across the mosaic

• the seam between the two images is feathered to ensure a smooth transition b
the two images and make the mosaic truly “seamless”

6 Click the Zoom-in  button on the Main  toolbar, then drag a box around 
the central area of the airphoto mosaic.

MapImagery applies the algorithm processing to the airphotos, then zooms in
display your area of interest.

7 Click the Grabber  tool, then drag the image to view adjacent areas.

MapImagery applies the algorithm processing, then pans to display the adjac
area.

8 Select File > Close All  to close all current tables (in case any others were 
also open).

Open Algorithm
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This example shows how you can access the power of ER Mapper algorithms
apply complex image enhancements and display them directly within MapInfo
(Each one of these airphotos is over 30MB in size.) This example uses only tw
airphotos, but you could just as easily display a mosaic algorithm containing 1
of megabytes (even gigabytes) of airphoto images.

Note: When you have displayed an image and selected the projection information in
MapInfo, MapImagery remembers this in the future. See “Choosing map projec
information” in part 3 in this chapter for more information on how and when to
select projections.

Set the option to add multiple images to the current mapper
For this next example, you will add several images as layers in the same map
window. MapImagery has setup options to make this easier.

1 Click the MapImagery Options  button (on the MapImagery  toolbar), 
or select MapImagery > MapImagery Options .

2 Click the General  tab. Under ‘When Opening an Algorithm Table’ select the 
‘Add to Current Mapper’ option. Click OK.

This tells MapImagery to add new images to the same mapper, rather than op
new mapper each time.

Open a merged satellite image algorithm

1 Click the Open Algorithm   button on the MapImagery  toolbar (or 
select MapImagery > Open Algorithm ).

The files in the ‘3_Balancing’ directory should be displayed.

2 Backup to the ‘examples’ directory. Double-click on the 
‘Functions_and_Features’ folder, then double-click on the ‘Data_Fusion’ 
folder.

A list of ER Mapper algorithm (.alg) files appears. These algorithms all show 
different ways of merging (or “fusing”) two different images into one.

3 Double-click on the file ‘Brovey_Transform.alg.’

4 The correct MapInfo projection parameters are displayed, then click OK.

MapImagery displays a color image of the San Diego, California area. This is 
merge of a Landsat TM satellite image (bands 5, 4 and 2) and a SPOT 
Panchromatic satellite image. By merging the two types of data, you get the h
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spatial detail provided by the SPOT Pan image (10-meter resolution) with the 
multispectral color information provided by the Landsat TM image (seven band
30-meter resolution). 

The Brovey Transform is a mathematical way of combining the two images th
also greatly enhances the color. Merging or fusion techniques like this are use
combine the strengths of different satellite sensors and create detailed, up-to-
views of the earth’s surface.

5 Use the Zoom-in  tool to zoom into the image. Then use the Grabber 

 tool to pan around inside it.

MapImagery applies the algorithm processing to merge the two image files, th
displays your new area of interest.

The image shows a high resolution, color-enhanced view of the area. As with 
airphoto mosaic, the ER Mapper algorithm creates this image interactively from
two separate Landsat and SPOT satellite imagery files. (The Brovey Transform
technique usually requires up to three intermediate image files to be created w
using traditional imaging software, but ER Mapper performs the processing in
time from the two source images without creating intermediate files.)

6 Select Map > View Entire Layer , then click OK on the pop-up dialog.

The image zooms out to the full extents of the merged satellite image.

Add a second image (algorithm) showing thematic land cover

1 Click the Open Algorithm   button on the MapImagery  toolbar (or 
select MapImagery > Open Algorithm ).

The files in the ‘Data_Fusion’ directory should be displayed.

2 Open the ‘examples\Functions_and_Features\Classification_Display’ folder.

3 Double-click on the file ‘ISOCLASS_Classification.alg.’

4 The correct MapInfo projection parameters are displayed, then click OK.

MapImagery displays a thematic color image of the same area of San Diego. 
Different colors correspond to different types of landuse in the area. This imag
was created from a 1985 Landsat TM satellite image using ER Mapper’s 
ISOCLASS unsupervised classification feature. Classification groups pixels w
similar spectral values into classes that can represent different types of landu
land cover. 
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Add a third image (algorithm) showing topography

1 Click the Open Algorithm   button on the MapImagery  toolbar (or 
select MapImagery > Open Algorithm ).

The files in the ‘Classification_Display’ directory should be displayed.

2 Open the ‘examples\Data_Types\Digital_Elevation’ folder.

A list of ER Mapper algorithm (.alg) files appears. These algorithms all show 
different ways displaying and processing digital elevation model (DEM) data f

3 Double-click on the file ‘Colordrape.alg.’

4 The correct MapInfo projection parameters are displayed, then click OK.

MapImagery displays a color shaded relief (or “colordrape”) image of the sam
area of San Diego. Colors represent elevation (reds are highest) and the shad
effect highlights topographic features such as hills and valleys. This image is 
illuminated from the northeast, so shadows appear on the southwest side of t
features. ER Mapper has a built-in “realtime shading” feature that lets you 
interactively change the shading parameters without creating output files.

View the three images (layers) in the mapper

1 Click the Layer Control  button on the Main  toolbar (or select Map > 
Layer Control ).

2 In the Layer Control dialog, turn off the Visible checkboxes for the 
‘Colordrape’ and ISOCLASS_classification’ layers, then click OK.

MapImagery redisplays the Brovey Transform algorithm.

3 If desired, repeat step 2 to view other images (turn on only the one you 
want, then click OK).

Turn off Visible
checkbox for layers
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4 If desired, save your workspace using File > Save Workspace .

5 Select File > Close All  to close any open tables.

3: Overlay MapInfo vector data

Open an ER Mapper world topography algorithm

1 Click the Open Algorithm   button on the MapImagery  toolbar (or 
select MapImagery > Open Algorithm ).

2 Backup to the ‘examples’ folder, open the ‘applications’ folder, then open the 
‘World_Topography’ folder.

A list of ER Mapper imagery (.ers) and algorithm (.alg) files appears.

3 Double-click on the ‘World_Topography.alg’ file.

4 If you see a message asking to overwrite the previous .tab file, click Yes.

5 Select the correct MapInfo projection items (as follows), then click OK:

• MapInfo Category–>Longitude / Latitude

• MapInfo Category Members–>Longitude / Latitude

• MapInfo Units –degrees

MapImagery displays a color shade relief image (a “colordrape”) of the world.
Colors of the land areas represent elevation (magenta are the highest, red are
lowest). Ocean areas are colored blue, and bathymetric features such as mid
ridges are shown by the shading effect.

Note: When displaying data that is in a Longitude Latitude coordinate system, it is 
important to select ‘degrees’ as the map projection units. This lets you overlay
other data that is also stored in degrees.

View Longitude Latitude coordinates on the image
1 Select Map > Options .

2 On the Map Options  dialog, select degrees  for ‘Coordinate Units.’

Objectives Learn to overlay MapInfo vector and point table data on an ER Mapper algorith
image. In this case, you will display a world shaded relief image generated by
ER Mapper algorithm, then overlay MapInfo data of a Lat/Long grid, world 
capitals, and country borders.
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3 Under ‘Display in Status Bar,’ click ‘Cursor Location.’ Then click OK.

4 Move the cursor around inside the satellite image.

Longitude Latitude coordinates appear in the Status Bar. (Negative Longitude
indicate the western hemisphere, and negative Latitudes indicate the souther
hemisphere.)

Overlay a Longitude Latitude coordinate grid
1 Select File > Open Table .

2 On the Map Options  dialog, open the ‘WORLD’ directory (under the 
MapInfo ‘Data’ directory).

3 Double-click on the ‘GRID15.TAB’ file.

MapInfo overlays a Longitude Latitude grid (graticule) with a 15-minute grid 
spacing.

Overlay a table of world capital cities
1 Select File > Open Table .

2 Double-click on the ‘WORLDCAP.TAB’ file.

MapInfo overlays the locations of world capital cities.

3 Click the Layer Control  button on the Main  toolbar (or select Map > 
Layer Control ). Turn on auto labelling, then click OK.

MapInfo redisplays the world map with labels (city names) plotted next to the 
symbols. (If desired, you can make the labels bigger, change fonts, and so on
selecting Layer Control  again and clicking Labels ...).

Turn on
Auto Label
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Overlay a table of vector country borders
1 Select File > Open Table .

2 Double-click on the ‘WORLD.TAB’ file.

MapInfo overlays the borders of countries on the world map.

Turn off the GRID15 and WORLDCAP layers

1 Click the Layer Control  button again. Turn off the ‘GRID15’ and 
‘WORLDCAP’ layers, make the ‘WORLD’ layer editable, then click OK.

MapInfo redisplays the map without the grid and capital cities layers.

Make the Africa country border polygons transparent

1 Click the Marquee Select  button on the Main  toolbar, then drag a 
selection box around the continent of Africa.

MapInfo selects all the polygons in your selection marquee.

2 Click the Region Style  button on the Draw  toolbar (or select Options 
> Region Style ).

3 On the Region Style dialog, select the ‘Pattern’ of ‘None,’ then click OK.

The selected region polygons redisplay without the fill pattern, so you can see
country borders in relation to the ER Mapper world topography image.

4 Click Zoom-in  on the Main  toolbar, then drag a box around the African 
continent to zoom in on it.

Turn off display
of GRID15 and
WORLDCAP

Make WORLD
layer editable
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Query the country data or go to other areas of the world
1 If desired, use the MapInfo query tools to get information about the 

countries, or follow the same steps as above to make country borders for 
other regions transparent.

2 (Optional.) Save your workspace using File > Save Workspace .

4: MapImagery settings and options

Table (.tab) files created by MapImagery
When you open an ER Mapper imagery or algorithm file (or any other support
format), MapImagery automatically creates a MapInfo table (.tab) file for the 
image. The table file contains information on the map projection, image exten
viewing resolution, and other information MapInfo needs to properly display th
image. When you open an image or algorithm file that was already opened in
past, MapImagery prompts you to overwrite the previously created table file in 
you have changed any parameters since then. 

You would want to overwrite the existing table file in the following cases:

• You selected the wrong map projection information the first time. Click Yes to 
overwrite the existing table file for the image, and select the correct projection
information for the future.

• You change the ‘Supersampling Factor’ on the MapImagery Options  dialog’s 
Supersampling  tab. This option lets you manipulate the quality of images with
MapInfo, but is also tied to the image extents and coordinates saved in the tab
If you change the supersampling factor, you must regenerate the table files fo
imagery files you opened in the past. Click Yes to overwrite the existing table file
for the image to update the supersampling setting. (If you do not overwrite the
existing table file, your image will display but the map coordinates will be wron
so this is very important.)

Algorithm (.alg) files created by MapImagery
When you open an ER Mapper imagery (.ers) or other supported image file, 
MapImagery automatically creates an ER Mapper-format algorithm file for the
image (in addition to a MapInfo table file). The algorithm file tells MapImagery
how to display the image file, and is independent from the image file itself.

Objectives Learn to understand the way MapImagery handles and displays imagery, and 
to setup default options to control the way images are displayed and printed in
MapInfo. (There are no exercises here, only information.)
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When you open an image file that was already opened in the past, MapImage
prompts you to overwrite the previously created algorithm file. You should do 
if you want to change the contrast enhancement option you selected the first 
you opened the image. Otherwise, you do not need to overwrite it.

Choosing map projection information
When you open an ER Mapper or other image file for the first time, or when y
choose to overwrite an existing table (.tab) file, you are presented with MapIn
projection options. These options let you choose the correct map projection a
coordinate units, and these are important to make sure that georeferenced im
display with correct coordinates in MapInfo.

Since the image often originated in ER Mapper, it usually has georeferencing 
information attached to it (stored in the .ers header file). You need to match th
ER Mapper projection information to the equivalent information in MapInfo. On
you do this one time for a given projection type, MapImagery remembers this 
setting and will automatically set the MapInfo defaults for you when you open
another image that has the same ER Mapper projection parameters.

To match the ER Mapper projection information to the MapInfo equivalent, 
examine the ER Mapper information at the top, then make the appropriate 
selections from MapInfo projection database:

ER Mapper datum,
projection, units

Select corresponding
MapInfo Category,
Member and Units
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The Supersampling setting
When you open an ER Mapper or other image file, MapImagery processes an
displays the image data at a predefined resolution. This is called supersampling, 
and is controlled by the ‘Supersampling Factor’ on the MapImagery Options  
dialog’s Supersampling  tab. For example, if you set supersampling to 8, then
8x8 pixel area is displayed for every underlying pixel.

You should set the supersampling factor according to these guidelines:

• Use lower values to speed display of very large images, or mosaic algorithms
containing many images. Lower values may not produce optimal hardcopy pr
however.

• Use higher settings to improve detail in on the screen when smoothing is enab
the ER Mapper algorithm, and when hardcopy printing from MapInfo.

Contrast enhancement options
When you open an ER Mapper imagery (.ers) file and are prompted to create
algorithm for it, clicking Yes displays the Choose Algorithm Style  dialog. This 
dialog lets you choose how contrast will be adjusted to improve the image 
presentation: 

• Create an algorithm with No contrast stretching–This displays the image without
enhancing the contrast. Use this option if you wish to view the image without 
enhancement or if your image is already contrast enhanced. Non-photograph
images like digital terrain models (DEMs) may look better when displayed this w
or may look better with contrast stretching.

• Create an algorithm with Automatic contrast stretching–This displays the image
with a linear contrast enhancement to improve color and brightness. Use this o
for images that are not already contrast enhanced (like satellite images) or if y
images look too dark or light or lack contrast using the no stretching option. 

The type of contrast enhancement applied is a linear contrast stretch that “clip
saturates) a certain percentage of brightest and darkest pixels at the high and
ends of the image histogram. The amount of clipping (percentage) is set in th
MapImagery Options  dialog’s Algorithm Generation tab. A 99% clip 
applies a mild contrast enhancement that look good on many types of images.
image still lacks contrast, choose 97.5. (The smaller the percentage the more
contrast, but experiment for best results.)

Note: The algorithm file contains the contrast enhancement settings, so the setting 
choose is automatically applied to all images you open (if you choose to overw
an existing algorithm file). If you have a problem image, try smaller percent va
for that image, then set the default back to 99% so it is used in the future.
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Close MapInfo

1 Close MapInfo by clicking the Close   button on the application window 
or selecting File > Exit .

• Display an ER Mapper image file (.ers) as a MapInfo table file

• Display an ER Mapper algorithm file (.alg) as MapInfo table file

• Overlay MapInfo vector and tabular table data on an ER Mapper image

• Choose MapImagery setup options to control image display and printing

What you 
learned...

After completing these exercises, you know how to perform the following tasks
MapInfo using the free MapImagery plug-in:
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Autodesk World
Users

This chapter explains how to use the capabilities of the Autodesk World softwa
display ER Mapper imagery and algorithm files as backdrops. This chapter co
steps similar to those described in the Autodesk World software documentatio
help system. 

Note: You must have a licensed copy of Autodesk World 2.0 to run this tutorial. You 
not need to have a copy of ER Mapper installed, but this is recommended to g
access to sample ER Mapper imagery and algorithms used in the following tut
(You can order the free ER Mapper installation CD-ROM from 
www.ermapper.com.)

About Autodesk World’s ER Mapper image viewing engine
As imagery data sources become more important for GIS applications, the ne
efficiently process, enhance and display large image files also becomes more
important. Many projects require the analysis of vector GIS drawing data by 
presenting it over image backdrops that show a “real world” perspective. For 
example, you gain a better understanding of parcel ownership, tax zones, zip c
and many other vector entities by overlaying them on an airphoto showing lan
and buildings.
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Autodesk World incorporates the ER Mapper viewing engine, which lets you 
incorporate nearly any type of image data into your projects. These include ae
photographs, satellite images, digital elevation (topography) images and man
more image types.

By incorporating the ER Mapper image viewing engine, Autodesk World users
not restricted by limited image handling capabilities as are some other GIS 
products. You can directly display ER Mapper imagery and algorithms, and im
formats with location information such as GeoTIFF, ESRI/GeoSPOT HDR, an
others. In addition, you can experience the full power of ER Mapper algorithm
from within Autodesk World.

Using Autodesk World with ER Mapper
By using Autodesk World in conjunction with a copy of the ER Mapper softwa
you gain access to the extensive capabilities of this powerful integrated mapp
and image processing product, including:

• Import and display over 100 different image formats

• Use advanced image processing functions such as contrast enhancement, 
multispectral classification, vegetation indexes, color shaded reliefs, filtering, 
merging images, and many others.

• Directly read TIFF, GeoTIFF, Windows BMP, ER Mapper images and algorith
ESRI BIL, SPOTView and Universal Data Format (UDF) imagery without the n
for import or conversion

• Easily view the entire project area in one image–no limits on image file sizes

• Geocode, orthorectify or reproject imagery easily to precisely register with GIS
vector drawing data

• Automatically display, mosaic and color balance numerous images

• Combine imagery, vector and tabular data from any number of sources

• Create and edit vector data over imagery backdrops, and highlight features of
interest and save them as vectors with ER Mapper’s raster to vector conversio

Hands-on exercises
These exercises show you how to use the ER Mapper image display capabilit
within Autodesk World.

• Insert an ER Mapper image into an Autodesk World drawing

What you will 
learn...

After completing these exercises, you will know how to perform the following 
tasks in Autodesk World:
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• Enhance the image contrast and apply image smoothing

• Choose equivalent coordinate systems in Autodesk World and ER Mapper

• Insert an ER Mapper smart data algorithm into an Autodesk World drawing

• Stack and change the order of multiple images in a drawing

• Combine image and vector drawing data in a project

1: Inserting an ER Mapper image

The ER Mapper imagery (.ers) format stores image data in its “raw” form. Tha
the imagery may not be processed or enhanced for best presentation. When 
insert an ER Mapper image, Autodesk World gives you options to enhance th
imagery as it is loaded and displayed.

Start Autodesk World
1 Start the Autodesk World software on your system.

2 Click the Maximize   button in the upper-right corner of the Autodesk 
World application window (if it is not already maximized).

Autodesk World expands to fill your desktop. You should start with a new proje

3 If you do not already have a new (empty) project open, start one by 
choosing File > New , then clicking Blank Template .

4 If the Display Manager  window is open, close it.

Before you 
begin...

Before beginning these exercises, you must have installed Autodesk World 
version 2.0 or higher on your system. These exercises use sample ER Mappe
imagery and algorithm files from the ER Mapper installation CD-ROM. You ma
also follow the general procedures using your own ER Mapper imagery (.ers) 
algorithm (.alg) files.

Objectives Learn to insert ER Mapper imagery (.ers) files into an Autodesk World drawing
(You can also use the following procedure to open any image formats directly
supported by ER Mapper, including TIFF and GeoTIFF, Windows BMP, 
SPOTView, ESRI BIL, and others.)
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Set the coordinate system for the new project
All projects have an associated coordinate system. If you are beginning with a
ER Mapper image that has location information as your “basemap,” you shou
choose the same coordinate system as the image for your project.

1 Choose File > Properties .

2 Click the Coordinate System  tab, then click Change....

3 On the Project Detail  dialog, select UTM27-11 from the Coordinate 
System  list.

This selection specifies a coordinate system using the NAD27 datum and the
Universal Transverse Mercator (UTM) map projection (zone 11 in the northern
hemisphere). The coordinate units are meters, so locations are defined in me
Eastings and Northings.

4 Click OK on the Project Detail  dialog, then click OK on the Project 
Properties  dialog.

This coordinate system is now assigned to your project, and is the same one u
the ER Mapper images you will use in the upcoming examples.

Insert an ER Mapper-format (.ers) image into the drawing
1 Choose Insert > ER Mapper Image .

2 On the Insert ER Mapper Image  dialog, click the Image  tab, then click 
Browse .

3 Double-click on the folder where ER Mapper is installed, then open the 
‘examples/Applications/Airphoto/1_Geocoding’ folder.

A list of ER Mapper algorithm (.alg) files appears.

4 Turn off the ‘Bilinear Smoothing’ and ‘Contrast Stretching’ options. (These 
will be explained later).

5 Click on the ‘Files of Type’ list to view the different image formats.

You can insert ER Mapper algorithms (.alg) and datasets (.ers), as well as TIF
BMP, ARC/INFO-GeoSPOT HDR, and others.

6 From the ‘Files of Type’ list, select Datasets (*.ers) .

7 Double-click on the file ‘San_Diego_Airphoto_34_rectified.ers.’

8 Click the Zoom All   button or choose View > Zoom All .

Autodesk World displays a color aerial photograph of the downtown San Dieg
California area. This image has been rectified to the NAD27 datum and UTM zone
11 map projection, so it has geographic location information (true earth 
coordinates).
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Zoom in to a small area to see the pixel resolution

1 Click the Zoom Window  button (or choose View > Zoom Window ), 
then drag a very small box over part of the photo to zoom into it.

If needed, do this again until you can see the small square areas that compris
digital image. These squares are called pixels (for picture elements), and are 
roughly equivalent to the smallest object you can see in the photo. In this ima
each pixel is about 1 meter in diameter, which is termed “1-meter resolution.”

Reload the image with smoothing and contrast enhancement
1 Choose Insert > ER Mapper Image .

2 This time turn on the ‘Bilinear Smoothing’ and ‘Contrast Stretching’ options.

3 From the ‘Files of Type’ list, select Datasets (*.ers) .

4 Click Browse , then double-click on the file 
‘San_Diego_Airphoto_34_rectified.ers’ again to reload it.

The airphoto image redisplays with improved contrast and a “smoother” 
appearance.

• Bilinear Smoothing improves the display of zoomed images or large hardcopy
prints by averaging the pixel values to remove the “blocky” look you saw previo
when smoothing was not turned on. (You only see the effect of smoothing when
zoom into the pixel level.)

• Contrast Stretching generally improves the image color and presentation by 
increasing contrast between the light and dark areas. This option is recomme
when inserting most image files, otherwise they may lack contrast or look too 
or light.

Zoom in and out in the image

1 Click the Zoom All   button or choose View > Zoom All .

The image zooms out to display the full extents of the airphoto.

2 Click the Zoom Window  button (or choose View > Zoom Window ), 
then drag a box over the central part of the photo to zoom into it.

3 Click the Zoom In  or Zoom Out  buttons, then click on the image 
to zoom in or out by fixed amounts.

4 When finished, click the Zoom All   button or choose View > Zoom All 
to zoom out to the full image extents.
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5 Once again, click Zoom Window , then drag a box over the central part 
of the photo to zoom into it.

Pan (scroll) the image

1 Click the Pan 2 Points  button (or choose View > Pan ). Click on one 
point in the photo, then click on a second point.

The image pans (scrolls) in the direction and distance you defined by your two
points. This is one way to view adjacent areas of an image.

2 Drag the scroll bars on the right or lower areas of the project window. 

The image pans in the direction you drag the scroll bar.

View geographic coordinates on the image
1 Choose Tools > Format Options .

2 Click the Coordinate  tab, select Latitude Longitude  from the ‘Display 
Type’ list, then click OK.

3 Point to various locations in the image.

The Latitude Longitude coordinates of the current cursor location appear in th
status bar. (The format is decimal degrees, and negative longitudes indicate t
western hemisphere.)

4 Choose Tools > Format Options  again.

5 Click the Units  tab, then select m from the ‘User Unit’ list.

6 Click the Coordinate  tab, select Projection Coordinate from the ‘Display 
Type’ list, then click OK.

7 Point to various locations in the image.

The UTM map projection coordinates appear in the status bar. (The format is 
meters of Northings and Eastings in UTM zone 11.)

Close the project
1 Choose File > Close .

When asked to save the contents or save changes, click No.
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2: Inserting multiple coregistered images

An ER Mapper algorithm is a list of processing steps or instructions ER Mappe
uses to transform a raw image file into a final, enhanced image on your scree
printer. An algorithm does not contain the actual image data, but only stores 
references to it. (The actual image data is stored in ERS or other files.) When
insert an ER Mapper algorithm into an Autodesk World drawing, it follows the 
steps in the algorithm and displays the finished image accordingly.

Note: In order to precisely overlay multiple images (as you will do next), the images m
have the same coordinate system information.

Start a new project
1 Start a new project by choosing File > New , then clicking Blank Template .

Set the coordinate system for the new project
1 Choose File > Properties .

2 Click the Coordinate System  tab, then click Change....

3 On the Project Detail  dialog, select UTM27-11 from the Coordinate 
System  list.

Set the data viewing coordinate type
1 Choose Tools > Format Options .

2 Click the Units  tab, then select m from the ‘User Unit’ list.

3 Click the Coordinate  tab, select Projection Coordinate from the ‘Display 
Type’ list, then click OK.

The display coordinates are now set to the units of the map projection (meters
Northings and Eastings in UTM zone 11.)

Objectives Learn to insert ER Mapper smart data algorithm (.alg) files into an Autodesk 
World drawing. Also learn to “stack” multiple images covering the same 
geographic area, and to turn images on/off and move them to the top of the 
display.
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Create drawing layers to display three different images
1 Choose File > Data Manager .

The Data Manager dialog lets you add and controls layers in your drawings.

2 Click the Drawing Data  tab to view drawing layers

3 Right-click on ‘Drawing1’ then select New Layer .

A new ‘Layer1’ is added in addition to the default ‘0’ layer.

4 Click on the ‘Layer1’ text and change it to satellite image .

5 Right-click on ‘Drawing1’ again, select New Layer , then name the new layer 
landuse image .

6 Right-click on ‘Drawing1’ again, select New Layer , then name the new layer 
terrain image .

You should have three new labelled layers (the order does not matter for now)

7 Click Close  on the Data Manager  dialog box.

Insert an ER Mapper satellite image algorithm (.alg) file
1 Choose Insert > ER Mapper Image .

2 On the Insert ER Mapper Image  dialog, click the Image  tab, then click 
Browse .

3 On the Insert Picture  dialog, select Algorithms (*.alg) from the ‘Files of 
Type’ list.

Drawing Data  tab

new drawing layers where
images will be inserted
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Note: When you insert an algorithm file, the Bilinear Smoothing and Contrast Stretc
options are disabled because the algorithm file contains the contrast enhance
and other information.

4 Double-click on the folder where ER Mapper is installed, then open the 
‘examples/Functions_And_Features/Data_Fusion’ folder.

A list of ER Mapper algorithm (.alg) files appears. These algorithms all show 
different ways of merging (or “fusing”) two different images into one picture.

5 Double-click on the file ‘Brovey_Transform.alg.’

Tip: You need a license for ER Mapper to create algorithms, but you can
insert and view them in directly in Autodesk World. This means that anyone u
ER Mapper can create algorithms and send them to you for use in your projec

6 Click General  tab, then select satellite image  from the ‘Layer’ list.

You can insert ER Mapper algorithms (.alg) and datasets (.ers), as well as TIF
BMP, ARC/INFO-GeoSPOT HDR, and others.

7 Click OK to insert the image into the drawing layer, then click Zoom All   

or choose View > Zoom All  to display it.

Autodesk World displays a color image of the San Diego, California area. This
merge of a Landsat TM satellite image (bands 5, 4 and 2) and a SPOT 
Panchromatic satellite image. By merging the two types of data, you get the h
spatial detail provided by the SPOT Pan image (10-meter resolution) with the 
multispectral color information provided by the Landsat TM image (seven band
30-meter resolution). 

select layer where
image will be inserted
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The Brovey Transform is a mathematical way of combining the two images th
also greatly enhances the color. Merging or fusion techniques like this are use
create to combine the strengths of different satellite sensors and create up-to
views of the earth’s surface.

8 Click Zoom Window  (or choose View > Zoom Window ), then drag a 
box over the central part of the image to zoom into it.

The image shows a high resolution, color-enhanced view of the area. The 
ER Mapper algorithm creates this image interactively from the two separate 
Landsat and SPOT satellite imagery files. (The Brovey Transform technique 
usually requires up to three intermediate image files to be created when using
traditional imaging software, but ER Mapper performs the processing in real ti
from the two source images without creating intermediate files.)

9 When finished, click the Zoom All   button or choose View > Zoom All 
to zoom out to the full image extents.

Insert a second algorithm image showing thematic landuse
1 Choose Insert > ER Mapper Image .

2 On the Insert ER Mapper Image  dialog, click the Image  tab, then click 
Browse .

3 Double-click on the folder where ER Mapper is installed, then open the 
‘examples/Functions_And_Features/Classification_Display’ folder.

A list of ER Mapper algorithm (.alg) files appears. These algorithms all show 
different ways of merging (or “fusing”) two different images into one picture.

4 Double-click on the file ‘Isoclass_classification.alg.’

5 Click General  tab, then select landuse image  from the ‘Layer’ list.

6 Click OK to insert the image into the layer and display it.

Autodesk World displays a thematic color image of the same area of San Dieg
Different colors correspond to different types of landuse in the area. This imag
was created from a 1985 Landsat TM satellite image using ER Mapper’s 
ISOCLASS unsupervised classification feature. Classification groups pixels w
similar spectral values into classes that can represent different types of landu
land cover. 

Insert a third algorithm image showing terrain and topography
1 Choose Insert > ER Mapper Image .

2 On the Insert ER Mapper Image  dialog, click the Image  tab, then click 
Browse .
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3 Double-click on the folder where ER Mapper is installed, then open the 
‘examples/Data_Types/Digital_Elevation’ folder.

These algorithms all show different ways displaying and processing digital 
elevation model (DEM) data files.

4 Double-click on the file ‘Colordrape.alg.’

5 Click General  tab, then select terrain image  from the ‘Layer’ list.

6 Click OK to insert the image into the layer and display it.

Autodesk World displays a color shaded relief (or “colordrape”) image of the s
area of San Diego. Colors represent elevation (reds are highest) and the shad
effect highlights topographic features such as hills and valleys. This image is 
illuminated from the northeast, so shadows appear on the southwest side of t
features. ER Mapper has a built-in “realtime shading” feature that lets you 
interactively change the shading parameters without creating output files.

View any of the three images
It is often helpful to “stack” multiple different types of images of the same 
geographic area (as you did here). Images are treated as CAD entities in Auto
World, so you stack multiple images the same way you stack vector data–put 
image on a separate layer and just turn the layers on and off. You can also co
the redraw order (which image is on top) of the layers by dragging them aroun
the Display Manager to achieve the desired ordering. 

1 Choose View > Display Manager .

2 In the Display Manager dialog, turn off the Entity Style checkboxes for the 
‘landuse image’ and the ‘terrain image.’

3 Press F5 (or select View > Refresh View ).

The merged color satellite image displays.

4 In the Display Manager , turn off the ‘satellite image’ checkbox and turn on 
the ‘landuse image’ checkbox, then press F5.

turn off landuse
and terrain images
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5 View any of the three images by turning on its layer and turning the other 
two off, then pressing F5 to refresh the view.

These simple examples show how you can use the power of ER Mapper algor
to showing various “views” of your image data as backdrops for analysis of yo
vector data in Autodesk World.

Close the project
1 If desired, save your project using File > Save As... .

2 Choose File > Close  to close the project.

3: Combining image and drawing data

Note: Before beginning, make sure the ‘AutoCAD DXF’ GDX driver has been added
Autodesk World. Consult your Autodesk World documentation or on-line help 
needed to do this before continuing.

Start a new project
1 Start a new project by choosing File > New , then clicking Blank Template .

Set the coordinate system for the new project
1 Choose File > Properties .

2 Click the Coordinate System  tab, then click Change....

3 On the Project Detail  dialog, select UTM27-11 from the Coordinate 
System  list.

Set the data viewing coordinate type
1 Choose Tools > Format Options .

2 Click the Units  tab, then select m from the ‘User Unit’ list.

3 Click the Coordinate  tab, select Projection Coordinate from the ‘Display 
Type’ list, then click OK.

Objectives Learn to use both image (raster) and drawing (vector) data in a project. In this
example, you will overlay a network of roads on a small aerial photograph ima
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The display coordinates are now set to the units of the map projection (meters
Northings and Eastings in UTM zone 11.)

Create a drawing layer to display an airphoto image
1 Choose File > Data Manager .

2 Click the Drawing Data  tab to view drawing layers.

3 Right-click on ‘Drawing1’ then select New Layer .

4 Click on the ‘Layer1’ text and change it to airphoto image .

Insert an ER Mapper airphoto image into the drawing
1 Choose Insert > ER Mapper Image .

2 On the Insert ER Mapper Image  dialog, click the Image  tab, then click 
Browse .

3 From the ‘Files of Type’ list, select Datasets (*.ers) .

4 Double-click on the folder where ER Mapper is installed, then open the 
‘examples/Shared_Data’ folder.

5 Double-click on the file ‘Airphoto.ers.’

6 Turn on the ‘Bilinear Smoothing’ and ‘Contrast Stretching’ options.

7 Click General  tab, then select airphoto image from the ‘Layer’ list.

8 Click OK to insert the image into the layer and display it.

9 Click the Zoom All   button or choose View > Zoom All .

Autodesk World displays a color aerial photograph of small part of the downto
San Diego, California area.

Open a DXF drawing to overlay on the airphoto image
1 Choose File > Data Manager .

2 Click the Drawing Data  tab, then click the Open Drawing   button.

3 From the ‘Files of Type’ list, select Autodesk DXF File (*.dxf) .

Note: If ‘Autodesk DXF’ does not appear as a filetype option, you need to install the
AutoCAD DXF GDX driver.

4 Open the ER Mapper ‘examples/Data_Types_AutoCAD_DXF’ folder.
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5 Double-click on the file ‘Roads.dxf.’

The DXF file is added as a layer in your project.

6 Click Close  on the Data Manager, then click the Zoom All   button or 
choose View > Zoom All .

Autodesk World displays a vector road network over the airphoto image. This 
very simple example of combining image and drawing (vector) data. This is th
most common way you will be using the ER Mapper image handling capabiliti
within Autodesk World.

Close the Autodesk World application
1 If desired, save your project using File > Save As....

2 Close Autodesk World by clicking the Close   button on the application 
window or selecting File > Exit .

• Insert an ER Mapper image into an Autodesk World drawing

• Enhance the image contrast and apply image smoothing

What you 
learned...

After completing these exercises, you know how to perform the following tasks
Autodesk World:
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• Choose equivalent coordinate systems in Autodesk World and ER Mapper

• Insert an ER Mapper smart data algorithm into an Autodesk World drawing

• Stack and change the order of multiple images in a drawing

• Combine image and vector drawing data in a project
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Index
Numerics
3D flythrough viewing 159

changing altitude 159
controlling direction/speed 160
summary of controls 161

3D perspective viewing 61, 151
bounding box 158
draw modes 157
lighting 157
multiple surfaces 161
panning the image 156
processing speed 165
resetting default view 155
rotating left/right 155
summary of movement controls 156
terrain detail 158
tilting forward/backward 154
tilting side to side 155
transparency of surfaces 163
vertical (z-scale) exaggeration 157
viewing cell values/coordinates 105
Z Offset 162
zooming in/out 155
ER Mapper Workbook - Seismic Geophysics Applications 383



Index 
A
Algorithm dialog box 43
Algorithm Geoposition Extents dialog box 168

Center option 171
Extents options 170
Zoom options 35

algorithm layers. See layers
algorithms

adding surfaces 165
basic concepts 14, 41
changing lookup table 51
colordraping 65
commenting 59, 79
copy & paste layers/surfaces 164
creating automatically 42, 181
creating manually 42
entering description 59
hue-saturation-intensity 85
multiple surfaces 161
opening 31
plotting as map object 272
printing 273
process diagram 44
saving 59, 78
simple example 49, 68
stopping (STOP) 50
tips for multiple layers 82
using as templates 43
viewing in 3-D perspective 152
wizards 181

Annotation layers
displaying vector data 239

annotation. See map composition
ARC/INFO coverages 18, 242
ArcView GIS 333

ER Mapper imagery extension 333
ArcView GIS ER Mapper plug-in

how to obtain 334
loading 335
opening ER Mapper images 336
overview 333
tutorial 335
using with ER Mapper 334
vector data 342
zoom and pan 338, 347
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Index
arithmetic operations. See formulas
aspect ratio 294
Autodesk World 367

bilinear smoothing 371
contrast enhancement 371
inserting ER Mapper images 369
setting coordinate system 370
tutorial 367
using images and drawing data 378
using multiple images 373

azimuth formula 149

B
boolean operations 135
boundary and interior tension 293

C
Calculate Statistics dialog box 200
Cell Values Profile dialog 101
centering images 171
Classification layers

displaying thematic data 138
setting color transparency 141

Color (RGB) compression 220
color (z-scale) bars 267
colordraping 65

HSI technique 85
tips 82
tips for HSI 97

combining images 65, 85
comments

defining 59, 79
viewing 61

composing maps. See map composition
compressed image

loading 222
compression of imagery 312
Compression Wizard

Actual compression ratio 222
Compress to Grayscale, RGB or Multiband 220
saving the compressed image 220
Target Compression ratio 221

Contour layer type 245
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Index 
convergence limit 293
convergence speed 293
convolution filtering. See filters

D
data inversion formulas 49, 68
data structure diagram 44
datasets. See raster datasets
dialog boxes 24

text entry 26
displaying datasets 47, 68, 75, 142
DXF files

linking to 18
Dynamic Links 18, 237

E
ECW compression 217
edge detection filters 118
Edit Sun Angle dialog box 70, 72, 89
Enterprise wide imagery 309

definition 310
free ER Mapper plug-ins 311
problems 309
solutions 311

ER Mapper
compression technology 312
dialog boxes 24
file choosers 25
help system 26
introduction 349
main menu 23
product capabilities 311
raster datasets 16
toolbars 23
user interface 21
vector datasets 16

ER Mapper plug-ins
for ArcView GIS 333
for MapInfo (MapImagery) 349
for office applications 323

ER Viewer 315
how to obtain 315
measuring distances 319
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Index
opening images 317
panning (roaming) images 319
printing images 321
product capabilities 315
tutorial 316
using as OLE server 323
viewing image properties 321
zooming (magnifying) images 318

ESRI ArcView GIS 333
exporting data 19

F
file chooser dialog boxes 25
Filter editor dialog box 119
filters

adjusting contrast 124
basic concepts 117
C 119
creating 122
deleting 122, 127
edge detection 123
editing 122
loading 120, 121
low pass (smoothing) 120
median noise removal 122
moving within diagram 126
spatial frequency 118
using multiple in stream 123, 125

Formula Editor dialog box 130
formulas

applications 129
basic concepts 129
checking syntax 133
display in process diagram 131
entering 133, 135
inverting data values 49, 68
masking data 138
null cell values 135
relations concept 131
restoring default 134
seismic azimuth 149
specifications 131
using variables 136

free imagery plugins for GIS and office applications 217
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Index 
G
Gaussian equalization 57

setting std. dev. 57
geolinking

basic concepts 167
Overview Pan mode 168
Overview Zoom mode 168
Screen mode 168, 176
setting display extents 170
setting image center 171
unlinking windows 176
using 3D images 174
Window mode 168, 172

GID Australia 349
GIS systems

ARC/INFO coverages 18
exporting images to 217
linking to 18

graphics formats
exporting to 20
using in map composition 272

Grayscale compression 220
gridding 276

aspect ratio 294
boundary and interior tension 293
convergence limit 293
convergence speed 293
creating a gridded image 280
gridded image file 280
gridding methods 276
gridding process 275
gridding wizard 279
input data types 17, 276
input sources 279
maximum number of iterations 294
minimum curvature method 277
output data 17, 276
project file 279
triangulation method 277

H
hardcopy printing 19
Height layer type 62
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Index
help
in dialog boxes 29

help system 26
high pass filters 118
histogram equalization 57, 74, 75, 91
histograms. See transforms
HSI algorithms

modifying color mapping 98
tips 97
wet look effect 95

hue (defined) 85
Hue layer type 90
hue layers 86

I
image algebra. See formulas
image files. See raster datasets
image processing

arithmetic operations 129
concepts 12
enhancements 17
ER Mapper algorithms 14
general tasks 14
output to disk file 191
rectification 225
traditional techniques 14
viewing data values 101

image windows
activating 38
closing 39
linking 167
loading datasets 47, 68, 75
measuring distances 104
moving 32
opening 31
panning with buttons 35
resizing 32
selecting current 38
setting geographic extents 170
using multiple windows 37
viewing coordinates 103
viewing dataset cell values 101
zooming with buttons 35
zooming with mouse 34
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imagery
compression 313
file formats 309
file sizes 309, 313
served over the internet 310, 311
sharing among applications 309
sharing via OLE 323
using in office applications 323

intensity (defined) 85
Intensity layer type 66, 86, 87

K
kernels. See filters

L
Layer tab 44
layers 44

Annotation 239
Annotation/Map Composition 249, 275
ARC/INFO coverage 243
changing priority (moving) 81
Classification 138
Contour 245
drag-and-drop 209
effect of ordering 195
Hue 90
Intensity 66
labelling 58
moving up or down 209
right-click layer options menu 67
selecting 62
turning on and off 74
viewing process diagram 80

Line Style dialog box 258
linking windows. See geolinking
links to external data 18, 237
loading datasets 47, 68, 75
lookup tables 51
low pass filters 118
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M
magnifying images. See zooming
map composition

adding inset images 272
area of polygon 259
basic concepts 249
deleting objects 260
drag and drop objects 267
drawing annotation 257
drawing map objects 263
duplicating (cloning) objects 262
Fast Preview option 269
importing graphics formats 272
importing text 272
length of line 258
object attributes 272
object selection tools 261
page background color 255
Page Relative option 272
Page Setup options 273
polygon attributes 259
polyline attributes 258
resizing/positioning objects 269
saving to disk 270
selecting multiple objects 261
selecting objects 258
setting map object attributes 265
setting up a page 251
special features 272
text attributes 261

map projections 225, 234
map projections. See rectification 225
MapImagery plug-in 349

algorithm (.alg) files created by 362
commercial version 350
contrast enhancement 364
controlling image layers 358
free version 349
how to obtain 350
measuring distances 353
opening ER Mapper algorithms 354
opening ER Mapper images 352
overlaying vector data 359
setting image map projection 353, 363
table (.tab) files created by 362
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tutorial 350
using with ER Mapper 350
viewing image coordinates 354
zoom and pan 353

MapInfo 349
MapImagery plug-in 349

masking images 138
math operations. See formulas
maximum number of iterations 294
measuring distances 104
mensuration 104
Microsoft Office applications 323
minimum curvature (MinC) 277
mouse buttons 22
mouse pointer

Hand mode 34
Pointer mode 101
shapes 22
Zoom mode 33
ZoomBox mode 33

Multiband compression 220
multispectral data 13

N
normalizing data ranges 202
null cell values 135

O
Object Linking and Embedding (OLE) 323
office applications

using imagery in 323
OLE

displaying images 326
drag and drop images 327
overview 324
tutorial 323

P
Page Setup dialog box 252
panning images

using linked windows 174
392 ER Mapper Workbook - Seismic Geophysics Applications



Index
with buttons 35
with mouse 34

perspective viewing. See 3D viewing
polygon attributes 259

area measurement 260
color and shading 259

polyline attributes 258, 259
polylines

arrows 258
color and style attributes 258
editing points 259
length (geographic units) 258
smoothing (spline) 259

Postscript files
linking to 18
printing to 20
using in map composition 250

printing images 19, 273
process stream diagram 44
profiles across datasets 107
profiles of data. See Traverse 105
project files 279
Pseudocolor color mode 51

R
raster dataset

map projection information 234
raster datasets

band concept 76
combining 201
description 12
displaying contours 245
editing header file 235
importing 16
merging into a single dataset 192
normalizing data ranges 202
opening directly 183
output to disk 191
statistics 199
viewing cell values 101
viewing information 199

raster images 13
rectification 17

overview 225
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regions
masking on image 146
showing means on scattergrams 114
using in formulas 145, 146

S
saturation (defined) 85
Saturation layer type 86, 91
Save As Dataset dialog box 195
saving datasets to disk 191
scattergrams

Defer button 112
highlighting on images 111
showing region means 114
viewing 110

seismic datasets
colordraping 72
HSI colordraping 85
sun angle shading 67, 87

shaded relief images 70, 73
shaded relief images. See sun angle shading
spatial frequency 118
spectral signatures

viewing 102
statistics

calculating 199
viewing 200

STOP button 50
sun angle shading

applications 72
azimuth control 71
basic use 67
elevation control 71
with colordraping 70, 73

surfaces 44
expanding/collapsing 79

T
tab pages 44
tabular data display 241
tabular data links 18
text attributes 261
Text Style dialog box 261
394 ER Mapper Workbook - Seismic Geophysics Applications



Index
toolbars
building algorithms 181
displaying 30
hiding 30
overview 23
using 29

Transform dialog box 52
transforms

Gaussian equalization 57
histogram clipping 55
histogram equalization 57
input histogram 48
plotting color bar on map 266
setting input data limits 55
view area-specific data range 58

Traverse dialog box 107
Traverse Extraction 105

modifying traverse lines 108
selecting dataset bands 107

traverse profiles 106
normalizing attribute ranges 202
tips for multiple bands 109

V
variables in formulas 136
View Mode 44
viewing data values 99
Virtual Datasets

advantages 205
basic concepts 205
creating algorithms for 210
editing 213, 214
limitations 214
loading 211
saving 210
to simplify processing 207, 210

W
warping images. See rectification 225
wavelet compression technology 217
wavelet image compression 312
well symbols 268
wet look effect 95
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windows. See image windows
wizards 181
word processing

inserting images via OLE 323

X
XYZ data 276

Z
zooming images

out to full extents 34, 37
to page extents or contents 256
using linked windows 174
with buttons 36
with mouse 34
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